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2 Introduction

Last Revised: 7 February 2024

2.1 Welcome

Welcome to ENERCALC® SEL

You've chosen one of the most respected Structural Engineering software packages
available today. In continuous development since 1983, ENERCALC SEL is the
culmination of years of development and refinement from suggestions of engineers
worldwide.

ENERCALC SEL is developed with the practicing engineer in mind. Although large
complex frames are fun projects, structural engineers spend most of their time designing
and analyzing the components of structures. Because most of the buildings worldwide rely
on simple beams, columns, foundations, walls, and other small items, this software
system will quickly become your best friend. ENERCALC SEL remembers the
mathematics, building code provisions, and standard materials you need to perform a
detailed and economical design.

Because we feel that simple, repetitive engineering problems are far more common than
extensive 3-D frame analysis, this software package is designed specifically for fast,
interactive engineering design of building components. We've combined the typical working
methods of engineers, national building code provisions, and construction material
databases with the principles of structural mechanics into each "calcsheet" module. You
will find that these modules operate very much like an electronic calculation pad.....simply
fill in the data entries and the entire calculation will be instantly updated for your review. 

To add even more power and utility to the system, we've added detailed design sketches
and stress diagrams, automatic design and sizing, an online help system, material
databases, and elegant calculation printing to ENERCALC SEL. 

ENERCALC SEL is designed around a file of calculations called a "Project". This single
file with the extension "EC6" can hold one or thousands of individual calculations. You add,
edit, and delete the calculations in your Project File during the in-office design stage. Then,
when it's time for submittal to a governing agency, you can print a complete set of
calculations. 

Because of the ever-expanding number of modules, we invite you to stay in close contact
with our website at enercalc.com. Maintenance releases, up-to-the-minute technical
advice, revised electronic documentation, and new product information will all be provided
there FIRST. 

ENERCALC has put years of work into this package in support of the highly technical and
dedicated service Structural Engineers provide to the people of the world. We continue to
enhance this product weekly and are committed to developing this product well into the
future. We extend our thanks for choosing ENERCALC, and look forward to using your
suggestions to provide you with ever improving tools for your daily work. 

https://enercalc.com/
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2.2 Warning & Disclaimer

Although it is our intent that the information contained in this manual and associated
software program is accurate and reliable, it is possible that there may be errors, both of
omission and commission, that we are not aware of at any time. ENERCALC, Inc. can
make no warranties, either express or implied, as to the accuracy of the material in this
manual and software nor its suitability for a specific purpose or application for which it is
advertised.  

ENERCALC, Inc., its owners, directors, and employees, can offer no guarantee and will
accept no liability for damages of any kind resulting from the use of the information
contained or generated by this document and the accompanying computer software.

If you do not agree to be bound by these conditions and the conditions contained in the
License Agreement  contained herein, then you may Internet deactivate the program and
uninstall the software within the trial period after the date of your order and request a full
refund of the License Fee.

2.3 License Agreement & Copyright

The complete License Agreement can be viewed by using the following link: License
Agreement 

2.4 End of Service Policy

At some point in the future the current version software will undergo a major overhaul of
capability increase. At this time the prior version reaches its "End of Service" time.

When a version reaches its "End of Service", access to support and maintenance will
cease in about 6 months (the time frame will be set by ENERCALC and is at our
discretion). The software will continue to operate but technical support, updates, and other
support related items will cease to be available.

All software products, ENERCALC SEL included, have a practical commercial lifetime. In
order to provide the highest quality products and support to our customers, each product is
developed utilizing a product life cycle methodology, which includes an End-of-Service
(EOS) phase.

The ENERCALC product EOS policy is to support the current release plus the previous
(one back) release for up to six (6) months by default. After this time, ENERCALC's
product development ceases active development and support of that software release
within the Maintenance and Support Plan. ENERCALC does not create or make available
maintenance releases or patches for software that has reached the EOS milestone.

During the EOS phase, ENERCALC will continue to investigate, troubleshoot, and
characterize issues in an attempt to provide solutions and workarounds using the
production releases. If a solution cannot be found using software that has reached the
EOS milestone, ENERCALC will suggest that the system be upgraded to a more recent
software release.

5

http://www.enercalc.com/pdf/ENERCALC_License_Agreement.pdf
http://www.enercalc.com/pdf/ENERCALC_License_Agreement.pdf
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Once the EOS process starts on a product release, a notice will be posted on all relevant
pages stating that the product release has entered the EOS process. 

Note: This policy is subject to revision.

2.5 RetainPro Mode Limitations

The latest available build of ENERCALC SEL is available as a subscription only.  However,
it is capable of operating in “RetainPro Mode” to allow usage by RetainPro users with
active Maintenance & Support Plans or current subscriptions.

RetainPro mode does have at its core:
· The extensive rewrite of most internal program code

· Newly designed user interface

· Reporting improvements

· Speed improvements in both user interface management and calculations

· Multi-core processor usage

· Activation system improvements including extensive awareness of internet
security

· Improvements to 3D image rendering

· Ability to change load combinations in an entire project file with one selection

· New 16+ million data point internal database of USGS Ss & S1 seismic values
contained in their latest databases

· New RPN Calculator that “tears off” of our user interface and can remain open
while working in SEL

· Extensive internal debug utilities that can be turned on and off by ENERCALC
support engineers during TeamViewer & similar screen sharing sessions

The full version of the latest build has a number of extra components and capabilities not
accessible in RetainPro mode:

· Local & Cloud usage with project file synchronization

· QuickCalc capability Referenced on Projects Tab

· ENERCALC 3D FEM ENERCALC 3D

· Steel Base Plate by FEM Steel Base Plate by FEM

· General Footing by FEM General Footing by FEM

· Flitch Plated Wood Beam Flitch Plated Wood Beam

· AutoDesk Revit Integration – Live 2 way analysis & design of building components

· Future enhancements and maintenance after MSP has expired

2.6 ENERCALC for Revit

ENERCALC for Revit is a separate, powerful program that enables a real-time connection
between a Revit model and the member calculations in ENERCALC SEL.  

51
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For more info:  enercalc.com/EFR_Help

2.7 License Types

ENERCALC SEL can be licensed in a variety of formats:

Annual Subscription (Installed on your computer)

You will receive a Product Control Code that will allow you to activate the software. After
you have entered your Product Control Code and performed an activation, the product will
be completely operational. Your user registration number and licensee name will appear on
all printouts and you will see a subscription expiration date on the licensing screen.  Usage
ends when the subscription expires or is canceled, but all Project Files remain intact.

Monthly Subscription (Installed on your computer)

You will receive a Product Control Code that will allow you to activate the software. After
you have entered your Product Control Code and performed an activation, the product will
be completely operational. Your user registration number and licensee name will appear on
all printouts and you will see a subscription expiration date on the licensing screen.  Usage
ends when the subscription expires or is canceled, but all Project Files remain intact.

Perpetual License (Installed on your computer)

You will receive a Product Control Code that will allow you to activate the software. After
you have entered your Product Control Code and performed an activation, the product will
be completely operational. Your user registration number and licensee name will appear on
all printouts and you will see a Maintenance & Support Plan (MSP) expiration date on the
licensing screen. When MSP expires, you can choose to renew MSP to keep up to date on
new versions. If you do not renew your MSP, then you can continue to use the software
indefinitely at whatever version you have when MSP expired.

Academic License

This is a special version/mode for students.  Each time an Academic license is granted an
expiration date is set after which time the software stops operating. In addition the printouts
have a watermark stating that it is an educational version and the student's name and
registration number are printed. Click here for an application for an Academic License.

https://enercalc.com/EFR_Help
http://www.enercalc.com/academic.html
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Plan Check License

This is a special version/mode for public plan review agencies. Each time a Plan Check
license is granted an expiration date is set after which time the software stops operating. In
addition the printouts have a watermark stating that it is a plan check version and the
agency's name and registration number are printed.  Click here for an application for a
Plan Check License.

http://www.enercalc.com/plancheck.html
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3 Access to Cloud Version

ENERCALC subscribers can run the app on any HTML5 browser.  

Simply point your browser to cloud.enercalc.com.

Enter your KW User Registration Number in the form of KW-NNNNNNNN.

Enter your password provided by ENERCALC (not your Product Control Code) in the form
of three letters or numbers hyphen three letters or numbers.

Optionally, you can enter a unique username.  This is used to store the specific settings
and information that are gathered by your selections and settings during a session. When
you next launch a session with this username those settings will be retrieved. If you do not
enter a name the general settings used by other users with no name entered are used.
Max length is 45.
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The Select Location dropdown will populate with the available sites, and will default to the
site with the lowest latency from your location.  You can select any site, but the best
performance will always be obtained by using the one with the lowest latency.  There is no
need to worry about being consistent with your selection of any particular site.  Your data is
replicated for redundancy, and will be available to the app, regardless of which site you
select.

Click the Launch button, and the app will be loaded and displayed.
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4 Installation (Not required to access cloud version)

General

ENERCALC® SEL must be installed on each computer where it will be used.   DO NOT
install on one computer and use a shortcut to the software on a different computer....IT
WILL NOT RUN PROPERLY.

You can install on ANY computer where you might want to use it. You will need “activate” it
on the computer where it will be used so it runs as an “activated” program.

The activated seat can easily be moved between computers as you desire using our
Internet Activation system. An Internet connection is needed only for the brief moment of
activating or deactivating.

 
Download Installation File

If you don't already have the latest installation file, you can download it using this link:
https://install.enercalc.com/ECSEL20_SETUP.EXE 

This link will ALWAYS install the MOST RECENT build of the software. Don’t save the
installation file for later use.....you will be saving the installer for what will soon be an old
copy of the software, because we update the builds quite often. 

This installation file will ask you to paste in the Product Control Code that ENERCALC has
assigned to you. Locate the email you received from ENERCALC that contains that long
scrambled looking string of characters. Always use the most recent email because it has
your latest PCC. 

The PCC has all the information for your license, including your Subscription (or
Maintenance & Support Plan) expiration date, name that will appear as the license holder,
etc. 

NOTE! If you installed our DEMO version be sure to UNINSTALL IT.  It cannot be
used as licensed software. 

Installation Procedure

This section describes installation of the software on any computer where you want to use
it. At this time we assume you have downloaded and started the installation program file.

https://install.enercalc.com/ECSEL20_SETUP.EXE
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Immediately after starting the installation program you will view a "Welcome" screen
identifying the product to be installed.

Click [Next > ]

Next you will be asked to paste your Product Control Code (PCC).  Note! The same PCC
is used in ALL your installations. You only need a new PCC when you renew your
Subscription.

The PCC is a scrambled looking string about 150 characters long that was supplied to you
in one of your product delivery emails.
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Locate your most recently received PCC, highlight it press Ctrl-C to copy it to the Windows
Clipboard. Then click the button circled to paste it into the entry area.

Now click the Check & Save PCC button.



Installation (Not required to access cloud version) 16

© 2024  ENERCALC, LLC

Next you will be asked to review the ENERCALC License Agreement. You have 30 days
after purchase for subscriptions to review the agreement and return the software, so it is
not necessary to read the entire document at this time. After installation you can print and
read the License Agreement using the License > License Agreement menu selection.

Choose “I Accept....” and click [Next > ]
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Next you will be asked to select the drive and folder location where the program files are to
be placed. A standard location for Microsoft Windows installations is given and our best
advice is to accept it.

ALWAYS INSTALL THE SOFTWARE ON THE COMPUTER WHERE IT WILL BE
USED....NOT A REMOTE DRIVE.

Click [Next > ]
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Next you will be asked to select the default drive and folder location where your Project
Files will be saved.  Feel free to customize this one, but our best recommendation is to
avoid Dropbox, OneDrive, and other mirroring systems.

Click [Next > ]
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Next you will be asked to select the drive and folder location where shared databases will
be saved. These include material databases. A standard location for Microsoft Windows
installations is given and again, our best advice is to accept it.

ALWAYS INSTALL THE DATABASES ON THE COMPUTER WHERE IT WILL BE
USED....NOT A REMOTE DRIVE.

Click [Next > ]
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Next you will be asked to name the Start menu program group that will contain the links for
starting up various parts of the software. (We recommend using what our installation
program suggests.)

This program group will be placed within the Start > Programs selection within Windows.

Click [Next > ]
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The next option allows you to create a desktop shortcut. The option is already checked,
however if you wish you can uncheck.

Click [Next > ]
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Next and immediately prior to the file placement process you will be given a summary of
your selected items.

If all is OK then Click [Next > ]

The files will then be copied to your computer.
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The final screen announces that the installation process is complete.

Click [Finish > ]

SOFTWARE INSTALLATION IS NOW COMPLETE! 
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5 Activation (Not required to access cloud version)

Activation 

ENERCALC® SEL has a security system that requires you to "Activate" the software. You
will copy & paste a Product Control Code (PCC) into the software and then use an
[Internet Activate] button to get permission from our Internet Activation server to run as a
registered program.  

You can install the software on as many computers you want. Paste in the Product Control
Code into each software installation.

You will use “Internet Activation” and “Internet Deactivation” to activate the software on
each computer up to the number of simultaneous seats you have purchased for your “KW”
user registration number. Deactivate one or more seats to free them up for use on another
computer, or use “Automatic Activation” so the seats are automatically made available
when the application is closed.

You only need to be Internet connected for the brief moment you activate or deactivate.
Otherwise the computer will remember it’s activated (when using Indefinite Activation), or it
will reactivate the next time you start the program (when using Automatic Activation).

Our Internet Activation System uses HTTPS REST API calls to connect to Enercalc.net for
communications. Most of the time it works great without any changes to firewalls or anti-
virus software. Sometimes you must pause your anti-virus software briefly during
activation or deactivation, or add a firewall rule to allow it to connect. In larger companies,
your IT staff will usually manage this for you.

Now start ENERCALC SEL, either by double-clicking the desktop shortcut named
"ENERCALC App"...

Or by clicking the Windows Start button and navigating to the "ENERCALC SEL 20"
program group and clicking "ENERCALC App"...
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If the software is not currently activated the window below will be displayed. 

This is the typical license activation window.  It presents the two primary activation
options: 

Indefinite: This selection will activate the program and leave it activated. Each time you
start the software thereafter it will launch immediately as “activated”. 

Automatic: Deactivates on exit and then automatically activates on launch. Ideal for larger
firms with numerous users, sometimes in different locations. 
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(The [Manual Activation] button is used in cases where Internet Activation does not work
due to the lack of Internet connectivity or security issues. You will be working directly with
our staff at these times.)

When you have made your selection, the program should display a confirmation screen
like the one below:

When you see this confirmation screen, you can dismiss it by clicking the [CLOSE] button.

CONGRATULATIONS!
Your software is now fully activated!

NOTE:  If you have any problems with activation, please be aware that during the activation
process, the application must be able to communicate via Internet with Enercalc.net using
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HTTPS over port 443 using REST API calls. Anti-Virus software sometimes interferes with
this communication. If this happens briefly “pause” your Anti-Virus software until Internet
Activation is complete.

5.1 Manual Activation

If you cannot activate the software using the simple [Internet Activate] method (because
you have no connection, restricted access to the Internet due to a firewall, or your
company prefers not to activate your installation this way), you can activate your software
using the [Manual Activation] method.  
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Click the [Manual Activation] button.  The system will provide some information in a
Verification box:
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Then instructions will be provided to you using the screen shown below: 

NOTE:  When using the Manual Activation method, the Manual Activation Code that you
receive from ENERCALC can only be used to activate the specific machine that was
used to make the Manual Activation Code request, because the request and the code
actually contain the Computer Name and other data that is specific to that particular
machine.  However, you can still use the Internet Deactivate function to return a manually
activated seat to your pool.  And then you would be able to use that available seat from
your pool to perform a normal Internet Activation on a different computer if desired.

5.2 Moving your Activation

This section will assist you in moving your activation from one computer to another: 
Moving Your Activation

https://www.enercalc.com/faq_help/moving_the_activation_to_a_dif.htm
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6 Software Updates

6.1 Web Update

At ENERCALC we are continually improving and enhancing our software. It is fairly simple
to make changes to the software here in our offices, however it can be overwhelming to
ship thousands of CDs to our user base. To distribute the latest software builds to the
entire user base, we depend on a Web Update system. The update is provided in two
ways:

Web Update System: This system is built into your software. It will check with our server to
see if a newer version of the software is available and prompt you with an option to install it
if available. See What Actually Happens below for a description of how it works.

The Web Update system uses Internet protocol HTTPS over port 443 to check if a newer
version of the software is available and to transfer those files from our server to your
computer as needed. You can configure the program to perform this check automatically
every time you start the software, but it can also be performed on an on-demand basis if
desired.
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Select Settings > Updates  from the main menu to display the web update screen as
shown below:

What actually happens during an update check: What actually happens during an
update check is that the software runs a program in the ENERCALC program folder
named EC6WebUpdate.exe. This program connects to our Internet servers using the
"HTTPS" protocol over port 443. It compares the version number you have installed with
the current build of the software stored on our servers. If there is a newer build available,
you are notified and upon approval, a small update installation program named
EC6_WebUpdate.exe is transferred from our server to your computer. This file then
executes to complete the file download and software updating/installation process.

EC6WebUpdate.exe and EC6_WebUpdate.exe are digitally signed applications that are
secure to run and are virus free.

The actual updating program EC6_WebUpdate.exe that is downloaded from our server will
need "write" access to the program installation folder.
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Check for MAJOR updates now: This button will download the updating program from
our server. This program will check your computer for a non-expired Maintenance &
Support Plan and update the software to the latest allowed version.

Note: The "WebUpdate" procedure may send information to ENERCALC, Inc. about your
installation and use of the software licensed from ENERCALC, Inc. This may include any
of the following: your ENERCALC assigned User Registration Number, the Installed Build
Number of your ENERCALC software, Internet IP address of the computer that will receive
the updated files, time usage for the various portions of the software, and potentially other
information only related specifically to the use of the software license. Absolutely no files,
configurations, settings, or other information not specifically regarding the usage of the
ENERCALC license will be sent.  If you are concerned about this, please contact us for
information on what is being sent. We have an open policy on providing you with
information showing what might be included.

TECH NOTE:  Some users with multiple installations may prefer to set the status of the
automatic check directly through the registry entry for convenience:

REG_CURRENT_USER\Software\ENERCALC\V20\DoCheckForUpdates

Yes = 1
No = -1

6.2 Update from Website

In addition to the Web Update system that is built into the software, it is also possible to
initiate updates by visiting the For Our Users page of www.enercalc.com and using the
Build 20 UPDATER link.

Note:
There are times where a more recent build will be available on the website than is
offered/detected by the built-in Web Update system.  The reason for this is as follows.  The
built-in Web Update system offers those updates that are regarded as "major" or that have
a significant impact on a majority of the users.  On the other hand, the website will always
offer an update for the absolute latest available build of ENERCALC SEL, regardless of
whether it is categorized as a "major" update or not.  

https://enercalc.com/users/
https://www.enercalc.com/
https://install.enercalc.com/ECSEL20_SETUP.EXE
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7 Support & Maintenance

7.1 Subscription vs. Maintenance & Support Plan

In the past, our Maintenance & Support Plan (MSP) offering was the way to ensure that
you will always had full technical support and access to the latest build of the software
during the term of the plan. The industry standard is now to offer software on a
subscription basis.

While your subscription is active, you will receive every new build, feature enhancement,
and improvement for your licensed software, ensuring you're always using the most
current technology. 

Users covered by an active MSP will receive maintenance updates on those modules and
functions that are provided by their plan.

You will have access to voice/fax/email technical assistance from our staff.

You will also receive discounts on new software releases and additional software licenses.
This is the easiest and most economical way for you and your company to keep your
software investment current.

Please see this web page for details on Subscriptions:  Subscription Info

Please see this web page for details on the Maintenance & Support Plan:  MSP Info

7.2 Getting Assistance

There are several ways to get assistance with using ENERCALC products.

HOWEVER, with the exception of referring to the program documentation and reviewing
the FAQ section on the website, all options require that you have an active subscription, or
that your Maintenance & Support Plan is current.

· Refer to the program documentation.

https://enercalc.com/Support/Subscriptions
https://media.enercalc.com/pdf/ENERCALC_MSP_INFO.pdf
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· Contact ENERCALC Technical Services by email:

    From the main menu:

                 

  
       From your email program: support@enercalc.com

· Contact ENERCALC Technical Services by phone: 800-424-2252 or 949-614-0689

· Review the "Frequently Asked Questions" (FAQ) page on our website: FAQ

7.3 Troubleshooting with the Browser Console

If you are ever in a situation where you are troubleshooting with our staff, they may ask for
some info that is reported in the console of your browser.  If you need some help locating the
console, here are the steps that apply specifically to Chrome:

Click the Customize and control Google Chrome button in the upper right-hand corner of the
Chrome window:

mailto:support@enercalc.com
https://media.enercalc.com/faq_help_20/index.html
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Use the menu to select More Tools > Developer Tools:

Finally, click on the Console tab:



Support & Maintenance 40

© 2024  ENERCALC, LLC

At this point, you will have access to some information that our developers may request. 
They may ask you to try to launch the app or perform some action.  But sure to let the system
work or fail or do whatever it needs to do.  This generally means waiting 30 to 60 seconds
before taking a screen capture.

When you no longer need to view the Console, you can close it by clicking the X in the upper
right hand corner of the Console (not the X that closes Chrome, though):
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7.4 Viewing Enhancements and Changes to the Software

The program offers a detailed list of revisions that have been made to the software.
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Click Help > Enhancement/Change History. The following window will be displayed:

This list can be set to display enhancements only, or it can display enhancements and
changes/corrections.  When the list is set to display both enhancements and
changes/corrections, it can be sorted by version or by module.
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8 Getting Started

8.1 System Overview & Design Philosophy

ENERCALC SEL is a collection of modules that provides analysis and design functionality
for components of buildings. 

Walls, columns, beams, footings, diaphragms, frames, and other common elements can
be thoroughly engineered through the use of the modules in this package. If you are a
typical engineer whose work consists of a regular flow of small and medium-sized
projects, this package is designed specifically for you.

As an engineer you will find that each module combines the governing code provisions,
mathematical analysis processes, and commonly available construction materials into a
simple and effective "calcpad" style fill-in-the-blanks program. You can feel partially
relieved that the software will consistently perform all the required checks that may be
skipped over when doing repetitive hand calculations....especially when fatigue sets in and
a deadline is near! You can enjoy the time to do more exhaustive design studies, come up
with safer and more economical designs, and enjoy clearly documented calculations for
review and archiving.

This software is not a "black box" program. Each calculation is designed to be a "visible
calcpad" where you can work with the data and immediately view the resulting
calculations. Automatic design is provided in most modules, and is intended primarily to
automate tedious iterative tasks.

You, as an experienced structural engineer or architect, can quickly enter and change
member sizes and other design parameters and view the results. In this way, ENERCALC
SEL maximizes the use of your time and design skills by enabling you to quickly define a
concept and then make necessary modifications to refine it into a final design.

8.2 About Our Documentation

Documentation of your software package is essential for your successful and pleasant use
of our products. We try hard to supply you, now and on an ongoing basis, with detailed
information on all aspects of the software. To support this commitment, we provide
documentation of your software in multiple forms:

· A Windows Help system file named ENERCALC.CHM is installed with your
software. This help system may be accessed by clicking  Help > Dynamic Help
from the main menu.

· A User's Manual in Adobe Acrobat PDF file format is available for download at any
time from our website: ENERCALC SEL User's Manual. 

· An Online Help system is available at http://www.enercalc.com/sel_help.

Printed Documentation

https://media.enercalc.com/pdf/SELManual.pdf
http://www.enercalc.com/sel_help
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Printed documentation is not provided with ENERCALC products.  This is in keeping with
the nearly universal industry move away from printed documentation.

Updating your Documentation 

The most up-to-date documentation for our software products is always available in
electronic form. Whenever the software is updated with the built-in Web Update system,
part of the process includes transferring the latest documentation to your computer. This
ensures that the content that you view by clicking  Help > Dynamic Help from the main
menu is current and coordinated.  

8.3 Building Codes Supported

Click here to view:  Supported Building Codes and Design Standards  

Databases of all commonly available steel and wood sections and materials properties are
also included.

8.4 Learning Structural Engineering Library

There are several sources of information that will assist you with learning to use
ENERCALC SEL.

· A series of tutorial videos is available at our website:
http://www.enercalc.com/training_videos.html

· This documentation. An Internet version of the help system is available at:
http://www.enercalc.com/sel_help/

· Responses to "Frequently Asked Questions" are available at our website:
http://www.enercalc.com/faq_help/

8.5 Introductory Videos

We continue to add topics to a series of videos that discuss all portions of the software.

To access nearly 40 videos please click here: Training Videos

Here is a partial view of what you will see....

https://enercalc.com/product-specifications/#:~:text=Referenced%20Building%20Codes%20and%20Design%20Standards
https://www.enercalc.com/Support/TrainingVideos
http://www.enercalc.com/sel_help/
http://www.enercalc.com/faq_help/
http://www.enercalc.com/training_videos.html
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8.6 Request for Suggestions

Although our intentions are to provide you with the best product possible, it is likely that
there may be areas of this User's Guide and the software itself that could be improved to
better suit your needs, be made simpler to operate, easier to understand, or support
engineering technologies that have emerged since this publication.

To call these to our attention and to offer suggestions for improvement, we sincerely
request that you send us your thoughts. Please address your comments to
support@enercalc.com.

mailto:support@enercalc.com
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9 Program Overview

9.1 Introduction

ENERCALC SEL is a collection of modules (also referred to as "calcsheets") that provide
functionality for the analysis and design of components of buildings. Walls, columns,
beams, footings, diaphragms, frames, and other common elements can be thoroughly
engineered through the use of the modules in this package. If you are a typical engineer,
whose work consists of a monthly flow of small and medium-sized projects, this package
is designed especially for you.

As an engineer, you will find that each module combines the governing code provisions,
mathematical analysis processes, and commonly available construction materials into a
simple and effective "calcpad" style fill-in-the-blanks program. You can feel partially
relieved that the software will consistently perform all the required checks that may be
skipped over when doing repetitive hand calculations. You can enjoy the time to do more
exhaustive design studies, come up with safer and more economical designs, and enjoy
clearly documented calculations for review and archiving.

This software is not a "black box" program. Each calculation is designed to be a "visible
calcpad" where you can work with the data and immediately view the resulting
calculations. Automatic design is provided in most modules, and is intended  primarily to
automate tedious iterative tasks.

You, as an experienced structural engineer or architect, can quickly enter and change
member sizes and other design parameters and view the results. In this way, ENERCALC
SEL maximizes the use of your time and design skills by enabling you to quickly define a
concept and then make necessary modifications to refine it into a final design.

The "Calcpad" Approach

When ENERCALC SEL was designed in 1983, our concept was revolutionary.....design it
like an engineer's calculation pad. When an engineer prepares a calculation, the finished
product is a neat and organized sheet of paper that follows the design flow from load
tabulation, force and stress calculation, to the final adequacy check of the structural
component that will satisfy the task.

At the time, all other competing programs were aging versions of mainframe programs that
had been modified to run on microcomputers. Many of those programs executed "batch"
design, where the user entered all the data, told the computer to run the program, and then
opened a crude file to review the results.  ENERCALC was unique in that the input and
output was mixed on the same screen....easy to see at a glance. But the most
revolutionary aspect was the tremendous speed it offered to prepare calculations.

This great speed was due to the fact that you could change a number and instantly see all
the updated results on the screen.  
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Moving forward, the current version of SEL for Windows maintains that same fill-in-the-
blanks approach with instant recalculation of results.  When using any of the approximately
30 calculation modules, all input data and output results are presented on the same screen
and viewed just by selecting a tab that groups the information.  Whenever you change an
input value, the entire module is recalculated and the results are immediately
visible. Thanks to efficient programming and fast modern computers, incredibly complex
structural analysis and design is performed in a split second.

This instant updating also happens when you are viewing graphical sketches of designs or
stress diagrams.....after any change, the graphics are instantly updated.

9.2 Typical Worksession

A Typical Worksession

In order of occurrence, here are the steps in using the software:

1. Start the program.

2. The Project Assistant is displayed where you can choose to use the last calculation,
the last project, a recent project, or create a new project.

3. A project is selected and you view the Project Manager. Here you can add new
calculations, edit existing calculations, insert non-calculation items into the project
(such as Excel files, Adobe Acrobat PDF files, or scanned images), and initiate project
printing capabilities.

4. Editing or adding a calculation takes you to one of the calculation modules. 

5. Using the calculation sheet, you enter data on the input tabs while reviewing results
and graphics on the output tabs.

6. When the structural calculation is complete, you can print it and/or save it.

7. You can always return to the Project Manager where you can add/edit/delete/print
other items within the current project, or save the current project and open a new one.
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9.3 Program Settings

Most of these items are covered in another section of this help document. Please click on
an item in the list below to jump to that section.

General Settings : Defines settings that are typical to the overall installation and to all
Project Files such as backup file creation and behavior of the Project Manager.

File Locations : Specifies the default file locations for Project Files and databases.

Printing & Title Block : Provides the ability for the user to define the look of their title
block.

Engineer's Stamp : Allows the user to upload a graphic image of their Professional
Engineer's stamp for inclusion on printed reports.

Updates : Allows control over behavior of web update system and direct access to the
update installation program on the web.

Default Values : Only accessible when a calculation module is open.  Provides control
over the default values used for that specific calculation module.

Default Governing Code:  Allows the user to select the default governing code for all NEW
project files.  Note:  This is different than changing the governing code for the current
Project File or changing load combination sets.

View Activation & License Information: Provides access to user information.

9.4 Files

Project Files
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ENERCALC SEL uses a single file to store the project information and all the calculations
and items that are created as a part of that "Project". This file uses an "EC6" extension.

The system automatically creates backup files in the same folder that the ENERCALC
Project File is stored.

To control the number of backup files to save, click Settings > General Settings and
adjust the spinner control.

As ENERCALC SEL advances in capabilities, the file formats used will change, but we will
always provide conversion programs for previously saved Project Files. 

General Comments
· Each ENERCALC Project File contains all information on a Project. There are no

other files you will need to keep track of.

· Always remember that the Project Manager is showing you the Divisions and
calculations for the current Project. It is NOT showing you a disk directory structure.

· There is no Save item on the File menu. After you have edited a calculation, you can
either click [SAVE] or [SAVE & CLOSE] within the individual modules.  Either one will
save the calculation data to the Project File.

Database Files

A number of database files are supplied with ENERCALC SEL. These files contain AISC
section properties, NDS stress grades, wood section properties, seismic acceleration
data, USA cities & Zip Codes, and other files. These files are not to be edited or modified in
any way by the user. 

User-Created Database Files

The user can create User Defined database files to store their own steel sections, wood
sections and wood stress databases.  These files are created and stored in the same
folder as the other database files.  User defined database files are differentiated from the
standard database files that are delivered with the software by inserting the word "_USER"
in the filename.

9.5 Projects Tab (Project Assistant)

When you launch ENERCALC SEL the Project Assistant is displayed by default, as
shown below.

This single dialog allows you instant access to prior Project Files, the last Project File, the
last-used calculation, or other functions to create or manage Project Files.
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Please see the numbered references below the graphic for specific descriptions.

(1) Click to immediately open the last Project File that you worked on.

(2) Click to immediately open the last Project File that you worked on and open the last
calculation you worked on.

(3) This list shows the most recent Project Files that you opened on this computer.  The
Recently Used tab displays the most recent Project File at the top of the list. Double-
click on any item in the list to open that Project File.

(4) Click to open the highlighted Project File in the list.

(5) Click to open a Windows File Open dialog that allows you to browse through disks and
folders to locate and open a Project File.

(6) Click to open the Windows File Create dialog that allows you to browse through disks
and folders and create a new ENERCALC Project File.

(7) Click to clone the currently highlighted Project File.

(8) Click to upload the currently highlighted Project File to ENERCALC Hosted Storage in
the cloud.

(9) Click to toggle Revit Mode.  Controls the ability of SEL to detect if REVIT is sending it
data.  When Revit Mode is “ON” the program constantly executes background
processes to monitor communication.  For this reason, it is always best to have Revit
Mode off when not needed.
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(10) Click to select the desired Project File storage location.

(11) Click to remove the highlighted file from the Recently Used list.

(12) Quick Calc provides fast access to calculation modules without creating a Project File
first.  Be aware, Quick Calc offers no ability to save after a calculation is started.
 So there will be no way to preserve a Quick Calc other than to print it to paper
or PDF.

9.6 Project Manager Tab

Project Manager

Immediately after a Project File is opened the Project Manager is displayed:

The Project Manager provides you with the ability to control the contents of your Project
File. Double-click any calculation to open the associated module and edit the parameters
of that calculation.  Please click here  to jump to detailed information for the Project
Manager.

93
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9.7 Current Calculation Tab

After a calculation is selected for editing, the focus changes from the Project Manager to
the Current Calculation tab, and the window fills with the user interface for that particular
calculation module as shown below:

For a review of using a typical calculation screen click here .55
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9.8 General Calculation Screen Usage

Please refer to the typical screen below and the numbered items that relate screen areas
to their descriptions:

(1) Indicates the module that you are working in.

(2) Indicates the name of the licensed owner of this installation & activation of the software.

(3) Access to help system: Opens the help system and displays the section specific to
this module.

(4) From left to right:
Print: Opens the Print Previewer where the report can be set up, previewed, printed to
a printer, or printed to PDF.
Cancel: Cancels all changes made to this module since the last save, closes the
module without saving, and returns to the Project Manager. If this calculation module
was just Added to the Project File, and if it was never saved, then this option will cause
the calculation to be removed without saving.
Clone: Uses the current calculation data to create an identical new calculation item in
the Project Manager.
Save: Saves the current Project File (to capture all the data entered into this module),
creates a report (which can be printed at a later time), and keeps the module open for
further editing.
Save & Close: Saves the current Project File (to capture all the data entered into this
module), creates a report (which can be printed at a later time), closes the module,
and returns to the Project Manager.

(5) Data input tabs: Click these tabs to move to various categories of data input.
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(6) Major Result Category Tabs: Select between major categories of result data to view;
numerical values, sketches, diagrams or 3D renderings.

(7) Numeric Result Tabs: Click these tabs to view the various components of calculated
results.

9.9 Databases

ENERCALC SEL contains several databases that you can use in the various modules.

To view the databases click Databases > (database) from the main menu. See below.

Specific information on each of the databases is provided here: Databases item in Main
Menu

9.10 Generating Reports

In ENERCALC SEL, the term "report" refers to the results documents created by the
program in either printed or PDF format.

74
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For each of the ENERCALC modules, the generation of a report starts by clicking the Print
button:

This opens a previewer that offers many options:

Print to Selected Printer:  Create a report and send directly to the currently selected
printer.
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Create PDF:  Create a report as an Adobe Acrobat PDF file.

Close:  Close the previewer without printing anything.

# Copies:  Set the desired number of copies.

Printer:  Select the desired printer.

Pages to Print:  Select what is to be printed.

Sections to Include:  Select individual report topics to include in the report.

Regenerate Report:  Recreate the report after changing the options in the Sections to
Include area.

The right side of the screen displays a preview of the current calculation report and offers
zooming and page scrolling controls.
 
In addition to the Regenerate Report button, reports are created and saved when you click
the [Save] or the [Save & Close] buttons in the upper-right corner of all modules:

Clicking either of these buttons causes a full report for the current module to be created
and saved into the Project File along with all of the input data for that module. This is how
the printouts are prepared for instant viewing and batch printing in the Project Printing
system.
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9.11 3D Renderings

The 3D tab in most modules offer a 3D rendering of the element in the current
calculation:  

Each calculation offers "Show" options that are specific to the type of element being
displayed.  Note that some of the show options will cause some renderings to switch into a
semi-transparent mode for clarity.  For example, when viewing the rendering for a General
Footing, the rendering will automatically switch to semi-transparent mode when the display
of rebar is turned on.

The X/Y/Z/Iso buttons allow the rendering to quickly be snapped to specific view angles. 
Rotate and Zoom controls make it easy to adjust the view, but note that the rendering can
also be manipulated by clicking and dragging with the left mouse button to rotate or with
the middle mouse button to pan.
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The Enlarge/Reduce button toggles between a large and small display window for the
rendering.

The Print button allows the 3D rendering to be printed to PDF or paper.

If you experience any issues with viewing the 3D renderings, type Run in the Windows
search box and then enter sysdm.cpl and press enter.  Select the Advanced Tab.  In the
Performance category click Settings.  Select "Adjust for best performance" and make sure
Enable Peek is checked.  Do not allow Windows to choose for you. 
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10 Main Menu

The main menu of ENERCALC SEL is always displayed.

The menu offers the following selections.  Click an item below to jump to that help section
page:

File : To create, load, close and print Project Files.
Settings : To establish settings, user information and default values
Databases :To view the various databases supplied with the software
Tools : To access utilities provided with the software
License : To directly access the licensing control window
Help : To access the help system, technical support options, Knowledge Base

with FAQs, Enhancement/Change History and the ENERCALC website.

10.1 File

Open Project: Opens a standard Windows File Open dialog allowing you to navigate your
disk drives and open a Project File.
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New Project: Opens a standard Windows File Create dialog allowing you to navigate your
disk drives and specify the name of a Project File to create.

Convert RetainPro RPX file to EC6 Project File: Allows you to select an existing
RetainPro RPX file and convert it into EC6 format, so it can be opened in ENERCALC
SEL.
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Save Project as New: Allows you to save the currently open Project File as a new file
using a different name. Opens a standard Windows File Create dialog allowing you to
navigate your disk drives and specify the name of the Project File to create.

Close Project: Closes the currently open Project File (making sure any unsaved data is
purged).
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Print Setup: Displays a typical Windows Printer Selection dialog to specify the printer to
be used for this work session.

Print Project: Opens the Project Printing  Manager.

Regenerate Reports: This selection is used to regenerate printouts so they will be
updated and displayed correctly in the Project Printing Manager. It can be used any time
the following information has changed:
· Project Information in the GENERAL Division of the Project Manager for the currently

open Project File
· Title block information filled in using Settings > Printing & Title Block from the main

menu

There is also a third situation where this command can come in handy. When running in
Evaluation mode, the software adds a watermark on the background of all printouts. This
watermark says "Evaluation Version" and "Unlicensed Usage", so the report is
inconvenient to use for submittal purposes. When the user later runs the software in
Licensed mode, those reports with the "Evaluation Version" watermark remain in the
Project File until they are reopened and saved. This can be a laborious process if the
Project File contains many calculations.  So the easier way to remove the watermarks in
one pass is to use the Regenerate Reports command.

128



Main Menu 66

© 2024  ENERCALC, LLC

When you click File > Regenerate  Reports > All, the program will automatically save
and close any open calculations.  Then the program will show a progress window as it
regenerates all the reports in your Project File:

Exit: Offers the option to save any pending work, then closes the currently open Project
File, and exits the software.

10.2 Settings

The Settings item in the main menu provides access to several selections that control
how various aspects of ENERCALC SEL operates. 

A selection of one of the first five items will open the Program Settings window and
preselect the appropriate tab for the chosen item.
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General Settings

Eliminate redundant Load Combinations for ALL calculations:  With this box checked
the software will only run load combinations that are unique.  It will automatically eliminate
any load combinations that result in a combination that is redundant.

Number of backup files:  Specifies the number of backup files to maintain for each
Project File.  When the number is set to anything greater than zero, the software will
automatically create a backup file with _backup_[n].ec6 appended to the file name, in the
same folder as the original Project File.   The zero setting is provided under the
presumption that the user has another backup system in place that they trust to protect
their work, therefore automatic backups are set to 0 to avoid unnecessary redundancy. 
The backup files are created when a Project File is CLOSED.
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Select where new calculations are inserted...: This applies to the way calculations are
inserted when using the Project Manager.  
· When the first option is selected and you use the [+Add] button, it adds a new

calculation to the project, and the calculation is inserted at the currently highlighted
location (currently highlighted item is shifted down).

· When the second option is selected and you use the [+Add] button, it adds a new
calculation immediately below the currently highlighted location.

Set Application font sizes to X points smaller:  Provides a way to scale fonts down, for
high resolution displays.

File Locations

Because modern operating systems allow multiple users per computer, Microsoft
suggests that software manufacturers create their own folder under Documents and set
that as the default location for user-created files. The program conforms to this
recommendation by suggesting an appropriate directory during the installation process.
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Default Project File Location: Specifies the default location where the program will point
when using File > Open or File > New from the main menu.

Database File Location: Specifies where the program should look for the steel database,
wood database, and other files that contain the databases of standard values. This location
needs to be accessible to all users on a specific computer. Microsoft suggests that
software manufacturers set the following as the default location for data files that are
referenced by the software, but not modified by the user: C:\Users\Public\Documents.

Load Database File Location: Specifies where the program should look for the load
combination database file and other files that are potentially edited by the user.  Because
this is a file that can be customized by the user, the default location for this file is the same
as the default location offered for storing Project Files.
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Printing & Title Block
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Title Block: These six entries correspond to the six lines in the upper-left corner of the
printout.

Logo File: Provides an option to specify a graphics file to be printed at the LEFT edge of
the title block.  If used, the six lines of Title Block information will be printed immediately to
the right of the logo. Logos can be JPG or JPEG formats only.

When a logo is specified, the height is adjusted to fit into the title block area and the right-
side "floats" according to the width of the image.

What to Print - Title Block: Check this box to print the title block at the top left of the
report.  With this item unchecked the printout begins with the calculation title bar (shown
as "Masonry Column" in the image above)

What to Print - Project Information: Check this box to print the Project Information at the
top right of the report. 
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What to Print - Date & Time: Check this box to print the computer date and time on the
report as shown below:

Select Printing Color Mode: This sets the default mode for printed reports created from
ENERCALC SEL.

Professional Engineer's Stamp

This tab allows a graphic image of the user's PE stamp to be uploaded.  Then the stamp
can be placed on printout by selecting the checkbox.

Update
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Click here to check for updates: This button will download the updating program from
our server. This program will check your computer for a non-expired Maintenance &
Support Plan and update the software to the latest version.

10.2.1  Default Values

Most of the user input values in the individual calculation modules have a default value or
setting that is stored within the program.  Many of these default values can easily be
changed by the user.  The procedure is as follows:

1. Open a new calculation of the particular module of interest.
2. Revise all of the initial values and settings as desired so that they represent the desired

default values or settings.
3. Click Settings > Default Values > Save.
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The current values will be saved as the new default values for that module, and these initial
values and settings will be used when a new instance of this calculation module is added
to any Project File.

10.3 Databases

This menu allows viewing of various databases supplied with the software.

10.3.1  Rolled Steel - AISC Database

The steel section database is available in all applicable steel modules. It contains typical
AISC rolled sections from many Editions of the AISC Steel Construction Manual.



ENERCALC SEL75

© 2024  ENERCALC, LLC

Note that it is also possible to create User Defined entries that can be referenced in
calculations.  

10.3.2  Wood Section Database

The wood section database contains the section properties for most of the sections listed
in the NDS and for many Engineered Wood Products.
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The wood section database is available in all applicable wood modules. It contains typical
wood sections available in the United States. These sections are also shown in the NDS. 
Also included are manufactured sections, however the list of those sections is only
updated occasionally.  Note that it is also possible to create User Defined entries that can
be referenced in calculations.  

10.3.3  Wood Reference Design Values Database

The Wood Reference Design Values database is available in all applicable wood modules.
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The Wood Reference Design Values database contains typical wood stress grades as
defined in the NDS. Also included are manufactured sections, however the list of those
sections is only updated occasionally.  Note that it is also possible to create User Defined
entries that can be referenced in calculations.  

10.3.4  Masonry Database

This is a reference table only.  It consists of data for common hollow concrete masonry
units:

10.3.5  Load Combination Database

This is the database of named load combination sets that can be automatically retrieved
into a calculation.
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A named load combination set can be established as a default and will be used whenever
a new calculation is created in the Project File.  Note that it is also possible to create new
load combination sets and/or revise the load combinations that are in the existing sets.  

The Load Combination Database is used to manage the load combinations that you can
use across all of your Project Files.  The load combinations specified in this section are
stored in a separate file and ARE NOT specific to a particular Project File.

With the Load Combination Database you can create many load combination sets. These
are listed in the Code Reference column.

For each set, you can then specify the individual load combinations for both factored load
and service load cases, which are used for LRFD and ASD respectively (also referred to
as strength design and allowable stress design).

Please see the descriptions for the numbered keynotes on the screen capture below.
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(1)  This area lists the load combination sets available for use.
(2)  Use these buttons to add, delete, copy or edit the name of load combination sets. The
button with the triangle symbol means "Change" or "Edit" and is used to edit the displayed
reference name for the set.

(3)  This is the area that displays all the load factors for the various load combination types.
 

(4) Use these buttons to add or delete individual load combinations. The button with the
triangle symbol means "Change" or "Edit" and is used to edit the numeric factors applied to
each type of load for the load combination that is highlighted.

When clicking the [Add] or [Edit] button, the following dialog is displayed:

Use this dialog to specify the reference name and the values for each load factor.

(5) Click the various buttons to select the category of load combinations to display.

(6) Use the   button to make the highlighted load combination set the
default that will be used in all new ENERCALC calculations.

Using Load Combinations

When creating a NEW calculation in the Project Manager, the default load combination set
is automatically loaded into the Load Combination tab in the module.

In the image below you can see that the load combinations have been loaded and are
displayed on Load Combinations tab in the Masonry Column module.
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The design method has been set to LRFD, so the software is displaying Factored
Combinations.

We have clicked the [Select] button to open a list of the available load combination sets
from the Load Combination database. Selecting one of them from this dropdown list will
load those new load combinations into this particular calculation only.
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10.3.6  Block & Geogrid Database

The Block & Geogrid Database is used to pair block data with geogrid data, to create viable
design combinations in the geogrid reinforced Segmental Retaining Wall module.  The
editor allows the user to add, edit, or delete block vendors, blocks, block offset values, and
then add, edit, or delete geogrid design data for use with each type of block.

  

Overview:  The editor shows a list of block vendors on the top of the screen.  Expanding
any of the block vendors will reveal the individual block types offered by that vendor. 
Expanding any of the individual block types will reveal the list of applicable offset values
that can be used for a wall assembled with that block type.  Clicking on any individual block
type will display the list of geogrids that have published design values for use with the
selected block.  Any combination of block and geogrid that is visible in the editor will be
available for selection in the geogrid reinforced Segmental Retaining Wall module.

The functions of the various tools and buttons on the Block & Geogrid Editor are described
below:

Import Block/Grid Data:  Allows the user to import a file (such as from a colleague) that
contains all of the block and grid data from another installation.

Export Block/Grid Data:  Allows the user to export a file that contains all of the block and
grid data from the current installation (such as to share with a colleague).

Refresh System Defaults:  Allows the user to reset the design values for block and grid
to the initial values as they were when the software was
originally installed.  This function is safe to use even if the
user has created any custom block/grid definitions after
installation, because the system automatically differentiates
between system-installed data and custom user data.  This
function will not alter or remove your custom user data if any
has been entered.
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Insert Vendor/Insert Block/Insert Offset:  The function of this button changes
depending upon what is selected in the top pane.  

· When the focus is on the label "Block Vendors" at the top of the tree, this button
takes the form of Insert Vendor, and it allows a new block vendor to be added to the
tree structure.

· When the focus is on any one of the block vendors in the tree, this button takes the
form of Insert Block, and it allows a new block type to be added to the selected
vendor.

· When the focus is on any one of the blocks in the tree, this button takes the form of
Insert Offset, and it allows a new offset value to be added to the selected block.

Edit Vendor/Edit Block/Edit Offset: The function of this button changes depending
upon what is selected in the top pane.  

· When the focus is on any one of the block vendors in the tree, this button takes the
form of Edit Vendor, and it allows the selected vendor name and website to be
edited.

· When the focus is on any one of the blocks in the tree, this button takes the form of
Edit Block, and it allows the selected block properties to be edited.

· When the focus is on one of the offset values, this button takes the form of Edit
Offset, and it allows the selected offset value to be edited.

When editing block definitions, the program presents the following dialog:

Delete Vendor/Delete Block/Delete Offset:  The function of this button changes
depending upon what is selected in the top pane.  

· When the focus is on any one of the block vendors in the tree, this button takes the
form of Delete Vendor, and it allows the selected vendor to be deleted.

· When the focus is on any one of the blocks in the tree, this button takes the form of
Delete Block, and it allows the selected block to be deleted.
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· When the focus is on one of the offset values, this button takes the form of Delete
Offset, and it allows the selected offset value to be deleted.

Create Block & Grid Combination:  When the focus on the top of the screen is on any
one of the blocks in the tree, this button allows the
user to define a new geogrid/block combination by
specifying geogrid vendor, type, and design
properties for use with the selected block.  It also
provides access to the Edit Geogrid Design Data
button that allows the user to edit LTDS, Ci and
RFCR values for the selected geogrid (see next

item).

Edit Block & Grid Combination:  When the focus on the top of the screen is on any
one of the blocks in the tree, this button allows the
user to edit the connection design properties for use
with the selected block/geogrid combination.  When
editing Block Connection Data for the selected
block/geogrid combination, the program presents
the following dialog:
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This dialog also provides access to the Edit Geogrid Design Data button that allows the
user to edit the LTDS, Ci and RFCR values for the selected geogrid. When editing Geogrid

Design Data for the selected geogrid, the program presents the following dialog:

Delete Block & Grid Combination:  When the focus on the top of the screen is on any
one of the blocks in the tree, this button allows the
user to delete the selected block/geogrid design
combination.  (Note:  This does not delete the
selected block from the block database, nor does it
delete the selected geogrid from the geogrid
database.  It merely removes the combination of the
selected block and grid from the list of available
assemblies to choose from.)

Disclaimer:  The design values for block/grid combinations have a direct and significant
influence on the results produced in the Segmental Retaining Wall module. 
The licensed practicing professional user must therefore exercise due
caution when editing values in the data table and when incorporating this data
into subsequent calculations. We strongly recommend that all block &
geogrid design values be obtained from test reports that are acceptable to the
code enforcement agency where the wall will be constructed. The design
values in this program are supplied as a convenience to the user and must
be verified with the manufacturers, test reports and code agencies.

Inserting Custom Block and Geogrid:

The procedure to add a new block and geogrid is as follows:

1. Click Databases > Block & Geogrid Database.
2. Click Insert Vendor and add a vendor for the new block.
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3. Click on the new block vendor and click Insert Block.
4. Enter the new block data and click the Save button.
5. Select the new block and click Insert Offset.
6. Enter an offset value and click the Save button.
7. Click on the block again and click Create Block & Grid Combination.
8. Click the ... button next to Geogrid Vendor Name and either select an existing geogrid

vendor or click Insert button and enter a new geogrid vendor name.
9. Click the ... button next to Geogrid Type and either select an existing geogrid or click

the Add button, and enter the name and data for the new geogrid.
10. Click the Select button.
11. Enter the necessary values.
12. Click the Save button.
13. The new combination of block and grid with connection data appears in the list on the

bottom, and is available for selection in the Segmental Retaining Wall module.

10.4 Tools

This menu item provides access to useful tools that are supplied with ENERCALC SEL.
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Calculator: We supply a Reverse Polish Notation Calculator (RPN) for engineers to
use for intermediate calculations when entering data. RPN calculators are the most
commonly used among engineers because they allow faster mathematics solutions when
nested (parenthetical) calculations are used.  It also includes a Copy button, which allows
a result value to be copied to the clipboard and then pasted into an input field in
ENERCALC SEL.

For more information on Reverse Polish Notation try these links:

http://en.wikipedia.org/wiki/Reverse_Polish_notation

http://www.hpmuseum.org/rpn.htm

http://en.wikipedia.org/wiki/Reverse_Polish_notation
http://www.hpmuseum.org/rpn.htm
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Retaining Wall Common Equations:  The Retaining Wall Equations Editor provides an
easy way to plug in parameters and get quick results for equations that generally relate to
retaining walls (with a few exceptions).

Remove Saved Reports from Project File: This command removes any reports that
have been saved in the current Project File.  It can be helpful in terms of reducing file size if
a Project File is to be emailed, but it will require that the reports be regenerated before they
can be printed. 

Optimize file by removing abandoned records: This command removes lost records in
a Project File which could occur if the program is terminated abnormally (perhaps from a
power outage, lockup, network failure, lockup of another program, etc).

Register ActiveX Modules: This selection provides a process of registering components
used by SEL with the operating system.
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10.5 License

The License item displays the licensing and activation menu.

10.6 Help

The Help item displays the Help menu.
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Manage your Software License: Automatically opens the Manage License page of our
website.

Dynamic Help: Displays the help system for the software that is installed on your
computer.

Web Documentation (most up-to-date): Displays the most up-to-date help information
located on our website.

Web FAQ Pages: Provides a direct link to the Frequently Asked Questions section at
www.enercalc.com.

Download PDF Docs: Downloads the PDF version of the documentation for the software
currently available at our website. The documentation on our website will always be for the
latest available version.

"For Our Users" Web Page: Provides a link directly to the "For Our Users" page of our
website, which offers information on current builds, Customer Information, Software
Installation & Update Links, Installation Info & FAQ links, info on Maintenance Plans &
Upgrades, Documentation Links,  Links to PDF Files of Relevant Information and Useful
Forms, and links for Prior Version Software Reinstallation.

"Training Videos" Web Page: Provides a link directly to the "Training Videos" page of our
website, which offers videos on topics such as Installation, General Operation, Using
Project the Manager, Designing Beams, Columns, Foundations, Slender Walls, working
with some of the Miscellaneous modules, and working with External Files.
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Create Tech Support Email: Provides you with a Tech Support form to fill out. When
finished, the data is transferred to an email form to send to our Tech Support Group. (Note:
Some computers and email software will not be able to paste the information into your
email program. This is not an ENERCALC issue.  In those situations, feel free to compose
an email to support@enercalc.com directly from your email program, and please
remember to indicate your "KW" User Registration number on all correspondence.)

Check for MAJOR Updates: Immediately runs the update check program named
EC6WebUpdate.exe, which resides in the ENERCALC program installation folder. If a
newer build is found, a window will be displayed prompting you to decide if you want to
continue to update your software.  If there is no newer build of the software available, then
you will be informed that your installation is currently up-to-date. 

Enhancement/Change History: Opens a window that lists revisions and enhancements
that have been performed on the software. Click here  to access a specific section with
additional information.

View Activation & License Information:  Another way to access user information.

41
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Problem Steps Recorder:  Provides a utility to record your steps and automatically
create a report to send to us for a tech support question.

Screen Capture:  Provides a utility to create a screen capture, such as to send to us for a
tech support question.

About: Displays a general window giving information about software version, copyright,
licensed user, activation status, and contact information for ENERCALC.



Part
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11 Project Manager

The Project Manager is displayed when a Project File has been opened.

The Project Manger provides the ability to create and modify a single Project File that can
contain a set of calculations and external items for a specific project. The layout, which will
be ever-improving, is designed to allow a Project File to be a single collection point for
documents relating to the load development and structural design of a building or other
structure.  

Components that all Project Files AUTOMATICALLY contain are:

GENERAL Division (Only one can exist in a Project File)
A storage location for pieces of information pertaining to areas of the entire project, such
as:

· Project Info, Building Department Contact Info, Designer Notes, Revisions, Client,
Designer.

· Future additions

Seismic, Wind, Other LOADS & FORCES Division (Only one can exist in a Project
File) (Not available in RetainPro mode)
These are storage locations for calculations of loads and forces:

· General forces for the project including Snow Loads, Wind Loads and Seismic Loads.

· Live load reductions.

· Future additions

Calculations Division
A storage location for calcs that the user adds to the Project File.

Components that any Project File CAN contain are:

Custom Divisions (An unlimited number can exist in a Project File)
Storage locations (folders) for organizing user-generated calculations and external items.

· Can be created, named, copied, organized, expanded, collapsed, and deleted.

· Are typically named in ways that are meaningful to the designer and that suit the
specific project.

· Are generally populated with calculations and external items.

· Provide a convenient way to selectively control project printing operations for logical
sets of calculations.

· Every new Project File is automatically populated with one Division named
"Calculations".
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Calculations (An unlimited number can exist in a Project File)
User-generated calculations that are created using the built-in modules and are stored in
Divisions.

· Can be created, moved between Divisions, and deleted.

· Can be copied to serve as the basis for a new calculation with similar input data.

· Can be imported from one Project File to another.

· Can be printed singly or in batch mode using the Project Printing Manager.

External Items (An unlimited number can exist in a Project File)  (Not available in
RetainPro mode)
User-generated external files that are created using external programs and then stored in
the Custom Divisions.

· Can consist of MS Excel spreadsheets, Adobe Acrobat PDFs, and scanned
documents/images.

· Can be embedded within the Project File for maximum portability, or can be linked to
the Project File to minimize file size. 

· Can be created, moved between Divisions, and deleted.
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Please see the descriptive keynotes on the following screen capture for information on
various areas of the Project Manager.

(1) Project Printing: These buttons allow you to print the report for the selected
calculation, or open the Project Printing system, which allows you to review all report
pages for all calculation items in the entire project. Click here  to review the specific
section on Project Printing.

128
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(2) Buttons to Add, Copy, Edit & Delete Individual Calculations: These buttons allow
you to add, copy, edit and delete ENERCALC calculations or external source items (such
as Excel sheets) in the selected Division. Click here  to review specific section.

(3) Sort Options: These three tabs sort your Project File content by Division grouping,
Type of calculation (Steel Beam, Concrete Column, Excel sheet, etc.) or Material
(Concrete, Steel, Wood, etc.). Click here  to review specific section. Note that the [Add],
[Copy], and [Delete] options are not available in the Type view or the Material view.

(4) Expand & Contract Tree: These two buttons fully expand or fully contract the tree
structure to display or hide the full contents of the Project File.

(5) GENERAL Division: The GENERAL Division is automatically created in each new
Project File. There can only be one GENERAL Division, and its purpose is to contain and
organize certain hard-coded pieces of general information that apply to the Project as a
whole. Click here  to review the section describing these items. The screen capture
below shows a view of the Project Manager with the GENERAL Division expanded to
display its contents:

113
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(6) LOADS & FORCES Divisions (Not available in RetainPro mode): The LOADS &
FORCES Divisions are also automatically created in each new Project File. There can
only be one of each LOADS & FORCES Division, and their purpose is to contain and
organize load related calculations.  The screen capture below shows a view of the Project
Manager with the Seismic LOADS & FORCES Division expanded to display its contents:

(7) Calculations Division: The Calculations Division is also automatically created in each
new Project File, but it is created merely as a user-convenience. It can be thought of as a
"custom" Division, because its name can be changed and it can be moved or deleted. The
user is free to create as many custom Divisions as the Project warrants, and to name
them as best suits the Project. 
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(8) Calculation List: This is the main list that displays all the calculation items that you
have added into your project. It allows you to organize your calculations into Divisions. See
image below for another look at two Divisions labeled "Beams" and "Columns". Columns
shows a [+] button to its left, indicating that the tree containing the calculations in that
Division is compressed. Click here  to review the section describing these items.104
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(9) Move Item in List: These buttons move the highlighted calculation up and down within
the list. Click here  to review specific section.

(10)  Import Calculations from other Project Files:  Click here  to review specific
section.

11.1 General Division

This Division contains a list of items that describe the entire project.

Building Code Information : Allows entry of information relating to the building code,
jurisdiction and building official's contact information.

Project Information : Allows entry of general information about the project.

Client Information : Allows entry of information specific to the engineer's client.

Designer Notes : Allows entry of up to 18 specific notes assigned by a specific person
on a certain date.

119
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Revisions : Allows entry of up to 18 specific revisions assigned by a specific person on
a certain date.

11.1.1  Building Code Information

This form allows you to select the Governing Building Code and Default Load Combination
Set, and to enter various information items pertaining to the jurisdiction where your project
is located. This data is specific to your Project File.

102
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11.1.2  Project Information

This form allows you to enter information specific to your project. This data is specific to
your Project File.

11.1.3  Client Information

This form allows you to enter information on your client for a specific project. This data is
specific to your Project File.
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11.1.4  Designer Notes

This form allows you to enter up to 18 distinct notes on the project, each with a specific
author and creation date. This data is specific to your Project File.

11.1.5  Revision List

This form allows you to enter up to 18 distinct revision explanations on the project, each
with a specific author and creation date. This data is specific to your Project File.
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11.2 Loads & Forces Divisions

The LOADS & FORCES Divisions contain a growing number of calculations including
Snow Loads, Live Load Reduction, Wind Loads, and Seismic Loads.

See specific descriptions under Calculation Modules > Loads & Forces Division .103
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11.3 Calculation List

The Calculation List is the main Project Manager view that you will use when building your
calculation sets for projects.

Most of a normal work session consists of adding and editing calculations in the list.
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Please see the notes below as well as the following sections to learn what each button
provides and how to manage the list of calculations.

Divisions: Divisions are the main organizational category for calculations. These are the
left-most text item in the calculation list and will display either a [+] or [-] to the left of their
name. Divisions can be created, copied, renamed, moved, and deleted. Calculations must
always exist within a Division, but they can be moved freely between Divisions. Click
Here  for the specific information section. The screen capture below illustrates an
example of how a Division can be renamed with a title that is meaningful to your project:

109
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Adding, Deleting, Copying: The four buttons shown below allow you to add, copy, edit, or
delete calculations and external items. Click here  for the specific information section.

Sorting by Division, Type and Material: Click one of these tabs to change the sorting
view of the calculations in your project. Click here  for the specific information section.

113
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Changing Calculation and Division Order: The buttons you see below are used to
move the highlighted calculation or Division up or down in the list. When moving a
calculation downward, if moving a calculation would tend to replace a Division name, then
the calculation item is moved into that Division. When moving a calculation upward, if
moving a calculation would tend to replace a Division name, then the calculation item is
moved into the Division above. Click here  for the specific information section.119
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Importing Calculations: Clicking the [Import] button displays the calculation import
system. 

Click here  for the specific information section.124
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11.3.1  Divisions

Divisions are used to organize calculations. The image below has custom Divisions
named Beams, Columns, Analysis, etc.
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· Clicking the [-] icon to the left of the Division name will compress the Division tree. See
image below...note how only the Division names are displayed, but their contents are
currently not visible.
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Right-clicking on a Division name will display the following pop-up menu: 
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Selecting [Change Division Name] will display the following dialog:
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11.3.2  Adding, Deleting, Copying

The four buttons shown below are used to manipulate the calculations and Divisions in
your current Project File:
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Add: Clicking [Add] displays the dialog below, where you can select the type of item to add
to your Project File. The window contains two categories of items: Calculations and
External Items.

The available Calculations are listed in the top portion of the dialog (and there will be
more as the product matures). These are ENERCALC-created structural engineering
calculations that you can use. The lower portion of the dialog lists the available External
Items that can be created externally from the ENERCALC software package and then
inserted into an ENERCALC Project File.  Click here  to go to the specific section.

Copy: For the currently highlighted item in the calculation list, clicking [Copy] creates a
new calculation of the same type using all of the information in the current calculation to
make the new calculation. 

Edit: For the currently highlighted item in the calculation list, clicking [Edit] opens the
calculation for editing.

Delete: Deletes the item that is currently highlighted in the calculation list. You are
prompted to confirm before the deletion is made.

1150
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11.3.3  Sorting by Division, Type & Material

Select the "Division", "Material", or "Type" tab to sort the calculation list based on these
three primary organizational hierarchies.
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Division: Organizes the calculation list by the Divisions you created, and sorts the
calculations within each Division in the order that you established. See below.
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Material: Organizes the calculation list by the materials to which they refer, and sorts the
calculations within each material in the order that you established. See below.
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Type: Organizes the calculation list by calculation type, and sorts the calculations within
each type in the order that you established. See below.
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11.3.4  Changing Calculation Order

The two buttons shown at the bottom of the calculation list (see image below) are used to
move the currently highlighted calculation or Division up or down in the list.
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In the image below, we have clicked on a Wood Ledger calculation:

 

The next step is to click the Shift Calculation Up button .
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Now notice that the Wood Ledger calc has shifted up one position:
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Now we will show that moving the last item in a Division downward will move the item to
the top of the next Division. Notice that we have highlighted the Flitch Plate calculation in
the screen capture below:
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If we click the Shift Calculation Down button , we will see in the following screen
capture that the Flitch Plate calc has shifted down one position, which puts it at the top of
the calcs in the Columns Division:
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11.3.5  Importing Calculations

The Import button is located as shown below:

Clicking the Import button will change the Project Manager screen to appear as shown in
the following image.
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Please see the descriptions following the numbered keynotes. The order of the notes
follows the order of usage.

(1)  Specify the source ENERCALC Project File from which you will import calculations
into the current (destination) Project File.

Clicking the [Select Source File] icon will display a standard Windows File Open
dialog:
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(2)  After identifying the source Project File, area (2) will show the calculations in that
source file in a tree-structure list. 

(3)  Click on the desired calculation in the source file to select it. It will become highlighted.

(4)  Click in the current (destination) Project File to highlight a line where the calculation
should be imported.  (The only restriction is that calculations cannot be imported into
the GENERAL Division or the LOADS & FORCES Divisions, so be sure to select a
location other than those two Divisions or any of their contents.)

(5) Click the [Copy Calc(s) Into Project at Highlight] button.
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Notice in the image below the [Wood Beam] calculation is now highlighted in green in the
current (destination) file to indicate the location where it will be inserted.

Note: If you made a mistake and want to cancel the selection, just highlight the calculation
in green on the left and click the [Remove Added Calc] button (6).

(7) To finish the import process click the  button.

(8) To completely cancel the import click the  button.
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11.4 Project Printing

The Project Printing system allows you to print a complete project full of reports in one
simple process.

You can review all the reports in your project and then select which reports to print.

To open the Project Printing system, click the button indicated in the screen capture below:

 

The screen will change to display the Project Printing Manager window.

On the left will be listed all of the calculations and external items in the Project File. The
items in the GENERAL Division and Loads & Forces Divisions are placed at the top, and
the items in the other Divisions are placed on the bottom.  When you highlight an item the
full report appears on the right side of the screen.
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See the numbered keynotes on the image below as we describe how to use the various
controls on the screen. The information is given in order of typical usage.

(1)  List of project items for which reports are available : This area is similar to the
item list in the Project Manager. All available report items are listed here.  Simply click an
item and the report for that item will be displayed in area (4).  Please REMEMBER that the
reports shown were created when you clicked [Save] or [Save & Close] in the specific
calculation.

(2)  Print / No-print check mark: This column contains a check mark  or an X 
to denote whether that particular report item is scheduled for printing.

(3) Clear All / Select All / Invert Selection buttons: These three buttons perform bulk
changes to the print/no-print status of all items in the project.

 Clears the print tags on all reports, so none will be printed. A is
displayed to the left of all reports after clicking this button.

 Selects the print tags on all reports, so all will be printed. A is
displayed to the left of all reports after clicking this button.

 Inverts the print/no-print tags on all reports.
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(4) Report Preview area: The complete preview of the report is shown in this area for the
report item highlighted in the list.

(5) Report page selection: When the highlighted item is a multi-page report, this box
selects the page to view.

(6) Print selected reports to printer: Displays the Windows standard Print dialog box
and begins printing all selected project items.

(7) Create single PDF file for selected reports:  Displays a Windows Open File dialog
box to request a filename for a PDF file and then creates a PDF of all selected project
items.

(8) Click [Close] to dismiss the Project Printing Manager.



Part

XII
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12 Sample Session

This section will guide you through a session of preparing and printing a calculation. We
will use the Wood Beam calculation because it contains all the features available in
ENERCALC SEL.

Some steps will not be applicable to RetainPro mode.

12.1 Starting the Program

First....let's start the program
 

To start ENERCALC SEL, navigate to the ENERCALC program group from the Start
menu.

Click the Windows [Start] button and move upward to locate the ENERCALC program
group and highlight it. You will see several selections. Move the cursor to highlight
Structural Library and release the mouse button.
 
ENERCALC SEL will now open, and you will be viewing the Project Assistant as
described below.

12.2 Project Assistant

This screen gives you the ability to instantly choose how you wish to begin your work
session. All of these options can also be easily chosen from the main menu.

 
For this Sample Session we want to create a new Project File, so the next step will be to
click the [Create New Project] button.
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The next window to be displayed (see below) will allow you to define the file name and
select the drive & directory where the file should be placed.

We will use the filename Sample Session and place it in a folder named ENERCALC
Project Files that we created specifically to hold Project Files.

 
Note: You could place the file in other directories, but keep in mind that Microsoft
is now recommending specific locations for saving user-generated files with the
newer operating systems, and the default ENERCALC data folder conforms to
these new best-practice recommendations. The important thing to recognize is
that an ENERCALC Project File can hold thousands of calculations, so it is likely
that there will only need to be a single ENERCALC Project File for each design
project in the office.
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12.3 Creating a Project File

Here's the Create NEW Project File dialog box with the new filename entered. NO FILE
EXTENSION is necessary....the program will append it. When the dialog appears as it
does below, just click [Save] and the file will be created.
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When a new Project File is created, the new Project File is immediately opened and
displayed in the Project Manager window. You can see in the screen image below that the
new Project File looks rather plain and simple.

 

 
  

Notice that the ONLY items appearing in the calculation list are the GENERAL Division, the
LOADS & FORCES Divisions, and a "starter" Calculations Division.
 
You can create as many Divisions as you like. They serve as a way to organize your
calculations into logical groups for your convenience . 

All newly created Project Files will contain these Divisions by default.  The "GENERAL"
Division and the "LOADS & FORCES" Divisions cannot be renamed or deleted, and they
serve specific purposes, which we will see shortly.  But the "Calculations" Division is just
created for convenience.  It can be renamed, deleted, copied, etc.

Before we add any calculations to this Project File, the next step will be to enter some
general information about the project itself. 
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12.4 Entering Project Information

Click the [+] icon to the left of the GENERAL Division in the Project Manager to expand its
contents, and then double-click the item named Project Info.
 

 
For this sample session you can fill in anything you like, just to see how the Project
Information fields can be used. Then click the [Save & Close] button.  If you see a
reminder relating to report regeneration, just click OK.

The purpose of the Reminder dialog is to alert us to the fact that some data just changed in
the title block. Under normal conditions, ENERCALC SEL generates the report for a single
calculation at a time, and it does that when the Save command is issued while a
calculation is open. This makes for a very efficient use of time by generating reports only
on an as-needed basis. However, because we just made a change to title block data, it is
likely that we want all reports regenerated and brought up to date at this time. This
Reminder dialog guides us to the command in the main menu that manually forces all
reports to be immediately regenerated.
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NOTE: This Project Information is printed in the upper-right corner of your printouts. All
ENERCALC SEL printouts have a Title Block area that contains your company's
information in the upper-left corner and the Project Information in the upper-right corner.
The above project information (and the title block information described in the next section)
will look like this on the printouts:
 

12.5 Setting up your Title Block

Before continuing on to add some calculations to the project, we'll demonstrate where to
enter company information to be included on ALL calculations produced within
ENERCALC SEL.
 
Click Settings > Printing & Title Block from the main menu. 
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The Printing & Title Block tab of the Program Settings dialog will be displayed. Here you
can use six lines to customize the printout with your own company information. This
information will be printed in the upper-left corner of ALL printouts (see sample previously).

 

The Logo File area of this dialog also offers the option to identify a graphic file of your

company's logo and specify that it be printed as part of the Title Block.  Clicking the 
button lets you use a file selection dialog to select a Windows Bitmap (BMP), GIF, JPG, or
WMF file.
 
At this time, please enter some information in all six lines so you can see it printed later in
this sample session. Click the [Close] button when finished, and then click the [OK] button
in the Reminder dialog.

The purpose of the Reminder dialog is to alert us to the fact that some data just changed in
the title block. Under normal conditions, ENERCALC SEL generates the report for a single
calculation at a time, and it does that when the Save command is issued while a
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calculation is open. This makes for a very efficient use of time by generating reports only
on an as-needed basis. However, because we just made a change to title block data, it is
likely that we want all reports regenerated and brought up to date at this time. This
Reminder dialog guides us to the command in the main menu that manually forces all
reports to be immediately regenerated.

12.6 Adding a Calculation

To add a calculation in the Project Manager, first highlight the location where you would like
the new calculation to be inserted. At present we only have one Division that can receive
user-created calculations, and it is named "Calculations".  So we will click on
"Calculations" to highlight it as shown below:   

 
      

 

Next, click the [Add]  button. 
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The next dialog will allow you to select exactly which calculation type you wish to add:
 

 

For this sample session we will use the Wood Beam module, so click the Beams tab, and
then click the [Wood Beam] button as shown below.

 

 
A Wood Beam calculation will be added in the Project Manager, and it will automatically be
opened for editing. The screen will reconfigure itself to display the graphical user interface
that is specific to the Wood Beam module. 
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12.7 Viewing the Calculation Screen

The screen should now appear as shown below. Please observe the following areas of the
screen....they are typical of ALL calculations in ENERCALC SEL.
  

 
 

The data entry tabs on the left side of the screen are where you enter your input values.
 
The results and graphics tabs on the right side of the screen are where you review the
calculated values, sketches, and graphs that result from calculations based on your input
values.
 
This screen layout is consistent throughout the majority of ENERCALC SEL calculation
modules. This enables you to display the tab of interest on the right and see how changes
to input data on the left affect it.

12.8 Changing the Default Values/Settings

When you first add any calculation to a Project File, that calculation will come in with
default values/settings for all user input items.  If you find that you are almost always
having to change certain items, it may make sense for you to revise those defaults to
better suit your work.  Revising the default values for any module is easy.  Just follow these
steps:

1. Add a new calculation of the module of interest to a Project File.  It will come in with the
existing default values/settings.
2. Revise the values/settings to suit.
3. Click Settings > Default Values > Save.
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This will save all of your current settings/values as the new defaults for that particular
module.  From that point onward, any time you add a new calculation of that module type, it
will automatically be populated with the default values/settings that you just established.

12.9 Entering Data

Below is a diagram for a wood roof beam we wish to design. 
  

 
 
The following steps will guide you through the process of setting the span lengths and
entering the loads as shown. (In a subsequent step we will select the member section size
and reference design values from the internal databases.)

The top portion of the screen should currently look like this:

The first thing we will do is add the left cantilever.  To do this, click the [+/-] icon at the left
end of the beam as shown bubbled below:

This opens the dialog named Select Add or Delete. It is currently set up to allow us to add
a new beam span, which is exactly what we want to do. There are some additional
settings offered at the bottom of the dialog in the form of checkboxes.  We don't need to
worry about these at this point, but it's good to know that they are available, because they
can offer some time-saving conveniences in certain modeling situations. 
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See the image of the Select Add or Delete dialog shown below:

For our purposes, all we need to do is click the [OK] button. This inserts a new beam span
to the left of the original beam as shown below:
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At this point, don't be concerned about the fact that the new span is not a cantilever and
that it is not the intended length.  We'll correct both of those items in just a moment.  For
now, let's repeat a similar process to add a new beam span on the right.  First click the
[+/-] icon that appears above the right-most support. The following dialog appears:

This is very similar to the Select Add or Delete dialog we saw before, except that it now
has an extra option to delete the span that is to the left of the support.  Although we don't
want to do this, it's good to know that this is the way that you would delete a span if
necessary. What we want to do is add a new beam span, and that is the option that is
currently selected (highlighted in yellow), so we can just click the [OK] button. 
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The screen should now display a 3-span continuous beam as shown below:

Now that we have three spans to work with, let's modify the support conditions to create
the cantilevered spans at the left and the right. To do this, click on the left-most support
icon shown bubbled below:

 

This will open the following pop-up menu that offers many options for defining the support
condition at that location:

 

Click the Free End option to remove all restraint from the left end, creating a cantilever.
Repeat the same process at the right-most support, but leave the remaining two supports
as they are currently configured.  (They represent pinned conditions that prevent
translation in all directions but offer no moment restraint.) The result will be the double-
cantilevered beam as shown below:
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Now that the support conditions have been established correctly, we can wrap up this
exercise by modifying the span lengths to match the problem definition. Start by clicking
the Beam Span Data tab shown bubbled below:

The screen layout will change to display the Beam Span Data tab as shown below:

Now, we just need to adjust the span lengths for each of the three spans.  

First, note that the graphical depiction of the beam helps us to make the association
between the three individual spans and the span numbers.  Click any of the three span
number buttons in the Select Span area and notice that a corresponding span becomes
highlighted in the large graphic at the top of the view.  Using this method, we can confirm
that the spans are logically ordered from number one on the left to number three on the
right. (Note that you can also click the highlighted rectangles shown above each beam
span, and they act in exactly the same way that the numbered buttons do.)
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So to finish things off, click the button for span [1] and verify that the left span becomes
highlighted. According to the problem statement, this span is supposed to be 7'-3", so you
can highlight the value that is presently displayed in the Span Length field, manually edit it
to say 7.25, and then press the [Tab] key to enter that value. The display will update to
show the proper span length for the left beam span as shown below:

Repeat the same process to set the Span Length for the middle span to 24'-0" and to set
the Span Length for the right span to 9'-6", at which time the display should appear as
shown below:
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The next step will be to enter the loads on the beam. Let's begin by entering the
concentrated load at the free end of the left beam span. Click the Span Loads tab to
display the following screen:

This screen contains tools to apply loads to a selected span at a time.  (Shortly, we will
see a convenience tool that will allow us to apply loads to ALL spans of a beam at one
time.)

Since we want to start by entering the concentrated load at the free end of the left beam
span, click the [1] button in the Select Span area to put the focus on Span 1. 
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The blue highlighted band in the table now represents the first load on Span 1. But it
currently indicates Load Type = None, because we have not defined the load yet. Click the
button indicated in the screen capture below to identify the load as being a concentrated
load:
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This will reconfigure the screen with the appropriate input fields to fully define the
magnitude, direction, and location of the concentrated load as shown below:

Select the checkbox for the Auto add beam weight option.  This will trigger the program to
determine the self weight of the beam that we eventually choose, and apply it as dead load
when the analysis is performed. 

Select the checkbox for the Auto Unbalanced Live load Placement option. This will initiate
the generation of additional loading conditions to ensure that all possible permutations of
live load placement are properly examined. Note that selecting this option can lead to
longer analysis times because of the number of different conditions that must be analyzed.
However, with the double-cantilevered beam configuration, it would be important for us to
have the module examine all of these potential loading permutations.
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The Load Source input field provides a location where you can add some descriptive text
for your own use to identify this particular load item. The use of this field is optional, so for
this sample session we will leave it blank.

When defining the magnitude of the concentrated load, note that the module is set up to
receive this kind of load in units of kips, and notice that it has input fields for the common
load cases, such as Dead, Live, Snow, etc. 

Click in the input field for Dead, enter a magnitude of 3.03, and then press the [Tab] key.
This enters the Dead load magnitude and moves the cursor to the next input field. 

Note: For convenience this module is configured such that loads with positive magnitudes
are assumed to act downward, since the majority of the load items are typically gravity
loads of some sort. 

The cursor is currently in the Lr input field, which represents Roof Live load.  We don't
need to enter any magnitude for Roof Live, so press the [Tab] key once again to place the
cursor on the Live load input field. Enter a magnitude of 2.824, and then press the [Tab]
key.

The final step in specifying this concentrated load is to identify its position using the
Location input field. Always specify the distance from the left end of this span to the
position of the concentrated load. In this case, the correct value is zero, which also
happens to be the default value for the Location field, so the Location field can be left as-
is. 
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The screen should now appear as shown below:

The next step will be to define the other concentrated load, which occurs at the free end of
the cantilever on the right end of the beam, by following a very similar process.

Click the [3] button in the Select Span area to put the focus on Span 3.

Click the  button to identify the load as being a concentrated load.

The magnitudes of this load are the same as those used at the opposite end of the beam,
so click in the input field for Dead, enter a magnitude of 3.03, and then press the [Tab] key
twice.  

In the Live load input field enter a magnitude of 2.824, and then press the [Tab] key.
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This concentrated load is to be positioned at the extreme right end of this span, so click in
the Location input field, enter a distance of 9.5 (9'-6" from the support at the left end of
Span 3), and then press the [Tab] key. The screen should now appear as shown below:

The next step in defining loads is to apply the uniformly distributed load across all three
spans. This could be done by using the Uniformly Distributed Loading Type here on the
Span Loads tab. But this would require some repetition, because the Span Loads tab is
specifically set up to facilitate the application of loads to one span at a time.
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To apply this load in a more efficient manner, click the Loads All Spans tab shown bubbled
below:

The screen will reconfigure itself to display different tools for applying various types of
loads to all spans of the beam. The one that is most appropriate for our application is the
one shown bubbled below:

Click that tool and note that the screen displays input fields for Tributary Width and load
magnitudes for the various Load Cases as shown below:
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Note: When using this tool, you can either leave the Tributary Width input field at its default
value of 1.0, and then enter the magnitudes for the various load cases in units of kips per
foot, or you can specify a Tributary Width magnitude other than 1.0 foot, and then enter the
magnitudes for the various load cases in units of kips per square foot, which will be
multiplied by the Tributary Width to determine the magnitude of the effective line load in
units of kips per foot.

For the purposes of our exercise, we will leave the Tributary Width input field at its default
value of 1.0. 

Click in the Dead load input field, enter a magnitude of 0.036, and press the [Tab] key
twice. 

In the Live load input field, enter a magnitude of 0.24, and press the [Tab] key once more. 

The last item to take care of is to observe the load combinations that will be used for
design. Click the Load Combinations tab indicated below:
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This will display the Load Combinations screen. On this screen, you can select the desired
Load Combination set.  In this case, we are already referencing the IBC 2018 load
combinations, which is our goal.  But if that selection did need to be changed, click the
"Select" button indicated in the screen capture below:
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This will open a pop-up menu offering choices of load combination sets that exist on the
current machine, similar to the one shown below:

 

Choose the option named IBC 2018.  This will set up the calculation to use load
combinations based on IBC 2018.

Next, click the  button, and confirm by clicking the [Yes] button. This is a very
convenient option for wood designs, because it automatically sets the C

D
 value based on

the shortest duration load case within each load combination. Note the various values of
C

D
 that result.
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The final step in this section is to ensure that all of the listed load combinations will be used

in the analysis and design. To do this, click the Load Combination Control button 
button. This will open a pop-up menu offering options for marking and clearing the Run
status of all of the load combinations in the list, as shown below:

Simply click the [Mark All] option, and all of the load combinations in the list will be marked
for use in the analysis and design.

12.10 Selecting Sections and Materials from Built-in Databases

In the previous topic you experienced part of the advantage of using ENERCALC
SEL...simplified data entry. The input screens naturally guide you through all of the
necessary items, and you are simply entering data into a form.

 
We still have two critical items to specify.....the design properties of the wood member to
use and the physical size of the beam.

 
First, let's retrieve the reference design values. For this sample we want to use a Douglas
Fir glued-laminated beam of type 24F-V8. 
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Click the General tab shown below:

In the Wood Material Selection category, click the [Select from Database] button

. The Wood Reference Design Values database will
be displayed as shown below:

 

  
We want to display ONLY the glued-laminated sections for Douglas Fir.  In the Size
Classes to Show category, click the [Table 5A Glulam - Beams] button:
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Click the [Contract Trees]  button to collapse the display of Wood Species
Common Names.

Click the [+] in front of the DF/DF item to expand the Douglas Fir list:

 
The result of these choices will be a list of stress grades as shown....
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Click the 24F-V8 item as shown, and then click the [Select] button. The stress information
area on the General tab will immediately be updated to reflect your selection:

 

 
Next, let's retrieve the section property data for a 6.75" x 30" glulam beam  
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Click the Beam Span Data tab  and make sure that the [All
Spans] option is selected as shown below:
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Then click the [Database] button shown bubbled below: 
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The Wood Section Database will be displayed as shown below:

 
 

Now click the  button in the Glued Laminated category so that only
those members are displayed. The result of this choice will be a list of glulam beams. 
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Scroll down through the database and highlight the 6.75" x 30" beam as shown below:
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Click the  button.  The beam size information area on the Beam
Span Data tab will immediately be updated to reflect your
selection:
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12.11 Displaying a Sketch

We now have a calculation with span lengths, loads, allowable stresses, and a beam size.
It's time to review the sketch to confirm that we have entered the critical span and load
information correctly. Click the 2D tab, and the working area of your screen will be
replaced with a simple diagrammatic representation of the beam.
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12.12 Displaying Diagrams

In addition to the Sketch of the beam, we can also display several types of diagrams.
Selecting the Diagram tab will display the Shear/Moment/Deflection diagram as shown
below: 
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Of special interest are the various load combinations that can be viewed.  By selecting the
desired load combination here you can view the detailed shear/moment/deflection
variations produced by each combination.

Note: In the previous steps, we turned on the option to have the program automatically
handle unbalanced Live load placement.  While this is a helpful feature for design, it tends
to produce an abundance of results. If you'd like to simplify the view of shear, moment, and
deflection diagrams, click the Span Loads tab and temporarily turn off the option to have
the program automatically perform unbalanced Live load placement. To view even more
specific diagrams, deselect the option to Display All Combinations, and then select the
load combination of interest in the dropdown list box.



ENERCALC SEL171

© 2024  ENERCALC, LLC

12.13 Displaying a 3D Rendering

To view a 3D rendering of the beam, click on the 3D tab.  Controls are provided to
manipulate the view angle, to turn various items on and off, and to print the view. 

12.14 Automatic Member Section Selection

An additional feature of many of ENERCALC SEL calculation modules is automatic
selection of sizes that satisfy your specified design criteria.

Note: If you turned off the option to have the program automatically perform unbalanced
Live load placement in the previous topic, please click back to the Span Loads tab now and
make sure the option for Auto Unbalanced Live Load Placement is selected once again.
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Click the Calculations tab as shown below:
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When the screen displays the Calculations environment, the Summary Results tab will be
displayed by default as shown below:



Sample Session 174

© 2024  ENERCALC, LLC

Take a look at the stress and deflection ratios indicted in the screen capture below:
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We can see that our 6.75" x 30" size guess works, but may not be an optimum use of the
section. It would be interesting to see if we could find a more efficient section. Rather than
manually trying other sizes from the database, we will use the Automatic Design function
to select an optimum member size for us. Click the [Auto Select] button on the Beam
Span Data tab shown below:
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The Wood Member Design dialog is displayed, and it allows you to set the design criteria:
                           

   

 
On the Wood Member Design dialog, click the [Glu-Lam - Western] section type, set the
Maximum Stress Ratio to 1.0, and the Minimum Total Deflection Ratio to 180, then click
the [Start Design] button. 
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The software will automatically search the built-in Wood Section Database for all sections
that satisfy this criteria using the beam span, stress grade, and loading you have specified.
 In a few moments the following dialog will be displayed:
 

Notice how the listed members can be sorted in different orders based on: Weight,
Bending Ratio, Shear Ratio, LL Deflection Ratio,Total Deflection Ratio, Depth, etc. This
allows you to review the beam sizes that pass your criteria in different ways.
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Click on the 5.125 x 27 beam and then click the [Select] button. The Summary Results tab
now appears like this:

12.15 Printing a Calculation

Okay...congratulations! You've created a Project File, added a calculation, entered data,
retrieved database information, performed an automatic design, and viewed some
graphics. It's time to print this calculation and take a look at what the software provides for
documentation.
 
Please remember that you have previously entered project information, title block
information, and of course now you have a valid engineering calculation to print.
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Printing is easy in ENERCALC SEL.  To print an individual calculation report while the
module is still open, click the [PRINT] button:
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The Print Document window opens as shown below:

 
 

This window provides controls to decide which sections to include in your report.  Be sure to
click [Regenerate Report] after making any changes in the Sections to Include area.
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Once selections have been made and the report has been regenerated, the report can be
previewed, printed, and/or printed to PDF.
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12.16 Saving a Calculation

With as much as we have accomplished in this short period of time, it is very important to
remember that we have not yet SAVED this calculation. Everything associated with this
calculation is still stored in the computer's RAM. A power outage or severe system lockup
would cause a loss of your current calculation.
 
So to save this new calculation to the Project File, click the [Save & Close] button

. The current calculation will be saved and the display will return to the
Project Manager.  In the image below, you can see that a Wood Beam calculation has
been added to the Division named "Calculations":

 

   
 Congratulations! Your calculation is now saved and you have a real Project File with an
actual calculation.

12.17 Editing a Division Name and Adding a New Division

Let's do a little more work here in the current Project File.  We will edit the Division named
"Calculations", and we will add a new Division.
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Edit a Division Name

To edit a Division name, simply right-click the name and click Change Division Name in
the dropdown menu.
 

 
 

In the Enter New Division Name dialog, revise the Division name to "2nd Floor Framing" as
shown below:
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Click [Save]. You will notice that the Division name has been revised from "Calculations"
to "2nd Floor Framing", but it still contains the Wood Beam calculation.

 

 
Now we will add a NEW Division named "3rd Floor Framing". To do this, click on the

Division named "2nd Floor Framing" and then click the [Add] button . In the
Module Selection dialog, click the [Insert Division] button shown below: 

Note: There is also an option in the right-click dropdown menu named Add Division.
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Then enter the name "3rd Floor Framing" and click [Save]. Your Project calculation list
should look like this:
 

12.18 Adding Another Calculation

Similar to the way we added our first calculation, we will now add another calculation in the
2nd Floor Framing Division by making a copy of the current Wood Beam calculation and
then move it into the 3rd Floor Framing Division.
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First, click on the Wood Beam calculation as shown in the screen capture below:

 

Then, click the  button. This will read all the data from the highlighted
calculation and create an entirely new calculation that is an exact copy of the highlighted
one.
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Here is a view of the newly created calculation:
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Double-click the new calculation to open it.  When the Wood Beam calculation module
opens, change the Description item to read "3rd Floor Cantilevered Beam" as shown
below:
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Next click the [Save & Close] button to save this new calculation to the Project File and
close the calculation. The Project Manager will appear as follows:
 

 
The final step is to move this new calculation into the 3rd Floor Framing Division. This is
easily done by using these buttons:
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While the new calculation is highlighted, click the Move Highlighted Item Down 
button twice to move it down to the 3rd Floor Framing Division. The Project Calculation list
will appear like this:
 

12.19 Creating a Technical Support Question

The occasion may arise that you will have a question about the software system. To best
serve you, there are certain pieces of information that are essential. Among these are your
name, the name of your company, your "KW" user registration number, and the build
number of the software you are using.
 
To make it easy for you to give us all this AND state your question, ENERCALC SEL has a
built-in technical support form. It allows you to simply type in your question and email it
directly to our Technical Support Group.

By emailing us your Technical Support questions, we can easily identify you, determine if
you are in need of a maintenance release, and easily read your questions.  In addition,
email offers the option of attaching the subject ENERCALC file.
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To create an email:

Click Help > Create Tech Support EMAIL from the main menu.  This opens the form
shown below, in which you can enter your question and attach your Project File if desired. 
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When finished, click the [Send] button to transfer the completed message (with
attachments) to your email program:
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12.20 Closing a Project File

It is now time to close out our work session. The data is saved in the Project File already,
so at this point we can close the current Project File by clicking File > Close Project from
the main menu or by clicking the Close Project button:



Part

XIII
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13 Calculation Modules

13.1 Loads & Forces Divisions

The Loads & Forces Divisions in the Project Manager are automatically created for you
when a new Project File is started.

Each Project File will contain the following Loads & Forces Divisions:

SEISMIC Loads & Forces
WIND Loads & Forces
Other Loads & Forces.

Each contains modules for the calculation of the respective types of load and force
calculations.  Their use is optional, but these calculation modules cannot be moved out of
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their respective Loads & Forces Division, nor can other calculation modules be moved into
or added to these Loads & Forces Divisions.

As ENERCALC SEL is enhanced, the Loads & Forces Divisions will contain more and
more tools to assist with developing your project load calculations.

13.1.1  ASCE Seismic Base Shear

Need more? Ask Us a Question

This module is a presentation of equivalent lateral force procedure seismic provisions in
ASCE 7.

The module currently supports calculations based on ASCE 7-16. All of the references to
ASCE 7 are given on the module screens. Above each screen capture are notes as
needed to call attention to entries or explain usage.  

The module is designed to allow you to work downwards through the tabs on the left side
of the screen. ASCE 7 skips all around in its definitions of things to check. This module
simplifies the process by properly ordering the items and the necessary decisions to be
made in working toward a final seismic base shear value.

The program includes a complete national zip code database and USGS databases of
seismic ground motion specifically for use with ASCE 7-16. Using city names or zip
codes, you can look up the latitude and longitude of the representative center of the zip
code. 

The seismic ground motion databases consist of "gridded" values for small increments of
latitude and longitude. Given the latitude and longitude for the city or zip code of interest,
the surrounding grid data points are located and those seismic ground motion values are
used to determine a value for the latitude and longitude of interest. For this reason the
values may not match the web-based USGS database values exactly.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General

Ss, S1: Ground Motion 

Three options are available to specify the SS and S1 values.
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Browse City Database
Use the Select State drop-down list box to select the State. Then click one of the City
First Letter buttons to have all cities (in the database) listed in the scrolling box on the
right. Then simply click on the city to select. Some city names have have multiple zip
codes.

Enter SS and S1 Directly

Or, you can enter the SS and S1 values directly.
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Enter Latitude & Longitude Directly
Or, you have the option to enter the latitude and longitude for the project location.
(Note that longitude is degrees WEST, so do not enter negative values.)

Site Class, Site Coefficients and Seismic Design Category

Select the appropriate Site Class based on the geotechnical conditions.
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Selection of Seismic Force Resisting System 

Click one of the large boxes at the top of the tab to load the table with specific selections
for that general category of Seismic Force Resisting System.

Note the checkbox for systems with flexible diaphragms. This may not apply to some
building systems...check ASCE for details on the particular system of interest.
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Redundancy Factor 

Depending on the Seismic Design Category determined from the prior selections of
Occupancy, Seismic Ground Motion and Building System, the Redundancy Factor per
ASCE will be shown here.

Specification of Building Period 

All four ASCE 7 options for building period determination are available here.
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Evaluation of Approximate Building Period

Approximate Period for Steel & Concrete Frames

Approximate Period for Concrete or Masonry Shear Wall Structures
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Long-Period Transition Period Reference Maps

Maps copyright ASCE.

Cs: Seismic Response Coefficient 

Please check ASCE 7 section references for details. 
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Vertical Distribution of Base Shear 

This tab calculates the vertical distribution of seismic forces.  Use the [Add] button for
each new level. To edit information for a level, highlight the corresponding line and click
[Edit].

Diaphragm Forces 

Using the information entered above (on the prior tab) the force distribution results are
shown here.
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13.1.2  ASCE Seismic Demands on Nonstructural Components

This module is an implementation of the provisions for seismic demands on nonstructural
components as per ASCE 7.  The module currently supports calculations based on ASCE
7-10 and ASCE 7-16.  Input parameters are taken directly from the nomenclature
presented in ASCE 7.

This calculation produces both component and connection design forces using the defined
parameters.

13.1.3  ASCE Seismic Wall Anchorage

This module is an implementation of the provisions for design and anchorage of walls to
resist seismic forces as per ASCE 7.  The module currently supports calculations based
on ASCE 7-10 and ASCE 7-16.  Input parameters are taken directly from the nomenclature
presented in ASCE 7.

The calculation produces:
· Out-of-Plane Force for Structural Wall Design

· Out-of-Plane Wall Anchorage Force
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The module is configured to allow the definition of up to 20 different wall conditions.  The
user has the option to decide which (if any) of the calculations will be included in a Project
Print.

13.1.4  ASCE Wind Enclosure

This module is an implementation of the provisions for determining the Enclosure
Classification for the determination of Wind Loads as per ASCE 7.
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The module currently supports calculations based on ASCE 7-10 and ASCE 7-16.  Input
parameters are taken directly from the nomenclature presented in ASCE 7.  

The calculation sheet is set up to permit up to ten different analyses to be documented
within a single Project File.  This can be useful when a project includes multiple buildings,
or in situations where multiple scenarios are being evaluated.

The data collection is presented in such a way as to guide the user through the module in
a logical progression.

Values of gross area and area of openings are provided for walls on four sides of the
building (arbitrarily designated "North", "South", "East", and "West").  Once these values
are provided, the module can determine if the structure qualifies as "Open" or not.  If the
structure is determined to be "Open", then the module will indicate that result and stop
there.  If the structure does not qualify as an "Open" structure, then input fields for Roof
Gross Area and Roof Opening Area will be displayed, and a set of four tabs will appear in
the bottom half of the screen.  Once the Roof areas are populated, the four tabs thoroughly
present the calculations to determine whether the structure qualifies as "Enclosed" or
"Partially Enclosed" when each of the four respective walls receives positive external
pressure.

The results of this determination are useful for project documentation requirements, as
well as in guiding the user to read the appropriate results values from other modules within
ENERCALC SEL.  

Note: The provisions of the ASCE Wind Enclosure module are already incorporated into
the ASCE 7-10 and 7-16 Wind Loads modules.  So it is not necessary to run the
standalone version of this module if the ASCE 7-10 or 7-16 Wind Loads modules will be
used.

13.1.5  ASCE 7-10/16 Wind Forces, Chapter 27, Part 1

Need more? Ask Us a Question

This module is a presentation of the Wind Forces provisions of Chapter 27, Part 1 of
ASCE 7-10 and ASCE 7-16.

Limited documentation is provided here, because all of the references to ASCE 7 are given
on the module screens.  

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General

The General tab provides an input field for a general description of the project and/or the
wind calculations that are being performed.

ASCE 7-10 / 7-16 Wind Force Evaluation

This tab provides access to a series of Calculation tabs that can be used to store up to ten
separate wind calculations.  These might be useful for studying different project sites,
different architectural concepts, or even evaluating separate buildings in a project.

The Description field can be used to distinguish from among the different wind load
calculations that might be defined in a single Project File.

The Print checkbox specifies whether or not the particular wind load calculation will or will
not be included when a Print command is clicked or when a Project Print is performed. 
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General (sub-tab of the ASCE 7-10 / 7-16 Wind Force Evaluation tab)

This tab collects basic data such as Risk Category, Basic Wind Speed, Directionality
Factor, Building Dimensions, Exposure Category, Topographic Factor, and information to
determine how the building frequency will be determined.

The Risk Category is only for reference in documenting the design.  It no longer influences
the importance factor, but it does dictate which Wind Speed map to use to determine the
Basic Wind Speed.

The Exposure Category is dependent upon the upwind characteristics.  Therefore, as
different building elevations become the windward face of the structure, it is possible that
the Exposure Category will change.  For this reason, the program allows the Exposure
Category to be defined separately for each building face in turn becoming the windward
face.

The Building Flexibility Selection offers three different options for defining the frequency of
the building.
· The first option declares that the building will be assumed to be rigid (having a frequency

greater than or equal to 1 Hz).
· The second option applies the prescriptive methods in Sections 26.9.2 and 26.9.3 of

ASCE 7-10 to approximate the frequency of the building based on construction
type/layout and mean roof height.

· The third option allows the user to explicitly specify the frequency in the North-South
direction and in the East-West direction.

Note that if the second option is selected, a new tab named "Frequency" will be introduced
between the "Story Data" tab and the "Gust Factor" tab.
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This tab contains the only difference between ASCE 7-10 and ASCE 7-16, which is
the introduction of Ke, the Ground Elevation Factor in ASCE 7-16.

Story Data

This tab collects the data required to define the vertical locations of the stories with respect
to finished grade.

The development of the story data table is controlled by the three buttons: Add Level, Edit
Level, and Delete Level, which perform their respective operations on the table of story
data.

Clicking Add or Edit opens the Story Information pop-up dialog as shown above.  Two
items are worthy of note on this dialog.  First, the Height to Story is always referenced from
grade, so it is looking to collect the height from grade to the story of interest, not the story
to story height.  Second, the values of e

Rx
 and e

Ry
 are only used if a building is determined

(or defined) to be "Flexible" (< 1 Hz) in a particular direction.  So if a building turns out to be
"Rigid" in one or both directions, then the values of e

Rx
 and e

Ry
 are not required in those

directions, and the values can be left at zero or a value can be entered, but the program
will ignore it.
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Frequency (Only displayed if the option is selected on the General tab to "Calculate
Frequency")

This tab displays the story data that was previously collected, and it requests the Building
Construction Type and the values of Li necessary to complete the check to determine if
the approximate methods of frequency determination are applicable.

If the approximate methods of frequency determination are found to be applicable, this tab
reports the approximate frequency.  Otherwise, a message will be displayed to indicate
that the approximate methods are not applicable, and that the building frequency must be
determined another way.
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Gust Factor

This tab displays the results of the Gust Factor determination for each of the four
elevations, in turn, being the face of the building that receives positive external pressure.

The North, South, East, and West tabs present the calculation and the resulting Gust
Factor that will be used in subsequent calculations when the respective building elevation
receives positive external pressure.

When the building is categorized as "Rigid" in a particular direction, the program offers the
checkbox option to force the value of the Gust Factor to 0.85 when the referenced
elevation receives positive external pressure.

When the building is categorized as "Flexible" in a particular direction, the program
requires one more value, which is the damping ratio.  This value is collected in an input box
on the respective direction tab when appropriate, and the value is incorporated into the
Gust Factor to be used when the referenced elevation receives positive external pressure.

It is worth noting that many of the parameters used in the calculation of the Gust Factor are
dependent upon the Exposure category.  Since the Exposure category can vary for each of
the four cardinal directions, it is possible that the Gust Factor for use when the North
elevation of the building receives positive external pressure may actually be different than
the Gust Factor for use when the South elevation of the building receives positive external
pressure.
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Enclosure

This tab displays the results of the Enclosure determination for each of the four elevations,
in turn, being the face of the building that receives positive external pressure.

The upper half of this tab is dedicated to evaluating the building to determine whether or not
it qualifies as an "Open" structure.  The module collects the gross areas of each of the four
walls along with the areas of opening in each of the four walls.  Based on the data provided
by the user, the module performs the calculations and checks the criteria to see if the
building qualifies as an "Open" structure.  If it does, then the module reports that result.  If
the building does NOT qualify as an "Open" structure" then additional input fields are
displayed to collect the gross area of the Roof, and the area of openings in the roof, and
the workflow continues to determine whether the building qualifies as "Enclosed" or
"Partially Enclosed".  This evaluation takes place four times, considering each of the four
walls to be the windward wall, in turn.  The intermediate calculations are performed and the
results are reported on each of the four wall tabs.

It is worth noting that a building could potentially be considered "Partially Enclosed" when
some of its elevations receive positive external pressure, and "Enclosed" when its other
elevations receive positive external pressure.

It is also worth noting that convenience buttons have been provided on each of the four wall
tabs to allow the user to simply declare the building to be "Enclosed" or "Partially
Enclosed" when the selected elevation receives positive external pressure.  These have
been implemented for situations where the evaluation has already been performed and/or
the user is already confident in making a decision by judgment.

The Enclosure classification is used downstream to select appropriate values of GCpi to
use when each of the four elevations becomes the windward wall.
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Velocity Pressures

This tab displays the results of the Velocity Pressure determination for the various walls
when each wall is under leeward, sidewall, and windward wall conditions.

The first row of data reports the values of Kh that are applicable when each of the walls
experiences leeward or sidewall pressures.

The second row of data reports the resulting values of qh that are applicable when each of
the walls experiences leeward or sidewall pressures.

Next, a table is presented that reports the values of Kz and the resulting values of qz that
are applicable, as a function of height, when each of the walls experiences windward wall
pressures.
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Pressure Coefficients

This tab reports the values of GCpi that are applicable when each of the respective
elevations receives positive external pressure.  The remainder of this tab is dedicated to
collecting the values of Cp or Cn as appropriate for the various surfaces of the building.  

Wall values are collected first, and the input fields collect values of Cp that will be used
when each of the four walls is a windward wall, a sidewall, or a leeward wall.

At the bottom of the tab is a customizable table that is set up to receive many lines of Cp
or Cn values pertinent to the roof.  A convenience button is provided to display the figures
that define the Cp or Cn values for various conditions.  A glance at the tables reveals that
the factors for roofs are frequently dependent upon the wind direction with respect to the
ridge, and also dependent upon whether pressures are desired for the windward or
leeward surfaces of the roof.  So some planning will be required to set this table up to yield
the desired results.  To make the downstream results most applicable and easy to read,
the program has been set up so that a roof pressure value will only be calculated for
situations where nonzero values of Cp or Cn have been specified.  To put this another
way, referring to the table above, there are no values of Cp defined for the North or South
elevations for the "Perpendicular: Windward" or "Perpendicular: Leeward" conditions.  This
is because the ridge is assumed to run in the North-South direction in the hypothetical
building being considered.  As such, it would not make sense to ask the program to report
windward or leeward roof pressures when the wind acts in the north or south directions. 
So to avoid overpopulating the output with meaningless results, the blank fields will be
interpreted by the program as an indication that the corresponding calculation is not
required.  We will see the benefit of this when we move to the Wind Pressures tab and see
how concisely these results are reported.  

On a related note, it is worth mentioning that the Cp and Cn tables occasionally report
values of zero for certain conditions.  These are typically provided for interpolation
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purposes.  But if a situation is ever encountered where a value of zero for Cp or Cn is
actually required for design purposes, the user is advised to enter a small nonzero value.

Wind Pressures

This tab reports the values of wind pressures that occur on the various surfaces of the
building when the named elevation receives positive external pressure. 

Looking at the screen capture above, we see that the North Wall tab is currently selected. 
Let's work through this tab thoroughly as an example.  As indicated in the on-screen note,
we interpret all of the results on this tab as being the pressures that occur on the named
surface of the building when the North Wall receives positive external wind pressure.
 So when we are focused on the North Wall tab:

· The "Windward Wall Pressures" are those that would apply to the North Wall when the
North Wall receives positive external pressure.  

· The "Leeward Wall Pressures" are those that would apply to the South Wall when the
North Wall receives positive external pressure.

· The "Sidewall Pressures" are those that would apply to the East and West Walls when
the North Wall receives positive external pressure.

· The "Roof Pressures" are those that would apply to the identified areas measured from
the North edge of the roof when the North Wall receives positive external pressure.
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Just to drive home the proper interpretation of the values reported on the Wind Pressures
tab, let's work through the East tab, so we can interpret some windward and leeward roof
pressures.  Remember that this hypothetical building is assumed to have a North-South
oriented ridge.  So when we are focused on the East Wall tab:

· The "Windward Wall Pressures" are those that would apply to the East Wall when the
East Wall receives positive external pressure.  

· The "Leeward Wall Pressures" are those that would apply to the West Wall when the
East Wall receives positive external pressure.

· The "Sidewall Pressures" are those that would apply to the North and South Walls
when the East Wall receives positive external pressure.

· The "Perp: Windward Roof Pressures" are those that would apply to the windward
(East) portion of the roof when the East Wall receives positive external pressure.

· The "Perp: Leeward Roof Pressures" are those that would apply to the leeward (West)
portion of the roof when the East Wall receives positive external pressure.

Note that all surfaces report pressures based on both the positive and the negative internal
pressure conditions, and the algebraic sign convention follows that of ASCE 7, which is to
say that positive values are interpreted to act toward the named surface and negative
values act away from the named surface.  Work this logic through an example such as a
windward wall and see that it all makes sense.  The negative internal pressure condition
produces higher total pressures toward the windward wall, than the positive internal
pressure condition does, because the negative internal pressure works in the same
direction as the external pressure on a windward wall.  Similar logic can be applied to all
other surfaces to demonstrate that the mathematics are proper.
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Story Forces

This tab reports the values of wind forces tributary to each story in the building.

Using the story heights determined on the Story Data tab, the Story Forces tab determines
the tributary heights for each floor by assuming a simply-supported wall construction that
spans between adjacent floor/roof levels.  Wind pressures are applied to the tributary
heights and multiplied by the perpendicular dimension of the building to arrive at forces for
each story.

The option is provided to either display or hide the forces tributary to the lower half of the
lowest level.  In some construction types, this component of load is delivered to a slab on
grade and is not a design consideration for the Main Wind Force Resisting System.

The program reports results for each of the four "Cases" as presented by Figure 27.4-8 of
ASCE 7-10 (Figure 27.3-8 of ASCE 7-16).  Cases 2 and 4 also incorporate a design
torsional moment as defined in the figure.  In all situations, the program reports the force
magnitude.  In situations where a torsional moment applies, the program reports the
moment arm that is being considered for each component of force, as well as the resulting
net moment.

The final item in the results on this tab is based on the minimum required wind loads per
Section 27.4.7 of ASCE 7-10 (Section 27.1.5 of ASCE 7-16).  That section requires that
the wind load to be used in the design of the Main Wind Force Resisting System for an
enclosed or partially enclosed building shall not be less than 16 psf multiplied by the wall
area of the building (and 8 psf multiplied by the roof area of the building projected onto a
vertical plane normal to the assumed wind direction).  So in this last item in the results list,
the program reports story forces assuming 16 psf applied to each wall of the building.  As
of build 6.12.4.24, the program does not collect enough information to consider the 8 psf
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on the projection of the roof area, so this additional load may need to be considered with
supplemental hand calculations on buildings with other than flat or low-slope roofs.

Base Shears & Torsions

This tab reports the summation of the wind story forces and torsions for all levels in the
building, for all four "Cases" and for the minimum required wind loads per Section 27.4.7.

Although "Base Shears" are not technically a part of the ASCE 7 design procedure for wind
loads, the summation of all story forces is often of interest to designers for a variety of
reasons.  Some designers like to see how the wind "base shear" compares to the seismic
base shear.  For some designers, the summation of the wind forces is useful in the
checking process to get a confidence level that the calculated pressures are reasonable. 
Whatever the reason, the values are reported on this tab if they are of interest. 

As with the Story Forces tab, the Base Shears & Torsions tab provides the option to either
include or exclude the component of shear and torsion that is tributary to the bottom half of
the lowest level.

13.1.6  ASCE 7-10/16 Wind Forces Chapter 28 and 30

This module is a presentation of the Wind Forces provisions of Chapter 28, Part 2 and
Chapter 30, Part 2 of ASCE 7-10 and ASCE 7-16.

Limited documentation is provided here, because all of the references to ASCE 7 are given
on the module screens.
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General

The General tab provides an input field for a general description of the project and/or the
wind calculations that are being performed.

Applicability Checklists

The Applicability Checklists tab provides a quick listing of the requirements in order to be
able to apply Chapter 28, Part 2 (MWFRS) and Chapter 30, Part 2 (Components &
Cladding).

Analysis Values

The Analysis Values tab collects the input (on the top of the screen) and displays the
results (on the bottom of the screen).

13.1.7  IBC Alternate All-Heights Wind Method

Need more? Ask Us a Question

This module is an implementation of the IBC Alternate All-Heights Wind Method.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help


ENERCALC SEL221

© 2024  ENERCALC, LLC

General, Checklist, & Analysis Values

This tab offers a checklist of the criteria that must be satisfied in order to apply the IBC
2015 Alternate All-Heights Wind Method.  Once all of the checkboxes are checked, the
module will offer input fields for analytical values such as Exposure Category, Mean Roof
Height, Topographic Factor parameters, Basic Wind Speed, Occupancy category, and
options for the selection of Velocity Pressure Coefficients. 
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MWFRS - Wall

This tab reports design pressures on windward walls, leeward walls, sidewalls and
parapets.  Pressure values are distinguished for Enclosed and Partially Enclosed
structures, and values are reported for the positive internal pressure condition and for the
negative internal pressure condition.
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MWFRS - Roof

This tab reports design pressures on roof surfaces.  Pressure values are distinguished for
the conditions of wind perpendicular to the ridge and wind parallel to the ridge.  In the case
of wind perpendicular to the ridge, pressure values are reported for flat roofs as well as for
various slope angles.  In all cases, results are presented for Enclosed and for Partially
Enclosed structures, and values are reported for the positive internal pressure condition
and for the negative internal pressure condition.
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MWFRS - Non BLDG

This tab reports net design pressures on the projection of surfaces of non-building
structures.
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C&C - Roof & Overhang

This tab reports design pressures on components and cladding within roof surfaces. 
Results are presented for Enclosed and for Partially Enclosed structures, and values are
reported for the positive internal pressure condition and for the negative internal pressure
condition.
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C&C - Wall & Parapet

This tab reports design pressures on components and cladding within wall and parapet
surfaces.  Results are presented for Enclosed and for Partially Enclosed structures, and
values are reported for the positive internal pressure condition and for the negative internal
pressure condition.

13.1.8  ASCE Snow Loads

Need more? Ask Us a Question

This module is an implementation of the ASCE method of determining Flat Roof Snow
Load, Sloped Roof Snow Load, and Snow Drifts on Lower Roofs, and Snow Drifts at Roof
Obstructions. The module currently supports calculations based on ASCE 7-10 and ASCE
7-16.  The Snow Loads module does not currently address the calculation of unbalanced
snow loads, rain on snow surcharges, or sliding snow surcharges.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General

Provides a place to enter descriptive text.

 Flat Roof Snow Loads

Allows up to 10 different flat roof snow loads to be calculated by entering values for all of
the parameters in accordance with ASCE 7.
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 Sloped Roof Snow Loads

Allows up to 10 different sloped roof snow loads.  The input form provides the option to
refer to a previously defined Flat Roof Snow Load, or to explicitly specify a Flat Roof Snow
Load value along with the remaining values for all of the parameters in accordance with
ASCE 7.

 Snow Drifts on Lower Roofs

Allows up to 10 different conditions to be evaluated for snow drifts on lower roofs.  The
input form collects values for all of the necessary parameters to determine the windward
and leeward drifts and selects the controlling case in accordance with ASCE 7.

Snow Drifts at Roof Projections

Allows up to 10 different conditions to be evaluated for snow drifts at roof projections.  The
input form collects values for all of the necessary parameters to determine the windward
drift in accordance with ASCE 7.

13.1.9  ASCE Live and Roof Live Load Reduction

This section enables the user to calculate reduced live and roof live loads for various parts
of a project.
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This section is a direct application of ASCE 7-10 and ASCE 7-16 Sections 4.7 & 4.8
concerning live and roof live load reductions. We refer the user to those sections of the
referenced design standards for specific descriptions of the values used in each column
seen below.

13.1.10  Project Load Group Builder

The Project Load Group Builder enables the user to store commonly used "Load Items"
and then combine them into various Groups to calculate total loads for the defined Groups.
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Load Items are defined and organized on the right-hand side of the screen as indicated in
the screen capture below:

You can type in a Category name (discussed in more detail below), a Load Name, choose
the Load Type, and specify the Load Value, and then click "Add as New Load".  The newly
added Load Item will appear in the Load Items List below.  To edit an existing Load Item,
click on the item of interest in the Load Items List, edit the values in the individual fields
above, and then click "Save Changes" 

Load Items are very flexible in their definition.  A Load Item could represent the weight of a
particular building construction material, such as the Dead Load of 3/4" plywood floor
sheathing in units of PSF.  A Load Item could also represent an allowance of 5 PSF Dead
Load for ceiling & lights.  But Load Items can also take the form of load types other than
Dead Load as well.  For instance, you could define a Load Item consisting of 100 PSF Live
Load, or 30 PSF Snow Load.  In this way, the Project Load Group Builder is capable of
tracking loads of all types that may be applicable to a particular area of a building.

One of the powerful features of the Project Load Group Builder is that it takes the Load
Item data that you enter and it saves that data in a file that is separate and distinct from
your Project File.  (The file is named LoadDbase.tps, and it is saved in the folder that you
have identified as your default Project File location.)  In this way, the system continues to
accumulate more and more of your commonly specified materials and loads as you work
on different projects.  And that ever-growing database of your custom Load Items is always
available to you on future projects.
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In order to bring some organization to the many load items that you may eventually
accumulate, the Project Load Group Builder introduces the concept of the "Category".  A
Category can contain one or more Load Items.  Here again, the way you use Categories
can be extremely flexible.  Some users may prefer to organize their Load Items into
Categories that represent different types of materials or loads.  For example, the
organizational hierarchy might take on a form like this where the bullet items represent
Load Items within the indicated Category:

Category: Roof Sheathing
· 1/2" sheathing

· 5/8" sheathing

· 3/4" sheathing

· 7/8" sheathing

· 1" sheathing

Category: Roof Framing
· 2x6@16" o/c

· 2x8@16" o/c

· 2x10@16" o/c

· 2x12@16" o/c

Category: NW Concrete Slab
· 4.5" total with 2" deck

· 5.0" total with 2" deck 

· 5.5" total with 2" deck

· 6.0" total with 2" deck

· 5.5" total with 3" deck

· 6.0" total with 3" deck

· 6.5" total with 3" deck

Category: LW Concrete Slab
· 4.5" total with 2" deck

· 5.0" total with 2" deck 

· 5.25" total with 2" deck

· 5.5" total with 2" deck

· 6.0" total with 2" deck

· 5.5" total with 3" deck

· 6.0" total with 3" deck

· 6.25" total with 3" deck

· 6.5" total with 3" deck
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Category: Live Load
· Classroom

· First Floor Corridor

· Office

· Stack Rooms

Category: Snow Load
· 30 PSF

· 32 PSF

· 34 PSF

· 36 PSF

And so on...

But remember, this is just one way that Categories could be used.  Here is yet another
idea:

Category: Typical classroom on structural floor
· DL of flooring

· DL of concrete slab on metal deck

· DL of composite metal deck

· DL allowance for structural steel framing

· DL allowance for ceiling & lights

· DL allowance for mechanical & misc.

· LL for classroom occupancy 

· LL for partition allowance

Category: Typical corridor on structural floor
· DL of flooring

· DL of concrete slab on metal deck

· DL of composite metal deck

· DL allowance for structural steel framing

· DL allowance for ceiling & lights

· DL allowance for mechanical & misc.

· LL for corridor above first floor occupancy 

Category: Typical roof structure
· DL of asphalt shingles

· DL allowance for second layer of asphalt shingles

· DL of metal roof deck

· DL  structural steel framing

· DL allowance for ceiling & lights

· DL allowance for mechanical & misc.

· SL for sloped roof

And so on...
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So remember that your Load Items and your Categories are being stored in a separate file,
and they are continuing to accumulate from one project to the next as you enter more data.
 Consider this as you decide on a system of organization that will work best for you.

Now that we have covered Load Items and Categories, we can introduce the real purpose
for this module, which is the "Load Group".  Very simply, a Load Group is a group of Load
Items that will be summed together.  

Load Groups are defined and manipulated on the right-hand side of the screen as indicated
in the screen capture below:

The Load Groups in the current Project File are listed in the "Group Name" list in the upper
left corner of the module.  The toolbar buttons above the list perform the following
functions:

Adds a new Load Group

Creates a copy of the selected Load Group

Allows the name of the selected Load Group to be edited
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Deletes the selected Load Group

When a Load Group is selected in the "Group Name" list, the details of that Load Group are
displayed in the lower left corner of the screen.  (A newly created Load Group will display
no detailed information until some Load Items are added to the Loaf Group.)  The display
will show the Load Items that have been added to the current Load Group including the
Load Item name, the Load Type (Dead Live, Snow, etc.), the magnitude of the load, and
the units.

So we have now covered Load Items and Load Groups.  The final detail is...how do we add
these Load Items to Load Groups?  The answer lies in the buttons shown below:

Adds the selected Load Item to the current Load Group

Removes the selected Load Item from the current Load Group

Finally, the Print function will automatically include all defined Load Groups and provide a
nice tabular summary of the Load Items that combine to produce each Load Group.

13.2 Analysis

Please select a subtopic.

13.2.1  ENERCALC 3D

ENERCALC 3D
A Structural Analysis and Design Program
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Accuracy, Reliability, Ease of Use

ENERCALC, INC.

13.2.1.1   License Agreement

OpenGL® is a registered trademark of Silicon Graphics, Inc. (SGI).
Windows® is a registered trademark of Microsoft Corporation.
ENERCALC 3D is a trademark of ENERCALC, Inc.

Copyright 2010-2020 by ENERCALC.  All rights reserved.

13.2.1.2   Terms and Conventions

The convention for commands in this documentation is Main Menu > Sub-Menu.  For
example, Create > Line Loads means the Line Loads command from the Create item in the
main ribbon.

Model View:  A window in the program that contains the graphical display of the model.

Report View:  A window in the program that contains the text or graphical report.

Structural Command:  A command in the program that affects the results for a model.

Member:  A beam or frame element.  It also refers to a truss when the element has full
moment releases at two ends.  The term “beam element”, “frame element” and “member” are
used interchangeably in this program. 

Shell: a four-node shell finite element.  It includes membrane action and plate bending action.
 It is sometimes called a plate.

Brick: an eight-node solid finite element.

Entity: A node, member, shell or brick.

Element:  A member or finite element (shell or brick).
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Object:  A node or finite element (shell or brick) or its dependent.

Dependent:  A structural entity whose existence depends upon the existence of another
structural entity.  For example, a support is a dependent of a node; a moment release is a
dependent of a member (beam element).  All loads are dependents of nodes or members or
finite elements.

Parent:  A structural entity which may have dependents.  Nodes and elements may be
parents.  For example, a node may be a parent of a support or a member.  A member may be
a parent of a moment release.

Distance List:  A comma separated list that specifies multiple distances.  For example, a
distance list of “12,2@14,3@10” will generate distances of 12, 14, 14, 10, 10, and 10 in length
units.

Orphaned Node:  A node that is not connected to any elements.

DOFs:  Degrees of freedom.

64-bit floating point (double precision):  The solver that uses 64-bit (8 bytes) floating-point
arithmetic.  The 64-bit floating point (double precision) is the standard solver in almost all
structural analysis programs.

128-bit floating point (quad precision):  The solver that uses 128-bit (16 bytes) floating-
point arithmetic.  The 128-bit floating point (quad precision) is extremely accurate and is
uniquely available in ENERCALC 3D.

13.2.1.3   Related Links

Use the following links to access detailed info.

ENERCALC 3D Training Manual:  https://enercalc.com/3d_training

ENERCALC 3D Verifications Manual:  https://enercalc.com/ec3d_verification/ 

13.2.1.4   Introduction

Built from the ground up, ENERCALC 3D is a powerful structural design / finite element
analysis software tool designed for structural engineers of all skill levels. ENERCALC 3D is
reliable, easy to use, and affordable. The software is designed for accuracy and simplicity,
allowing engineers to get the job done without being overwhelmed by useless features.

The program includes the following frame and finite elements:
- 2D and 3D beam and truss element (also called member).  The element can be

linear, tension-only or compression-only.
- 3D four-node shell element, with thick (MITC4) plate and thin (Kirchhoff) plate bending

and plane membrane stress (compatible and incompatible) formulations.
- 3D eight-node solid element (brick) with compatible and incompatible formulations.
- Linear and nonlinear nodal, line, and surface spring elements.
- Rigid diaphragm.

https://enercalc.com/3d_training
https://enercalc.com/ec3d_verification/
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The program includes the following analysis and design options:
- Static linear analysis.
- Geometric nonlinear (P-Delta) analysis.
- Standard 64-bit floating point (double precision) and extremely accurate 128-bit

floating point (quad precision) skyline solvers.
- Lightning fast sparse solver based on Intel PARDISO solver.
- Nodal, point, line, and surface forces; point moments; self-weight.
- Forced displacements on supports.
- Member moment releases.
- Concrete beam, column and slab/wall designs according to ACI 318-02/05/08/11/14.

- Steel beam and column design according to AISC 15th Edition LRFD.

The program provides the following main user interface features:
- Multiple views with different display settings.
- Graphically drawing nodes, members and finite elements, area loads and rigid

diaphragms via mouse-click.
- Versatile spreadsheets for input data and results.
- Powerful automatic model generations for continuous beams; 2D and 3D frames; 2D

and 3D shells; arc beams and non-prismatic beams.
- Quality 3D graphical rendering with hidden line or surface removal based on

OpenGL®
- Loading diagram; moment and shear diagram for members; contours for shells and

solids; deflection diagram.
- Flexible editing features such as undo/redo, duplicate, move, scale, delete, revolve,

extrude, splitting members, sub-mesh shells, node and element merging.
- Real time panning, zooming and rotating.
- Many different selection methods such as point/window/cross select, select by IDs,

select by properties, with options to freeze or thaw parts of a model.
- Flexible annotations for input and results.
- Text and graphical reports in html format.  Graphical report may contain multiple

images.  Text report may be saved in plain text format.
- Print previews for graphical and text reports
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Graphical User Interface (GUI)

ENERCALC 3D has a modern graphical user interface.  It includes ribbons, toolbars, multiple
views and a status bar.
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Spreadsheet Navigation

The program uses spreadsheets extensively for data input and output.  It offers multiple ways
to navigate within a spreadsheet as specified in the following table.

Key Action 

up arrow Moves active cell up one row 

down arrow Moves active cell down one row 

right arrow Moves active cell right one column 

left arrow Moves active cell left one column 

Shift+arrow
k
e

Extends selection in direction of arrow key 



Calculation Modules 240

© 2024  ENERCALC, LLC

Key Action 

y
 

Page Up Moves active cell one page up 

Page Down Moves active cell one page down 

Ctrl+Page
U
p
 

Moves active cell one page left

Ctrl+Page
D
o
w
n
 

Moves active cell one page right

Home Moves active cell to first cell in row 

End Moves active cell to last cell in row that contains data 

Ctrl+Home Moves active cell to first row, first column 

Ctrl+End Moves active cell to last row and column that contain
data 

Tab Moves active cell to next cell to the right (or at end of
row moves to beginning of next row) 

Shift+Tab Moves active cell to next cell to the left (or at beginning
of row moves up to end of row above) 

Shift+space
 

Selects current row 

Ctrl+space Selects current column 

Shift+Ctrl+s
p
a
c
e
 

Selects entire sheet 

Ctrl+X or
S
h
i
f
t
+
D

Cuts current selection or active cell's data to
Clipboard 
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Key Action 

e
l
 

Ctrl+V or
S
h
i
f
t
+
I
n
s
 

Pastes Clipboard contents into active cell 

Ctrl+C or
C
t
r
l
+
I
n
s
 

Copies current selection or active cell's data to
Clipboard 

Enter Active cell moves down

Esc If sheet is in edit mode, previous cell value replaces
new value and edit mode is turned off 

F2 If edit mode is on, cell value is cleared 

13.2.1.5   Ribbons
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Right-click Menu

One important feature of the graphical user interface is the right-click menu.  It has been
designed to put commonly used commands within close reach at all times.  No matter what
ribbon tab is displayed, right clicking on the main area of the screen will open the following
menu:

Quick Access Toolbar

Pan

The Pan command in the Quick Access toolbar is the same as View > Pan.
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Rotate

The Rotate command in the Quick Access toolbar is the same as View > Rotate.

Zoom

The Zoom command in the Quick Access toolbar is the same as View > Zoom.

Restore Model

The Restore Model command in the Quick Access toolbar is the same as View > Restore
Model.

Node Display Options

Quick Access toolbar > Node Display Options opens a dialog that offers various options to
control the display of data items related to nodes.

Member Display Options

Quick Access toolbar > Member Display Options opens a dialog that offers various options to
control the display of data items related to members.

Shell Display Options

Quick Access toolbar > Shell Display Options opens a dialog that offers various options to
control the display of data items related to shells.
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Display Options

Quick Access toolbar > Display Options prompts you with the following dialog.  

It allows you to view annotations for nodes and elements and their properties.  The element
local axes may also be displayed using this command.  Three annotation modes are
available.  You may annotate all entities, annotate selected entities, and erase existing
annotations.  For performance reasons, it is recommended that the annotations be applied
only for objects of interest.
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Clear All Display Options

Quick Access toolbar > Clear All Display Options is a convenient way to turn off all display
options in one step.

Isometric (and other) View

The Isometric View command in the Quick Access toolbar is the same as View > Preset
Views.

Quick Access Tab

Save

The Save command in the Quick Access tab is the same as File > Save.

Save & Close

The Save & Close command in the Quick Access tab is the same as File > Save & Close.

Close without Saving

The Close without Saving command in the Quick Access tab is the same as File > Close
without Saving.

Undo

Quick Access tab > Undo undoes the previous structural command.  By default, you may
undo up to 10 levels.  You may set a different number of undo levels by running Settings &
Tools > Data Options.  Non-structural commands such as zooming or panning may not be
undone.  More undo levels requires more computer memory.

Redo

Quick Access tab > Redo reverses the previous Undo command.  
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Static Analysis

The Static Analysis command in the Quick Access tab is the same as Analysis > Static
Analysis.

Node Display Options

Quick Access tab > Node Display Options opens a dialog that offers various options to
control the display of data items related to nodes.

Member Display Options

Quick Access tab > Member Display Options opens a dialog that offers various options to
control the display of data items related to members.

Shell Display Options

Quick Access tab > Shell Display Options opens a dialog that offers various options to control
the display of data items related to shells.
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Display Options

Quick Access tab > Display Options prompts you with the following dialog.  

It allows you to view annotations for nodes and elements and their properties.  The element
local axes may also be displayed using this command.  Three annotation modes are
available.  You may annotate all entities, annotate selected entities, and erase existing
annotations.  For performance reasons, it is recommended that the annotations be applied
only for objects of interest.
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Clear All Display Options

Quick Access tab > Clear All Display Options is a convenient way to turn off all display
options in one step.

Query

The Query command in the Quick Access tab is the same as View > Query.

Hide Selected

The Hide Selected command in the Quick Access tab is the same as View > Hide Selected.

Hide All Except Level

The Hide All Except Level command in the Quick Access tab is the same as View > Hide All
Except Level.

Hide All Except Plane

The Hide All Except Plane command in the Quick Access tab is the same as View > Hide All
Except Plane.

Show All

The Show All command in the Quick Access tab is the same as View > Show All.

Toggle Grid Display

The Toggle Grid Display command in the Quick Access tab is the same as Create > Grids &
Snaps > Toggle Grid Display and View > Drawing Grids > Toggle Grid Display.

Pan

The Pan command in the Quick Access tab is the same as View > Pan.

Zoom

The Zoom command in the Quick Access tab is the same as View > Zoom.

Rotate

The Rotate command in the Quick Access tab is the same as View > Rotate.

Restore Model

The Restore Model command in the Quick Access tab is the same as View > Restore Model.

File

The File ribbon provides commands that are related to files.  
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Save Only

When the current window is a model view, File > Save Only saves the model.  If the model
has not been saved before, the Save As dialog will be displayed prompting you to enter a file
name.

Save & Close

File > Save & Close saves the current model data, closes the model and redisplays the Model
Manager window.

Close without Saving

File > Close without Saving provides a way to close the current model and return to the Model
Manager without saving the current model.

General Information

File > General Information prompts you with the following dialog that allows you to specify the
Project Name, Model Name, and Engineer:
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Model Statistics

File > Model Statistics displays the key statistics about the model.

DXF Options

File > DXF Options allows for the import and export of DXF files.

View Log File

File > View Log File allows you to view the log file generated during the solution process.
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Create

The Create ribbon provides commands to draw individual nodes and elements based on a
drawing grid or existing nodes and parametrically generate models of regular shape.

Nodes

Create > Nodes allows you to draw new nodes in the model.  To draw a node, simply move
the mouse, point to an intersection of the grid and click the left mouse button.  You may also
draw a node by entering nodal X, Y, and Z (optional) coordinates in the command window via
the keyboard.  This is very useful if you need to draw nodes outside the grid interactions.  The
command remains in effect until another command is selected, the right mouse button is
clicked, or ESC is pressed.

Members

Create > Members allows you to draw new members in the model.  To draw a member,
simply move the mouse and click the left mouse button from point to point.

The clicked points must be intersections on the grid or existing nodes.  These points become
the element nodes.  New nodes are created if necessary.  Members are drawn continuously. 
Right clicking the mouse once lets you start drawing members from a new location. 
Remember, the start and end nodes determine the default local coordinate system.  The
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members drawn have the current section and material properties.  You may use the
commands in the Modify ribbon to assign appropriate properties to them.

You may also specify a node by entering nodal X, Y and Z (optional) coordinates in the
command window via the keyboard.  This is very useful if you need to specify nodes outside
the grid interactions.  In addition, you may specify a node by entering an existing node number
directly.  You can combine the use of keyboard and mouse to draw members.

You may turn on annotations for nodes and members while drawing.  To do that, use the
Display Options buttons on the Quick Access Toolbar.  The command remains in effect until
another command is selected, the right mouse button is clicked twice, or ESC is pressed.

Shells

Create > Shells allows you to draw new shells in the model.  To draw a shell, simply move
the mouse and click the left mouse button from point to point.  The clicked points must be
intersections on the grid or existing nodes.  These points become the element nodes.  New
nodes are created if necessary.  Remember, the order of clicked points determines the
default local coordinate system.  The shells drawn have the current thickness and material
properties.  You may use the commands in the Create or Modify ribbons to assign appropriate
properties to them.

You may also specify a node by entering nodal X, Y, and Z (optional) coordinates in the
command window via the keyboard.  This is very useful if you need to specify nodes outside
the grid interactions.  In addition, you may specify a node by entering an existing node number
directly.  You can combine the use of keyboard and mouse to draw shells.
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You may turn on annotations for nodes and shells while drawing.  To do that, use the Display
Options buttons on the Quick Access Toolbar.  The command remains in effect until another
command is selected, the right mouse button is clicked, or ESC is pressed.

Bricks

Create > Bricks allows you to draw new bricks in the model.  To draw a brick, simply move
the mouse and click the left mouse button from point to point.

The grid must be set up in 3 dimensions.  The clicked points must be intersections on the grid
or existing nodes.  These points become the element nodes.  New nodes are created if
necessary.  Remember, the order of clicked points must be such that the vector of the
surface 1-2-3-4 points to the surface 5-6-7-8.  The bricks drawn have the current material
properties.  You may use the commands in the Create or Modify ribbons to assign appropriate
properties to them.

You may also specify a node by entering nodal X, Y, and Z coordinates in the command
window via the keyboard.  This is very useful if you need to specify nodes outside the grid
interactions.  In addition, you may specify a node by entering an existing node number directly.
 You can combine the use of keyboard and mouse to draw bricks.
 
You may turn on annotations for nodes and bricks while drawing.  To do that, use the Display
Options buttons on the Quick Access Toolbar.  The command remains in effect until another
command is selected, the right mouse button is clicked, or ESC is pressed.

It is generally not easy to draw bricks in 3 dimensions due to visualization difficulty.  You may
generate bricks based on shells using the commands such as Modify > Extrude or Revolve. 
You may also use spreadsheets to input nodes and bricks by running Tables > Nodes or
Bricks. 

Boundary Conditions
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Create > Boundary Conditions > Support prompts you with the following dialog.

It allows you to assign supports (rigid boundary conditions) to selected nodes in the model. 
One or more of the six global degrees of freedom (DOFs) may be restrained.  In addition, you
may specify enforced displacements in the restrained DOFs.  The enforced displacements
may be used to model support settlements.  You may regard them as special loads.  For
normal supports, enforced displacements in the restrained DOFs are zero.  The program
provides three commonly used supports, namely, pinned, fixed and roller.  In order for support
assignments to take place, nodes must be selected beforehand.  

After clicking “Apply to Selected Nodes”, you can start to continuously assign supports by
window-selecting nodes until you right click the mouse or press the ESC key.
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Create > Boundary Conditions > Inclined Rollers prompts you with the following dialog.

It allows you to define an inclined roller support on XY, YZ or XZ plane. 

An inclined roller can only move along the line between the reference point (defined in the
dialog) and the support location.  For example in the following figure, the roller is located at
coordinate (8.0, 5.0, 0) and is inclined 30 degrees from the X-axis.  
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We can use the reference point (8.0 + 10 * cos30, 5 + 10 * sin30, 0) = (16.666, 10, 0) to
constrain the support.  An inclined roller is a type of multi-DOF constraint.  

A regular support and multi-DOF constraints may be applied on the same node as long as the
support/constrained directions do not interfere with each other.

Multi-DOF constraint forces and moments are listed separately from the regular support
reactions in the analysis results.

Create > Boundary Conditions > Springs prompts you with the following dialog.  

It allows you to assign nodal, line, and surface springs (flexible boundary conditions) to
selected nodes, members, or shells in the model.  
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A nodal spring may be restrained in one or more of the six global DOFs (Dx, Dy, Dz, Dox,
Doy and Doz).  A line or surface spring may be restrained in one or more of the three global
translational DOFs (Dx, Dy and Dz).  To qualify to be a valid flexible restraint, the
corresponding spring constant must be specified.

A restraint may be designated as linear, compression-only or tension only.  A compression-
only restraint is active only when the nodal displacement in the restrained direction is
negative.  A tension-only restraint is active only when the nodal displacement in the restrained
direction is positive.  The presence of tension only or compression only springs makes the
model nonlinear and requires iterative solution for each load combination.

After clicking “Assign”, you can start to continuously assign nodal, line or surface springs by
window-selecting nodes, members or shells until you right click the mouse or press the ESC
key.

Constraints

Create > Constraints > Diaphragms prompts you with the following dialog.  

It allows you to define regular or generic rigid diaphragms (in-plane) in a 3D model.  For
example, to model horizontal concrete floors, you may select one node on each floor and
apply regular diaphragms to the selected nodes in XZ plane (with normal in the global Y
direction).  Instead of using plate elements, rigid diaphragms allow you to model stiff in-plane
actions quickly.  The program further provides the option to ignore the rigid diaphragm actions
as an analysis option (Analysis > Analysis Options).
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Create > Constraints > Coupled Springs prompts you with the following dialog. 

It allows you to assign coupled springs to selected nodes. Coupled springs are useful in
modeling/simplifying substructures such as bridge foundations. It is important to enter the
coupled spring stiffness matrix in the appropriate units.
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Create > Constraints > Generic Constraints prompts you with the following dialog. 

It allows you to define a generic constraint at one or two nodes. If the constraint is applied to
the same node, the constraint DOFs must be different.  Constrained DOFs must be
compatible: Q1 and Q2 must be both translational or rotational.  Constraint factors must be
non-zero.

A regular support and multi-DOF constraints may be applied on the same node as long as the
support/constrained directions do not interfere with each other.

Multi-DOF constraint forces and moments are listed separately from the regular support
reactions in the analysis results.
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Create > Constraints > Equal Constraints prompts you with the following dialog.  

It allows you to define a generic constraint at one or two nodes.   An equal displacement
constraint is one type of multi-DOF constraint.  

A regular support and multi-DOF constraints may be applied on the same node as long as the
support/constrained directions do not interfere with each other.

Multi-DOF constraint forces and moments are listed separately from the regular support
reactions in the analysis results.

Model Generators

Create > Model Generators provides commands to quickly generate commonly used
structural components in a model.  These commands may be used multiple times to
generate different parts in the model. 

Create > Model Generators > 2D Truss/Frame provides a variety of common truss and frame
templates for quick generation of these common structural assemblies.
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Create > Model Generators > Rectangular Frames prompts you with the following dialog.  

It allows you to quickly generate 1D frames (continuous beams), 2D frames (plane frame or
grillage) or 3D frames (space frames).  The distance list is a comma separated list that
specifies multiple distances.  For example, a distance list of “12, 2@14, 3@10” will generate
distances of 12, 14, 14, 10, 10 and 10 in length unit.  You may leave appropriate distance
list(s) blank to generate on a plane or along a line.  You may specify pinned or fixed supports
at the bottom.  The generated members have the default section and material properties.  You
may assign them appropriate properties using commands in the Modify ribbon.
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The following three examples show the uses of this command.  The first example is a
continuous beam in the X direction generated using the input from the dialog above.  The first
two spans are of 10 ft and the last three spans are of 15 ft.  The pinned supports are also
generated automatically.

The second example is a 2D frame on the XY plane with horizontal spans 10, 10, 18, 10, 10 ft
and vertical spans 15, 8, 8, 8 ft as shown in the following.  
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A rectangular frame is first generated using the input from the following dialog.  
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The frame is then modified by selecting and deleting nodes 19, 24, 25, 26, 29, 30 and
horizontal members at the bottom.  Notice when a node is deleted, elements (and their
dependents such as loads) connected to that node are automatically deleted also.
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The third example is a 3D frame with 6 spans in the X direction, 4 spans in the Z direction,
and 10 spans in the Y direction.  All spans are 10 ft.  The frame is fixed at the bottom.  
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It is generated using the following input.
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Create > Model Generators > Cylindrical Frames prompts you with the following dialog.

It allows you to quickly generate 2D or 3D cylindrical frames.  The distance list is a comma
separated list that specifies multiple distances.  For example, a distance list of “12, 2@14,
3@10” will generate distances of 12, 14, 14, 10, 10 and 10 in length unit.  You may leave the Y
direction distance list empty, in which case, a plane cylindrical frame will be generated.  You
may specify pinned or fixed supports at the bottom.  The generated members have the default
section and material properties.  You may assign them appropriate properties using
commands in the Modify ribbon.

You have the option not to generate members.  In this way, you can generate nodes on
cylindrical system first.  Then you may use the command Create > Shells (Bricks) by Nodes
to generate a system of shell (brick) elements.
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Using the input from the screen capture above, the following 3D cylindrical frame was
generated.  You may need to set the element local angles for columns for correct orientation. 
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Create > Model Generators > Rectangular Shells prompts you with the following dialog.

It allows you to quickly generate shells in a rectangle.  The distance list is a comma separated
list that specifies multiple distances.  For example, a distance list of “12,2@14,3@10” will
generate distances of 12, 14, 14, 10, 10 and 10 in length units.  You may specify an insertion
point to translate and rotation parameters to rotate the generated shells.  The generated
shells have the default thickness and material properties.  You may assign them appropriate
properties using commands in the Modify ribbon.

This command can only generate shells in a rectangle.  To generate shells in a general
quadrilateral, you may first define one quadrilateral shell and then use the command Modify >
Sub-Mesh Shells to sub-divide it.
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The following example shows a 10x10 rectangular mesh of shells generated using the input
from the screen capture above.
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Create > Model Generators > Circular Shells prompts you with the following dialog.

It allows you to quickly generate shells in a circle.  You may specify the number of segments
to control the fineness of the mesh.  Generally speaking, a relatively fine mesh is
recommended to minimize the discretization error along the curved edge.  The generated
shells are mostly rectangular in shape, with some general quadrilaterals along the edge.  You
should not use rectangular thin plate formulation in the analysis.  You may specify an insertion
point to translate and rotation parameters to rotate the generated shells.  The generated
shells have the default thickness and material properties.  You may assign them appropriate
properties using commands in the Modify ribbon.
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The following example shows shells generated in a circle using the input from the screen
capture above.
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Create > Model Generators > Arc Members prompts you with the following dialog.  

It allows you to quickly generate members along an arc. You may specify an arc radius, the
start and end angles, and the number of segments.  You may specify an insertion point to
translate and rotation parameters to rotate the generate shells.  The generated members
have the default section and material properties.  You may assign them appropriate properties
using commands in the Modify ribbon.
 
The following example shows members generated along an arc using the input from the
screen capture above.
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Create > Model Generators > Non-Prismatic Members prompts you with the following dialog.  

It allows you to quickly convert each of the selected prismatic members into multiple
prismatic members to approximate a non-prismatic member. The distance list is a comma
separated list that specifies multiple distances.  For example, a distance list of “12, 2@14,
3@10” will generate distances of 12, 14, 14, 10, 10 and 10 in length units.  The lengths of the
selected prismatic members must be consistent with the distance list.
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The left and right haunches of the non-prismatic members may be of type linear, parabolic or
straight.  You must define the geometry including middle depth (DM), left depth (DL), right
depth (DR), width, left length ratio (LL / L), right length ratio (LR / L).  Each of the selected
prismatic members will be exploded into multiple prismatic members to approximate the non-
prismatic member’s behavior.  Appropriate member sections will be automatically added and
assigned in the model.  Existing loads on the selected prismatic members will be assigned to
the new members appropriately.

Create > Model Generators > Rectangular Tank provides a quick way to model an open-
topped rectangular tank with parametric input.

Entities from other Entities

Create > Entities from other Entities provides commands to quickly generate elements using
other elements that already exist in a model. 

Create > Entities from other Entities > Nodes from Grid will convert all grid points to nodes in
one sweep.  You may use this command as many times as you like.  You must merge nodes
manually if necessary.  The generated nodes may then be used to generate members, shells,
or bricks using the following three commands.
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Create > Entities from other Entities > Members by Nodes allows you to quickly generate new
members based on selected base members and existing nodes.  New members are skipped
if no valid nodes exist.  The following five figures show how this command may be used.

Given one selected member and existing nodes in the screen capture above and using the
input in the figure below:   
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10 new members in the figure below are generated:

By selecting all 11 members in the screen capture above and using the input in the following
figure:
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33 more members are generated in the following figure:

Create > Entities from other Entities > Shells by Nodes allows you to quickly generate new
shells based on selected base shells and existing nodes.  New shells are skipped if no valid
nodes exist.  The concept in this command is similar to Generate > Members by Nodes.

Create > Entities from other Entities > Bricks by Nodes allows you to quickly generate new
bricks based on selected base bricks and existing nodes.  New bricks are skipped if no valid
nodes exist.  The concept in this command is similar to Generate > Members by Nodes.

Grids & Snaps

Use Create > Grids & Snaps to create dimensional control for precision drawing.
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Create > Grids & Snaps > Drawing Grid Setup offers the controls to configure the grid used
for snapping and dimensional control.  The command prompts you with the following dialog.

It allows you to generate a 1D, 2D or 3D rectangular grid for drawing or guidance.  The
distance list is a comma separated list that specifies multiple distances.  For example, a
distance list of “12, 2@14, 3@10” will generate distances of 12, 14, 14, 10, 10 and 10 in
length units.  You may specify a distance list for the X, Y, or Z direction or any combination of
them.  

You may specify an insertion point to translate and rotation parameters to rotate the grid.  The
drawing grid may be turned on or off by running the command View > Grids & Snaps >
Drawing Grid or by simply pressing F7.  You may regard the grid as a user defined coordinate
system that can be changed at any time.  The coordinates of the grid intersection under the
mouse are displayed in the status bar.  It helps you to identify correct points when drawing
nodes or elements.  
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The following example shows the use of this command.

Create > Grids & Snaps > Toggle Grid Display turns the grid on and off.

Create > Grids & Snaps > Snap to Points controls the number of snap points along every
member.

Create > Grids & Snaps > Perpendicular Point causes the cursor to snap to points on
members that lie on perpendicular lines from the last point to the member.

Create > Grids & Snaps > Clear Snap Points resets the snap points.

Member Properties

Create (or Modify) > Member Properties contains the commands used to assign and/or
review member properties.
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Create (or Modify) > Member Properties > Member Properties prompts you with the following
dialog.  

It allows you to assign one or more properties such as material, section etc to members. 
Make sure the “Use” checkbox by each property is set correctly.  After clicking “Assign”, you
can start to continuously assign all checked properties by window-selecting members until
you right click the mouse or press the ESC key.
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Create (or Modify) > Member Properties > Materials prompts you with the following dialog.  

It allows you to define and/or assign materials to selected elements in the model.  An ID is
assigned automatically to each material by the program and may not be changed.  You may
assign a label with 127 maximum characters to each material for easy identification.  The
material properties include: 

· Young’s modulus (E),

·

· Weight density,

· Temperature coefficients.

The shear modulus (G) is calculated automatically. 

These material properties are used in the structural analysis of the model.  Material properties
related to design may be set from design ribbons.  For example, concrete strength f'c and
reinforcement strengths fy and fys may be defined from Design > RC Materials.  
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You may add standard steel and concrete materials by clicking the “Std Materials” button.  A
standard material label starts with “Steel” or “Concrete”. 

You may add one or more materials by clicking the “New Rows” button.  You may also print
all materials in the list by clicking the “Print” button.  The “Assign active material to currently
selected elements” checkbox may be used to assign the active material to selected
elements.  The active material refers to the one that currently has focus in the list in the
dialog.  In order for material assignments to take place, members, shells or bricks must be
selected beforehand.  

A more flexible way to assign material and other properties to entities is to use Modify >
Member Properties or Modify > Shell Properties command, which allows you to
continuously assign one or more properties to entities.

The program always has a default material labeled “Default”.  You may not delete this material
or change its label.  You may, however, change its properties.

Create (or Modify) > Member Properties > Member Sections prompts you with the following
dialog.  
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It allows you to define and/or assign sections to selected members in the model.  An ID is
assigned automatically to each section by the program and may not be changed.  You may
assign a label with 127 maximum characters to each section for easy identification.  The
section properties include:

· moment of inertia about major axis (Iz)

· moment of inertia about minor axis (Iy)

· torsional moment of inertia (J)

· section area (A)

· shear area in the local y direction (Ay)

· shear area in the local z direction (Az). 

These properties are used in the analysis.  Other properties (B, H, Tf and Tw) are dimensions

for regular sections such as rectangular, circular, wide flange sections.  These dimensional
properties are used for graphic rendering only (not used in analysis).

You may add one or more sections by clicking the “New Rows” button.  You may also print all
sections in the list by clicking the “Print” button.  The “Assign active section to currently
selected members” checkbox may be used to assign the active section to selected
members.  The active section refers to the one that currently has focus in the list in the dialog.
 In order for section assignments to take place, members must be selected beforehand.

A more flexible way to assign member properties is to use Modify > Member Properties
command, which allows you to continuously assign one or more properties to members.

Note: The section property input does not include Ixy – the product of inertia.  For a section
where Ixy is not zero such as an angle, the principal axes of a cross section are different from
its geometric axes.  In such situations, you should enter section properties in its principal
axes and adjust the member element local angle accordingly.
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You may add a regular section by clicking the “Regular Section” button.  The program
displays the following dialog.  

Three regular sections are currently provided by the program, namely rectangular, circular,
wide flange and Tee sections.  The properties of these sections are calculated automatically.
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You may also add sections from the AISC steel shape table (above) or NDS wood shape
table.  You should not modify an AISC or NDS shape label or its properties.

You may create one and only one rigid link section for use in the model by simply click “Rigid
Link” button.  A rigid link is a member that has very large sectional properties (A, Ay, Az, Iz, Iy
and J).  There can only be one rigid link section defined in the model and it must be named as
“RIGID_LINK”.  The properties for the RIGID_LINK section must be set to 0’s on the member
section dialog.  The program will appropriately calculate A, Ay, Az, Iz, Iy and J during the
solution process. Self weight for rigid links will be ignored by the program.

The program always has a default section labeled “Default”.  You may not delete this section
or change its label.  You may, however, change its properties.

Create (or Modify) > Member Properties > Local Angles prompts you with the following dialog
to assign local angles to the selected members and/or shells.  

The element local angle is used to change the element local coordinate system.



ENERCALC SEL287

© 2024  ENERCALC, LLC

Create (or Modify) > Member Properties > Moment Releases prompts you with the following
dialog.  

It allows you to assign moment releases to selected members in the model.  Major or minor
moment releases may be applied to the start and/or end ends of the members.  Trusses are
members with moments fully released at both ends.  The program assigns appropriate
moment releases automatically if the model type is of “2D Truss” or “3D Truss”.  However, if
the model contains both trusses and beams, you should use the model type “2D Frame” or
“3D Frame”, and assign appropriate moment releases to members.  In order for moment
release assignments to take place, members must be selected beforehand.
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Create (or Modify) > Member Properties > Tension/Compression Only prompts you with the
below dialog.

It allows you to assign nonlinearity (linear, tension only or compression only) to the selected
members.  The member stiffness will be ignored if a tension only member is subjected to
compressive forces or if a compression only member is subjected to tensile forces. The
presence of tension only or compression only members makes the model nonlinear and
requires iterative solution for each load combination.
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Create (or Modify) > Member Properties > Cracking Factors prompts you with the following
dialog.  

It allows you to assign cracking factors to selected beams, columns, and plates.  Cracking
factors apply only to bending stiffness of members and shell elements.  

Note:  Cracking factors are not considered by the program unless you check the option “Use
cracked section properties (Icr) for members and finite elements” in Analysis > Analysis
Options. Analysis results are cleared after assignment of cracking factors.
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Create (or Modify) > Member Properties > Rigid Offsets prompts you with the following dialog.
 

It allows you to assign rigid offsets to the selected members.  This command will effectively
break each selected member into two or three members, with either or both ends being rigid
links.

Shell Properties

Create (or Modify) > Shell Properties contains the commands used to assign and/or review
member properties.
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Create (or Modify) > Shell Properties > Shell Properties prompts you with the following dialog.

It allows you to assign one or more properties such as material, thickness etc to shells.  Make
sure the “Use” checkbox by each property is set correctly.  After clicking “Assign”, you can
start to continuously assign all checked properties by window-selecting shells until you right
click the mouse or press the ESC key.

Create (or Modify) > Shell Properties > Materials prompts you with the same dialog as for
Materials for members.  It is provided in this ribbon for convenience.
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Create (or Modify) > Shell Properties > Thicknesses prompts you with the following dialog.  

It allows you to define and/or assign thicknesses to selected shells in the model.  An ID is
assigned automatically to each thickness by the program and may not be changed.  You may
assign a label with 127 maximum characters to each thickness for easy identification.  The
thickness properties include thickness only.

You may add one or more thicknesses by clicking the “New Rows” button.  You may also
print all thicknesses in the list by clicking the “Print” button.  The “Assign active thickness to
currently selected shells” checkbox may be used to assign the active thickness to selected
shells.  The active thickness refers to the one that currently has focus in the list in the dialog. 
In order for thickness assignments to take place, shells must be selected beforehand.

A more flexible way to assign shell properties is to use Modify > Shell Properties
command, which allows you to continuously assign one or more properties to shells.
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The program always has a default thickness labeled “Default”.  You may not delete this
thickness or change its label.  You may, however, change its properties.

Create (or Modify) > Shell Properties > Element Local Angles prompts you with the same
dialog as for Members.  It is provided in this ribbon for convenience.

Story Drift Nodes

Create > Story Drift Nodes prompts you with the following dialog.  

It allows you to enter nodes that will be used for floor drift calculation.  An empty row is
allowed if all rows below it do not contain any non-empty fields.  Selected rows (whole row
must be selected) may be cut by clicking the button “Cut Selected Rows”.
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Named Selection

Create > Named Selection prompts you with the following dialog.  

It allows you to save the currently selected items to a named group.  You may use the
command Create > Select by Properties > Select by Selection Names to recall the previously
saved named selections.  This command is very useful to group related items.
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Levels

Create > Levels prompts you with the following dialog.  

It allows you to define physical levels in the model.  Once levels are defined, you are able to
view a level plan by using the command View > Hide All Except Level.  To reveal the hidden
parts of the model, click View > Show All.

Draw Loads

Create > Draw Loads contains the commands used to apply loads to the model.



Calculation Modules 296

© 2024  ENERCALC, LLC

Create > Draw Loads > Nodal Loads prompts you with the following dialog.  

It allows you to assign nodal loads to selected nodes in the model.  You must select a load
case to which the nodal loads belong.  Nodal loads are specified in the global coordinate
system.  The loads are nodal forces in the X, Y, or Z direction if radio button “X”, “Y”, or “Z” is
selected.  The loads are nodal moments in the X, Y, or Z direction if radio button “OX”, “OY”,
or “OZ” is selected.  The load magnitude may be any non-zero value.
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Create > Draw Loads > Point Loads prompts you with the following dialog.  

It allows you to assign point loads to selected members in the model.  You must select a load
case to which the point loads belong.  Point loads may be specified in either the local or global
coordinate system.  The loads are point forces in the X, Y, or Z direction if radio button “X”,
“Y”, or “Z” is selected.  The loads are point moments in the X, Y, or Z direction if radio button
“OX”, “OY”, or “OZ” is selected.  The load magnitude may be any non-zero value.  The load
distance is the ratio of the load location (measured from the member start) to the member
length.  A distance of 0.5 places the load at the middle of each selected member.
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Create > Draw Loads > Line Loads prompts you with the following dialog.  

It allows you to assign line loads to selected members in the model.  You must select a load
case to which the line loads belong.  Line loads may be specified in either the local or global
coordinate system.  The loads are line forces in the X, Y, or Z direction.  The start and end
magnitudes of the load may be zero for either end but not for both.  The load distances are
the ratios of the load start and end locations (measured from the member start) to the
member length.  A start distance of 0.0 and an end distance of 1.0 place the line load on the
entire span of each selected member.
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Create > Draw Loads > Area Loads prompts you with the following dialog.  

It allows you to assign area loads to enclosed areas of members in the model.  You must
select a load case to which the area loads belong.  Area loads may be specified in either the
local or global coordinate system.  Global area loads may be in the global X, Y, or Z direction. 
Local area loads may only be in the local z direction, which is perpendicular to the load area.

A load area is defined by specifying three or four coplanar nodes.  The area load is then
distributed as line loads to perimeter members of enclosed areas within the load area prior to
static or dynamic solution.  Various area load distribution methods are available.  It is
recommended that area loads be defined in their own load cases.  In this way, you will find it
easier to identify, edit, and delete area loads later on.

The program also allows you to convert area loads to line loads automatically.  This feature
lets you see how the program would convert the area loads prior to the solution.  For more
information on the load conversion, see Tables > Area Loads.
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Create > Draw Loads > Surface Loads prompts you with the following dialog.  

It allows you to assign surface loads to selected shells in the model.  You must select a load
case to which the surface loads belong. Surface loads may be specified in either the local or
global coordinate system.  The loads are surface forces in the X, Y, or Z direction.  Surface
load applies to the entire surface of a shell element.

Create > Draw Loads > Thermal Loads prompts you with the following dialog.  

It allows you to assign thermal loads to selected elements in the model.  You must select a
load case to which the surface loads belong. Currently, ENERCALC 3D considers thermal
effect in longitudinal direction of members, membrane directions of shells, and bricks.  It does
not consider thermal gradients in members or shells.
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Create > Draw Loads > Self Weights prompts you with the following dialog.  

It allows you to define how the program computes self weights for all elements in the model. 
You must select a load case to which self weights belong.  The self weights may act in the
global X, Y, or Z direction.  By default, self weights act in the global Y direction.  You may
specify a self weight multiplier (applied to material densities).  A zero multiplier ignore self
weights altogether.

Create > Draw Loads > Self Weight Exclusion allows self weight to be considered or ignored
for selected members, shells, and bricks. 

Generate Loads

Create > Generate Loads contains the commands used to automatically generate certain
types of loads in the model.
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Create > Generate Loads > Fluid Loads prompts you with the dialog.

It allows you to generate fluid loads applied to selected shells in the model.  You must select a
load case to which the fluid loads belong.  Fluid loads are applied in the local coordinate
system.  The load variation must be in global X, Y or Z direction.
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Create > Generate Loads > Pattern Loads prompts you with the following dialog.  

It allows you to generate pattern loads applied to specified members in the model.  You must
select a load case (generally live case) that contains loads to be patterned.  A pattern ratio is
also available (to address provisions such as ACI 318-19 Section 6.4.3.3, where a factor is
applied in certain skip loading situations). Load patterning allows us to generate maximum
positive and negative moment at each span, maximum positive and negative moment at each
support as well as maximum shear at each support.  The existing point and line loads in the
load case will be patterned based on odd, even and adjacent/alternate spans.  These
patterned loads are assigned to their own load cases.  The program automatically generates
additional load cases and load combinations based on the load patterning.
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It should be pointed out that the program does not consider support conditions for pattern load
generation.  One pattern load case cannot be used in more than one load combination prior to
load pattern generation.
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Create > Generate Loads > Moving Loads prompts you with the following dialog.

It allows you to generate moving loads applied to specified members in the model.  You must
select a load case that contains moving loads.  Only point loads on the specified members in
the load case will be moved.  These moving loads are assigned to their own load cases.  The
program automatically generates additional load cases and load combinations based on the
moving step size.  

If the Bi-Directional option is deselected, generation steps will take place in the positive global
axis direction. 
If the Bi-Directional option is selected, generation steps will take place in the positive AND
negative global axis direction. 
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It should be pointed out that one moving load case cannot be used in more than one load
combination prior to moving load generation.

Create > Generate Loads > Case-Copy Loads prompts you with the following dialog.  

It allows you to copy all loads from one load case to another.  You have the option to delete
existing loads in the target load case.  The loads copied may also be multiplied by a factor.  At
least two load cases must exist in the model in order to use this command.

Create > Generate Loads > Convert Area Loads to Line Loads will convert all area loads to
line loads in every load case.  This is useful in checking how area loads would be converted
during the solution process.  You can always undo the area loads to line loads conversion.

Create > Generate Loads > Convert Local Loads to Global Loads will convert all member
point loads, line loads and shell surface loads from local coordinate systems to global
coordinate system in every load case.  This is useful for data transfer from ENERCALC 3D to
Revit Structure using FastFrame Revit Link.  You can always undo the local loads to global
loads conversion.



ENERCALC SEL307

© 2024  ENERCALC, LLC

Create > Generate Loads > Additional Masses prompts you with the dialog below.

It allows you to assign additional masses and mass moment of inertia to selected nodes. 
The mass can be applied to X, Y and/or Z directions while the mass moment of inertia can be
applied to OX, OY and/or OZ directions.  Additional Masses are added to the mass calculated
from the load combination for frequency analysis (see the command: Analysis > Frequency
Analysis).  Mass moment of inertia values can only be input using the Additional Masses
command.

The mass unit is a force unit divided by the acceleration of gravity, while the mass moment of
inertia has units of mass times length squared.  The acceleration of gravity is taken as 386.09
in/sec 2̂ or 9.8 m/sec 2̂.
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Create > Generate Loads > Response Spectra Library prompts you with the dialog below.  

It allows you to define spectra for current and future projects.  You can then use one or more
spectra in  Analysis > Response Spectrum Analysis.

You may view/modify a user-defined spectrum by double clicking the spectrum.  
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The first spectrum can not be edited or deleted.  Spectra generated based on building codes
cannot be edited but can be deleted.
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Load Cases

Create > Load Cases prompts you with the following dialog.  

It allows you to define load cases to be used for loads and load combinations.  A number is
assigned to each load case automatically by the program.  You may assign a label with 127
maximum characters to each load case for easy identification.  Duplicate labels in load cases
are not allowed.  A load type specifies the characteristics of the load case.  Examples are
DEAD, LIVE, WIND, EARTHQUAKE.  They are used to generate standard load combinations
in Create > Load Combinations.

You may add one or more load cases by clicking the “New Rows” button.  You may also print
all load cases in the list by clicking the “Print” button.  

The program always has a default load case labeled “Default”.  You may not delete this load
case or change its label.  You may however change its type.
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Load Combinations

Create > Load Combinations prompts you with the following dialog.  

It allows you to define combinations of existing load cases in the model.  The program solves
for load combinations but not for load cases.  You may assign a label with 127 maximum
characters to each load combination for easy identification.  Duplicate labels in load
combinations are not allowed.  
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You may add one load combination by clicking the “Add” button.   You may then define the
new load combination in the following dialog.  

The definition includes a label with 127 maximum characters, a load factor for each load
case, and a P-Delta flag.  A load factor of zero excludes the respective load case from
participating in the load combination.  You may print all load cases and their corresponding
load factors in the list by clicking the “Print” button.  
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If you need to design concrete beams, columns and/or plates, check “Perform Concrete
Design using this Load Combination” for each load combination that is appropriate for
concrete design.  

When concrete columns are to be designed, the program needs to calculate the

infamous b
d
 value.  The easiest way to facilitate this calculation is to create a load

combination specifically for the purpose of defining the sustained loads.  (It might even
be helpful to name this load combination "Sustained".)

In some models, this sustained load combination might just consist of 1.0 times the
dead load case.  In other situations, the sustained load combination might consist of 1.0
times the dead load case and 1.0 times a self-weight load case.  In still other cases, the
sustained load combination might consist of 1.0 times the dead load case and some
percentage of the live load case.  It depends entirely on how the load cases were set up
for the given model.

Then, a sustained load factor must also be entered.  This can only be a single factor, but
it must be representative of the constituent load cases (like a weighted average),
because this one factor will be applied to the entire sustained load combination to
calculate the maximum factored sustained axial load.

Finally, this sustained load combination must be designated in Concrete Design > RC
Model Design Criteria before performing concrete column design.

If you need to design steel members, check or uncheck “Perform Steel Design using this
Load Combination”.  If you need to use the load combination to check total or live load
deflection, check or uncheck appropriate boxes.

You may modify, copy, or delete a load combination by clicking the “Modify”, “Copy”, or
“Delete” button.  You may also create a load combination for every load case with a unit load
factor for the load case but zeros for the rest of the load cases.  To do that, click the “Unit
Cases” button.

You may also generate standard load combinations based on design codes such as ACI 318-
02/05/08/11/14 by clicking the button “Generate Std”.

There must be at least one load combination in a model.



Calculation Modules 314

© 2024  ENERCALC, LLC

Line Select

Create > Line Select allows you to line-select elements by clicking-dragging the left mouse
button. The line-selection selects or unselects a group of entities that the drawn line
intersects.

Select versus Reverse Select

By default, the selection mode is REVERSE SELECT, that is, entities picked will be selected
if they are currently unselected and will be unselected if they are currently selected.  However,
the selection mode will be SELECT if CTRL is pressed while selecting, that is, entities picked
will always be selected.  

The selection of nodes and elements is an important activity in the program.  Most of the
commands apply only to selected nodes or elements.  For this reason, many selection
methods are provided in the program and are explained in the following sections.

Window/Point Select

Create > Window/Point Select allows you to window-select or point-select nodes and
elements by clicking or clicking-dragging the left mouse button.  The Window/Point Select
command is the default selection command in the program.

Point versus Window

The point-selection selects or unselects at most one node or element.  The window-selection
selects or unselects a group of nodes or elements within a rectangular selection window.  

Window Drawn Right-to-Left versus Left-to-Right

If the selection window is drawn from left to right, then only entities that are entirely within the
selection rectangle will be selected/unselected.

If the selection window is drawn from right to left, then all entities that are crossed by the
selection rectangle will also be selected or unselected.  

Select versus Reverse Select

By default, the selection mode is REVERSE SELECT, that is, entities picked will be selected
if they are currently unselected and will be unselected if they are currently selected.  However,
the selection mode will be SELECT if CTRL is pressed while selecting, that is, entities picked
will always be selected.  

The selection of nodes and elements is an important activity in the program.  Most of the
commands apply only to selected nodes or elements.  For this reason, many selection
methods are provided in the program and are explained in the following sections.
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Select

Create > Select offers a variety of quick options for selecting specific nodes, members or
shells.

Create > Select > Select Nodes prompts you with the following dialog.  

It allows you to select nodes by specifying a range of node IDs.

Three selection modes are provided: “Select”, “Unselect”, “Reverse Select”.  The “Select”
mode will select nodes.  The “Unselect” mode will unselect nodes.  The “Reverse Select”
mode will select the unselected nodes and unselect the selected nodes. 

Create > Select > Select Members prompts you with a dialog to select members by
specifying a range of member IDs.

Three selection modes are provided: “Select”, “Unselect”, “Reverse Select”.  The “Select”
mode will select members.  The “Unselect” mode will unselect members.  The “Reverse
Select” mode will select the unselected members and unselect the selected members.

Create > Select > Select Shells prompts you with a dialog to select shells by specifying a
range of shell IDs.

Three selection modes are provided: “Select”, “Unselect”, “Reverse Select”.  The “Select”
mode will select shells.  The “Unselect” mode will unselect shells.  The “Reverse Select”
mode will select the unselected shells and unselect the selected shells.
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Create > Select > Select Bricks prompts you with a dialog to select bricks by specifying a
range of brick IDs.

Three selection modes are provided: “Select”, “Unselect”, “Reverse Select”.  The “Select”
mode will select bricks.  The “Unselect” mode will unselect bricks.  The “Reverse Select”
mode will select the unselected bricks and unselect the selected bricks.

Create > Select > Select All selects all nodes and elements.  You may use this command by
pressing CTRL+A.

Create > Select > Unselect All unselects all nodes and elements.  You may use this
command by pressing ESC.  If you are in the middle of another command such as zooming,
press ESC twice to unselect all.

Select by Properties

Create > Select by Properties offers a variety of quick options for selecting specific nodes,
members or shells by their properties.

Create > Select by Properties > Select by Materials prompts you with the following dialog.  

It allows you to select/unselect elements that use the specified materials.

Three selection modes are provided: “Select”, “Unselect”, “Reverse Select”.  The “Select”
mode will select elements.  The “Unselect” mode will unselect elements.  The “Reverse
Select” mode will select the unselected elements and unselect the selected elements.
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Create > Select by Properties > Select by Member Sections prompts you with the following
dialog.  

It allows you to select/unselect members that use the specified sections. 

Three selection modes are provided: “Select”, “Unselect”, “Reverse Select”.  The “Select”
mode will select elements.  The “Unselect” mode will unselect elements.  The “Reverse
Select” mode will select the unselected elements and unselect the selected elements.
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Create > Select by Properties > Select by Member Orientations prompts you with the
following dialog.  

It allows you to select/unselect members based on their orientations to the three global axes.
For example, you may select/unselect all vertical columns by checking the global Y direction. 
The selection modes are similar to the ones used in previous sections and are not repeated
here.

Create > Select by Properties > Select Tension/Compression Only Members allow you to
select all tension-only or compression-only members.
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Create > Select by Properties > Select by Shell Thicknesses prompt you with the following
dialog. 

It is similar to the one used in View > Select by Properties > Member Sections.  View > Select
by Properties > Shell Thicknesses applies to shells only.  Three selection modes are similar
to the ones used in the previous section and are not repeated here.

Create > Select by Properties > Select Orphaned Nodes selects all orphaned nodes.

Create > Select by Properties > Select Elements with Self Weight Excluded selects all
members whose self weight has been excluded.

Create > Select by Properties > Select Inactive Elements selects all inactive elements.

Create > Select by Properties > Select Elements by Nodes selects elements that are
connected to currently selected nodes.
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Create > Select by Properties > Select by Coordinates prompts you with the following dialog.  

It allows you to select/unselect nodes and elements based on nodal coordinates.  Nodes are
selected/unselected if their coordinates are within the boundary of the minimum and
maximum coordinates.  Elements are selected/unselected if coordinates of their nodes are
within the boundary of minimum and maximum coordinates.  The selection modes are similar
to the ones used in previous sections and are not repeated here.
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Create > Select by Properties > Select by Selection Names allows you to select/unselect
nodes and elements based on saved named selections.  You may assign (or save) named
selections from the Create ribbon.

Create > Select by Properties > Select by RC Beam Design Criteria allows you to select
beam members based on their design criteria.

Create > Select by Properties > Select by RC Column Design Criteria allows you to select
column members based on their design criteria.

Create > Select by Properties > Select by RC Plate Design Criteria allows you to select plate
elements based on their design criteria.

Create > Select by Properties > Select by Steel Design Criteria allows you to select members
based on a steel design criteria.

Create > Select by Properties > Select by Unity Check Ratios allows you to select members
based on their unity check ratio.

Invert Selection

Create > Invert Selection inverts the current selection state of all nodes and elements. 
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Advanced Meshing

The Advanced Meshing ribbon provides commands to create complex meshes.  It offers the
ability to incorporate multiple regions of varying mesh density, holes, control points and
control lines (called "Trees").

Add Region

Advanced Meshing > Add Region displays the following dialog.

It allows you to add a region to mesh model. You must first select beams as the boundary
(closed polygon) of the region. You have the option to deactivate or delete the selected beams
after the mesh region is created.  This ensures that the selected beams will not be part of the
structural model.
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Add Hole

Advanced Meshing > Add Hole displays the following dialog.

It allows you to add a hole to a mesh region. You must first select beams as the boundary
(closed polygon) of the hole. You have the option to deactivate or delete the selected beams
after the hole is created. This ensures that the selected beams will not be part of the
structural model.

Add Internal Points

Advanced Meshing > Add Internal Points displays the following dialog.

It allows you to add internal points to a mesh region. You must first select existing nodes as
the location of the internal points in the mesh region. 
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Add Tree

Advanced Meshing > Add Tree displays the following dialog.

It allows you to add a tree to a mesh region. You must first select beams as the branches of
the tree. Please note that disconnected branches are not allowed. You have the option to
deactivate or delete the selected beams after the tree is created. This ensures that the
selected beams will not be part of the structural model.

Edit Region

Advanced Meshing > Edit Region displays the following dialog.

It allows you to edit an existing mesh region.
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Edit Hole

Advanced Meshing > Edit Hole the following dialog

It allows you to edit an existing hole in a region.

Edit Internal Points

Advanced Meshing > Edit Internal Points displays the following dialog.

It allows you to edit internal points in a region. You have the option to edit a single internal point
or all internal points within a region.
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Edit Tree

Advanced Meshing > Edit Tree displays the following dialog.

It allows you to edit an existing tree in a region.

Delete Region

Advanced Meshing > Delete Region displays the following dialog.

It allows you to delete an existing region.
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Delete Hole

Advanced Meshing > Delete Hole displays the following dialog.

It allows you to delete one or more holes in a region.

Delete Internal Points

Advanced Meshing > Delete Internal Points displays the following dialog.

It allows you to delete one or more internal points in a region.
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Delete Tree

Advanced Meshing > Delete Tree displays the following dialog.

It allows you to delete one or more trees in a region.

Clear Mesh Model

Advanced Meshing > Clear Mesh Model allows you to clear the mesh model. This will delete
all regions and its dependents such as holes, internal points and trees.

Load Mesh Model from File

Advanced Meshing > Load Mesh Model from File allows you to load a previously saved mesh
model file (*.SUR) and therefore replace the existing mesh model.

Save Mesh Model to File

Advanced Meshing > Save Mesh Model to File allows you to save the existing mesh model to
a file (*.SUR). The saved mesh file can be edited, loaded later.
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Activate Regions

Advanced Meshing > Activate Regions displays the following dialog.

It allows you to deactivate/activate one or more regions before generating mesh.

Generate Mesh

Advanced Meshing > Generate Mesh displays the following dialog.

It allows you to generate mesh. You have the option to save the generated mesh to a named
selection.
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Generate Mesh from File

Advanced Meshing > Generate Mesh from File allows you to generate mesh from a previously
saved mesh model file (*.SUR).

View Mesh Model

Advanced Meshing > View Mesh Model shows or hides the mesh model.

Annotate Mesh Model

Advanced Meshing > Annotate Mesh Model allows you to annotate mesh model objects.  Also
see Display Options on the Quick Access Toolbar.

Modify

The Modify ribbon provides commands to edit or modify the model.

Lock Model

Modify > Lock Model locks the model so that you cannot modify it.  You may still access non-
structural commands such as zooming and panning while the model is locked.  The model
may be automatically locked after an analysis is performed successfully.  To do that, just click
Settings & Tools > Preferences.
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Copy

Modify > Copy prompts you with the following dialog.  

It allows you make one copy of the selected parts of a model to a different location.  You may
specify copy distances along the X, Y or Z directions.  Nodal or element dependents (except
loads) are copied together with their parents automatically.  For example, when a member is
copied, moment releases on that member are copied also.  You have the option to copy the
loads attached to the selected nodes or elements.  You have the option to automatically
merge nodes and elements after copying.  You should check this option unless duplicate
nodes are explicitly permitted. 
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Array

Modify > Array prompts you with the following dialog.  

It allows you make one or more copy of the selected parts of a model to a different location. 
You may specify the step size along the X, Y or Z directions.  Nodal or element dependents
(except loads) are copied together with their parents automatically.  For example, when a
member is copied, moment releases on that member are copied also.  You have the option to
copy the loads attached to the selected nodes or elements.  You have the option to
automatically merge nodes and elements after copying.  You should check this option unless
duplicate nodes are explicitly permitted. 
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Mirror

Modify > Mirror prompts you with the following dialog.  

It allows you to mirror the selected parts of a model to a different location by defining a mirror
plane.  Nodal or element dependents (except loads) are mirrored together with their parents
automatically.  For example, when a member is mirrored, moment releases on that member
are mirrored also.  You have the option to copy the loads attached to the selected nodes or
elements.  You have the option to automatically merge nodes and elements after copying. 
You should check this option unless duplicate nodes are explicitly permitted.
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Move Origin

Modify > Move Origin prompts you with the following dialog.  

It allows you to reset the model origin.  In particular, the origin may be set at the current model
center.  This allows you to center the model so its view may be rotated more smoothly.
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Move

Modify > Move prompts you with the following dialog.  

It lets you move selected parts of a model to a different location.  You may specify move
distances along the X, Y or Z directions.  Nodal or element dependents such as loads are
moved together with selected nodes or elements automatically.  You have the option to
automatically merge nodes and elements after moving.  You should check this option unless
duplicate nodes are explicitly permitted. 

Note:  When using this command, be sure to select the intended entities AND THEIR
NODES, before executing the command.  If the entities are selected without their nodes, the
command will not work.
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Rotate

Modify > Rotate prompts you with the following dialog.  

It lets you rotate selected parts of a model by an angle about one of the global axes.  Nodal or
element dependents such as loads are moved together with the elements.  You have the
option to automatically merge nodes and elements after rotating.  You should check this
option unless duplicate nodes are explicitly permitted. 

Note:  When using this command, be sure to select the intended entities AND THEIR
NODES, before executing the command.  If the entities are selected without their nodes, the
command will not work.
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Scale

Modify > Scale prompts you with the following dialog.  

It lets you scale selected parts of a model in the X, Y or Z directions.  You may specify the
coordinates of a base point and scales for the three global directions.  

The following formula is used to perform the scaling in the program.

Xnew = Xbase + (Xold - Xbase) * scale

Where Xnew represents the nodal coordinates after scaling, Xold represents the nodal

coordinates before scaling and Xbase represents coordinates of the base point.

Note:  When using this command, be sure to select the intended entities AND THEIR
NODES, before executing the command.  If the entities are selected without their nodes, the
command will not work.
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Delete

Modify > Delete prompts you with the following dialog.

It allows you to delete selected nodes or elements or their dependents.  Loads are deleted
based on their visibilities in the model view.  Dependents such as loads will be deleted if their
parent nodes or elements are deleted.

Extrude

Modify > Extrude provides various methods of creating entities by starting with a selected set
and extruding them by specified distances.
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Modify > Extrude > Extrude Nodes to Members prompts you with the following dialog.  

It generates a series of members by extruding selected nodes along a global direction.

You may specify a distance list and an extrusion direction for the generation of beams.  The
distance list is a comma separated list that specifies multiple distances.  For example, a
distance list of “12,2@14,3@10” will generate distances of 12, 14, 14, 10, 10 and 10 in length
units.  You have the option to automatically merge nodes and elements after extrusion.  You
should check this option unless duplicate nodes are explicitly permitted. 

The following screen capture illustrates the members that are generated by extruding one
node (the first node) using the input from the dialog above.
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Modify > Extrude > Extrude Members to Shells prompts you with the following dialog.  

It generates a series of shells by extruding selected members along a global direction. You
may specify a distance list and an extrusion direction for the generation of shells.  The
extrusion direction must not be parallel to the selected members.  You have the option to
automatically merge nodes and elements after extrusion.  You should check this option
unless duplicate nodes are explicitly permitted.  You also have the option to automatically
delete selected members after the extrusion. 

The input in the above dialog is applied to the members in the screen capture below...

members used for extruding

...to generate the shells in following screen capture by extruding.

shells generated
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Modify > Extrude > Extrude Shells to Bricks prompts you with the following dialog.  

It generates a series of bricks by extruding selected shells along a global direction.  You may
specify a distance list and an extrusion direction for the generation of shells.  The extrusion
direction must not be parallel to the selected shells.  You have the option to automatically
merge nodes and elements after extrusion.  You should check this option unless duplicate
nodes are explicitly permitted.  You also have the option to automatically delete selected
shells after the extrusion. 

The input in the above dialog is applied to the shells in the screen capture below...

shells used for extruding
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...to generate the bricks in the following screen capture by extruding.

bricks generated

Revolve

Modify > Revolve provides various methods of creating entities by starting with a selected set
and revolving them through specified angles.
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Modify > Revolve > Revolve Members to Shells prompts you with the following dialog.  

It generates a series of shells by revolving selected members about the global Y axis.  You
may specify the number of segments, start and end angles for revolving.  The program will
merge nodes automatically.  You have the option to automatically delete the selected
members after revolving.
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The input in the above dialog is applied to the members in the screen capture below...

members used for revolving

...to generate the shells in the screen capture below by revolving.

shells generated
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Modify > Revolve > Revolve Shells to Bricks prompts you with the following dialog.

It generates a series of bricks by revolving selected shells about the global Y axis.  You may
specify the number of segments, start and end angles for revolving.  The program will merge
nodes automatically.  You have the option to automatically delete the selected shells after
revolving.
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The input in the dialog above is applied to the shells in the screen capture below...

shells used for revolving

...to generate the bricks in the screen capture below by revolving.  Bricks are rendered in the
figure.

bricks generated

Split

Modify > Split provides tools for subdividing members.
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Modify > Split > Split Members prompts you with the following dialog.  

It allows you to divide selected members by specifying 2 or more segments of equal length or
by providing a distance list.  Loads on the original members are assigned automatically to the
generated members after splitting.  You have the option to automatically merge nodes and
elements after splitting.

The input in the dialog above is applied to the members in the screen capture below...

members before splitting
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...to generate the members in the screen capture below by splitting.

members after splitting

Modify > Split > Insert Nodes at Intersections of Selected Members allows you to insert nodes
at all intersections of the selected members.  The newly created nodes are likely isolated
(orphaned) nodes, meaning they are not attached to intersecting members.  Generally
speaking, you should explode the members at these nodes.  The program prompts you to do
so at the end of this command.

Modify > Split > Split Selected Members at Nodes allows you to split selected members at
nodes which are located on but are not connected to these members.

The following figure shows a shell with edge members on four sides:

The following figure shows shells generated by sub-meshing (2x2) the shell from above:

Notice in the figure above, the middle nodes on the edge are on but not yet connected to the
members.  
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The following figure shows members generated by splitting members at nodes.  

The figures are rendered using the command View > Render, with the rendering ratio of 80%
for both members and shells.

Member Properties

Modify > Member Properties provides tools for assigning properties to members.

Modify > Member Properties > Member Properties initiates the same command as Create >
Member Properties > Member Properties.  It opens the dialog that allows assignment of
member properties.

Modify > Member Properties > Materials initiates the same command as Create > Member
Properties > Materials.  It opens the dialog that allows you to define and/or assign materials to
selected elements in the model.  

Modify > Member Properties > Sections initiates the same command as Create > Member
Properties > Sections.  It opens the dialog that allows you to modify sections in the model.  

Modify > Member Properties > Element Local Angles initiates the same command as Create
> Member Properties > Local Angles.  It allows a member local angle to be modified.

Modify > Member Properties > 3-Point Member Orientation prompts you with a dialog to
specify an X, Y, and Z coordinate.  The orientation of selected members will be changed so
the local z-axis of all selected members is perpendicular to the plane formed by the two
member end coordinates and the specified X, Y, Z coordinate.

Modify > Member Properties > Moment Releases initiates the same command as Create >
Member Properties > Moment Releases.  It allows moment releases to be modified.

Modify > Member Properties > Tension/Compression Only initiates the same command as
Create > Member Properties > Tension/Compression Only.  It allows the
Tension/Compression Only assignment to be modified.

Modify > Member Properties > Convert Members to Rigid Links will convert selected
members to rigid links. 

Modify > Member Properties > Cracking Factors initiates the same command as Create >
Member Properties > Cracking Factors.  It allows cracking factors to be modified.

Modify > Member Properties > Rigid Offsets initiates the same command as Create >
Member Properties > Rigid Offsets.  It allows rigid offsets to be modified.
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Shell Properties

Modify > Shell Properties provides tools for assigning properties to shells.

Modify > Shell Properties > Shell Properties initiates the same command as Create > Shell
Properties > Shell Properties.  It opens the dialog that allows assignment of shell properties.

Modify > Shell Properties > Materials initiates the same command as Create > Shell
Properties > Materials.  It opens the dialog that allows you to define and/or assign materials to
selected shells in the model.  

Modify > Shell Properties > Thicknesses initiates the same command as Create > Shell
Properties > Thicknesses.  It opens the dialog that allows modification of shell thicknesses.

Modify > Shell Properties > Element Local Angles initiates the same command as Create >
Shell Properties > Element Local Angles.  It allows a shell local angle to be modified.

Modify > Shell Properties > Match Local x-Axes with Source prompts you with a dialog to
specify a source shell.  The orientation of the local x-axes of the selected shells will be
changed to match the orientation of the local x-axis of the source shell.

Modify > Shell Properties > Match Local z-Axes for Shells prompts you with a dialog to specify
a source shell.  The orientation of the local z-axes of the selected shells will be changed to
match the orientation of the local z-axis of the source shell.

Modify > Shell Properties > Align Local z-Axes with Reference Point prompts you with a dialog
to specify a reference point.  The orientation of the local z-axes of the selected shells will be
changed to match the vector from the reference point to the center of the selected shells.

Modify > Shell Properties > Align Local y-Axes with Reference Point prompts you with a dialog
to specify a reference point.  The orientation of the local y-axes of the selected shells will be
changed to match the vector from the reference point to the center of the selected shells.
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Sub-Mesh Shells

Modify > Sub-Mesh Shells prompts you with the following dialog.

It allows you to sub-mesh selected shells by specifying 2 or more segments along sides 1-2
& 4-3 and sides 2-3 & 1-4.  Loads on the original shells are assigned automatically to the
generated shells after sub-meshing.  You have the option to merge nodes and elements after
sub-meshing.  You should check this option unless duplicate nodes are explicitly permitted.

The input in the dialog above is applied to the shells in screen capture below...

shells before sub-meshing

...to generate the shells in the screen capture below by meshing.
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shells after sub-meshing

Renumber

Modify > Renumber offers options to renumber entities in the model.

Modify > Renumber > Auto Renumber All Nodes prompts you with the following dialog.  

It allows you to renumber all nodes sequentially based on nodal coordinates.



ENERCALC SEL353

© 2024  ENERCALC, LLC

Modify > Renumber > Renumber Selected Nodes prompts you with the following dialog. 

 It allows you to Renumber selected nodes based on the following two modes:

a). Increment each selected node number by a delta (may be positive or negative).  For
example, if we have selected node numbers 2, 5, 8 and a delta of 2, the new node numbers
will be 4, 7, and 10.

b). Renumber each selected node from a new start number (must be positive) and a step
(may be positive or negative).  For example, if we have selected node numbers 2, 5, 8, a new
start number of 1000 and a step of 2, the new node numbers will be 1000, 1002, 1004.

If renumbering is successful, nodal dependents such as loads, masses and springs will be
renumbered automatically.  The renumbering will be undone automatically if any errors are
encountered.

Modify > Renumber > Renumber Members (or Shells, or Bricks) command is similar to
Renumber Selected Nodes.
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Switch Coordinates

Modify > Switch Coordinates prompts you with the following dialog.  

It allows you to switch the X and Z, or the Y and Z coordinates of the selected nodes.  For
example, you may generate a floor system on the XY (vertical) plane and then switch
coordinates to place the floor on the XZ (horizontal) plane.

Reverse Node Order for Selected Elements

Modify > Reverse Node Order for Selected Elements allows you to reverse the nodes’ order
for selected elements.  For members and shells, this command in effect changes their local
coordinate systems.  For bricks, this command may be used to rectify a wrong nodal ordering
which results in negative diagonals in element stiffness.

It is important to point out that dependents on the elements are not reversed or changed
accordingly.  After running this command, you should check on these dependents such as
loads and moment releases on members, loads on shells, etc.

Merge All Nodes & Elements

Modify > Merge All Nodes & Elements merges all nodes that are located within a distance
tolerance between two or more nodes, and merges all elements that share the same nodes. 
You may set the distance tolerance using the command Settings > Data Options.

Remove All Orphaned Nodes

Modify > Remove All Orphaned Nodes removes all nodes that are not connected to any
elements.  Orphaned nodes make the model unstable.  They must be removed prior to the
solution. 

Element Activation

Modify > Element Activation allows members, shells, and/or bricks to be selectively activated
or deactivated.

This allows these modeling entities to remain in the model while studying the effects of
ignoring their structural contributions to the model.
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View

The View ribbon provides commands to graphically view inputs such as geometry and
loading; perform selections by various methods; and display outputs such as shear and
moment diagrams for members, and contours for shells and bricks.

Drawing Grids

View > Drawing Grids > Drawing Grid Setup is the same as Create > Grids & Snaps >
Drawing Grid Setup.

View > Drawing Grids > Toggle Grid Display shows or hides the drawing grid.  

Redraw

View > Redraw regenerates and redraws all graphics in the model view.

Restore Model

View > Restore restores original settings for the model view.  These settings include zooming
= 1.0, panning = 0, rotation = 0. 

Preset Views

You may place the model view in a preset orientation by selecting one of these commands:

Front Back Left Right

Top Bottom Isometric

Named Views

View > Named Views allows you to save the current view settings such as zooming factor,
panning distance or rotation angles so that you may recall the same view settings later on.

Zoom Extent

View > Zoom Extent displays the entire model in the view.
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Zoom Window

View > Zoom Window zooms in on a specific part of the model by clicking and dragging the
left mouse button.  The command remains in effect until another command is selected, the
right mouse button is clicked, or ESC is pressed.

Zoom Object

View > Zoom Object zooms in on a specific node, member, shell or brick.  The command
remains in effect until another command is selected, the right mouse button is clicked, or
ESC is pressed.

Zoom Previous

View > Zoom Previous lets you zoom back to the previous view.  You may use this command
after you zoom in or pan to view a portion of your model in greater detail.

Zoom In

View > Zoom In zooms in on the model by a preset factor (1.25).  You may use this command
by pressing CTRL+UP arrow or CTRL+RIGHT arrow.

Zoom Out

View > Zoom Out zooms out on the model by a preset factor (1.25).  You may use this
command by pressing CTRL+DOWN arrow or CTRL+LEFT.

Pan

The Pan controls allow the view of the model to be moved.

View > Pan > Pan Left pans the model to the left by a preset screen distance.  You may use
this command by pressing CTRL+LEFT arrow. 

View > Pan > Pan Right pans the model to the right by a preset screen distance.  You may
use this command by pressing CTRL+RIGHT arrow. 

View > Pan > Pan Up pans the model to the top by a preset screen distance.  You may use
this command by pressing CTRL+UP arrow. 

View > Pan > Pan Down pans the model to the bottom by a preset screen distance.  You may
use this command by pressing CTRL+DOWN arrow. 

View > Pan > Pan Screen pans (moves) the model by clicking and dragging the left mouse
button.  The command remains in effect until another command is selected, the right mouse
button is clicked, or ESC is pressed.

Rotate

The Rotate commands allow the view of the model to be spun around various axes.

View > Rotate +X rotates the model view about X by a preset positive angle (5 degrees).  You
may use this command by pressing SHIFT+DOWN arrow. 

View > Rotate -X rotates the model view about X by a preset negative angle (5 degrees).  You
may use this command by pressing SHIFT+UP arrow. 
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View > Rotate +Y rotates the model view about Y by a preset positive angle (5 degrees).  You
may use this command by pressing SHIFT+RIGHT arrow. 

View > Rotate -Y rotates the model view about Y by a preset negative angle (5 degrees).  You
may use this command by pressing SHIFT+LEFT arrow. 

View > Rotate +Z rotates the model view about Z by a preset positive angle (5 degrees).  You
may use this command by pressing CTRL+SHIFT+UP arrow or CTRL+SHIFT+RIGHT arrow.

View > Rotate -Z rotates the model view about Z by a preset negative angle (5 degrees).  You
may use this command by pressing CTRL+SHIFT+DOWN arrow or CTRL+SHIFT+LEFT
arrow.

Pan

View > Pan allows you to pan the model view in real time by clicking and dragging the left
mouse button.  The command remains in effect until another command is selected, the right
mouse button is clicked, or ESC is pressed.

Zoom

View > Zoom allows you to zoom in or out on the model view in real time by clicking and
dragging the left mouse button up or down.  The command remains in effect until another
command is selected, the right mouse button is clicked, or ESC is pressed.

Rotate

View > Rotate allows you to rotate the model view in real time by clicking and dragging the left
mouse button.  The command remains in effect until another command is selected, the right
mouse button is clicked, or ESC is pressed.
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Load Diagram

View > Load Diagram prompts you with the following dialog.  

It allows you to view loads of selected types in selected load cases.  You may have the
options to show load magnitudes or units.  The line load intervals may vary between 1 and 16.
 An interval between 2 to 6 is recommended.  Transparency may be set for non-area loads
and area loads so you can see objects underneath the loads.  The displayed loads may be
deleted.  The loads not displayed cannot be deleted unless their parent nodes or elements are
deleted.
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Query

View > Query lets you query extensive input and output information for a single node, member
or finite element.  

For example, a node query will list node id, nodal coordinates and nodal loads.  It will also list
relevant support or nodal spring information.  If there are analysis results, it will list nodal
displacements, support or spring reactions as well.
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Measure

View > Measure lets you click two locations and obtain the distance between the two
coordinates.

Render Options

View > Render Options prompts you with the following dialog.  

It allows you to turn on or off the shading of the surfaces of members, shells and bricks as
though they were illuminated from multiple light sources.  It provides a way for you to
realistically visualize the image of the model.  For shells, you have the option to render
thickness as well as surface.

You have the option to apply different rendering percentages to different elements.  Enter
100% for full rendering, 0% for no rendering, and anything in-between for partial rendering. 
The partial rendering (e.g. 50-80%) may be useful in identifying connectivity of elements to
nodes.

Note: Rendering a model can be expensive in terms of memory and time usage by the
program.  You should turn off the rendering when it is not necessary.

Quick Render

View > Quick Render is a toggle that switches between the wireframe display and the
rendered view.  When shells are present in the model, it actually acts as a 3-way toggle that
introduces a third view that displays plates rendered and with actual thickness displayed.

You may use this command by pressing F8.
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Diaphragm Render

View > Diaphragm Render is a toggle.  It controls the rendering of diaphragms.

Global Axes

View > Global Axes shows or hides the legend of the global axes in the bottom-left corner of
the window.  You may use this command by pressing F5. 

Contour Legend

View > Contour Legend shows or hides the contour legend.  The results must exist for the
contour legend to be displayed.

Comment

View > Comment allows you to insert a comment at a specified location.  

The comment must be less than 256 characters in length.  To remove an existing comment,
go to Tables > Comments and delete the comment entry.

Hide Selected

View > Hide Selected hides the selected nodes, elements and their dependents.  The hidden
nodes or elements are not displayed and are not modifiable unless the model integrity is at
stake.  This command allows you to focus on some particular parts of the model.  For
example, if you want to work on a particular floor of a three dimensional building, you may
select the floor, invert the selection and hide the selected elements.
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Hide All Except Level

View > Hide All Except Level hides the all nodes, elements and their dependents except those
on the specified level.  

This command provides a shortcut to the previous command when you would like to focus on
elements of the model in a horizontal plan view.  You must have levels defined (through
Create > Levels) before running this command.

Hide All Except Plane

View > Hide All Except Plane hides all nodes, elements and their dependents except those on
the specified plane.

 This command provides a shortcut to the previous command when you would like to focus
on elements of the model in a plan view.

Show All

View > Show All displays all nodes, elements and shells (even if they were previously hidden).

Display Options

View > Display Options allows control over what is and is not displayed on the screen.
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Tables

The Tables ribbon provides commands to create or modify all input data of a model using
spreadsheets.  

Spreadsheets provide an alternative method to the graphic input described in earlier chapters.
 You may combine both methods to create a model quickly.

The spreadsheets support the common clipboard actions such as “CTRL+X” to cut,
“CTRL+C” to copy and “CTRL+V” to paste data.  You may even share data between the
spreadsheets in the ENERCALC 3D and other spreadsheet programs such as Microsoft
Excel.  For example, you may generate node data in an Excel spreadsheet, copy the nodal
coordinate data and paste to the Nodes spreadsheet in the program.  In this way, you can
take advantage of the more powerful data manipulation functions in the Excel. 

In each spreadsheet, you may add one or more rows by clicking the “New Row” button.  You
may also print data in the spreadsheet by clicking the “Print” button.  You have the option to
view only the selected data.  To do that, click Tables > Show Data for Selected Entities Only. 
You may not modify the data in the spreadsheet when this option is chosen. 

The "Fill Down" Command

When working in the tables, it is often convenient to fill a column or a specific range of cells
with the same value.  The "Fill Down" command makes this very easy.

The command works in two modes:

· To fill an entire column with a specific value, right click on the cell containing the desired
value and click OK.

· To fill a specific set of cells with a specific value, highlight the set of cells to be changed,
then right-click on the cell containing the desired value (can be anywhere in the current
table) and click OK.

Show Data for Selected Entities Only

Tables > Show Data for Selected Entities Only is a toggle to control what is displayed when
tables are viewed.

Materials

The Tables > Materials command opens the Material Data table to display the materials that
have been defined in the current model.  It also offers assignment options.

Sections

The Tables > Sections command opens the Section Data table to display the sections that
have been defined in the current model.  It also offers assignment options.
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Thicknesses

The Tables > Thicknesses command opens the Shell Thickness Data table to display the
thicknesses that have been defined in the current model.  It also offers assignment options.
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Nodes

Tables > Nodes prompts you with the following dialog.  

It allows you to enter nodes in a spreadsheet.  Each node includes the nodal coordinates and
the selection status.  You may not modify the node IDs. 

An empty row is allowed if all rows below it are empty (except the node ID and status fields). 
You may not delete the existing nodes in the dialog.  To delete the existing nodes, you must
dismiss this dialog and click Modify > Delete.

Due to machine inaccuracy of floating point values, some commands (such as Modify >
Rotate) may cause the presence of very small numerical coordinate values.  You may round
off these tiny values to be zeros by clicking the Round-off Coordinates button.  The epsilon
used for the round-off may be set from Settings & Tools > Data Options.  The default epsilon
value is 1e-10 and must be less than or equal to 1e-6.
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Members

Tables > Members prompts you with the following dialog. 

It allows you to enter members in a spreadsheet.  Each member includes the IDs of start and
end nodes, the material and section IDs, the element local angle, and the selection status. 
You may not modify the member ID.  All other IDs must be valid (defined).  Material and
section combo boxes are provided for you to correctly pick and apply proper material and
section IDs to selected members.

An empty row is allowed if all rows below it are empty (except the member ID and status
fields).  You may not delete the existing members in this dialog.  To delete the existing
members, you must dismiss this dialog and click Modify > Delete.
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Shells

Tables > Shells prompts you with the following dialog.  

It allows you to enter shells in a spreadsheet.  Each shell includes the IDs of four element
nodes, the material and thickness IDs, the element local angle, and selection status. You may
not modify the shell IDs.  All other IDs must be valid (defined).  Material and thickness combo
boxes are provided for you to correctly pick and apply proper material and thickness IDs to
selected shells.

An empty row is allowed if all rows below it are empty (except the shell ID and status fields). 
You may not delete the existing shells in this dialog.  To delete the existing shells, you must
dismiss this dialog and click Modify > Delete.
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Bricks

Tables > Bricks prompts you with the following dialog.  

It allows you to enter bricks in a spreadsheet.  Each brick includes the IDs of eight element
nodes, the material ID and selection status.  You may not modify the brick IDs.  All other IDs
must be valid (defined).  The material combo box is provided for you to correctly pick and
apply proper material IDs to selected bricks.
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Supports

Tables > Supports prompts you with the following dialog.  

It allows you to enter supports in a spreadsheet.  Each support includes the node ID, the fixity
flag, and enforced displacements for all restrained DOFs.  The node IDs must be valid
(defined).

The fixity flag is a string of 6 characters representing restrained DOFs in Dx, Dy … Doz.  For

each character in the flag, enter ‘1’ if the DOF is restrained and ‘0’ if unrestrained.  For
example, “111111” represents a fixed support while “111000” represents a pinned support. 
Enforced displacements may be applied to the restrained DOFs.  They may be regarded as
special loads and can be used to model known support settlements.  For normal support,
they are 0s.  Enforced displacements applied to unrestrained DOFs will be discarded.    
 
An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.

Springs

Tables > Springs offers options to access the tables for Nodal Springs, Line Springs and
Surface Springs.
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Tables > Springs > Nodal Springs prompts you with the following dialog. 

It allows you to enter nodal springs in a spreadsheet.  Each nodal spring includes the node ID,
the spring non-linearity flag and six spring coefficients Kx, Ky …, Koz.  The node ID must be

valid (defined).

The spring flag is a string of 6 characters representing the spring non-linearity in three
translational DOFs (Dx, Dy, Dz) and three rotational DOFs (Dox, Doy, Doz).  For each

character in the flag, enter ‘0’ if the restrained DOF is linear, ‘1’ if compression-only and ‘2’ if
tension only.  For the unrestrained DOFs, just enter 0s for the corresponding spring
coefficients.

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.

Tables > Springs > Line Springs offers options to access the table for Line Springs.

Tables > Springs > Surface Springs prompts you with dialogs similar to that in Tables >
Springs > Nodal Springs.  However, only three translational DOFs Dx, Dy, Dz are available for

line or surface spring coefficients.
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Member Releases

Tables > Member Moment Releases prompts you with the following dialog.  

It allows you to enter member moment releases in a spreadsheet.  Each moment release
includes the member ID, four 1-character release codes for major moment release (the local
oz), and minor moment release (the local oy) for both ends of members.  Enter ‘1’ for the
released local DOF and ‘0’ for the un-released local DOF.  The member ID must be valid.

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.
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Diaphragms

Tables > Diaphragms prompts you with the following dialog.  

It allows you to enter generic or regular rigid diaphragms in a spreadsheet.  For a generic
diaphragm, four distinct nodes are required to define the diaphragm plane.  For a regular
diaphragm in global XZ, YZ and XY plane, only the first node is required to define the
diaphragm plane. 

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.

Rigid diaphragms may be used instead of plate finite elements to model stiff in-plane actions
such as concrete floors.  Internally, the program creates multiple in-plane rigid links for each
diaphragm prior to static or frequency analysis.  A rigid link is simply a member with very large
sectional properties that can be adjusted with the diaphragm stiffness factor (see Settings >
Data Options).  The larger the diaphragm stiffness factor, the stronger the in-plane rigid
diaphragm action is.  The presence of rigid links with large diaphragm stiffness factor (say
1E10) could create numerical difficulties during the solution if 64-bit floating point solver is
used.  However, the unique 128-bit floating point solver in ENERCALC 3D makes this
problem nonexistent in that much larger diaphragm stiffness factor (say 1E20) may be used
without creating numerical difficulties during solution.
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The program further provides the option to ignore the rigid diaphragm actions as an analysis
option (Analysis > Analysis Options).

Multi-DOF Constraints

Tables > Multi-DOF Constraints provides access to the table where multi-DOF constraint
data is reported.

Load Cases

Tables > Load Cases command is identical to the one found in the Create ribbon.  It is
provided here for convenience.

Load Combinations

Tables > Load Combinations command is identical to the one found in the Create ribbon.  It is
provided here for convenience.
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Nodal Loads

Tables > Nodal Loads prompts you with the following dialog.  

It allows you to enter nodal loads in a spreadsheet.  Each nodal load includes the node ID, the
load direction, and magnitude.  The load direction is specified in the global coordinate system.
 The load is a force if the load direction is in the X, Y or Z direction and moment if in the OX,
OY or OZ.  The node ID must be valid (defined).

An empty row is allowed if all rows below it do not contain any non-empty fields.  Selected
rows (whole row must be selected) may be cut by clicking the button “Cut Selected Rows”.
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Point Loads

Tables > Point Loads prompts you with the following dialog.  

It allows you to enter member point loads in a spreadsheet.  Each point load includes the
member ID, the load coordinate system, direction, magnitude, and distance.  The load is a
force if the load direction is in the X, Y or Z direction and moment if in the OX, OY or OZ.  The
load distance is the ratio of load location (measured from the start of the member) to member
length.  The member ID must be valid (defined).

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.
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Line Loads

Tables > Line Loads prompts you with the following dialog.  

It allows you to enter member line loads in a spreadsheet.  Each line load includes the
member ID, the load coordinate system, direction, start and end magnitudes, and the start
and end distances.  The load is a force in the local or global X, Y, Z directions.  The load
distances are the ratio of load start and end locations (measured from the start of the
member) to the member length.  The member ID must be valid (defined).

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.
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Area Loads

Tables > Area Loads prompts you with the following dialog.  

It allows you to enter member area loads in a spreadsheet.  Each area load includes four
node IDs, the load coordinate system, direction, load distribution, and load magnitude.  The
area load may be in global X, Y or Z direction, or in local Z direction.  The four nodes form a
quadrilateral load area and must be in the same plane.  Node-4 may also be the same as
Node-1, in which case the load area is a triangle.  Area loads in one or all load cases may be
converted to lines loads in their respective load cases.

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.
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Surface Loads

Tables > Surface Loads prompts you with the following dialog.  

It allows you to enter shell surface loads in a spreadsheet.  Each surface load includes the
shell ID, the load coordinate system, direction, and magnitude.  The load is always a force in
the local or global X, Y or Z directions.  The shell ID must be valid (defined).

An empty row is allowed if all rows below it are empty.  Selected rows (whole row must be
selected) may be cut by clicking the button “Cut Selected Rows”.
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Self Weights

The Tables > Self Weights command is identical to the one found in the Create ribbon.  It is
provided here for convenience only.

Thermal Loads

Tables > Thermal Loads > Member Thermal Loads displays a table of members and their
temperature increase. 
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Tables > Thermal Loads > Shell Thermal Loads displays a table of shells and their
temperature increase.
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Tables > Thermal Loads > Brick Thermal Loads displays a table of bricks and their
temperature increase.
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Masses

Tables > Masses > Calculated Masses prompts you with the following dialog.  

It allows you to view the masses calculated from the load combination for frequency analysis
set in Analysis > Frequency Analysis.  The program will automatically convert all forces (not
moments) in the positive or negative gravity direction to masses and apply them in all
available mass degrees of freedom.  

Obviously, the calculated mass values cannot be modified.  However, you may convert all the
calculated masses to additional masses.  In this case, the “Convert loads to masses” option
in Analysis > Frequency Analysis will be disabled.  This technique may be useful when you
want to account for the influence of axial loads on frequencies.
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Tables > Masses > Additional Masses prompts you with the following dialog.  

It allows you to enter additional nodal mass and nodal mass moment of inertia values.  Each
nodal mass or mass moment of inertia includes the node ID, the mass direction, and
magnitude.  The mass direction is specified in the global coordinate system.  The unit of
measurement for mass is force divided by the acceleration of gravity.  For mass moment of
inertia, the unit of measurement is mass times length units squared.  The acceleration of
gravity is generally takes as a constant value of 386.09 in/sec 2̂ or 9.8 m/sec 2̂.  

An empty row is allowed if all rows below it do not contain any non-empty fields.  Selected
rows (whole row must be selected) may be cut by clicking the button “Cut Selected Rows”.
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Response Spectra Library

Tables > Response Spectra Library prompts you with the dialog below.  

It allows you to define spectra for current and future projects.  You can then use one or more
spectra in  Analysis > Response Spectrum Analysis.

You may view/modify a user-defined spectrum by double clicking the spectrum as shown in
the screen capture below.  
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The first spectrum can not be edited or deleted.  Spectra generated based on building codes
cannot be edited but can be deleted.
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Story Drift Nodes

Tables > Story Drift Nodes prompts you with the following dialog.  

It allows you to enter nodes that will be used for floor drift calculation.  An empty row is
allowed if all rows below it do not contain any non-empty fields.  Selected rows (whole row
must be selected) may be cut by clicking the button “Cut Selected Rows”.
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Comments

Tables > Comments prompts you with the following dialog.  

It allows you to add or delete comments at different locations in the model.  You may also add
an individual comment using View > Comments.  A comment must be less than 256
characters in length.

An empty row is allowed if all rows below it do not contain any non-empty fields.  Selected
rows (whole row must be selected) may be cut by clicking the button “Cut Selected Rows”.

Analysis

The Analysis ribbon provides commands to set the analysis options and to perform analyses.
 For more information on analysis, please refer to "Technical Topics".
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Analysis Options

Analysis > Analysis Options prompts you with the following dialog.  

It allows you to set important options before performing analysis on the model.  
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The “Model type” determines the type of the model to analyze.  Model type “3D Frame & Shell”
is the most general.  It has all six degrees of freedom (DOFs) available to every node in the
model.  Any model may be analyzed with this model type.  However, computer memory or
time may be wasted if a simpler model can be used.

Model type “2D Frame” may be used to model a 2D frame (beams and trusses) structure in
the XY plane.  Only three DOFs (Dx, Dy and Doz) are available to every node in the model. 

The rest of the DOFs are suppressed.  

Model type “3D Truss” may be used to model 3D truss structures.  Only three DOFs (Dx, Dy,

and Dz) are available to every node in the model.  The rest of the DOFs are suppressed.  If

the model contains both 3D trusses and beams, “3D Frame & Shell” model type must be
used and appropriate moment releases assigned.

Model type “2D Truss” may be used to model 2D truss structures in the XY plane.  Only two
DOFs (Dx and Dy) are available to every node in the model.  The rest of the DOFs are

suppressed.  If the model contains both 2D trusses and beams, “2D Frame” model type must
be used and appropriate moment releases assigned.

Model type “2D Plate Bending” may be used to model 2D plate bending structures such as
flat slabs or mat foundations in the XY plane.  It uses only the plate bending action of the shell
formulation.  Only three DOFs (Dz, Dox and Doy) are available to every node in the model. 

The rest of the DOFs are suppressed.  The self weight should be in either –Z or +Z direction
depending on your sign convention for loads.

Model type “2D Plane Stress” may be used to model 2D plane stress structures such as
shear walls in the XY plane.  It uses only the membrane action of the shell formulation.  Only
two DOFs (Dx and Dy) are available to every node in the model.  The rest of the DOFs are

suppressed.

Model type “3D Brick” may be used to model 3D solid structures.  Only three DOFs (Dx, Dy,

Dz) are available to every node in the model.  The rest of the DOFs are suppressed.

Non-linear convergence control includes the maximum iterations and axial force tolerance
between adjacent P-Delta iterations.  The maximum iterations apply to both P-Delta analysis
and analysis involving non-linear springs.  It is provided to avoid excessive number of
nonlinear iterations during the solution.  A default value of 10 is usually sufficient.  Axial force
tolerance between adjacent P-Delta iterations reflects the actual convergence of the P-Delta
analysis.  The default value of 0.5% should be good for most cases.  It is a good idea to
perform a linear analysis before the P-Delta analysis.  In this way, you may identify any
problems in the model before the more rigorous analysis option is undertaken.

By default, the program considers shear deformations on members in the model.  You must
also set shear areas of member sections for this option to take effect.  To do that, click
Create (or Modify) > Member Properties > Member Sections.  You may ignore member shear
deformations by unchecking “Consider shear deformation on members”.  Generally, shear
deformations on members are insignificant.  However, you should check this option when
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members are of relatively great depths.  Shear deformation, when considered, applies to both
the element stiffness matrix and local (segmental) deflections.

The number of segments for member segmental output may be set from 1 to 127.  A value of
20 segments is recommended in most cases.  More segments produce more accurate
results, but require more usage of computer memory.  The accuracy may be reflected in the
smoothness of moment, shear and deflection diagrams.  Since member local deflection is
computed based on the moment and shear diagrams, a value of more than 20 segments
may be needed if very accurate local deflection is desired.

You may specify whether to use cracked section properties for the analysis.  The cracking
factors are specified in Create (or Modify) > Member Properties > Cracking Factors or
Concrete Design > Cracking Factors.  Cracking factors will not be applied until “Use cracked
section properties (Icr) for members and finite elements” is checked here.  This option is
given so that you do not need to reenter cracking factors if you decide to use gross section
properties in a different analysis run.

Usually, stresses in finite elements are not continuous across element boundary.  You may
average them for adjacent shells/bricks at nodes.  This usually makes the results more
accurate and the contours smoother.  However, it may also disguise insufficient convergence
for an unsatisfactory (coarse) finite element mesh.  Obviously, stress averaging can only
apply to adjacent elements that have compatible local coordinate systems.  For planar
elements, stress averaging should only apply to adjacent elements that share the same local
coordinate systems.  Special attention should be given to shear stress averaging at supports
since shears of adjacent elements may have opposite signs.
 
By default, the program uses the MITC4 for shell bending formulation.  The MITC4 is a thick
plate formulation and accounts for the out-of-plane shear deformation.  However, if the shell
elements are all rectangular, you may use the classical Kirchhoff plate bending formulation. 
The Kirchhoff plate element is a thin plate formulation and ignores the out-of-plane shear
deformation.

For the membrane formulation of the shell element or of the brick element, incompatible
modes may be added to the standard isoparametric (compatible) formulation.  The
incompatible shell element models the in-plane bending more accurately than the standard
compatible element.  The incompatible brick element, which produces much more accurate
results than the compatible one, should almost always be preferred.
 
There are three kinds of solvers available in ENERCALC 3D: 

Double precision 64-bit floating point Skyline solver:  
· standard solver similar to many analysis programs in the market

· enough for most structures

Double precision 64-bit floating point Sparse solver:
· fastest, but lacks informative messages when something goes wrong during a solution

· can only be used for static analysis

· useful to solve extremely large structural models

· offers an out-of-core approach to minimize the requirement of computer memory
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Quad precision 128-bit floating point Skyline solver:
· provides an invaluable alternative for some large or numerically sensitive models where the

64-bit floating point (double precision) solver may fail 
· extremely stable and accurate, but relatively slow

· the recommended solver if the model contains rigid diaphragms to avoid numerical
difficulties.

You have the option to consider rigid diaphragm actions during the solution.  This is useful to
ignore rigid diaphragms without deleting the existing diaphragms.

Static Analysis

Analysis > Static Analysis performs the static analysis of the model.  You should set the
appropriate analysis options before running this command.  To do that, just click Analysis >
Analysis Options.

The following dialog is displayed showing the progress of the solver.

The solver first solves all linear load combinations, then all nonlinear load combinations.  If the
model contains compression-only or tension-only springs, every load combination is a
nonlinear load combination.  Otherwise, only P-Delta load combinations are nonlinear.  The
nonlinear load combinations are solved iteratively and therefore may require considerable
solution time.

You may abort the solving process by pressing ESC if a non-sparse solver is used.
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Frequency Analysis

Analysis > Frequency Analysis prompts you with the following dialog.  

It allows you to set important options before performing frequency analysis on the model.  

The load combination for mass and stiffness must be specified.  If you want to input nodal
mass and/or mass moment of inertia directly, you may do so from Create > Generate Loads
> Additional Masses or Tables > Masses > Additional Masses.  The load combination is also
used to form the correct stiffness matrix if the model response is not linear.

The number of modes is used to determine how many frequencies and mode shapes are to
be computed.  This value must be less than the total number of mass degrees of freedom. 
Practically speaking, only the lowest eigen modes are used for design purposes.

The number of iteration vectors q is normally set as the minimum of (2 * p, p + 8), where p is
the number of modes requested [Ref. 1].  A higher convergence rate can be achieved by
using more iteration vectors.  This may be necessary if some eigen modes are missing after
the solution or if the solution becomes unstable.
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The tolerance of eigenvalues is used to measure the convergence of eigenvalues during each
successive solver iteration.  It is expressed as the following:

 (i = 1, 2, … number of requested modes)

where k is the subspace iteration counter.

A maximum number of subspace iterations is used to prevent excessive solution time.  If the
solver reaches this limit without convergence, the eigen results should not be trusted.

Response Spectrum Analysis

Analysis > Response Spectrum Analysis prompts you with the dialog below.  

It allows you to perform response spectrum analysis in global X, Y and/or Z directions.  There
are three mode combination methods available in the program: CQC (complete quadratic
combination), SRSS (Square root of sum of squares) and ABSSUM (absolute sum). CQC
method for modal combination is applicable to a wider class of structures and is therefore
recommended method.  Critical damping ratio (0 <= damp < 1.0) affects CQC results.  When
critical damping ratio is 0, CQC method is the same as SRSS method.
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You must first run from Analysis > Frequency Analysis prior to running this command. 
Response spectra can be defined from Tables > Response Spectra Library. Inertia forces in
global direction X, Y or/and Z from response spectrum analysis will be calculated and then
converted to nodal loads.  

These nodal forces will be placed in respective load cases such as
INERTIA_LOADCASE_X_MODE_1, INERTIA_LOADCASE_X_MODE_2 etc. Existing
loads in these load cases will be deleted prior to the load conversion.  

In addition, response spectrum load combinations INERTIA_LOADCOMB_X_MODE_1,
INERTIA_LOADCOMB_X_MODE_2 etc. will be created or recreated.  

Static analysis will be performed on spectrum load combinations (as well as normal user-
defined load combinations) automatically.  Modal combinations will be subsequently
calculated for results such as displacements, forces and stresses etc. using CQC, SRSS or
ABSSUM on the response spectrum load combinations. Normally, modal combination results
are all positive due to the sign lost during SRSS, CQC and ABSSUM procedures.  However,
you can choose to use signage for modal combination results based on the dominant mode
(with maximum participation factor) in each global direction.  

Modal combination results is done in each global direction first.  Using directional factors,
these directional modal results will be combined into final modal combination results, which
can be added to any user-defined load combination results if non-zero response spectrum
load factor is specified in the load combination definition (see Loads > Load Combinations).

View Log File

Analysis > View Log File initiates the same command as File > View Log File.

Analysis Results

The Analysis Results ribbon provides commands to view and print analysis results for each
load combination.

Show Results for Selected Entities Only

Analysis Results > Show Results for Selected Entities Only is a toggle to control what is
displayed when results are viewed.

Results Load Combination

Analysis Results > Results Load Combination is a dropdown selector that establishes which
load combination will be used for the display of results.
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Nodal Displacements

Analysis Results > Nodal Displacements displays the following dialog.  

It allows you to view nodal displacements for each load combination.  The displacements for
each node include three translational components Dx, Dy and Dz and three rotational

components Dox, Doy and Doz.  You have the option to view the displacements for the

selected nodes only.

Story Drifts

Analysis Results > Story Drifts displays the following dialog.  

It allows you to view story drifts for each load combination.  You have the option to view the
story drifts for the selected nodes only.
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Support Reactions

Analysis Results > Support Reactions displays the following dialog.  

It allows you to view support reactions for each load combination.  The reactions for each
support include three force components Rx, Ry and Rz and three moment components Rox,

Roy and Roz.  You have the option to view the reactions for the selected supports only.

Nodal Spring Reactions

Analysis Results > Nodal Spring Reactions displays the following dialog.  

It allows you to view nodal spring reactions for each load combination.  The reactions for each
nodal spring include three force components SRx, SRy and SRz and three moment

components SRox, SRoy and SRoz.  You have the option to view the reactions for the

selected nodal springs only.
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Line Spring Reactions

Analysis Results > Line Spring Reactions displays the following dialog.  

It allows you to view line spring reactions for each load combination.  The reactions for each
line spring include three force components SRx, SRy and SRz.  You have the option to view
the reactions for the selected line springs only.

Surface Spring Reactions

Analysis Results > Surface Spring Reactions displays the following dialog.  

It allows you to view surface spring reactions for each load combination.  The reactions for
each surface spring include three force components SRx, SRy and SRz.  You have the

option to view the reactions for the selected surface springs only.
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Multi-DOF Constraint Forces & Moments

Analysis Results > Multi-DOF Constraint Forces & Moments displays the following dialog.  

It allows you to view constraint forces and moments for each load combination.  The value
columns can be either constraint forces (for DOF X, Y and Z) or moments (for DOF OX, OY
and OZ). 

Member End Forces & Moments

Analysis Results > Member End Forces & Moments displays the following dialog.  

It allows you to view forces and moments at the ends of each member for each load
combination.  The end forces and moments include axial force Fx, major shear Fy, minor

shear Fz, torsion Mx, minor moment My, and major moment Mz.  You have the option to view

the end forces and moments for the selected members only.
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Member Segmental Results

Analysis Results > Member Segmental Results displays the following dialog.  

It allows you to view member segmental results for each load combination.  The segmental
results are shown at each segmental point designated by a distance along the member. They
include axial force Fx, major shear Fy, minor shear Fz, torsion Mx, minor moment My, major

moment Mz, major local deflection Dy, and minor local deflection Dz. You have the option to

view the segmental forces and moments for the selected members only.
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Shell Forces, Moments & Stresses

Analysis Results > Shell Forces, Moments & Stresses > Shell Forces & Moments displays
the following dialog.  

It allows you to view shell forces and moments for each load combination.  The shell forces
and moments include in-plane normal forces Fxx, Fyy and shear force Fxy; out-of-plane

bending moments Mxx, Myy, Mxy; and out-of-plane shear forces Vxx, Vyy.  You may specify

the force and moment locations to be at the nodes and/or the center of each shell by running
Settings & Tools > Data Options.  You have the option to view the forces and moments for
the selected shells only.
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Analysis Results > Shell Forces, Moments & Stresses > Shell Principal Forces & Moments
displays the following dialog.  

It allows you to view shell principal forces and moments for each load combination.  The shell
principal forces and moments include in-plane principal forces Fmax, Fmin and the principal

angle F-angle; out-of-plane principal moments Mmax, Mmin and the principal angle M-angle;

out-of-plane principal shear force Vmax and the principal angle V-angle.  You may specify the

principal force and moment locations to be at the nodes and/or the center of each shell by
running Settings & Tools > Data Options.  You have the option to view the principal forces and
moments for the selected shells only.
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Shell Stresses [Top & Bottom]

Analysis Results > Shell Stresses [Top] or Shell Stresses [Bottom] displays the following
dialog.  

It allows you to view shell top or bottom stresses for each load combination.  The shell
stresses include three normal components Sxx, Syy, Szz and three shear components Sxy,

Sxz and Syz.  You may specify the stress locations to be at the nodes and/or the center of

each shell by running Settings > Data Options. You have the option to view the stresses for
the selected shells only.
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Shell Principal Stresses

Analysis Results > Shell Principal Stresses displays the following dialog.  

It allows you to view shell top or bottom principal stresses and Von Mises stresses for each
load combination.  You may specify the stress locations to be at the nodes and/or the center
of each shell by running Settings > Data Options. You have the option to view the stresses for
the selected shells only.
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Shell Nodal Resultants

Analysis Results > Shell Nodal Resultants displays the following dialog.  

It allows you to view shell nodal resultants for each load combination.  The nodal resultants
are concentrated forces and moments at element nodes that keep individual elements in
equilibrium.  They are expressed in the local coordinate system.  You have the option to view
the nodal resultants for the selected shells only.
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Bricks

Analysis Results > Bricks > Brick Stresses displays the following dialog.  

It allows you to view brick stresses for each load combination.  The brick stresses include
three normal components Sxx, Syy, Szz and three shear components Sxy, Syz and Sxz. 

You may specify the stress locations to be at the nodes and/or the center of each brick by
running Settings > Data Options.  You have the option to view the stresses for the selected
bricks only.

Analysis Results > Bricks > Brick Principal Stresses displays the following dialog.  

It allows you to view brick principal stresses and Von Mises stresses for each load
combination.  Brick principal stresses are shown at locations of nodes and/or center of each
shell.  You may control the locations by running Settings > Data Options.  Brick principal
stresses include three principal components S1, S2, S3 and direction vectors (V1x, V1y and

V1z) and (V3x, V3y and V3z).  You have the option to view the principal stresses for selected

bricks only.

Dynamics
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Analysis Results > Dynamics > Eigenvalues displays the following dialog.  

It allows you to view eigenvalues (λ) and their derivatives such as periods (T), frequencies (f),
and circular frequencies (ω ).  In addition, an error measure is calculated for each eigenvalue
according to the following (see Ref. 1):

Error Measure = 

Where is the vector in the matrix corresponding to .

Analysis Results > Dynamics > Eigenvectors displays the following dialog.  

It allows you to view eigenvectors (mode shapes) for each mode of vibration.  It is worthwhile
to point out that eigenvectors are meaningful only in their relative values.
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Analysis Results > Dynamics > Mode Participation Factors displays the following dialog.  

It allows you to view mode participation factors for each mode in global X, Y and Z directions. 
You must perform response spectrum analysis beforehand.

Analysis Results > Dynamics > Modal Displacements SX, SY and SZ displays the following
dialog.  

It allows you to view modal displacements for each mode as well as their SRSS combination
in global X, Y and Z directions. You must perform response spectrum analysis beforehand.
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Analysis Results > Dynamics > Inertial Forces SX, SY and SZ displays the following dialog.  

It allows you to view inertia forces for each mode in global X, Y and Z directions. You must
perform response spectrum analysis beforehand.  Inertia forces are converted to nodal loads
in different inertia load cases automatically during response spectrum analysis. 

Analysis Results > Dynamics > Modal Nodal Displacements displays the following dialog.  

It allows you to view nodal displacements in modal combinations (including directional
combinations). You must perform response spectrum analysis beforehand. 
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Analysis Results > Dynamics > Modal Support Reactions displays the following dialog.  

It allows you to view support reactions in modal combinations (including directional
combinations). You must perform response spectrum analysis beforehand.  

Note: The support reactions do not include multi-DOF constraint forces and moments.

Analysis Results > Dynamics > Modal Nodal, Line, Surface Spring Reactions open dialogs
similar to Modal Support Reactions. You must perform response spectrum analysis
beforehand.  

Analysis Results > Dynamics > Modal Multi-DOF Constraint Forces & Moments displays the
following dialog.  

It allows you to view multi-DOF constraint forces & moments in modal combinations
(including directional combinations). You must perform response spectrum analysis
beforehand.  
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Analysis Results > Dynamics > Modal Member End Forces & Moments displays the following
dialog.  

It allows you to view member end forces and moments in modal combinations (including
directional combinations). You must perform response spectrum analysis beforehand.

Analysis Results > Dynamics > Modal Member Segmental Results displays the following
dialog.  

It allows you to view member segmental results in modal combinations (including directional
combinations). You must perform response spectrum analysis beforehand.

Analysis Results > Dynamics > Modal Shell Forces & Moments displays the following dialog.  

It allows you to view shell forces and moments in modal combinations (including directional
combinations). You must perform response spectrum analysis beforehand.
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Analysis Results > Dynamics > Modal Brick Stresses displays the following dialog.  

It allows you to view brick stresses in modal combinations (including directional
combinations). You must perform response spectrum analysis beforehand. 

Analysis Results > Dynamics > Modal Base Shears displays the following results window. 

It allows you to view modal base shears in X and Z directions. You can compare them with
the base shears computed by equivalent lateral force procedure using relevant code such as
ASCE 7-10. You must perform response spectrum analysis beforehand.  

Base Shears are not computed by the program if the model contains multi-DOF constraints.
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Shear & Moment Diagram

Analysis Results > Shear and Moment Diagram prompts you with the following dialog.  

It allows you to view the member shear (including axial force) diagram or moment (including
torsion) diagram for the selected load combination.  Only one shear or moment diagram for
the selected load combination may be displayed per window.  However, you may display
different shear or moment diagrams in multiple windows.  To open a new window, click
Settings  & Tools > New Window.

You have the option to show values and units for the diagram. You may show diagrams on all
members or on selected members only. You may also erase existing diagrams. By default,
no diagram is displayed even if an analysis has been performed successfully.
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Deflection Diagram

Analysis Results > Deflection Diagram prompts you with the following dialog.  
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It allows you to view the deflected shape of the model for the selected load combination.  The
deflected shape is constructed by adding nodal displacements to nodal coordinates.  For
members, you have the option to show the local y and/or z deflection as well.  You need to
adjust the displacement magnification to view the deflection properly.  The deflection
displayed is for the selected load combination only.  However, you may display deflections for
different load combinations in multiple windows.  To open a new window, click Window > New
Window.  The deflection values and units may be shown for the member local deflections. 
You may choose to have shadows of the undeformed shape and deformed shape hidden.  

You cannot perform mouse selection while the deflected shape is shown.  However, you may
open another window with the undeformed shape and perform mouse selection as usual.

Contour Diagram

Analysis Results > Contour Diagram prompts you with the following dialog.  

It allows you to view a result contour for shells and/or bricks for the selected load
combination.  

Four display modes are available.  They are Iso-Surface and Value, Iso-Surface only, Value
only, None or Erase.  The Iso-Surface provides color bands for the contour component in
different ranges.  The number of ranges (or colors) may be either 16 or 8.  Either top or
bottom stresses may be specified for plate/shell elements.  The Value (the absolute
maximum) of the contour component may be shown for each element.  The contour may be
displayed in colors or gray scale.  The latter is useful for people with color-impaired visions.
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The contour components include:
· nodal displacements (Dx, Dy, Dz, Dox, Doy, and Doz)

· shell bending moments (Mxx, Myy, Mxy) and shears (Vxx, Vyy)

· shell membrane normal forces (Fxx, Fyy) and in-plane shears (Fxy)

· shell and brick stresses (Sxx, Syy, Szz, Sxy, Sxz, Syz)

· surface spring reactions (SRx, SRy, SRz)

· shell principal moments (Mmax, Mmin) and shear (Vmax)

· shell principal membrane forces (Fmax, Fmin) 

· principal stresses (S1, S2, S3) for shells and bricks

· Von Mises stresses for shells and bricks

Only one contour component for the selected load combination may be displayed per window.
 However, you may display different contour components in multiple windows.  To open a new
window, click Settings & Tools > New Window.

Four different modulations may be applied to values of the contour component.  They are
“Positive and Negative”, “Absolute”, “Positive Only”, “Negative Only”.  For example, you may
choose the contour component “Mxx” and the modulation “Negative Only” to view only the
negative moments Mxx of the plates.
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The following screen capture shows a displacement (Dz) contour for a plate, with display

mode “Iso-Surface and Values” and value modulation of “Positive and Negative”.
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Mode Shape

Analysis Results > Mode Shape prompts you with the following dialog.  

It allows you to view a mode shape after a frequency analysis is performed.  You need to
adjust the mode shape magnification to view the deflected shape properly.  Mode shape
diagrams are generated for a single mode; multiple mode shapes can be viewed by using
multiple view windows.  To open a new window, click Settings & Tools > New Window.  

Mode Shape diagrams can be created with the ‘shadow’ of the undeformed shape, allowing
for more concise presentation of the deflected shape.  Like deformation diagrams from static
analyses, the Mode Shape diagrams are ‘locked’ so that the model cannot be edited.  To edit
the model, either remove the diagram or open another window with the undeformed shape
displayed. 

Response Animation

Analysis Results > Response Animation toggles on or off structural responses (such as
deflection, moment shear diagrams or stress contours) animation.  Animation parameters
may be set in Settings & Tools > Preferences.
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Concrete Design

The Concrete Design ribbon provides commands related to concrete design for beams,
columns, and slabs.  This includes tools to input design parameters, execute the design
process and review the design results in graphical and tabular form.

With the exception of the Cracking Factors command, the commands in the Concrete Design
ribbon do not affect the analysis results.  A static analysis must be done successfully before
design can be performed.
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RC Materials

Concrete Design > RC Materials prompts you with the following dialog.  

It allows you to define concrete and reinforcement strength properties for the existing
materials.  The strength properties include: 

· Concrete compressive strength fc

· Concrete reinforcement strength fy

· Concrete stirrup or tie strength fys

If standard materials are used in Create > Materials, these strength properties will be set
automatically.  You may override these properties prior to performing concrete design.  No
concrete design will be performed on a member or shell if its f'c is zero.  You should not
modify materials that are not concrete on this dialog.
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RC Model Design Criteria

Concrete Design > RC Design Criteria prompts you with the following dialog.  

It allows you to enter global options for concrete design.  You are encouraged to read the
method of solution in the technical part of this document in order to understand these options.
 You should use this command before performing concrete design.

Design Code
Specifies design codes.  Currently the program supports ACI 318-
02/05/08/11/14 only.

Column min and max
reinforcement ratios

Column minimum and maximum reinforcement ratios are used to
generate column sections.  They should be set between 1% and
8%.  For all practical purposes, the maximum reinforcement ratio
should be less than 4% to avoid rebar congestion.

Neutral axis steps for
accuracy

Neutral axis steps affect the solution accuracy and speed.  A value
of 250 ~ 500 for neutral axis steps is sufficiently accurate for most
sections.  The adequacy of neutral axis steps can be determined by
smoothness of the P-Mx and/or P-My interaction diagrams.

Biaxial angle steps

Biaxial angle steps affects the solution accuracy and speed.  For
biaxial problems, steps must be multiple of 4.  A value of 16 or 32 is
sufficiently accurate for most sections.  The adequacy of biaxial
angle steps can be determined by smoothness of the Mx-My
interaction diagram.  For uniaxial problems, biaxial angle steps
should always be set to 4.  This will give P-Mx (+) at 0 degree angle,

P-Mx (-) at 180 degrees angle, P-My (+) at 90 degree angle, P-My
(-) at 270 degrees angle.  
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Design Code
Specifies design codes.  Currently the program supports ACI 318-
02/05/08/11/14 only.

Axial capacity steps for
display

Specifies the number of axial steps for the display of interaction
diagrams / surfaces and result data in the spreadsheet.  This value
should be smaller than neutral axis steps.  A value of 20 to 50 is
usually adequate.

Exclude concrete
displaced by steel

Should almost always be checked.  This option is provided for
verifications with textbooks only!

Always use 1.0 for Cm

If this option is checked, Cm = 1.0 will be used for all concrete
columns.  Otherwise, the program will compute Cm automatically
based on moment curvature and the existence of transverse
loading on the column.

Sustained load
combination for

computing Beta-d in
columns

Specify the load combination that contains the all sustained load
cases with each case load factor equal to 1.0.

Ignore compressive
force in concrete shear

capacity

Specify whether or not to ignore the increase in column concrete
shear capacity due to the influence of compressive force.  Axial
forces are ignored on concrete beams.

Check capacity at
column ends only

If this option is checked, column capacity is checked at its ends
only.  Otherwise, column capacity is checked at every station along
the column that analysis outputs. 

Compute minimum
moment

If this option is checked, a minimum moment Pu * (0.6 + 0.03h) is
used for design

Automatically compute
support widths

Select this option so that flexural design starts at the support faces
and shear design starts at a distance of ‘d’ from the face of support.

Slab/plate min. reinf.
ratios

Specify slab/plate minimum top and bottom reinforcement ratios for
design.  According to ACI 318-02/05/08/11 7.12.2.1, area of
shrinkage and temperature reinforcement shall provide at least
0.18% of gross concrete area.
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RC Design Criteria

Concrete Design > RC Design Criteria > RC Beam Design Criteria prompts you with the
following dialog.  

It allows you to define and/or assign different design criteria to selected concrete beams.  An
ID is assigned automatically to each design criterion by the program and may not be
changed.  You may assign a label with 127 maximum characters to each design criterion for
easy identification.  The beam design criteria include: 

· Number of stirrup legs.

· Stirrup bar size.

· Bottom and top concrete covers measured from section edge to the centroid of
longitudinal bars.

You may add one or more criteria by clicking the “New Rows” button.  You may also print all
design criteria in the list by clicking the “Print” button.  The “Assign active criteria to selected
members checkbox may be used to assign the active beam design criterion to selected
beams.  The active criterion refers to the one that currently has focus in the list in the dialog. 
In order for beam design criteria assignments to take place, beams must be selected
beforehand.

The program always has a default beam design criterion labeled “Default”.  You may not
delete this criterion or change its label.  You may however change its properties.
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Concrete Design > RC Design Criteria > RC Column Design Criteria prompts you with the
following dialog.  

It allows you to define and/or assign different design criteria to selected concrete columns. 
An ID is assigned automatically to each design criterion by the program and may not be
changed.  You may assign a label with 127 maximum characters to each design criterion. 
The column design criteria include:

· Sway flags in x and y directions.

· Unbraced lengths in x and y directions.  You may enter zero if you want the program to
use the member lengths as the unbraced lengths.

· Effective length factors in x and y directions.

· Number of tie legs.

· Tie bar size. 

· Concrete cover to the outside surface of ties.  Since different longitudinal bar sizes
may be used during automatic section generation, the program computes concrete
cover to bar center based on the following formula: “cover to tie” + “tie diameter” + one
half of “longitudinal bar diameter”  Note:  This is different from concrete cover for
beams.

· Start and end bar trial sizes for section generation.

· Bar layout:
All Patterns: Patterns will be tried with bars placed on Major Sides, Minor Sides, and
Equal Sides of the section as described below.
Major Sides: Bars will be placed only on the sides parallel to the section major axis.
Minor Sides: Bars will be placed only on the sides parallel to the section minor axis.
Equal Sides: Bars will be distributed equally on all sides.

· Confinement: Confining reinforcement can be either tied or spiral.  Spiral applies to
circular sections only.
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You may add one or more criteria by clicking the “New Rows” button.  You may also print all
design criteria in the list by clicking the “Print” button.  The “Assign active criteria to selected
members” checkbox may be used to assign the active column design criterion to selected
columns.  The active criterion refers to the one that currently has focus in the list in the dialog.
 In order for column design criteria assignments to take place, columns must be selected
beforehand.

The program always has a default column design criterion labeled “Default”.  You may not
delete this criterion or change its label.  You may however change its properties.
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Concrete Design > RC Design Criteria > RC Plate Design Criteria prompts you with the
following dialog.  

It allows you to define and/or assign different design criteria to selected concrete plates.  An
ID is assigned automatically to each design criterion by the program and may not be
changed.  You may assign a label with 127 maximum characters to each design criterion. 
The plate design criteria include: 

· Bottom-x, bottom-y, top-x and top-y concrete covers measured from plate edge to the
centroid of bars 

You may add one or more criteria by clicking the “New Rows” button.  You may also print all
design criteria in the list by clicking the “Print” button.  The “Assign active criteria to selected
shells” checkbox may be used to assign the active plate design criterion to selected plates. 
The active criterion refers to the one that currently has focus in the list in the dialog.  In order
for plate design criteria assignments to take place, plates must be selected beforehand.

The program always has a default plate design criterion labeled “Default”.  You may not delete
this criterion or change its label.  You may however change its properties.
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Exclude Concrete Elements

Concrete Design > Exclude Concrete Elements prompts you with the following dialog.  

It allows you to include or exclude concrete design for selected beams, columns, and plates. 
For example, you might want to exclude some plate elements (such as those near supports)
from concrete design where large stress spikes are present.  Plate envelope contours do not
include the excluded shell elements.  This makes the contour bands appear more distinct
from each other.
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Cracking Factors

Concrete Design > Cracking Factors prompts you with the following dialog.  

This command is also available from Create (or Modify) > Member Properties > Cracking
Factors.  It allows you to assign cracking factors to selected beams, columns, and plates. 
Cracking factors apply only to bending stiffness of members and shell elements.  

Note:  Cracking factors are not considered by the program unless you check the option “Use
cracked section properties (Icr) for members and finite elements” in Analysis > Analysis
Options. Analysis results are cleared after assignment of cracking factors.



Calculation Modules 428

© 2024  ENERCALC, LLC

RC Design Properties

Concrete Design > RC Design Properties > RC Beam Design Properties prompts you with
the following dialog.  

It allows you to continuously assign concrete beam design properties to members.  After
clicking “Assign”, you can start to continuously assign concrete beam design properties by
window-selecting members until you right click the mouse or press the ESC key.
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Concrete Design > RC Design Properties > RC Column Design Properties prompts you with
the following dialog.  

It allows you to continuously assign concrete column design properties to members.  After
clicking “Assign”, you can start to continuously assign concrete column design properties by
window-selecting members until you right click the mouse or press the ESC key.
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Concrete Design > RC Design Properties > RC Plate Design Properties prompts you with
the following dialog.  

It allows you to continuously assign concrete plate design properties to shells.  After clicking
“Assign”, you can start to continuously assign concrete plate design properties by window-
selecting shells until you right click the mouse or press the ESC key.
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RC Member Input

Concrete Design > RC Member Input prompts you with the following dialog.  

It allows you to enter beams and columns for concrete design in a spreadsheet.  Each
element includes the class (“B” for beam, “C” for column), design criteria ID, cracking factor,
and exclusion design flag (0 for included, 1 for excluded). The element cracking factor with a
value between 0 (fully cracked) and 1 (uncracked) applies to the moments of inertia of
member elements.  You may not modify the member ID.  Design criteria IDs must be valid
(defined).  Beam and column design criteria dialogs are provided for you to correctly pick and
apply proper element class and design criteria to selected members.
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RC Plate Input

Concrete Design > RC Plate Input prompts you with the following dialog.  

It allows you to enter plates for concrete design in a spreadsheet.  Each element includes
design criteria ID, cracking factor, and exclusion design flag (0 for included, 1 for excluded).
The element cracking factor with a value between 0 (fully cracked) and 1 (uncracked) applies
to the moments of inertia of member elements. You may not modify the plate (shell) ID. 
Design criteria IDs must be valid (defined).  Plate design criteria combo box is provided for
you to correctly pick and apply proper element design criteria to selected shells.

Perform Concrete Design

Concrete Design > Perform Concrete Design performs the concrete design based on the
design criteria and design input.  You must run the analysis successfully prior to running this
command.
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Concrete Design Output

Concrete Design > Concrete Design Output > RC Analysis Envelope displays the following
dialog.  

It allows you to view the negative and positive moment envelope as well as the shear
envelope for concrete design.  You have the option to view the envelope for the selected
beams/columns only.  

Note: The envelope only considers the load combinations that are designated for concrete
design.

Concrete Design > Concrete Design Output > RC Beam Results displays the following
dialog.  

It allows you to view top and bottom required steel for flexure and their corresponding design
moments at every analysis output station along the member.  You have the option to view the
RC beam results for the selected beams only. 
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Concrete Design > Concrete Design Output > RC Column Results displays the following
dialog. 

It allows you to view the final column design sections and their capacity ratios.  Some
intermediate results such as moment magnification factors (labeled "Mz-Factor" and "My-
Factor"), Beta-d and Cm’s are output as well.  You have the option to view the RC column
results for the selected columns only.

Concrete Design > Concrete Design Output > Member Shear Results displays the following
dialog.  

It allows you to view the required stirrup (tie) spacing for concrete beam and column shear
design.  You have the option to view the shear design results for the selected beams and
columns only.
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Concrete Design > Concrete Design Output > Wood-Armer Moments displays the following
dialog.  

It allows you to view the critical Wood-Armer moments (top and bottom, local-x and local y
directions) and the corresponding load combinations for concrete plates (shells).  These
moments are used directly in computing the required plate reinforcement areas.  You have
the option to view the Wood-Armer moments for the selected plates only.

Concrete Design > Concrete Design Output > RC Plate Results displays the following dialog.
 

It allows you to view the required plate reinforcement areas (top and bottom, local-x and local
y directions) and the corresponding Wood-Armer moments for concrete plates (shells).  You
have the option to view the plate design results for the selected plates only.

Flexural/Axial Interaction
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Concrete Design > Flexural/Axial Interaction > Sections displays all column sections
generated by the program based on the input of material, section and column design criteria. 



ENERCALC SEL437

© 2024  ENERCALC, LLC

Concrete Design > Flexural/Axial Interaction > P-Mx (+) displays the P-Mx result data in a

spreadsheet, with positive moment about the section major axis (at biaxial angle of 0
degree). 

Concrete Design > Flexural/Axial Interaction > P-Mx (-) displays the P-Mx result data in a

spreadsheet, with negative moment about the section major axis (at biaxial angle of 180
degrees). 

Concrete Design > Flexural/Axial Interaction > P-My (+) displays the P-My result data in a

spreadsheet, with positive moment about the section minor axis (at biaxial angle of 90
degrees). 

Concrete Design > Flexural/Axial Interaction > P-My (-) displays the P-My result data in a

spreadsheet, with negative moment about the section minor axis (at biaxial angle of 270
degrees). 

Concrete Design > Flexural/Axial Interaction > P-Mx-My displays the P-Mx-My result data in a

spreadsheet at each biaxial angle step and axial capacity step.
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Concrete Design > Flexural/Axial Interaction > Print Diagrams allows you to view and print the
interaction diagrams for each column section.  
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The red and blue lines are the interaction diagrams about section major and minor axes
respectively.  A sketch of the section and the key control points are listed above the diagrams
as well.

Concrete Design Diagrams

Concrete Design > Concrete Design Diagrams > RC Member Envelope Diagram displays
the following dialog.  

It allows you to view the required flexural reinforcement as well as the moment and shear
envelope used for designing concrete beams.  It also allows you to view required stirrup or tie
spacing for concrete beams and columns. You have the option to view the member envelope
diagrams for the selected members only.
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Concrete Design > Concrete Design Diagrams > RC Plate Envelope Contour displays the
following dialog.  

It allows you to view the required flexural reinforcement as well as the Wood-Armer moments
(top and bottom, local x and y directions) for concrete plates (shells).  You have the option to
view the plate envelope contours for the selected plates only.
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Concrete Design Tools

Concrete Design > Concrete Design Tools > Rebar Database displays the following dialog.

It allows you to select different rebar databases for use in concrete design.
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Concrete Design > Concrete Design Tools > K Calculator allows you to accurately calculate
effective length factors (braced and unbraced Ks) based on the beam and column relative
stiffness input.
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Concrete Design > Concrete Design Tools > Quick R-Beam Flexural Design allows you to
quickly design a rectangular concrete beam according to ACI 318-02/05/08/11/14.  

Minimum reinforcement may be optionally computed.  You have the option to design the
rectangular beam as singly or doubly reinforced.  A negative reinforcement area means the
design fails.
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Concrete Design > Concrete Design Tools > Quick T-Beam Flexural Design allows you to
quickly design a concrete tee beam according to ACI 318-02/05/08/11/14.

Minimum reinforcement may be optionally computed.  The tee beam is always designed as
singly reinforced.  A negative reinforcement area means the design fails.

Unity Check

Concrete Design > Unity Check displays a graphical result of the pass/fail status of all
designed members.  Passing members are highlighted in blue.  Failing members are
highlighted in red.

Steel Design

The Steel Design ribbon provides commands related to steel design for beams and columns.
 This includes tools to input design parameters, execute the design process and review the
design results in graphical and tabular form.

The commands in the Steel Design ribbon do not affect the analysis results.  A static analysis
must be done successfully before design can be performed.
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Steel Materials

Steel Design > Steel Materials prompts you with the following dialog.  

It allows you to define steel strength properties for the existing materials.  The strength
properties include: 
· Steel yield stress Fy

· Steel rupture stress Fu

If standard materials are used in Tables > Material Data, these strength properties will be set
automatically.  You may override these properties prior to performing steel design.  No steel
design will be performed on a member if its modulus is not close (within 10%) to 29E3 ksi. 
You should not modify materials that are not steel on this dialog.
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Steel Design Criteria
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Steel Design > Steel Design Criteria > Steel Design Criteria prompts you with the following
dialog.

Use Direct Design Method currently only affects how the moment magnification factor B1 is
calculated. You also have the option not to consider moment magnification factor B1
altogether.  Please be advised that P-Delta analyses should be performed on load
combinations that are used for steel design.

To be conservative, you can always use 1.0 for Cm that accounts for nonuniform moment. 
Uncheck the Always use 1.0 for Cm” if you would like the program to calculate Cm for
automatically.

You have the option to only use sections defined in Design > Steel Section Pool during the
design process.  This is useful if you do not want the program to use too many steel section
sizes for the entire model.

Connector distance for double angles is used for sections that are double angles.

The default number of section candidates designed for each member is 10.

You can also specify limits for total load deflection and live load deflection.
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Steel Design > Steel Design Criteria > Steel Member Design Criteria prompts you with the
following dialog.  

It allows you to define and assign design criteria for members.

An ID is assigned automatically to each design criterion by the program and may not be
changed.  You may assign a label with 127 maximum characters to each design criterion.  
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The column design criteria include:

· Section Prefix, which is a comma delimited list.  For example, if you want the member
section to be with W10 or W12 size, enter the prefix as “w10,w12”.  You also specify the
prefix as the exact AISC shapes.  Use the prefix “Default” if you do not want the member
section changed from the original shape.

· Sway flags in x and y directions.

· The length between points that are braced against lateral displacement of compression
flange Lb.  Currently, the program only supports equal Lb along the member length.  For
non-continuously braced, the program will use the member length for Lb if the value is
entered 0.  For continuously braced, 0 must be entered for Lb.

· Lateral-torsional buckling modification factor for nonuniform moment diagrams Cb.  The
program will automatically calculate Cb if the value is entered 0.  You can always use Cb =
1.0 for conservative reasons.

· Unbraced lengths in x, y and z directions.  You may enter zero if you want the program to
use the member lengths as the unbraced lengths.

· Effective length factors in x, y and z directions.

· You have the option to set the maximum capacity ratio.  By default, this ratio is 1.0.  You
can set a value less than 1.0 (but greater than 0.0) for conservative reasons.
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Steel Design > Steel Design Criteria > Steel Section Pool prompts you with the following
dialog.  

It allows you to define a list of sections that may be used exclusively for design.

You can copy a list of section labels from the AISC table.  You can also enter sections
manually.  Each line in the section pool box can only contain one section.  Furthermore, you
can automatically add all the section candidates to the section pool (from Design > Steel
Design Results).
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Steel Design > Steel Design Criteria > Exclude Steel Elements prompts you with the following
dialog.  

It allows you to include or exclude steel design for selected members.  

Steel Member Design Properties

Steel Design > Steel Member Design Properties prompts you with the following dialog.  

It allows you to continuously assign steel design properties to members.  After clicking
“Assign”, you can start to continuously assign steel design properties by window-selecting
members until you right click the mouse or press the ESC key.
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Steel Member Input

Steel Design > Steel Member Input prompts you with the following dialog.  

It allows you to enter members for steel design in a spreadsheet.  Each element includes the
design criteria ID, and exclusion design flag (0 for included, 1 for excluded).  You may not
modify the member ID.  Design criteria IDs must be valid (defined).  Steel design criteria
combo box is provided for you to correctly pick and apply proper steel design criteria to
selected members.
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Perform Steel Design

Click Steel Design > Perform Steel Design to initiate a Steel Design process.  (Static analysis
results must be current in order to run a steel design.)  

The message box will indicate when the design is complete.
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Steel Design Results

Steel Design > Steel Design Results allows you to view the steel design results.  

It also allows you to update member sections.  

The section column in the screen capture above includes a list box that contains the member
original section (first entry in the list box) and designed section candidates (second or more
entries in the list box).  You can change the member sections by picking the proper section
candidates. Please be advised you need to re-analyze and design after one or more member
sections are updated.

In addition, you can add all the section candidates to Section Pool, which can be used in the
next round of design.

Finally, you can view the detailed calculation procedure for each member for the most critical
load condition.
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Steel Design Tools

Steel Design > Steel Design Tools > K Calculator offers a tool to calculate the K value of
columns by entering the ratios of the sum of the EI/L values at the top and bottom of the
column segment.

Steel Design > Steel Design Tools > Steel Section Check allows you to perform steel section
capacity check.

Lux, Luy and Luz are unbraced lengths in local x, y and z directions.  Kx, Ky and Kz are
unbraced length factors in local x, y and z directions.

Lb is the unbraced lateral length.  Cb is the lateral-torsional buckling modification factor for
non-uniform moment diagrams.  It should be greater or equal to 1.0.  You can use 1.0 for Cb
conservatively.

Connector Distance is used for double angles only.

Pu, Mux, Muy, Vux, Vuy are required axial, major moment, minor moment, major shear and
minor shear.  For Pu, the compressive force is positive while tensile force is negative. 
Moment Mux is positive when section top most fiber is under compression. Moment Muy is
positive when section rightmost fiber is under compression.  Moment magnification may be
optionally considered to account for the P-delta (P-δ) effect.
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If direct design method is chosen, the program will calculate stiffness reduction parameter
based on Eq. C2-2a and C2-2b of the code.

Cmx, Cmy are coefficients accounting for non-uniform moments when computing moment
magnification.  You can use 1.0 for Cmx and Cmy conservatively.  If Cmx or Cmy is 0, 1.0 is
used in the computation instead.

Results include axial capacity (phi-Pn), moment capacity (phi-Mnx, phi-Mny), shear capacity
(phi-Vnx, phi-Vny), moment magnification factors (B1x, B1y) and critical ratio.  The section is
deemed safe to resist a load if the critical ratio is less than 1.0, otherwise, the section is
deemed unsafe.  Please note that for single angle, the moment capacity is given about the
principal axes (w-w and z-z).
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Steel Design > Steel Design Tools > Steel Section Design allows you to quickly design steel
sections against a set of load effects.  The Section Design input and output are shown below:

For Section Filter Criteria, you can use either Section Prefixes or section dimension limits (but
not both).  The section prefixes is a comma delimited list such as W12, W14.  If section
prefixes is used, the section dimension limits will be ignored.  If a section dimension limit is
zero, then that limit criteria is ignored.

By default, a maximum of ten section candidates will be provided after a successful design. 
You can then view the detailed check for each of the section candidate.

Unity Check

Steel Design > Unity Check displays a graphical result of the pass/fail status of all designed
members.  Passing members are highlighted in blue.  Failing members are highlighted in red.

Reporting

The Reporting ribbon provides access to tools for creating printed reports.
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Print Text Report

Reporting > Print Text Report allows you to preview and print a report for the model using the
current report configuration options.

Print Envelope Report

Reporting > Print Envelope Report allows you to print enveloped diagrams of multiple load
combinations on members.  You may give a name to the type of envelope.  You have the
option to print an envelope report on selected members only.  Two charts are printed on each
page.  You have the option to select the diagram type for each chart.  For example, you may
select the major moment Mz diagram for chart one and the major shear Vy diagram for the
second chart.
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Print Current View

Reporting > Print Current View allows you to preview and print the current model view.

Print Options

Reporting > Print Options prompts you with the following dialog.  

It allows you to generate a report for input and/or output data in html file format.  

The command provides different options to control the contents of the report.  For example,
you may generate a report for selected nodes or elements only. After clicking the OK button,
the graphical report will be displayed in a report view within the web browser.  You may then
print the report to a PDF file.
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Print RC Report

Reporting > Print RC Report displays the following dialog.  

It allows you to print concrete design report on beams and columns.   You have the options to
include flexural design for concrete beams, axial-flexural design for concrete columns as well
as shear design for concrete beams and columns.  You also have the option to print the
report on selected members only.  
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The following figure shows the print preview for a column axial-flexural design report.
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Print Steel Design Report

Reporting > Print Steel Design Report is the same command as Design > Steel Design
Results.

Settings & Tools

The Settings & Tools ribbon provides commands related to settings for model data and
graphical entities in model views.  Some of these settings may be applied beyond the current
model, that is, they may be saved for use in future models.

New Window

Settings & Tools > New Window creates a new window or view based on the current view. 
You may create different model views with different display settings with respect to zooming,
panning, loading diagram, shear or moment diagrams, contours, etc.  For example, you may
have one model view to display moment diagram, another view to display shear diagram. 
You may create as many views as you want.  However, too many views may clutter the view
area and make graphic display sluggish.

Tile Horizontal

Settings & Tools > Tile Horizontal arranges all opened windows horizontally.

Tile Vertical

Settings & Tools > Tile Vertical arranges all opened windows vertically.

Cascade

Settings & Tools > Cascade arranges all opened windows in an overlapped manner. 

Clear Undo & Redo

Settings & Tools > Clear Undo & Redo clears the undo/redo buffer, thus frees up computer
memory.  It is a good idea to use this command before the solution so that more memory
may be committed to the solver.

Clear Results

Settings & Tools > Clear Results clears all results from computer memory.  You need to re-
solve the model to obtain new results.

Clear Everything

Settings & Tools > Clear Everything clears all input and output (results) data from computer
memory.  You should think twice before running this command.
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Unit Conversion

Settings & Tools > Unit Conversion displays a tool for conversion between various units.

Calculator

Settings & Tools > Calculator displays the Windows Calculator.

Text Editor

Settings & Tools > Text Editor displays the Windows Notepad.

Copy Command History

Settings & Tools > Copy Command History copies the history in the command window to the
clipboard.  You may then paste the command history content to a text editor using Ctrl + V.  A
command history is associated with each open document.

Clear Command History

Settings & Tools > Clear Command History clears the history in the command window.  You
may want to copy the command history before running this command.
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Toolbar

Settings & Tools > Toolbar toggles the display of the Input/Output Data toolbar.
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Units & Precisions

Settings & Tools > Units & Precisions prompts you with the following dialog.  

You may select different units and precisions for various physical measurements used in the
model.  You may use this command as many times as you like.  You may convert existing
data associated with a unit in the model by checking or unchecking the check box to the right
of that unit.  For example, if you mistakenly enter all nodal coordinates in a wrong length unit,
you may select the correct length unit and uncheck the conversion checkbox to correct nodal
coordinate input.

Default English and Default Metric let you quickly set predefined units commonly used for the
imperial or metric system.  Consistent English and Consistent Metric buttons let you set
predefined consistent units for the imperial or metric system.  In a consistent unit system,
units for the same type of physical measurements are the same.  For example, units for both
length and dimension are the same, which is inches for imperial system and meters for
metric system.  

You may set the precision for each unit in either decimal or scientific format.  Precision
settings are used in displaying data in spreadsheets, diagrams, and reports. 
 
By checking “Save as defaults for future use”, units will be remembered for use in future
models.  It is a good idea to also save graphic scales at the same time.  To do that, just click
Settings & Tools > Graphic Scales. 
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Data Options

Settings & Tools > Data Options prompts you with the following dialog.  
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Distance tolerance is used for distance comparisons in certain commands such as Modify >
Merge All Nodes & Elements and Modify > Split Members.  Distances less than distance
tolerance are considered zero by the program.  

The “Undo/redo levels” sets the maximum undo/redo levels which the program will perform. 
The program requires extra computer memory for each undo/redo level.  The default undo
levels setting is 100.  Depending on your computer memory and model sizes, you may want
to set undo levels to be smaller.

Round-off epsilon is used to truncate floating point numbers such as those found in results. 
For example, a fixed support may have a displacement of 1.077e-10 when in fact it should
zero.  A round-off epsilon of 1e-9 will do just that.  

Stresses are computed at the center and at the nodes of finite elements such as shells or
solids.  However, you may request the program to show stresses at the finite element center
only, nodes only, or both. The checkbox “Show only selected entities in spreadsheet”
determines if all or selected nodes, elements and their dependents will be shown in the
spreadsheet.  By checking this checkbox, you may easily query selected entities in a large
model.  It is important to point out that data in some input spreadsheets may not be modified
when this option is checked.  The checkbox “Save results when the document is saved” gives
you the option to save results (when available) to a file when the model input data is saved. 
The result file is a binary file and has the same file name as model input file, but with an
extension of “rst” (static results) or “dyn” (dynamic results).  The result file could be much
larger than the model input file.

The fictitious oz stiffness factor is used to multiply the minimum of diagonal terms (excluding
oz) in the shell stiffness matrix to construct the fictitious oz stiffness terms.  The smaller this
factor, the more accurate the solution, especially for very thin and doubly curved shells.  The
valid range for this factor is [1e-12, 1e-3].  You normally do not need to change its default
value (1e-7).  Numerical difficulties may arise during solution if this value is set too small.

The diaphragm stiffness factor is used to control the diaphragm rigidity.  The larger this factor,
the more rigid the diaphragm action is. The valid range for this factor is [0, 1e20].  The default
value is 1e4.  Numerical difficulties may be present during static or frequency analysis if the
diaphragm stiffness factor is set too large (say 1e13 for 64-bit floating point solver).  It is
generally recommended to use 128-bit floating point solver to avoid the aforementioned
problem.
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Graphic Scales

Settings & Tools > Graphic Scales prompts you with the following dialog.  

You may set scales for graphical entities such as loads, nodes, supports etc.  By “Save as
defaults for future use”, these scales will be saved for future use.  It is a good idea to save
units at the same time.  To do that, click Settings & Tools > Units & Precisions.
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Colors

Settings & Tools > Colors prompts you with the following dialog.  

It allows you to set colors of different graphical entities in the model.  You may modify the
color(s) of one or more items at a time.  By checking “Use color cues for different materials”,
concrete, steel and wood materials will show different colors in rendering mode.

By checking “Use white background for image captures”, a white background will be used for
the captured image even if a different background color is used in the model views.  This
option will reduce the amount of ink required to print the images. Color settings can be
optionally saved for future use.
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Preferences

Settings & Tools > Preferences prompts you with the following dialog.  

The “Automatic file backup period” determines how frequently the model files are saved
automatically.  Enter 0 for no auto-saves.

Settings for “Response Animation” can be set here.  You may activate the Response
Animation command from the Analysis Results ribbon after an analysis has been performed
successfully.

You have the options to lock the model after analysis is performed successfully.  By default,
an internal HTML viewer is used to view text and graphical reports.  

By default, rubber-banding is enabled while drawing beams, shells or bricks.  You may want
to disable this feature if your computer graphic card is not fully OpenGL compatible.

Additional settings related to the font for graphics and the spreadsheet appearance are
available.

When the sparse solver is used for static analysis, you may choose an out-of-core approach
so computer memory usage is minimized.  You may specify the maximum amount of
memory to be used in the out-of-core sparse solver.  This value should be smaller than the
physical memory available in your system.  
 
Preferences are always saved for future use.
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Help

The Help ribbon provides access to user's manuals, tech support, training materials and
reference info.

Online User's Manual

Help > Online User's Manual opens an online version of the ENERCALC 3D User's Manual.

User's Manual PDF

Help > User's Manual PDF opens a PDF version of the ENERCALC 3D User's Manual.

Technical Support

Help > Technical Support opens a form to submit a support request.

Upload Model to Support

Help > Technical Support opens a form to upload a model for a technical support question.

Online Training Manual

Help > Online Training Manual opens an online version of the ENERCALC 3D Training
Manual.

Training Manual PDF

Help > Training Manual PDF opens a PDF version of the ENERCALC 3D Training Manual.

Training Videos

Help > Training Manual PDF opens a list of links to training videos.

Verification Manual

Help > Verification Manual provides a link to the verification manual for ENERCALC 3D.

Release Notes

Help > Release Notes provides technical details on the various releases of ENERCALC 3D.

About ENERCALC 3D

Help > About ENERCALC 3D indicates the build number of the current release of
ENERCALC 3D.
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Sign Conventions

Help > Sign Conventions > Beam Forces & Moments displays the beam sign conventions
portion of the user's manual.
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Help > Sign Conventions > Shell Forces & Moments displays the shell sign conventions
portion of the user's manual.
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13.2.1.6   Toolbars

Input/Output Toolbar

Settings > Toolbars > Input/Output Toolbar shows or hides the toolbar that contains input and
output buttons.  They are an alternate way to open the named tables or forms.
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Status Bar

Settings > Toolbars > Status Bar shows or hides the status bar at the bottom of the screen.

1: Currently selected command
2: Type of model
3: Cursor coordinates (when cursor is on a grid point)
4: Current Load Combination
5: Solution status 

13.2.1.7   Coordinate Systems

Two kinds of coordinate systems are used in the program, namely, the global coordinate
system and the local coordinate system.  The global coordinate system is the one and only
fixed Cartesian system in a structural model.  The local coordinate system applies to each
individual member or finite element.

Global Coordinate System

The global coordinate system is a fixed Cartesian system that is used for entire model.  The
three axes are denoted by capital letters X, Y and Z.  They follow the right-hand rule.  By
default, that is, when a model is not rotated for viewing purpose, the X axis points from left to
right (horizontal), the Y axis points from bottom to top (vertical), and the Z axis points from
screen to out of screen (perpendicular to screen).

The global coordinate system is used in the following input:
- nodal coordinates, nodal loads
- degrees of freedom related to nodes, supports and springs 
- self weights
- point, line, and surface loads on members and finite elements [may also be specified in the

element local coordinate system]

The global coordinate system is used in the following output:
- nodal displacements
- support and spring reactions
- brick stresses

Local Coordinate Systems - General

Each member or finite element has a local coordinate system.  It is a Cartesian system that
has a default orientation (when local angle equals 0) and may be changed at any time. The
three axes are denoted by small letters x, y, z.  They follow the right-hand rule.

The local coordinate system exists to facilitate input and output for member and finite
elements.  For example, point or line loads on a member may be most conveniently specified
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in the local coordinate system of the member.  The element results such as shears and
moments are output in the local coordinate system for design purposes.  

Since the local coordinate systems directly affect input and results, it is always prudent to
check them for correctness using the commands such as View > Annotate or Render.  You
may change the local coordinate systems using the commands such as Edit > Element
Local Angle or Reverse Node Order for Selected Elements.  It is the directional vectors that
matter...the origin of the local coordinate system is insignificant in this program.

The local coordinate system is used in the following input:
- point, line, and surface loads on members and finite elements [may also be specified

in the global coordinate system]
- member moment releases

The local coordinate system is used in the following output:
- member forces, moments, and local deflections
- shell forces, moments, and stresses

In the following sections, Vx, Vy and Vz (with lowercase subscripts) represent the local x, y,

and z vectors respectively.  VX, VY and VZ (with uppercase subscripts) represent the global

X, Y, and Z vectors respectively.  For vector algebra, please refer to relevant math textbooks. 

Member Local Coordinate System

The local coordinate system of a member is determined by the start and end nodes, and an
element local angle.  The default (local angle equals 0 degrees) local coordinate system of a
member is defined using the following procedures:

Steps Description Mathematical Notations

A Vx points from node 1 (N1) to node 2 (N2) Vx = N2 – N1

B1 For vertical members:
Vz is always parallel to VZ

For vertical members
Vz = VZ

B2
For non-vertical members:

Vz is perpendicular to a plane formed by Vx and VY

For non-vertical
members 

Vz = Vx x VY

C Vy is determined based on Vx and Vz and the right-

hand rule
Vy = Vz x Vx
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For a member with a non-zero local angle (γ), first follow the procedures above that
determine the default local coordinate system.  Then rotate the default system a γ angle about
its local x vector Vx.  The rotated Vx, Vy and Vz define the local coordinate system. The figure

below shows the local coordinate systems of some members with different local angles (γ).

Local coordinate systems for members with different local angles
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Four-Node Shell Local Coordinate System

The local coordinate system of a shell is determined by its four nodes, and an element local
angle.  The default (local angle equals 0 degrees) local coordinate system of a four-node shell
is defined based on the shape of the shell element.

Rectangular Shell Non-Rectangular Shell

For rectangular shells, the default local coordinate system is easily defined by the following:
local x points from N1 to N2, local y points from N1 to N4 and local z is perpendicular to the
shell surface.

For non-rectangular shells, the default local coordinate system is defined using the following
procedures:
 

Steps Description Mathematical Notations

A Local z is perpendicular to the shell surface

Let V1 = N2 – N1, 

Let V2 = N4 – N1

Vz = V1 x V2

B1
For horizontal shells that are parallel to global

XZ plane, local x is parallel to global X
For horizontal shells 

Vx  =  VX

B2
For non-horizontal shells, Vx is perpendicular to

a plane formed by VY and Vz 

For non-horizontal shells 
Vx = VY x Vz

C
Vy is determined based on Vx and Vz and the

right-hand rule
Vy = Vz x Vx
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For a shell with a non-zero local angle (γ), first follow the procedures above that determine the
default local coordinate system.  Then rotate the default system a γ angle about is its local z
vector Vz.  The rotated Vx, Vy and Vz define the local coordinate system.  The figure below

shows the local coordinate systems of some shell elements with different local angles (γ)

Local coordinate systems for shells with different local angles

Eight-Node Brick Local Coordinate System

The local coordinate system for a brick element is always identical to the global coordinate
system.  It is fixed and cannot be changed. 

13.2.1.8   Nodes

Nodes are numbered points in space.  They are used to define the geometry and connectivity
of all members and finite elements in a model.  For members, a node is sometimes referred
to as a joint, which has a physical meaning of the intersection of two members such as a
beam and a column.  However, in this program, the term “node” is generally preferred
because it carries a more general meaning.

Nodal Coordinates

The location of a node is defined by the global X, Y, and Z coordinates.  Since each member
or finite element connects to two or more nodes, nodal coordinates define the geometry of a
model.  For example, when you move an element, you actually move the locations of the
nodes connected to that element.

Degrees of Freedom (DOFs)

Each node may have a maximum of six global degrees of freedom (DOFs) associated with it.
 They are three translational DOFs along the global X, Y, Z directions (Dx, Dy and Dz) and

three rotational DOFs about the global X, Y, Z directions (Dox, Doy and Doz).  
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Some of these DOFs may not be available depending upon the type of a model.  

For example, the model type “2D Truss” has Dx and Dy available and Dz, Dox, Doy, Doz
unavailable or suppressed; while the model type “2D Plate Bending” only has Dz, Dox, Doy
available and Dx, Dy, Doz suppressed.  

You may always use the model type “3D Frame and Shell” to analyze any structure, however,
time and computer memory may be wasted if a simpler model type can be used instead.  You
may choose the appropriate model type by command Analysis > Analysis Options.

Six nodal displacements associated with 6 DOFs are output for each node.  For restrained or
unavailable DOFs, the program outputs the corresponding displacements as zero.  Nodal
displacements should be the first thing to check for when determining result correctness
since the solution is displacement-based.  If the displacements are wrong, nothing else will be
correct.

Node Numbers

A distinct integral number is assigned to each node.  Node numbers are used to define the
connectivity of member and finite elements.  Duplicate numbers in nodes are not permitted. 
There can be gaps in node numbering sequence.  The program will automatically renumber
the nodes internally before performing the solution.  The order of node numbering in a model
is insignificant to the final results, but it may affect the time and computer memory required to
solve the model.  For a very large model, node renumbering may be important in order to
reduce the half band width in the global stiffness matrix and therefore the solution time.  You
may renumber the nodes sequentially based on nodal coordinates using the command Edit >
Renumber Nodes.

Half Band Width (HBW) is defined as [Ref.7] as follows:

where m is the total number of structural elements, and the max dofel and min dofel are the

maximum and minimum global degrees of freedom numbers associated with element el.
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For example, in the screen captures below, models A and B are identical 3D frames (6 DOFs
per node) but with different node numbering schemes.  Model A has a HBW of 6 * (9 + 1) =
60 while model B has a HBW of 6 * (5 + 1) = 36.  Therefore, model B is more economical
than model A because of the reduction of half band width.  

Model A: HBW=60 Model B: HBW=36

Loads

Forces or moments may be applied to a node.  These forces and moments are specified in
the global coordinate system.  You may regard enforced displacements as special kinds of
loads.  They are specified in supports.

Supports

By default, a node is unrestrained, that is, it is free to move in any of the six available DOFs. 
However, for a model to be stable, restraints on one or more DOFs must be imposed on
some nodes.  Restraints may be rigid or flexible.  Rigid restraints are referred to as supports
while flexible restraints are referred to as springs.  You may regard supports as springs with
infinite spring constants.

You may assign a support with one or more DOFs (Dx, Dy, Dz, Dox, Doy and Doz)

restrained to a node.  The program uses a six-character code to represent restraint
conditions of a support in six DOFs.  For example, “111111” represents a fixed a support
while “111000” represents a pinned support.  By default, restrained DOFs have zero enforced
displacements.  You may specify non-zero enforced displacements to any or all of restrained
DOFs.  The enforced displacements are discarded if they are assigned to unrestrained
DOFs.  You may regard these enforced displacements as special kinds of loads.  They
participate in all load combinations but always with a load factor of 1.0.

The forces or moments required to enforce rigid restraints are called support reactions.  They
are computed by the program.
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Springs

Springs are flexible restraints.  Springs applied to nodes are referred to as nodal springs. You
may assign a nodal spring to a node with one or more global DOFs (Dx, Dy, Dz, Dox, Doy
and Doz) restrained.  To qualify to be a valid flexible restraint, the corresponding spring

constant must be specified. A restraint may be designated as linear, compression-only or
tension only.  A compression-only restraint is active only when the nodal displacement in the
restrained direction is negative.  A tension-only restraint is active only when the nodal
displacement in the restrained direction is positive.  If a model contains one or more
compression-only or tension-only springs, the whole problem becomes nonlinear and the
solution becomes iterative for each load combination.

The forces or moments required to enforce the flexible restraints are called spring reactions. 
They are computed by the program. 

13.2.1.9   Members

A member is a two-node straight frame element with a constant cross section.  The term
“frame element”, “beam element”, and “member” are used interchangeably in this program. 
The truss element is a special frame element with moments fully released at both ends.  The
frame element formulation accounts for axial, torsional, and bending about strong and weak
axes, with options to include shear deformations and axial stress stiffening (P-Delta) effects. 
Moment releases may be applied to either or both ends of the element. 

The frame element may be used to model continuous beams, 2D or 3D frames, 2D or 3D
trusses or a mixture of two.  The program provides powerful commands to generate
commonly used framed structures such as continuous beams, 2D or 3D frames, arc beams,
and non-prismatic beams.  A non-prismatic member is approximated by subdividing the
original member into several prismatic members.  You may access these commands from
the Create ribbon. 

Member Sections

Each member must have a section assigned to it.  The section properties include: 
· A: axial section area

· Ay: shear area along the member local y direction

· Az: shear area along member the local z direction

· Izz:  moment of inertia about strong the local axis z

· Iyy:  moment of inertia about weak the local axis y

· J:  torsional moment of inertia

Ay and Az may be zero, in which case, the program ignores shear deformations of the

element.  Mathematically speaking, the program interprets them as being infinite.  For
rectangular sections, Ay = Az = 5/6A.  For solid circular sections, Ay = Az = 0.9A.  For thin-

walled hollow circular sections, Ay = Az = 0.5A.  For wide flange sections, Ay = web area, Az
= area of two flanges [Ref. 6].  To consider member shear deformation, you must choose the
proper option from the command Analysis > Analysis Options.  Shear deformation, when
considered, applies to both element stiffness and local deflections.
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Local Coordinate System

Each member has its own local coordinate system.  The element local coordinate systems
are used in element stiffness formulations.  They are also used for inputs such as loads and
releases and outputs such as internal shears and moments.  For the definition of the member
local coordinate system, refer to Coordinate Systems.  

Member Numbers

A distinct integral number is assigned to each member.  Duplicate numbers in members are
not permitted. There can be gaps in the member numbering sequence.   The order of
member numbering in a model is insignificant to the results or solution time.  You may
renumber the members sequentially using the command Edit > Renumber Members.

Beams vs. Trusses

By default, a member or frame element is a beam.  However, if you choose the model type to
be either “2D Truss” or “3D Truss”, then the frame element becomes a truss element.  The
program assigns full moment releases automatically to the ends of all members and
suppresses all three rotational DOFs Dox, Doy, Doz for each and every node.  For the model

type “2D Truss”, the program also suppresses translational DOF Dz.  Generally speaking, if a

model contains only 2D or 3D truss elements, you should choose the model type as “2D
Truss” or “3D Truss”.  If a model contains both trusses and beams, you should choose the
model type“2D Frame” or “3D Frame & Shell”, and assign appropriate moment releases to
individual beams.  It may also be necessary to assign appropriate restraints to nodes to
ensure stability of the model. You may choose the appropriate model type by running the
command Analysis > Analysis Options.

Elastic Stiffness Matrix

Total number of DOFs of a member is the summation of DOFs of the two nodes.  Therefore,
for a 3D beam, the stiffness matrix is of size 12 x 12.  The elastic stiffness matrix in the local
coordinate system with shear deformation is given [Ref. 8] as follows:

where: ;  ;    ;  ;    
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Geometric Stiffness Matrix

When a tensile axial force is present in a member, the bending stiffness of that member is
increased.  Conversely, when a compressive axial force is present in a member, the bending
stiffness of that member is reduced.  The stiffness matrix that reflects this kind of stress
stiffening effect is called the geometric stiffness matrix [Ref. 3, 7].  It is determined by the
element geometry and stress conditions, and is independent of the elastic properties.  The
geometric stiffness matrix is very effective in accounting for the P-Delta effect and is
implemented in the program.  It may also be used to perform buckling analysis of the
structure but is not implemented in the program directly. 

Like the elastic stiffness matrix, the geometric stiffness matrix is of size 12 x 12 and is given
[Ref. 3, 7] as follows: 

where P is the average of the axial forces (positive in tension, negative in compression) at the
member ends.

When the linear static (first order) analysis is chosen, the member stiffness matrix is the
elastic stiffness matrix.  When the P-Delta (second order) analysis option is chosen, the
member stiffness matrix is the summation of the elastic stiffness matrix and the geometric
stiffness matrix.  You may set the appropriate analysis option with the command Analysis >
Analysis Options .

Moment Releases

By default, a member is rigidly connected to two end nodes.  You may however assign
moment releases to either end of the member.  It is important to note that the releases are
applied with respect to the member local coordinate system.  The moment releases may be
in major bending direction (Doz) or minor bending direction (Doy) or both.  The element

stiffness matrix is modified to enforce moment releases.

Tension/Compression-Only

By default, a member is linear.  You may assign nonlinearity (tension-only or compression-
only) to the selected members.  The member stiffness will be ignored if a tension-only
member is subjected to compressive forces or if a compression-only member is subjected to

388
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tensile forces. The presence of tension- or compression-only members makes the model
nonlinear, so an iterative solution is required for each load combination.

Rigid Links

A rigid link is a member that has very large sectional properties (A, Ay, Az, Iz, Iy and J).  There
can only be one rigid link section defined in the model and it must be named as “RIGID_LINK”.
 The properties for the RIGID_LINK section must be set to 0’s on the member section dialog. 
The program will appropriately calculate A, Ay, Az, Iz, Iy and J during the solution process.
Self weight for rigid links will be ignored by the program.

Rigid Diaphragms

Rigid diaphragms may be used instead of plate finite elements to model stiff in-plane actions
such as concrete floors.  Internally, the program creates multiple in-plane rigid links for each
diaphragm prior to static or frequency analysis.  A rigid link is simply a member with very large
sectional properties that can be adjusted with the diaphragm stiffness factor (see Settings >
Data Options).  The larger the diaphragm stiffness factor, the stronger the in-plane rigid
diaphragm action is.  The presence of rigid links with large diaphragm stiffness factor (say
1E10) could create numerical difficulties during the solution if the 64-bit floating point solver is
used.  However, the unique 128-bit floating point solver in ENERCALC 3D makes this
problem nonexistent in that much larger diaphragm stiffness factor (say 1E20) may be used
without creating numerical difficulties during the solution.

The program further provides the option to ignore the rigid diaphragm actions as an analysis
option (Analysis > Analysis Options).

It is important to point out that rigid diaphragm action in the program does not use
Equal Displacement Constraints.  

Loads

Point loads or line loads may be applied to a member.  Point loads may be forces or
moments.  Line loads must be forces.  You may specify loads in either the global or local
coordinate system.  The locations of loads must be in ratios of the member length, measured
from the start of the member.  The following figure shows examples of point and line loads.

Point Loads Line Loads

local y force, distance=0.6 local y force, start distance=0,end distance=1
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Point Loads Line Loads

local z moment, distance=0.4 global Y force, stat distance=0.2, end distance=0.8

The self weight of members may be calculated automatically if the material weight densities
and self weight multiplier are nonzero.  By default, self weight acts in the negative global Y
direction.  You may however change the direction to positive or negative direction of the global
X, Y, or Z.  This flexibility is useful in some circumstances.  For example, if you model a
grillage on the XY plane, the self weight may be either in the positive or negative global Z
direction, depending on your preference on load sign convention.  To activate automatic self
weight calculation, use the command Loads > Assign Self Weights.

An area load may be applied to multiple members on a whole planar area.  The area is
defined by three or four coplanar nodes.  The area load is then distributed as line loads to
perimeter members of enclosed sub-areas within the load area prior to static or dynamic
solution.  Area loads are distributed to perimeter members that form each of the enclosed
sub-areas according to the following methods:

- Two-way (rectangular sub-areas)
- Short-Sides (rectangular sub-areas)
- Long-Sides (rectangular sub-areas)
- AB-CD Sides (rectangular sub-areas)
- BC-AD Sides (rectangular sub-areas)
- Centroid-based
- Circumference-based

The first five distribution methods apply to four-node rectangular sub-areas only.  The
centroid-based method may be applied to convex sub-areas only.  The circumference-based
method may be applied to both convex and concave sub-areas.  Loads may also be
distributed to sides parallel to AB-CD or BC-AD sides of the load area.  The program is
intelligent enough to determine the most appropriate load distribution if inconsistencies arises.
 For example, if you select two-way distribution method for a sub-area that is not rectangular,
the program will use the centroid-based method if the sub-area is convex or the
circumference-based method if the sub-area is concave. 

The program allows you to convert area loads to line loads directly and automatically.  This
feature allows you to see how exactly the program would distribute area loads to members
prior to the solution.  Of course, you can always undo the conversion if you want to keep the
area loads.  For more information on the load conversion, please see Loads > Assign Area
Loads.
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As an example, let’s say we have a 3.5 x 1.5 ft rectangular sub-area subjected to 100 lb/ft 2̂. 
The following line loads are converted from the same area load based on different distribution
methods.

Two-way Distribution

Short-side Distribution

Long-side Distribution

Centroid-based Distribution

Circumference-based Distribution
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Area loads may be specified in either the local or global coordinate system.  Global area loads
may be in the global X, Y, or Z direction.  Local area loads may only be in the local z direction,
which is perpendicular to the load area.  It is recommended that area loads be defined in their
own load cases.  In this way, you will find it easier to identify, edit, and delete area loads later
on.

There are a few limitations to the area load concept in the program.  The first limitation is that
the sub-areas must be close-formed by perimeter members.  In the following figure, the sub-
area formed by node 97, 98, 104 and 103 is not a closed sub-area because there is no
member connecting the node 97 and 98.  As a result, no area loading will be distributed to the
three perimeter members from the sub-area.  The second limitation is that sub-areas must
not overlap.  In Figure 16.3, the sub-areas in node 101, 102, 120 and 119 are overlapping. 
This will result more load being distributed to the members in these sub-areas.  The program
gives a warning when the area load footprint is not equal to the total actual loaded area.  The
problem may be solved by splitting members 119-108, 107-120 and 113-114 at the
intersection point.

The third limitation is that any sub-area may not contain more than one concave node (with
internal angle more than 180 degrees).  The fourth limitation is that any sub-area may not
contain the same node more than once in forming the perimeter polygon.

The program offers automatic generation of live load patterning (point and line loads only). 
The following figure shows how the program generates load patterning on a five-span
continuous beam.  Loads on each generated pattern reside in a separate load case
automatically generated.  Additional load combinations are generated as needed as well.
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All Spans

Odd Spans

Even Spans

Second Support + Alternate Spans

Third Support + Alternate Spans

Fourth Support + Alternate Spans
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All Spans

Fifth Support + Alternate Spans

The program also offers automatic generation of moving loads (point loads only).  The
mechanism employed by the program is similar to the live load patterning.

Line Springs

Springs are flexible restraints.  Springs applied to members are referred to as line springs.
You may assign a line spring to a member with one or more global DOFs (Dx, Dy and Dz)

restrained. To qualify as a valid flexible restraint, the corresponding spring constant must be
specified.  A restraint may be designated as linear, compression-only or tension-only.  A
compression-only restraint is active only when the nodal displacement in the restrained
direction is negative.  A tension-only restraint is active only when the nodal displacement in
the restrained direction is positive.  If a model contains one or more compression-only or
tension-only springs, the whole problem becomes nonlinear and the solution becomes
iterative for each load combination
 
The forces or moments required to enforce the flexible restraints are called spring reactions. 
They are computed by the program.

Internal Forces and Moments

The program outputs internal forces and moments at designated stations along the member
length.  You may specify the number of segments ranging from 1 to 127 for member output
by running the command Analysis > Analysis Options.  For smooth moment and shear
diagrams, the program may add extra segments.  

The following figure shows the positive direction of the internal forces and moments of
members.  

Forces Moments
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Forces Moments

Axial Force Vx Torsion Mx

Major Shear Vy
Major Moment Mz

Minor Shear Vz Minor Moment My

The following figure is an alternative way to show the positive direction of the internal shears
and moments on the local xy and xz planes.

Moment & shear on the local xy plane Moment & shear on the local xz plane

13.2.1.10   Shells

A shell is a structure or part of a structure which has a relatively small thickness in
comparison with the other two dimensions.  A general shell forms a curved surface in space.
 When it forms a flat surface, it is also called a plate.  In this program, when the term “plate” is
used, it refers to flat shell in the out-of-plane bending action.  
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The shell element in the program is a four-node (quadrilateral) element that combines the in-
plane membrane action and the out-of-plane bending action.  The in-plane membrane action
is a standard isoparametric compatible formulation with the option to add incompatible
modes.  The out-of-plane bending action is a thick-plate formulation, with the option to use the
thin-plate formulation when the element is rectangular.  The element can be used to model
both flat-surface plates and curved-surface general shells.  Applications of shell elements in
structures are wide and far-reaching.  Examples are concrete floors, mat foundations, shear
wall, folded plates, barrel vaults, cooling towers, spherical domes, water tanks, etc.  The
program provides powerful commands to generate these and other commonly used plate and
shell structures.  These commands include Geometry > Generate Shells, Edit > Extrude,
Revolve, etc.

For many years, a great number of papers have been published on the subject of plate and
shell structures.  Although the membrane action of a shell element is relatively simple, the
(plate) bending action is much more complex.  Many plate elements have been proposed,
some of which have been implemented in commercial programs.  However, most of these
proposed plate elements are either ineffective or unreliable.  One of the main hurdles is
known as transverse “shear locking”, that is, elements behave too stiff with respect to shear
deformation especially when elements are thin or geometrically distorted.

One of the few reliable plate elements is a rectangular thin plate element developed by O.C.
Zienkiewicz [Ref. 2].  It is based on the Kirchhoff thin plate bending theory in which a line
straight and normal to the mid-surface of the plate before loading is assumed to remain
straight and normal to the deformed mid-surface after loading.  The transverse shear strain is
therefore assumed to be zero.  This plate element is important in that it is the first plate
element that can be applied reliably in engineering practice.  Prior to this, plate analysis
depended mainly on very few “closed-form” solutions of simple geometry and boundary
conditions, and other very approximate methods such as equivalent frame method of ACI
[Ref. 12].  The Kirchhoff rectangular thin plate is implemented in the program.  It produces
results that converge to “closed-form” solutions as finite element meshes are refined.  The
element, however, has to be rectangular in shape and does not account for shear
deformation.

A much more reliable and effective plate bending element is the MITC4 developed by K.J.
Bathe and others [Ref. 1].  It is a thick plate that is based on Mindlin plate theory in which a
line straight and normal to the mid-surface of the plate before loading is assumed to remain
straight but not necessarily normal to the deformed mid-surface after loading.  The element
considers shear as well as bending deformations and may be used for both thick and thin
plates.  This plate element differs from earlier Mindlin theory based plate elements in that
different (mixed) interpolations are used to account for the bending and transverse shear
strains.  The MITC4 plate bending element is implemented in the program.  It is free from
“shear locking” and performs well even when element meshes are distorted.  The shape of
the element may be any general quadrilateral as long as the aspect ratio is within a
reasonable range (say 0.2 to 5.0).

Shell Thicknesses

Each shell must have a thickness assigned to it.  Based on the ratio of thickness to span
length, you may choose to use the thin or thick plate bending formulation.
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The thick plate formulation is generally recommended over the thin plate formulation because
it applies equally well to both thick and thin plates.  The program therefore uses the thick plate
formulation by default.  If thickness to span ratio is less than 1/20 and elements are
rectangular, you may use the thin plate formulation.  The thickness should be compared to
the support distances, not to the sizes of individual plate elements.

It is important to point out that out-of-plane shear forces exist in thin plates even though shear
deformations are not considered.  You may draw an analogy between a plate and a beam.  A
thin plate is analogous to a Euler-Bernoulli beam while a thick plate is analogous to a
Timoshenko beam.  We consider shear deformation for the Timoshenko beam but not for the
Euler-Bernoulli beam, while shear forces exist in both the Euler-Bernoulli and Timoshenko
beams.

Local Coordinate System

Each shell element has its own local coordinate system.  The element local coordinate
systems are used in element stiffness formulations.  They are also used for inputs such as
loads and outputs such as internal shears, moments, and stresses.  Local angles for
rectangular shells must be 0s if thin plate bending formulation is used in the analysis options.
 For definition of the shell local coordinate system, refer to Coordinate Systems.  

Shell Numbers

A distinct integral number is assigned to each shell.  Duplicate numbers in shells are not
permitted. There can be gaps in shell numbering sequence.  The order of shell numbering in
a model is insignificant to the results or solution time.  You may renumber the shells
sequentially using the command Modify > Renumber > Renumber Selected Shells.

Element In-Plane Stiffness Matrix

The in-plane element formulation accounts for Dx and Dy of the local coordinate system.  The

in-plane stiffness matrix of the element is based on the standard isoparametric formulation
[Ref 1, 2, 3].  However, when the element is rectangular in shape, incompatible modes may
be optionally added to the formulation [Ref. 3].  An incompatible element, when applied, yields
results of high quality especially when used to model in-plane bending.  Full two by two
numerical integration is used to calculate the in-plane stiffness matrix of the element.

Element Out-of-Plane Stiffness Matrix

Out-of-plane bending accounts for Dz, Dox and Doy of the local coordinate system.  By

default, the MITC4 thick plate formulation is used [Ref. 1].  If the thin plate option is chosen,
elements with rectangular shapes will be calculated based on the Kirchhoff thin plate
formulation [Ref. 1].  Full two by two numerical integration is used in either case to calculate
the out-of-plane stiffness matrix of the element.

Combining Element In-Plane and Out-of-Plane Stiffness Matrices

The shell element stiffness matrix is the combination of the in-plane and out-of-plane stiffness
matrices.  In order to avoid singularity of the stiffness matrix, a very small “fictitious” stiffness
is added to the diagonal term associated with the local DOF Doz.
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Loads

Surface loads may be applied to a shell. You may specify loads in either the global or local
coordinate system.  Surface loads are lumped to element nodes before solution.  The self
weight of shells may be calculated automatically if the material weight densities and self
weight multiplier are nonzero.  By default, the self weight acts in the negative global Y
direction.  You may, however, change the direction to positive or negative direction of the
global X, Y or Z.  This flexibility is useful under certain circumstances.  For example, if you
select the model type “2D Plate Bending”, the self weight may be either in positive or negative
global Z direction, depending on your preference on the sign convention.  To activate
automatic self weight calculation, use the command Create > Draw Loads > Self Weights.

Surface Springs

Springs are flexible restraints.  Springs applied to shells are referred to as surface springs.
You may assign a surface spring to a shell with one or more global DOFs (Dx, Dy and Dz)

restrained. To qualify as a valid flexible restraint, the corresponding spring constant must be
specified.  A restraint may be designated as linear, compression-only or tension-only.  A
compression-only restraint is active only when the nodal displacement in the restrained
direction is negative.  A tension-only restraint is active only when the nodal displacement in
the restrained direction is positive.  If a model contains one or more compression-only or
tension-only springs, the whole problem becomes nonlinear and the solution becomes
iterative for each load combination.
 
The forces or moments required to enforce flexible restraints are called spring reactions. 
They are computed by the program.  Surface springs may be used to model Winkler mat
foundations.  It may be worthwhile to note that in modeling a mat foundation, surface spring
constants are the soil subgrade moduli while surface spring reactions are the soil pressures.

Internal Forces or Moments

The internal forces and moments exist at every point on the middle surface of the shell
element.  They represent the resultants of different normal and shear stresses over the
element thickness.  The internal forces have the units of force per unit length and the internal
moments have the units of moment per unit length.

The in-plane or membrane results include the normal forces Fxx, Fyy and shear force Fxy. 

The out-of-plane results include the shear forces Vx, Vy and bending moments Mxx, Myy,

Mxy.  Mxy is also called twisting moments.  It is important to differentiate these forces and

moments
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The following figure shows the positive direction of the internal forces and moments of a shell.
 They represent forces and moments at one point on the middle surface of the element.  The
program outputs these forces and moments at the four corner nodes and /or at the center of
the element.  You may use Analysis Results > Results  Diagrams > Contour Diagram to see
the distribution of these and other resultants.  Generally speaking, internal forces or moments
(or result in general) are different across element boundaries.  You have the option to average
forces and moments for adjacent elements at nodes.  To do that, click Analysis > Analysis
Options.

the in-plane axial and shear forces

the out-of-plane bending shears the out-of-plane bending moments
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Based on the internal forces and moments, the program computes the internal stresses at
the shell bottom (the –z side) and top (the +z side) as follows.  The stresses are expressed in
the local coordinate systems.  The stress directions correspond to the in-plane normal axial
forces and shear, and the out-of-plane shears.

(@ bottom) or (@ top)

(@bottom) or (@ top)

(@bottom) or (@ top)

The program also outputs in-plane principal forces and angles, and out-of-plane principal
forces, moments, and angles.  In addition, principal stresses S1, S2, and S3 are computed

based on the stresses  as follows:  

The Von Mises stress, which is often used to estimate the yield of ductile materials, is then
computed as follows:
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Membrane Nodal Resultants

The membrane nodal resultants of a shell are concentrated forces Fx and Fy (with force

units) at the four nodes of each shell element.  They in effect keep each individual element in

equilibrium (in-plane).  They are expressed in the local coordinate system. 

You may view nodal forces of selected shell elements by Quick Access Toolbar > Annotate. 
The membrane nodal forces may be used to compute shears, axial forces, or moments in a
shear wall. For example, the following three shells represent a pier in a shear wall.  Each shell
is 1.5 x 1.5 ft in size.  Membrane nodal resultants Fx and Fy are shown in the first and second

rows respectively at each corner of the element.  The shear, axial force and moment
resultants on the top of the pier may be computed as follows:

Fxi (kips) Fyi (kips) Xi (ft) Fyi * Xi (ft-kips)

1.758 -2.284 -2.25 5.139

3.226 1.663 -0.75 -1.24725

7.226 -8.458 -0.75 6.3435

5.786 4.611 0.75 3.45825

3.144 -3.718 0.75 -2.7885
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Fxi (kips) Fyi (kips) Xi (ft) Fyi * Xi (ft-kips)

2.722 3.082 2.25 6.9345

Shear 
ΣFx = 23.862

Axial Force
ΣFy = -5.104 Moment

ΣM = 17.8395

13.2.1.11   Bricks

The Brick element in the program is an eight-node solid element based on isoparametric
compatible or incompatible formulation [Ref 1, 2, 3].  It may be used to model structures
where actions in all three dimensions are significant.  

Local Coordinate System

The local coordinate systems for all Bricks are the same.  They are identical to the global
coordinate system.  The element nodal connectivity must be numbered in such a way so that
the normal vector of the surface 1-2-3-4 points to the surface 5-6-7-8 in the following figure.  

solid element

This is to avoid negative diagonals in the element stiffness matrix.  You may use the
command Modify > Reverse Node Order for Selected Elements if the normal vector is not in
accordance with the requirement.  For more information about the brick local coordinate
system, refer to Coordinate Systems. 

Brick Numbers

A distinct integral number is assigned to each Brick.  Duplicate numbers in Bricks are not
permitted. There can be gaps in Brick numbering sequence.  The order of Brick numbering in
a model is insignificant to the results or solution time.  You may renumber the Bricks
sequentially using the command Modify > Renumber > Renumber Selected Bricks.

Element Stiffness Matrix

The element formulation accounts for Dx, Dy and Dz of the local coordinate system.  The

element stiffness matrix is based on isoparametric compatible or incompatible formulation
[Ref 1, 2, 3].  Therefore, the stiffness matrix is of size 24 by 24.  Full two by two numerical
integration is used to calculate the stiffness matrix.
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Loads

Loads on Brick elements must be input as nodal loads.

The self weight of Bricks may be calculated automatically if material weight densities and self
weight multiplier are nonzero.  By default, the self weight acts in the negative global Y
direction.  You may however change the direction to positive or negative direction of the global
X, Y or Z.  To activate automatic self weight calculation, use the command Create > Draw
Loads > Self Weights.

Internal Stresses

Three normal stresses σxx, σyy , σzz and three shear stresses σxy, σxz,  σyz  are computed

by the program.  They are output at the eight nodes and/or at the center of the element.

The program also outputs principal stresses S1, S2, S3 and the corresponding directional

vectors (V1x, V1y, V1z) and (V 3x, V 3y, V 3z).  The Von Mises stress, which is often used to

estimate the yield of ductile materials, is then computed as follows:

13.2.1.12   Static Analysis

The stiffness (or displacement-based) method is used in the solution of the structural model.
The following outlines the major analysis steps:

· The individual element stiffness matrix [k] is computed in the element local coordinate
system.

· Based on the element nodal connectivity, [k] is transformed to the global coordinate
system and assembled into the global stiffness matrix [K].

· The load vector [R] for each load combination is formed.

· The equation [K] [U] = [R] is solved for the nodal displacements [U].  

· Other structural responses such as internal forces and moments are computed
based on the nodal displacements.

Load Cases and Load Combinations

Each of the nodal loads, point loads, line loads, surface loads, and self weights must be
assigned to a load case.  The enforced displacements of supports are special loads and are
considered in each load combination.  The load cases are used as bases for the load
combinations and are not solved directly.  If you desire to solve for a particular load case, you
may form a load combination with a unit load factor for that load case and 0s for all other load
cases.   

P-Delta analyses may be performed on one or more load combinations.

Linear, Non-linear Static Analyses

The program is capable of performing linear and nonlinear static analyses.  The linear
analysis may be applied to models where structural responses such as the displacements
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are expected to be linearly related to the applied loads.  Otherwise the nonlinear analysis
must be applied.  The program currently handles two types of nonlinearity: the element
nonlinearity when compression-only springs or tension-only springs are present, and the
geometric nonlinearity which is commonly known as the P-Delta effect.  The P-Delta effect
refers to the axial stress influence on the element bending stiffness.  Generally, a tensile axial
force increases the element bending stiffness while a compressive axial force reduces the
element bending stiffness.  The P-Delta effect exists in both members and shell elements. 
However, the program only accounts for the P-Delta effect on members.

The program assigns each load combination to be linear or nonlinear just before analysis is
performed.  If a model includes one or more nonlinear elements (compression-only springs or
tension-only springs), the entire problem becomes nonlinear, that is, all load combinations are
assigned to be nonlinear.  If there are no nonlinear elements present in the model, only the P-
Delta load combinations are set to be nonlinear while the rest of load combinations are linear.
 The non-linear load combinations must be solved iteratively and therefore are potentially time
consuming.  Analyses are performed on all linear load combinations first and then on all
nonlinear load combinations.  

In order to avoid excessive iterations on nonlinear load combinations, you can use the
command Analysis > Analysis Options to set “Maximum nonlinear iterations”.  For the P-Delta
load combinations, you can use the same command to set “Axial force tolerance between P-
Delta iterations”.  A tolerance of 0.5% is normally acceptable.  It is strongly recommended that
you perform linear analyses for all load combinations before you attempt P-Delta analyses.  In
this way, you can identify any modeling problems prior to performing more rigorous and
generally more time consuming P-Delta analyses.

It may be interesting to note that the P-Delta analysis may be used to estimate the buckling
load of a structure for a P-Delta load combination.  To do that, try to apply different scales (λ)
uniformly to the load factors of all load cases in the P-Delta load combination, until a zero or
negative diagonal term is detected in the global stiffness matrix during the solution process. 
The lowest scale λ is the buckling load factor. 
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P-Delta (P-∆) vs. P-delta (P-δ)

The P-Delta (P-∆) refers to the second order effect associated with the lateral translation of
the members [Ref. 10, 11, 12].  Consider the moment M at the bottom of the column in the
figure below.  

If the effect of the axial force on bending is ignored, M = H * L.  However, if the effect of the
axial force on bending is considered, M = H * L + P * ∆.  The increase in moment in turn
increases the deflection ∆, which further increases M, and so on.  An equilibrium will
eventually be reached unless the axial load P exceeds the column critical buckling load. 

P-delta (P-δ) refers to the second order effect associated with the member curvature [Ref.
10, 11, 12].  Consider the moment M at the middle of the column in the figure below.
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A secondary moment P * δ is induced by the axial load acted upon the lateral defection of the
column.  This additional moment will cause more lateral deflection, which in turn will induce
more secondary moment, and so on.  An equilibrium will eventually be reached unless the
axial load P exceeds the column critical buckling load.

The presence of the axial force in effect reduces the column bending stiffness.  The member
geometric stiffness accounts for this reduction.  The P-Delta analysis in the program is
capable of handling both P-∆ and P-δ effects.  In order to account for the P-δ component,
however, you must split compression members (columns) into several segments.  Normally
four segments for each column are enough.  The program provides the command Edit > Split
Members to automatically split members.

As an example [Ref. 13], assume in the figure above, the beam-column is of L = 12 ft in
length, and is subjected to an axial compressive load of P = 100 kips and a transverse load of

Q = 6 kips at midspan.  The member section: 4 x 4 inches, I = 21.33 in4, A = 16 in2.  The
material: E = 30000 ksi, υ = 0.30.  Theoretical results are calculated as follows:

Linear (bending only):  ft-kips;  in

P-δ (bending and axial load):  radian (or 51.57o)

ft-kips;  in

To solve this problem in the program, we can create one linear load combination and one P-
Delta load combination.  Since the problem involves the P-δ effects, the beam-column must
be modeled with multiple elements (4 beam elements generally sufficient).  The results from
the program are compared with the theoretical results below:

The moments and deflections at the midspan for linear and P-δ behaviors

Analysis Type Effects ENERCALC 3D Theoretical

Linear

δmid (in) 0.5832 0.583

Mmid (ft-kips) 18 18

P-δ

δmid (in) 0.8643 0.864

Mmid (ft-kips) 25.203 25.2
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Solution Algorithm

Mathematically, the static analysis involves solving the following simultaneous equations: 

[K] [U] = [R]

where [K] is the global stiffness matrix, [U] is the displacement vector, and [R] is the load
vector for each load combination.

There are two solution algorithms used in ENERCALC 3D: skyline and sparse.  The skyline
solution algorithm used to solve the equation above was developed by K.J. Bathe [Ref. 1].  It
is an active column (also called profile or skyline) solver that involves the factorization of a
stiffness matrix and the back-substitution of the load vector.  The factorization generally takes
most of solution time while the back-substitution is relatively fast.  For all linear load
combinations, the factorization only needs to be performed once.  For nonlinear load
combinations, the factorization has to be performed multiple times on each load combination
because the global stiffness matrix has to be updated during the solving process.  This is the
reason why linear and nonlinear load combinations are analyzed separately. 

The sparse solver only stores non-zero elements in the global stiffness matrix, thus it is both
more memory efficient and much faster than the skyline solver.  It also has the option to use
an out-of-core approach to minimize the requirement of computer memory.  This is useful to
solve extremely large structural models.  The sparse solver is available for static analysis
only.  It lacks some of the informative error messages when something goes wrong during
the solution process.

Solution Accuracy and Stability

At the very basic level, the solution involves basic arithmetic operations such as addition,
subtraction, multiplication and division on floating point numbers.  Since all numbers in
computers are stored in finite number of bits or digits, round-off errors are introduced by
manipulations of these numbers.  Round-off errors depend on the precisions of floating point
arithmetic and may affect the solution accuracy and stability under certain circumstances.
Two types of precisions are generally available on most computers today: single precision
and double precision.  A single precision (or 32-bit) floating point value has numerical
accuracy of about 7 significant digits while a double precision (or 64-bit) floating point value
has numerical accuracy of about 15 or 16 significant digits.
 
Take a look at the following example:

A = 1.00000001; B = -1.0; C = 1.0; D = C / (A + B);

Theoretically, D = 100000000.0.  With 64-bit floating point arithmetic, the statement yields D =

we can see, D is approximately (not exactly) equal to the theoretical answer with double
precision arithmetic.  The solution collapsed (division by zero) with single precision arithmetic.
 The reason for this to happen is during the addition of A and B, the fractional part of A
(0.00000001) is rounded off due to lack of enough significant digits.  In general, 32-bit floating
point arithmetic should never be used in any structural or finite element analysis programs.  
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The 64-bit floating point (double precision) has been the predominant solver over the last
several decades.  For most not-so-large and well-conditioned models, standard 64-bit floating
point solvers produce results that are sufficiently accurate for practical uses.  However for
very large and complex models and especially those under ill-conditioned circumstances,
standard 64-bit floating point solvers sometimes produce inaccurate results.  

Ill-conditioning occurs when small errors in the coefficients of equations before or during the
solution process have large impact on solution results.  It may make the solution unstable and
results unreliable.  Very severe ill-conditioning may even make the coefficient matrix singular
and thus a solution non-existent.  Some examples where ill-conditioning may occur are: finite
elements with severe shape distortion or large aspect ratio; shells with very strong in-plane
stiffness and very weak out-of-plane bending stiffness; very flexible elements connected to
very stiff elements.  It may be worthwhile to note that when ill-conditioning does happen, finer
element meshes tend to make the problem worse.  

During the solution process of a large model, round-off errors tend to accumulate.  We can
determine the number of significant digits lost based on the diagonal decay ratio [Ref. 3]. 

ri = Kii / Pii

where Kii is the original diagonal coefficient of the global stiffness matrix and Pii is the

reduced value of Kii just before it is used for back-substitution.  The number of significant

digits lost is about log10(ri).  For example, if ri is 108, then 8 digits are lost.  The solution

results given by the 64-bit floating point (double precision) are unreliable if 12 or more
significant digits are lost during the solution process.  The program reports the number of
digits lost during the solution process.  

Consider the following cantilever beam under a tip load of 10,000 lbs:

L = 100 in; Izz = 200 in4;

E = 2.9e7 psi; ν  = 0.3; 
P = -10000 lb
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The beam is modeled with 1, 1000, 10000, 20000, 50000 elements and an analysis is
performed on each model.  Theoretically all models should yield the same tip deflection of -
0.5747 inch (shear deformation ignored).   The following table shows tip deflections for the all
five models using the 64-bit floating point (double precision) in the program.

Effect of number of elements on accuracy (the 64-bit skyline solver) of a cantilever beam

No of elements 1 1,000 10,000 20,000 50,000

Tip deflection (in) -0.5747 -0.5748 -0.6522 -0.1534 No solution

No of digits lost 0 8 12 12 -

As we can see from the table above, the tip deflections given by the 64-bit skyline solver tend
to deteriorate in accuracy as the number of elements increases.  For the model with 50,000
elements, some diagonal terms in the global stiffness matrix even become negative.  The
solver has to abort and the solution is not obtainable anymore.  

After identifying a severe ill-conditioning problem, the 64-bit floating point (double precision)
generally stops the solution process.  No results are better than wrong results.  To
address the problem, a more accurate solver is needed.  ENERCALC 3D implements a
unique 128-bit floating point (quad precision) solver which offers unparalleled advantages in
solution accuracy and most importantly solution stability over the standard 64-bit floating point
(double precision) solver.  The 128-bit floating point (quad precision) provides numerical
accuracy up to 30 significant digits.  Many of ill-conditioned problems for the 64-bit floating
point solver become well-conditioned problems for the 128-bit floating point solver.  The
superiority of the 128-bit floating point solver can be demonstrated by running the same
cantilever beam above with 50,000 elements, the tip deflection given by the 128-bit floating
point (quad precision) is -0.5747 inch, the correct answer.

A more practical application of the 128-bit floating point (quad precision) may be in the
modeling of a rigid diaphragm (e.g. floor with much larger in-plane stiffness than out-of-plane
stiffness).  Most of the other programs model this kind of rigid diaphragm action through equal
displacement constraints in order to avoid numerical difficulties.  With the 128-bit floating point
solver available in ENERCALC 3D, you may model the floor as a flexible diaphragm, yielding
much more realistic results.  

It should be pointed out that the 128-bit floating point (quad precision) requires twice as much
memory as the 64-bit floating point (double precision).  It is also significantly slower. 
However, in situations where the standard 64-bit floating point solver produces unreliable or
even wrong results, the 128-bit floating point (quad precision) provides an invaluable
alternative.  Between faster but wrong results and slower but correct results, the latter is
obviously preferable.

13.2.1.13   Frequency Analysis

The frequency analysis solves for frequencies and corresponding mode shapes
(eigenvectors) of the structural system.  Many concepts discussed in the previous
chapter-“Static Analysis”, apply to the frequency analysis as well.
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Solution Algorithm

Mathematically, the frequency analysis involves solving the following Eigen problem: 

[K] [Φi] = λi [M] [Φi]

where [K] is the global stiffness matrix, [M] is the global mass matrix, [Φi] is the ith mode

shape and λi is the ith eigenvalues which is equal to the free vibration circular frequency

squared (ω i)
2
.  Other related values are frequency fi which is 2π ω i and period Ti which is 1 /

fi.  For practical reasons, we are generally interested only in the lowest eigenvalues (and

therefore lowest frequencies).

The solution of eigenvalue problems must be iterative in nature because it is equivalent to
finding the roots of the polynomial p(λ).  The solution algorithm to solve the equation above is
given by K.J. Bathe [Ref. 1].  It uses the subspace iteration method to iteratively find the
lowest p eigenvalues λ1, λ2, … λp and corresponding vectors [Φ1], [Φ2], …[Φp].  Eigenvalues

are extracted in ascending order.  Each eigenvector is then normalized such that [Φi]
T[M] [Φi]

= [I] where [I] is the identity matrix, a diagonal matrix with unit values along the main diagonal.

A tolerance may be set before the solution to control the convergence of eigenvalues during
each successive solver iteration.  It is expressed as the following:

  (i = 1, 2, …number of requested modes)

where k is the subspace iteration counter.
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To prevent excessive computing time, a maximum number of subspace iterations may be set
before the solution.  If the solver reaches this limit without convergence, the eigen results
should not be trusted.

Mass and Stiffness

The global mass matrix [M] is diagonal and is computed based on the load combination for
frequency analysis and/or additional nodal masses/mass moments of inertia.  The load
combination for frequency analysis may be specified in Analysis > Frequency Analysis.  The
program will automatically convert all forces (not moments) in the positive or negative gravity
direction to nodal masses and apply them in all available mass degrees of freedom. 
Additional nodal masses and mass moments of inertia may be input from Loads > Additional
Masses or Input > Additional Masses.  Zero terms in the global mass matrix [M] are allowed. 
The number of eigenvalues requested must be fewer than the mass DOFs which is the
number of nonzero diagonal terms in [M].  Due to the lumped mass modeling, the elements
should be properly divided or submeshed for a continuous vibration model.  For example, a
beam with uniformly distributed mass should be divided into at least eight elements in order to
find accurate vibration results.
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The load combination for frequency analysis is also used to compute the global stiffness
matrix [K] if the model response is not linear.  This may be the case if 1). The load
combination for frequency analysis is of P-Delta type; or 2). The model contains nonlinear
elements such as compression-only springs.  In the first case (geometric nonlinearity), the
compressive forces decrease the model stiffness (and therefore lengthen the vibration
periods of the model) while tensile forces increase the model stiffness.  The influence of the
axial loads is greater on the lower frequencies than on the higher ones.  The effect of
nonlinearity on the stiffness matrix of the structure is incorporated as follows:

· An iterative (nonlinear) static analysis is first performed with the loads in the load
combination for frequency analysis.

· The stiffness matrix at the end of the static analysis will be used in the frequency
analysis.  The stiffness therefore includes geometric and element nonlinearities
corresponding to the end of the nonlinear static analysis.

Forced displacements at supports are ignored in frequency analysis.

Solution Convergence

Due to the iterative nature in the eigen solution, much more computational effort is required (in
order to achieve satisfactory convergence) in frequency analysis than in static analysis. 
Another important difference is solution stability, which is more difficult to achieve in frequency
analysis.  To ensure that the smallest required eigenvalues and the corresponding
eigenvectors have been computed, the program performs a Sturm sequence check after the
subspace iterations [Ref 1].  A warning message is given in the solver dialog if some eigen
values are missing after the Sturm sequence check.  Under some rare circumstances, the
solution may become unstable and the solver has to abort the solution process

Several remedies can be used to address the solution instability and solution divergence.  
1). Solve for fewer number of modes.
2). Use larger number of iteration vectors.
3). Use 128-bit floating point arithmetics instead of 64-bit floating point arithmetics.
These remedies may be used in tandem.  Once again, the 128-bit floating point arithematics
is especially effective for solution stability.

The maximum number of subspace iterations is set to 18 by default.  If no convergence is
achieved at this limit, you should rerun the frequency analysis with a larger maximum number
of subspace iterations.
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13.2.1.14   Response Spectrum Analysis

Analysis > Response Spectrum Analysis prompts you with the dialog shown in the screen
capture below.

It allows you to perform response spectrum analysis in global X, Y and/or Z directions. There
are three mode combination methods available in the program: CQC (complete quadratic
combination), SRSS (Square root of sum of squares) and ABSSUM (absolute sum). CQC
method for modal combination is applicable to a wider class of structures and is therefore
recommended method. Critical damping ratio (0 <= damp < 1.0) affects CQC results. When
critical damping ratio is 0, CQC method is the same as SRSS method.

You must first run from Analysis | Frequency Analysis prior to running this command.
Response spectrums can be defined from Loads | Response Spectra Library or Input Data |
Response Spectra Library. Inertia forces in global direction X, Y or/and Z from response
spectrum analysis will be calculated and then converted to nodal loads. These nodal forces
will be placed in respective load cases such as INERTIA_LOADCASE_X_MODE_1,
INERTIA_LOADCASE_X_MODE_2 etc.  Existing loads in these load cases will be deleted
prior to the load conversion. In addition, response spectrum load combinations
INERTIA_LOADCOMB_X_MODE_1, INERTIA_LOADCOMB_X_MODE_2 etc. will be created
or recreated. Static analysis will be performed on spectrum load combinations (as well as
normal user-defined load combinations) automatically. Modal combinations will be
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subsequently calculated for results such as displacements, forces and stresses etc. using
CQC, SRSS or ABSSUM on the response spectrum load combinations. Normally, modal
combination results are all positive due to the sign lost during SRSS, CQC and ABSSUM
procedures. However, you can choose to use signage for modal combination results based
on the dominant mode (with maximum participation factor) in each global direction. 

Modal combination results is done in each global direction first. Using directional factors,
these directional modal results will be combined into final modal combination results, which
can be added to any user-defined load combination results if non-zero response spectrum
load factor is specified in the load combination definition (see Create > Loads > Load
Combinations).

13.2.1.15   Concrete Design – ACI 318-02/05/08/11/14

The concrete design module performs concrete design for beams, columns and plates
(bending only) according ACI 318-02, 05, 08, 11 and 14 [Ref. 19].  Static analysis must be
performed successfully before concrete design can be performed.  Sound engineering
judgment is especially important to interpret and apply the design results given by the
program.

Note: The provisions that apply for ACI 318-02 and 05 shall apply to ACI 318-08, 11 and
14 unless explicitly stated otherwise.

Concrete Column Design

General
The concrete column module designs concrete rectangular or circular columns against axial,
uniaxial or biaxial bending as well as shear based on ACI 318-02/05/08/11/14 Code
Provisions.  The program generates EXACT (not approximate or empirical) P-Mx-My
interaction surfaces for all sections according to user-specified design criteria.  The capacity
ratio is computed for each column based on capacity interaction surfaces and axial force-
biaxial bending in each load combination. Slenderness effects are considered for both non-
sway (braced) and sway (unbraced) frames.  Shear design in columns is based on the shear
force envelope with the option to include or exclude axial force influence on concrete shear
capacity.

Axial Load and Moment Convention
For concrete design, compressive and tensile axial loads have positive and negative signs
respectively.  The major moment is designated as Mx in design as opposed to Mz used in
analysis output.  The minor moment is designated as My in both analysis and design.
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Solution Assumptions

· The strain in reinforcement and concrete is directly proportional to the distance from
the neutral axis (ACI 318-02/05 10.2.2).

· The maximum usable strain at the extreme concrete compression fiber is equal to
0.003 (ACI 318-02/05 10.2.3).

· The stress of steel is fs = Es * εs but fs  <= fy where Es = 29000 ksi, εs is steel strain

and fy is the yield strength of steel (ACI 318-02/05 10.2.4).

· The tensile strength of the concrete is neglected in flexural calculation (ACI 318-02/05
10.2.5).

· A uniformly distributed stress of 0.85fc is assumed over an equivalent compression
zone bounded by the edge of the cross section and a line parallel to the neutral axis at
a distance a = β1* c where c is the distance from extreme compression fiber to

neutral axis (ACI 318-02/05 10.2.7.1).

· β1 = 0.85 – 0.05 * (f’c - 4) and 0.65 <= β1 <= 0.85 and f’c unit is ksi

· Reinforcement ratio ρ should be 1% <= ρ <= 8% for column sections (ACI 318-02/05
10.2.7.3).

Solution Algorithms

1.  All sections are EXACTLY solved biaxially based on the solution assumptions
above.  Each section is solved based on the following steps.

2.  Nominal Strength Calculation (Pn, Mnx, Mny)

2a. The nominal capacity of a section is computed at successive choices of biaxial angles. 
The choices of angles are based on the user input for biaxial angle steps found in the
command Concrete > Design Options.  Biaxial angle steps affect the solution accuracy and
speed.  For biaxial problems, steps must be multiples of 4.  A value of 16 ~ 32 is sufficiently
accurate for most sections.  The adequacy of biaxial angle steps can be determined by
smoothness of the Mx-My interaction diagram.  For uniaxial problems, biaxial angle steps

should be set to 4.  This will give P-Mx (+) at 0 degree angle, P-Mx (-) at 180 degrees angle,

P-My (+) at 90 degree angle, P-My (-) at 270 degrees angle.  
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The number of biaxial angle steps is analogous to the number of sides of a polygon used to
approximate a circle or ellipse.  A uniaxial solution in the program is therefore analogous to
using a square to approximate a circle or a rectangle to approximate an ellipse.  A biaxial
solution with 16 angle steps is analogous to using a 16-sided polygon to approximate a circle
or an ellipse.  Obviously, the 16-sided polygon is closer or more accurate to approximate a
circle than a square.  The moral of this comparison is that a low value of biaxial angle steps
tends to give more conservative biaxial capacity for the section.

2b). For each biaxial angle, Pn, Mnx, Mny and maximum tensile steel strain εt are computed

at successive choices of neutral axis distance c using strain compatibility and stress-strain
relations to establish bar forces and the concrete compressive results.  The choices of c are
based on the neutral axial steps found in the command Concrete > Design Options.  Neutral
axial steps affect the solution accuracy and speed.  A value of 250 ~ 500 for neutral axis
steps is sufficiently accurate for most sections.  The adequacy of neutral axis steps can be
determined by smoothness of the P-Mx and/or P-My interaction diagrams.  In addition, the

program always computes several control points.  They are maximum Pn (compression),

minimum Pn (tension), fs = 0; 0.25fy; 0.5fy and 1.0fy (balanced condition).  Concrete

displaced by steel may be optionally included or excluded (by default).

2c). Mnx-Mny contour curves are computed for successive choices of axial forces.  This is

achieved through interpolation on the Pn, Mnx and Mny already calculated for each biaxial

angle in the procedure above.  The choices of axial forces are based on the neutral axial
steps found in the command Concrete > Design Options.   
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3.  Design Strength Calculation (φPn, φMnx, φMny)

Design strength according to ACI 318-02,05/08/11/14 is obtained by multiplying Pn, Mnx and

Mny of each biaxial angle by applying strength reduction factor φ  as determined in the

following (ACI 318-02/05 9.3.2):
Φc = 0.65, α  = 0.80 for tied confinement

Φc = 0.70, α  = 0.85 for spiral confinement for ACI 318-02/05

Φc = 0.75, α  = 0.85 for spiral confinement for ACI 318-08/11/14

For (εt <= εy, compression-controlled sections)

φ = Φc 

For (εt > 0.005, tension-controlled sections)

φ = 0.90
For  (εy  < εt < 0.005)

φ = Φc + (0.9 - Φc) * (εt  - εy ) / (0.005 – εy)

where εt is maximum tensile steel strain for the biaxial angle and εy is steel yield strain (at

balanced condition) 

In addition, φ  Pn must be always less than the following (ACI 318-02/05 10.3.6.1)

Φc * α * [ 0.85 * fc
’ * (Ag – As) + fy * As] if concrete displaced by steel is excluded or 

Φc * α * [ 0.85 * fc
’ * Ag + fy * As] if concrete displaced by steel is not excluded.

4.  Capacity Ratio

Capacity ratio is computed for each section based on the loads and the capacity of the
section.  It is defined as the following:
For a given load set (Pu, Mux, Muy), find the section capacity Mx-My contour at φPn= Pu.  The

capacity ratio for the load set is the larger of: 

Where (φMnx,max, φMny, max) is the interaction point between the line from point (Mux, Muy)

to point (0, 0) and the Mx-My contour line. is the maximum compression or tension capacity of

the section, depending on the positive or negative sign of Pu.  If Pu is outside the maximum

compression or tension capacity, a capacity ratio of 99.9 is assigned.

A capacity ratio equal or less than 1.0 means the design strength is greater than the required
strength; and the section is adequate to resist all input loads. A capacity ratio greater than 1.0
means the design strength is less than the required strength and the section is inadequate to
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resist all input loads.  It is important to realize that capacity ratio defined in the program is just
a measure of section adequacy against loads.  It should not be equated to a factor of safety. 

Capacity Ratio Calculation Example

To illustrate the calculation of capacity ratio in the program, see the following example.
For a given load set (Pu, Mux, Muy) = (333 kip, 180 ft-kip, 125 ft-kip), a Mx-My capacity

contour at φPn = 333 kip is obtained as shown below.  In addition, the maximum

compression capacity = 1050.2 kip.
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The interaction point between the line from point (180 ft-kip, 125 ft-kip) to point (0, 0) and the
contour line is obtained as (214.1 ft-kip, 148.7 ft-kip)

Therefore, the capacity ratio corresponds to the load set is 0.841.  The section is adequate to
resist the load.

P-δ and P-∆ Effects
Two types of second-order moment effects may develop in a frame.  
1). P-δ effect is associated with individual member curvature.  Additional second-order
moment may develop by member (usually a column) axial force (P) acting upon the lateral
deflection (δ) of the column axis away from the chord connecting the column ends.  It is
possible to account for P-δ effects on columns independently.

2). P-∆ effect is associated with the lateral drifts of the frame members.  Additional second-
order moment may develop by axial force (P) acting upon the lateral translation (∆) of the
frame nodes relative to their original position.  It is NOT possible to account for P-∆ effects on
columns independently.

Slenderness Effects
For a non-sway frame, P-∆ effect may be safely ignored and the first-order structural analysis
is therefore sufficient.  The program then accounts for P-δ effect by magnifying the first-order
moments using ACI moment magnification method.

For a sway frame, the second-order structural analysis must be performed to account for P-∆
effect.  In addition, the program accounts for P-δ effect by magnifying the second-order
moments using ACI moment magnification method.  In fact, all columns in sway frames must
first be considered as braced columns under gravity loads acting alone.

Braced or Unbraced Column
The column is considered braced if one of the following two criteria is met:
Criterion 1:  Increase in column end moment due to second-order effects is less than 5% of
the first-order moment

Criterion 2:  Stability index Q for the column story under consideration from the first-order
analysis

(ACI 318-02/05 Eq10-6)

311

423

423
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Section Properties for Structural Analysis and Computing K
It is important to point out that in both first- and second-order analyses; appropriate member
stiffness must be used to account for the effects of axial loads, cracking, and creep.

for normal weight concrete

for wc between 90 and 155 lb/ft3

Moment of inertia (ACI 318-02/05 10.11.1)
= 0.35 Ig for beams and cracked walls

= 0.70 Ig for columns and uncracked walls

= 0.25 Ig for flat plates and flat slabs

Area
A = 1.0 Ag

Note: 
a). Ig and Ag are based on the gross concrete cross section, neglecting reinforcement.

a). Ig for Tee beams can be closely approximated as 2 times Ig for the web.

b). 0.70 Ig should be used for walls first.  If the factored moments and shears indicate that a

portion of the wall will crack due to stresses reaching the concrete modulus of rupture, the
analysis should be repeated with 0.35 Ig for the cracked portions of the wall.

[Ref. 16 pp577]

The program allows a user to modify the moments of inertia through Element Cracking Factor
from Concrete > Cracking Factors.  In order to use stiffness reduction, you also need to
check “Use cracked section properties (Icr) for members and finite elements” in Analysis
Options.  This allows you to consider or ignore cracking in the analysis without re-entering
element cracking information.

Radius of Gyration

427
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Effective Length Factor K

Find relative stiffness ratios ( ) of columns and beams at the top and bottom joints
of the column

                                                                                                  
                                                                                                                                                       
                                                                                                
Section properties are the same as used in the first-order analysis (step 1)

For practical reasons,  for fixed end and  for hinged end.

The effective length factor K is solved from the from the following equations
For braced frames:

For unbraced frames:

The program provides a tool to calculate the effective length factor K based on the input

.  The equations above provide a more accurate K calculation than what is given
by (ACI 318-02/05 10.12.1)

Unsupported Length Lu
The unsupported lengths Luy, Luz of a column are the clear distances between lateral

supports in column local y and z directions (ACI 318-02/05 10.11.3.1).  A zero value of Lu
means that it is equal to the member length between the end nodes.

For non-sway frames, an optional check is made kLu / r <= 34 – 12(M1/M2)  (ACI 318-02/05

Eq10-7).  Braced frame k is used here.  Lu is unbraced length in local x and y directions.  M1
and M2 are the smaller and larger factored end moments on the compression member

respectively.  (M1/M2) is positive if the member is bent in single curvature and negative

otherwise.
 
For sway frames, an optional check is made kLu / r <= 22 (ACI 318-02/05 10.13.2).  Sway
frame k is used here. 

423

423
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Minimum Moments
The program calculates minimum moments for both braced and unbraced frames,

 , where h is in inches (ACI 318-02/05 10.12.3.2).  The program
conservatively applies the minimum eccentricity about both axes simultaneously.

Equivalent Moment Factor Cm (ACI 318-02/05 10.12.3.1)

 if M1 = 0 or M2 = 0

 if transverse load exists

 if end moments only.  (ACI 318-02/05 Eq10-13).  

Although not required, the program also conservatively applies  for ACI 318-
08 /11/14.

The sign of is: positive if the column is bent in single curvature, negative otherwise.

Note, Cm is only applicable to non-sway frames.  You have the conservative option to always
use Cm = 1.0 from Model Design Criteria under Concrete > Design Criteria.

Section Properties for Critical Loads Computation
The EI used in the frame analysis above is an average value.  In designing individual columns,
the following reduced EI should be used to reflect the greater chance of cracking:

(ACI 318-02/05 Eq10-12)

The Infamous
The ratio of maximum factored axial sustained load to maximum factored axial total load.  The

factor  accounts for the effects of creep.

Generally:  

Critical Load Pc

  where (ACI 318-02/05 Eq10-10)
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Moment Magnification Factor

 (ACI 318-02/05 Eq10-9)

Pu is the average of axial force at both ends.  If , the design fails and a

capacity ratio of 999.9 is assigned.

Other Requirements
Reinforcement ratio for columns: 

Bar requirements: minimum 4 bars for tied columns, 6 bars for spiral columns.

Tie requirements: >= #3 for No. 10 longitudinal bars and smaller; >= #4 for No. 11 14, 18
longitudinal bars.

Column Trial Size

The ACI code requires that the reinforcement ratio for columns be within .  It

is usually economical to have .
For tied columns

For spiral columns

Based on rectangular or circular sections used for analysis, the program will generate column
sections with different reinforcement configurations. 

Column Shear Reinforcement

The column shear design is based on 

(ACI 318-02/05 Eq11-1)

where .

Given bw, d, fc, fy, number of stirrup legs n, and stirrup (tie) area Av, the required stirrup

spacing is computed at every analysis station.
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Concrete shear strength
1.  For Pu < 0 (column subjected to tension)

(ACI 318-02/05 Eq11-8)

2.  For Pu >= 0 (column subjected to compression)

(ACI 318-02/05 Eq11-4)

Note: 

· For circular section,  and d = 0.8(2R) where R is the radius of the circular
section.  (ACI 318 11.3.3 and 11.5.7.3)

· Nu = 0 if the influence of compression on concrete shear strength is ignored.

·  (ACI 318 11.1.2)

· ksi in design of shear reinforcement. (ACI 318-02/05 11.5.2)

· Light-weight concrete is not considered.

· Torsional forces are not considered.

The following is the algorithm used to compute the stirrup (tie) spacing(s) in the program.

If , the design fails (ACI 318-02/05 11.5.7.9).

If , no stirrup required (ACI 318-02/05 11.5.6.1).  The program does not check
member depths when applying minimum shear reinforcement for ACI 318-08/11/14.

If , smax <= min(d/2, 24 in) (ACI 318-02/05 11.5.5.1)

If , smax <= min(d/4, 12 in) (ACI 318-02/05 11.5.5.3)

If , s = min <= smax (ACI 318-02/05 11.5.6.3)

Otherwise, s = <= smax (ACI 318-02/05 Eq11-15)

According to ACI 318-02/05, column confinement spacing shall not exceed 16 longitudinal bar
diameters, 48 tie bar or wire diameters, or the least dimension of the compression members.
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The following additional requirements are needed for column spirals:
· The maximum center-to-center spacing:

 s <   (Derived from ACI 318-02/05 Eq10-5)
· The clear spacing between successive turns shall not exceed 3 inches, nor be less

than 1 inch. (ACI 318-02/05 7.10.4.3)

Concrete Beam Design

General
The concrete beam module designs concrete rectangular or Tee beams against enveloped
bending about strong axis (local z) and enveloped shear along local y.  Axial force, bending
about weak axis (local y), and torsion are not considered.  Furthermore, no deep beam action
is considered.  If axial force or biaxial bending actions cannot be neglected, the use of column
design module is recommended.

Beam Flexural Reinforcement

The beam top and bottom flexural reinforcement is computed at each analysis station along
the beam length. Minimum reinforcement is computed for the bottom steel.  The program
designs each beam against positive or negative moment with single layer of tension steel with
tension-controlled condition.  For flexural design, the critical section at a support may be taken
at the face of the support (but not greater than 0.175 * span length from the support center).
The program offers an option to account for these conditions by automatically computing
beam support widths from Model Design Criteria under Concrete > Design Criteria.

The following algorithm assumes one layer of tension steel, that is, dt = d, the depth of the

tension steel centroid.  This assumption is made due to its simplicity and conservative nature
and is reasonable unless the tension steel strain is very close to 0.005 – the tension-
controlled limit strain.

The design result is reflected in top and bottom reinforcement diagrams.
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Rectangular Beam Flexural Design Algorithm

Given b, d = dt, d’, fc, fy and Mu find required As (and As’ if needed)

Step 1: Determine maximum moment without compression steel, using the tension-controlled

limit  and .

Step 2: If , design the section as singly-reinforced as follows:

(ACI 318-02/05 10.5.1)
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Step 3: If , design the section as doubly-reinforced as follows (still assuming the

tension-controlled limit and ):

Note, the tensile steel required to balance the compressive steel is

The design fails if fs’ < 0.  For practical reasons, the design also fails if . 

Tee Beam Flexural Design Algorithm

Given b, bw, hf , d = dt, fc, fy and Mu, find required As

Step a).  Assuming a <= hf and tension-controlled section with 
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If a > hf, go to Step b)

If , the design fails.
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Step b). a > hf and tension-controlled section with 

If , the design fails.

Beam Shear Reinforcement

The member shear reinforcement (stirrup spacing) is computed at each analysis station
along the member length. Stirrup size and number of legs are assumed uniform along the
length of a member as part of input.  For shear design, sections located less than a distance
d from the face of the support may be permitted to be designed for Vu computed at a distance
d from the support (ACI 318-02/05 11.1.3.1).  The program offers an option to account for
these conditions by automatically computing beam support widths from Model Design Criteria
under Concrete > Design Criteria.

The design result is reflected in a stirrup spacing diagram.

Beam Shear Design Algorithm

The shear design for concrete beam is the same as that of concrete column except the axial
force is always treated as zero.

422
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Concrete Slab/Wall Design

General
The concrete slab/wall module designs concrete slabs or walls against enveloped positive
and negative Wood-Armer bending moments in slab local x and y directions.  Axial force
action is ignored.  The program produces contours of required areas of steel which can be
averaged with some commonsense to finish the design. 

Wood-Armer Moments
Wood-Armer Formula [Ref 18, pp198] is the most popular approach to convert Mx, My and
Mxy to orthogonal plate design moments Mux and Muy

The procedure to obtain Mux and Muy for designing plate bottom reinforcement is as follows:
· Mux = Mxx + |Mxy|

Muy = Myy + |Mxy|
· If Mux < 0 and Muy < 0

Mux = 0
Muy = 0

If Mux < 0 and Muy > 0
Mux = 0 
Muy = Myy + |Mxy * Mxy / Mxx|

If Mux > 0 and Muy < 0
Muy = 0
Mux = Mxx + |Mxy * Mxy / Myy|

· Mux >= 0
Muy >= 0

The procedure to obtain Mux and Muy for designing plate top reinforcement is as follows:
· Mux = Mxx - |Mxy|

Muy = Myy - |Mxy|
· If Mux > 0 and Muy > 0

Mux = 0
Muy = 0

If Mux > 0 and Muy < 0
Mux = 0 
Muy = Myy - |Mxy * Mxy / Mxx|

If Mux < 0 and Muy > 0
Muy = 0
Mux = Mxx - |Mxy * Mxy / Myy|

· Mux <= 0
Muy <= 0
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Wood-Armer Formula is a lower bound solution method which satisfies the following
conditions for a given external load: 

· The equilibrium conditions are satisfied at all points in the plate.

· The yield strength of the plate elements is not exceeded anywhere in the plate.

· The boundary conditions are complied with.

A lower bound solution is conservative in nature. 

Stress Singularity
The stresses and bending moments at the point of a concentrated load on the slab are
theoretically infinite.  This theoretically means that if we used all the steel in the world, we still
did not have enough steel to resist the stress at that point.  This is of course ridiculous.  The
reason is of course because we prescribe an impossible loading (“concentrated load”).  If we
distribute the load over a small area (circle), the stresses become finite.

In finite element analysis, the program will never give you a stress of infinite magnitude.  Still,
at a point of concentrated force such as a column acting on a flat plate, stresses may have
rather significant spikes.  According to Ugural [Ref 15, pp116], the actual stress caused by a
load on a very small area of radius rc can be obtained by replacing the actual rc with an

equivalent radius re.

 (rc > 0.5t)

 (rc <= 0.5t)

where t is the plate thickness.

By applying this method, we can use stresses at half of the slab thickness instead of those at
the concentrated loading point.  By excluding the finite elements (usually finely meshed) near
the concentrated loading points, we can provide practical and reasonable design results.

Flexural Reinforcement

The plate top and bottom flexural reinforcement in local x and y direction is computed at each
nodal point as well as the center.  No minimum reinforcement is considered.  The program
only designs each plate with tension-controlled condition.  The procedure is similar to that of
concrete beams except no double reinforcement is considered.

13.2.1.16   Steel Design

The steel design module performs steel design for beams and columns according AISC 15th
edition LRFD [Ref. 21].  Static analysis must be performed successfully before steel design
can be performed.  Sound engineering judgment is especially important to interpret and apply
the design results given by the program.

Due to the fact that the software provides step-by-step calculation procedures, the technical
treatment of the design process is kept minimal here.

425
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Section Orientation

The orientations of section local X and Y axes of various AISC shapes are shown in the figure
below.
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Member Internal Forces and Moments

1. Axial force P acts perpendicular to the section.  Moments Mx and My act about section local
X and Y axes respectively.  They have the following sign conventions.

Axial Force P: positive for compression; negative for tension
Moment Mx: Positive when section top most fiber is under compression.
Moment My: Positive when section rightmost fiber is under compression.

2.  All moments are referenced about the geometric centroid of the gross section.

3.  Loads are the required strength computed by the code-specified factored load
combinations using either hands or analysis program.  It is assumed that an overall 2nd

program uses moment magnification procedure to calculate the P-delta (P-δ) effect, which
accounts for slenderness of columns in non-sway structure or for slenderness along the
lengths of columns in sway structure.

4.  Critical ratio (also called capacity ratio) is computed for each section based on the
magnified factored loads and the capacity of the section.  Critical ratio equal or less than
1.0 means the design strength is greater than the required strength and the section is
adequate.  Critical ratio greater than 1.0 means the design strength is less than the
required strength and the section is inadequate.

Solution Algorithms

Because detailed step-by-step calculation procedure is available for each member on Design
> Steel Design Results, we will not list the algorithm here.
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The following works are not referenced directly in this documentation, but are the primary
programming references in the development of this program.  Like the great engineering
works cited above, these great programming works deserve the respect of being listed here.

a.  B. Stroustrup, “The C++ Programming Language” 3rd ed., Addison-Wesley 
Publishing Company, 1997

b.  R.Wright & M.Sweet, “OpenGL SuperBible”, 2nd ed., Waite Group Press, 2000
c.  D.J. Kruglinski, “Inside Visual C++”, Microsoft Press, 1996
d.  M. Woo & J. Neider & T. Davis & D. Shreiner, “OpenGL Programming Guide”,

Addison-Wesley Publishing Company, 1999
e.  C. Petzold, “Programming Windows 95”, Microsoft Press, 1996 

f.  C. Musciano & B. Kennedy, “HTML The Definitive Guide” 3rd ed., O’Reilly &
Associates, Inc., 1998

13.2.1.18   Appendix

Unit Conversions

From English to Metric From Metric to English

1 ft => 0.3048 m 1 m => 3.28084 ft

1 in => 25.4 mm 1 mm => 0.03937 in

1 kip => 4.44822 kN 1 kN => 0.22481 kip

1 lb => 4.44822 N 1 N => 0.22481 lb

1 kip-ft => 1.35582 kN-m 1 kN-m => 0.73756 kip-ft

1 kip-in => 0.112985 kN-m 1 kN-m => 8.85073 kip-in

1 lb-ft => 1.35582 N-m 1 N-m => 0.73756  lb-ft

1 lb-in => 0.112985 N-m 1 N-m => 8.85073  lb-in

1 kip/in 2̂ => 0.00689476 kN/mm 2̂ 1 kN/mm 2̂ => 145.04 kip/in 2̂

1 lb/in 2̂ => 0.00689476 N/mm 2̂ 1 N/mm 2̂ => 145.04 lb/in 2̂
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Designations, diameters and areas of standard bars

ASTM 615 (English) ASTM 615 96a (Metric)

Bar No Diameter (in) Area (in 2̂) Bar No
Diameter

(mm)
Area (mm 2̂)

#3 0.375 0.11 #10 9.5 71

#4 0.500 0.20 #13 12.7 129

#5 0.625 0.31 #16 15.9 199

#6 0.750 0.44 #19 19.1 284

#7 0.875 0.60 #22 22.2 387

#8 1.000 0.79 #25 25.4 510

#9 1.128 1.00 #29 28.7 645

#10 1.270 1.27 #32 32.3 819

#11 1.410 1.56 #36 35.8 1006

#14 1.693 2.25 #43 43.0 1452

#18 2.257 4.00 #57 57.3 2581

13.2.2  2D Frame

Need more? Ask Us a Question

This module provides force & deflection analysis, steel member stress analysis and wood
stress analysis for two dimensional frames.

The frame you create can be general in nature...the module is not limited to trusses or
frames with rigid connections. You have the ability to specify the connection between all
members in terms of axial, shear and bending restraints or releases. 

Here are the highlights of this module:

· Use the Frame Wizard to automatically create common trusses and frames.

· Generic joint & member method of specifying the geometry of the frame.

· Completely flexible way to specify how the X, Y & Z degrees of freedom for joints are
connected to the boundary and how the members are connected to the joints (three
degrees of freedom are available at each end of each member).

· Apply forces and moments directly to joints. You can also specify joint start
temperatures.

· All loads can have dead, live, roof live, snow, wind, seismic and earth types.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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· Apply concentrated and distributed loads to beams. These loads can be Global or local
in direction and can be applied as forces, moments or temperature changes.

· Members are easily linked to section properties. For stress analysis you can set
unbraced length, slenderness factors, Cb & Cm for members.

· Loads and members can be deactivated for quick modeling of alternatives.

· Complete AISC and NDS section databases are available.

· Specify material properties used by sections.

· Specify an extensive set of load combinations.

· Complete graphics of frame with deflected shapes.

· Complete stress & deflection diagrams of members individually.

· Extensive reporting capability and control.

· Module uses beam elements and a very fast matrix solver. With each change of the
input data, the frame can be completely recalculated in an instant. (For convenience with
large models or when running many load combinations, this module has been enhanced
with the ability to turn the Automatic Recalculation feature off, and to trigger manual
recalculations only when desired.)

Note: This module is intended to be a simple alternative to complex frame programs. The
intent is to provide a simple and fast tool to perform simple indeterminate analysis &
member design. No P-Delta effects, exotic elements, or non-linear analysis will ever be
added to this module.
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Program Limitations

Maximum Number of Allowed:

Joints = 300
Joint Loads = 600
Beams = 600
Beam Point Loads = 600
Beam Distributed Loads = 600
Sections = 100
Materials = 50
Load Combinations = 100

13.2.2.1   Frame Wizard

Overview

The Frame Wizard can create complete 2D Frame models for many typical framing
configurations and truss layouts with just a few simple inputs. 

The Frame Wizard is also especially helpful when you are just beginning to use this
module and want to learn about how to specify joint end restraints and member end
releases.

Types of Models the Frame Wizard Can Generate

Pratt Truss

Warren Truss

Vierendeel Truss

Howe Truss

Inverted Warren Truss
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Single Bay 3-Member Frame

Continuous Member

Multi-Bay One Story Frame

Multi-Story Single Bay Frame

Multi-Story Frame

Please send additional requests to support@enercalc.com.

mailto:support@enercalc.com
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Example: Using the Frame Wizard to create a Pratt Truss

Creating a truss with the Frame Wizard is extremely simple. Just start by selecting
[Pratt] and clicking [Next].

The screen you see below will be displayed.

Simply enter the overall length and height of the truss and the number of panels the
truss will have. The sample image shown has 6 panels.
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The next entries allow you to easily specify a member size for the three main
members that are typically the same on a truss like this (Verticals, Horizontals, and
Diagonals).

The button to the right of each data entry area provides access to the built-in section
database in ENERCALC SEL.

If you DO specify a database section, all of the associated section properties will be
brought into the frame model for you.

If you DO NOT specify a database section, then the members will be assigned a
name of "Vertical", "Diagonal" or "Chord" as a section group. Then all you need to do
is enter property values for those three sections.

To finish just click [Finish]. The model will be instantly created.

Example: Using the Frame Wizard to create a Continuous Beam

The Frame Wizard is an extremely efficient way to model a continuous beam. Just
start by selecting [Continuous Member] and then click [Next]. 
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The screen you see below will be displayed:

Note: This wizard allows just one section to be entered BUT you can easily change
that beam specification for each span after the model is built.

Enter the Number of Spans first.

The next entry allows you to easily specify a member section name. The button to the
right of each data entry area provides access to the built-in section database in
ENERCALC SEL. 

If you DO specify a database section, all of the associated section properties will be
brought into the continuous beam model for you.

If you DO NOT specify a database section then the members will be assigned a
name of "Beam" as a section group. Then all you need to do is enter property values
for that section.

For specification of span lengths you can either use [Equal Spacing]:

-or- [Specify Spacing] which allows you to enter the span lengths for each span.

Then just click [Finish], and the model will be instantly created.
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13.2.2.2   Joints & Joint Loads

Need more? Ask Us a Question

Joints are the points in space where members are interconnected. Members can ONLY
connect to another member or the boundary by first connecting to a joint.

IMPORTANT: See JOINT RESTRAINTS below.

Joints & Loads

This tab contains two sub-tabs that allow you to specify joints and loads applied to the
joints, and one sub-tab dedicated to the display of results that are relevant to joints. 

Note: The data entered into this module is linked by a database system. The effects of this
linking can be seen in the screen capture seen below.  Notice that the table in the upper
half of the view lists available joints for which Joint Data can be viewed. As a result of the
data linking, selecting Joint #1 in the upper table automatically causes the lower table to
display a list of members connected to Joint #1.  

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Automatic Joint Generation

You can use the [Generate] button to have joints automatically generated. The joint
generation popup is self explanatory....just select from the mode of generation, specify a
label increment, the number of joints to generate, and the x and y distance increments to
use. The "Grid Irregular X & Y" can generate some very complex joint layouts.
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Another powerful tool is the Also Generate Members option, which will generate members
to interconnect between the joints for the generation grid or arc/circle you have specified.

Joint Restraints

These interconnections are extremely important, and when set incorrectly, they lead to the
majority of the instabilities and other unexpected results when using this 2D Frame 
module. The connections between members and the connections to the boundary have a
significant effect on structural behavior, and as such, they warrant a thorough discussion
and complete understanding. 

Always keep in mind the following concepts related to joint boundary restraints and the end
releases of the member(s) connecting to the joint:

· Joints have Degrees of Freedom (DOF) associated with them.  

· In the 2D Frame program, each joint has two translational and one rotational DOF.  

· An individual DOF may be restrained or released.  

· DOF can be defined as Boundary Restraints or as Member End Releases.

· When the degrees of freedom are defined as Boundary Restraints, they are defined with
respect to the global coordinate axis system.

· When the degrees of freedom are defined as Member End Releases, they are defined
with respect to the member local coordinate axis system.

The term Degrees of Freedom refers to the capability of a joint to move in the X and Y
direction and to rotate about the Z axis.
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An X Restraint prevents a joint from moving in the Global X direction.
A Y Restraint prevents a joint from moving in the Global Y direction.
A Z Restraint prevents a joint from rotating about the Global Z axis.

Please see the diagram below for a brief primer on joint restraints and member releases. 

The dark black items define the joint restraints. Joint restraints attach the joint to the
boundary. The boundary is an infinitely stiff support and is most commonly a foundation.
When a joint is restrained against translation in the X and Y directions and against rotation
about the  Z axis, it is held firmly in place. Any forces or moments applied to it will result in
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a reaction which is the boundary applying a force to the joint to keep it from moving in a
particular direction.

THE MOST IMPORTANT PIECE OF INFORMATION: Each joint must be prevented from
moving in/rotating about each of its three degrees of freedom, either by a joint restraint or
by a positive connection to member. If a joint can translate or rotate in an unrestrained
manner, then it is unstable.

NEXT MOST IMPORTANT PIECE OF INFORMATION: When a joint restraint is
specified, then any connected members that are not released in that particular direction
will not deflect in that direction. If a joint has an "X" restraint and a member framing into that
joint does not have an "X" release, then the member is actually rigidly connected to the
boundary through the joint.

ALSO IMPORTANT: When you are modeling a frame, nearly all joints will be free from the
boundary. This means that those joints will need to have their X, Y & Z degrees of freedom
restrained by a connection to one or more members.  Because members can only attach
to each other through a joint, this is usually handled by virtue of the member having all
three degrees of freedom "fixed" at its ends.  BUT FOR TRUSS CONNECTIONS, THIS
CAN CAUSE PROBLEMS WITH THE "Z" rotational degree of freedom. For truss models
(where moments are not applied to nodes), it may be easier to achieve stability for all joints
by declaring all joints as "fixed" against rotation about the Z-axis, and then "pinning" both
ends of all members to prevent the transfer of moment from one member to another.
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Joint Data

Joint Data Tab

This tab is where you add and edit the joints that define the member interconnections for
the frame.

Joint Label
The label for a joint can be up to 25 characters long. They are CASE INSENSITIVE
meaning the module internally converts all joint names to all lower case for internal
usage.

Location
This is the X and Y location of the joint in a Cartesian coordinate system.
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Boundary Restraints
These specify how the joint is connected to the boundary. The boundary is an infinitely
rigid item and is typically a footing. See the Joints & Joint Loads  topic for more
information.

When you click on these items (or use [Tab] to move between them) the entry turns
into a drop-down list box with the available selections.

Temperature
This specifies the base temperature for the joint. It is only used when you are defining
temperature loads for the members.

[+Add Joint]

Prompts you for the label to assign to the newly added joint. Joint labels can be up to
25 characters long.

546
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[- Delete Joint]
Deletes the highlighted joint after your confirmation. Keep in mind that members
depend upon joints for connectivity. So if there are any members connected to a joint,
the members will be deleted if the joint is deleted. Any joint loads that were assigned to
a joint will also be deleted if the joint is deleted.

Generate
See bottom of this section.

Joint Sketch/Full Frame Sketch
The Joint Sketch displays a graphic representation of the individual joint that is
currently selected in the list of joints along with the member(s) that frame into it.  The
Full Frame Sketch displays a graphic representation of the entire model with the
currently selected joint highlighted for easy recognition.

Editing Joint Information

Click on any data item in the joint list, and the list will switch to an editing mode. See the
image below where we have clicked on the "X Loc" for joint 1.

You can type in a numeric value or use the "spin" buttons to change the value by a fixed
decimal amount.

To finish the entry either press [Tab], [Enter] or click on another data item in the list.
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When your entry is completed the entire frame will be recalculated if the Auto
Calculate option is selected.

Automatic Joint Generation

You can use the [Generate] button to initiate the automatic generation of joints. Just select
from the mode of generation, and you can specify the label and the x and y distance
increments to use. The "Grid Irregular X & Y" can generate some very complex joint
layouts.

Another powerful tool is the Also Generate Members option, which will generate members
to interconnect the joints for the generation grid or arc/circle you have specified.
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Joint Loads

Joint Loads 

This tab provides the input locations for all loads applied to the joints in the frame. 

Select Joint: list is where you select the joint for which you wish to view/modify loads.
This selection controls what is visible in the other two sections.

Applied Loads for Joint: is where you assign and edit the loads applied to that joint.

Adding & Deleting Loads

To add a joint load just click the [Add] button and a new load entry line will be added at the
bottom of the list for the currently selected joint.
To delete a load just click on the load line you wish to delete and click the [Delete] button.
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Editing Joint Load Information

Click on any data item in the joint load list, and it will switch into an editing mode. See the
image below where we have clicked on the Dead load column in the first line in the list of
loads associated with joint 4.

You can type in a numeric value or use the "spin" buttons to change the value by a fixed
decimal amount.

To finish the entry either press [Tab], [Enter] or click on another data item in the list.

When your entry is completed the entire frame will be recalculated if the Auto
Calculate option is selected.

Note: If a load is applied in the same direction that a Joint Restraint is specified, that load will
immediately be "absorbed" by the joint restraint, so it will not have any effect on the frame.
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Joint Results

Joint Results

This tab displays the calculated displacements/rotations and reactions for the joint
selected in the Select Joint list.

13.2.2.3   Members & Member Loads

Need more? Ask Us a Question

"Member" is the generic term that describes the beams, columns, struts, braces,
diagonals, hangers, and other structural entities that make up the truss or frame. This
module uses a general stiffness matrix approach to solve for forces and deflections.
Members are modeled by one-dimensional (length-only) entities that offer resistance to
axial loads, bending moment about an axis perpendicular to the plane of the frame, and
shear forces acting in the plane of the frame.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Members & Loads

Member End Releases

These interconnections lead to the greatest potential for instabilities and other unexpected
effects from the use of the 2D module. The connections between members and the
connections to the boundary have a significant effect on structural behavior, and as such,
they warrant a thorough discussion and complete understanding. Always keep in mind the
following concepts related to joint boundary restraints and the end releases of the
member(s) connecting to the joint:

· Joints have Degrees of Freedom (DOF) associated with them.  

· In the 2D Frame Analysis program, each joint has two translational and one rotational
DOF.  

· An individual DOF may be restrained or released.  

· DOF can be defined as Boundary Restraints or as Member End Releases.

· When the degrees of freedom are defined as Boundary Restraints, they are defined with
respect to the global coordinate axis system.

· When the degrees of freedom are defined as Member End Releases, they are defined
with respect to the member local coordinate axis system.

The term Degrees of Freedom refers to the capability of a joint to move in the X and Y
direction and to rotate about the Z axis.

An X Restraint prevents a joint from moving in the Global X direction.
A Y Restraint prevents a joint from moving in the Global Y direction.
A Z Restraint prevents a joint from rotating about the Global Z axis.
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Please see the diagram below for a brief primer on joint restraints and member releases.

The dark black items define the joint restraints. Joint restraints attach the joint to the
boundary. The boundary is an infinitely stiff support and is most commonly a foundation.
When a joint is restrained against translation in the X and Y directions and against rotation
about the  Z axis, it is held firmly in place. Any forces or moments applied to it will result in
a reaction which is the boundary applying a force to the joint to keep it from moving in a
particular direction.

THE MOST IMPORTANT PIECE OF INFORMATION: Each joint must be prevented from
moving in/rotating about each of its three degrees of freedom, either by a joint restraint or
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by a positive connection to member. If a joint can translate or rotate in an unrestrained
manner, then it is unstable.

NEXT MOST IMPORTANT PIECE OF INFORMATION: When a joint restraint is
specified, then any connected members that are not released in that particular direction
will not deflect in that direction. If a joint has an "X" restraint and a member framing into that
joint does not have an "X" release, then the member is actually rigidly connected to the
boundary through the joint.

ALSO IMPORTANT: When you are modeling a frame, nearly all joints will be free from the
boundary. This means that those joints will need to have their X, Y & Z degrees of freedom
restrained by a connection to one or more members.  Because members can only attach
to each other through a joint, this is usually handled by virtue of the member having all
three degrees of freedom "fixed" at its ends.  BUT FOR TRUSS CONNECTIONS, THIS
CAN CAUSE PROBLEMS WITH THE "Z" rotational degree of freedom. For truss models
(where moments are not applied to nodes), it may be easier to achieve stability for all joints
by declaring all joints as "fixed" against rotation about the Z-axis, and then "pinning" both
ends of all members to prevent the transfer of moment from one member to another.

Member Data

Member Data 

Members always span between two joints. The Member End Conditions tell the module
how each of the three degrees of freedom at each end of the member are attached to the
joint. To connect two members rigidly together you must specify the two connecting ends
as "fixed" conditions for all three degrees of freedom. That locks each beam end to the
joint.

For each member you can specify the section to use for its properties, and values to be
used when stress analysis is performed (unbraced length, slenderness factor, Cm and
Cb).

You can also set the member to be inactive to test force distributions and stresses for
alternate framing conditions.
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Editing Member Information

Click on any data item in the member list, and the list will switch into an editing mode. See
the image below where we have clicked on the "X" degree of freedom for the I: end of
member 1-2.

You can type in a numeric value or use the "spin" buttons to change the value by a fixed
decimal amount.

To finish the entry, either press [Tab], [Enter] or click on another data item in the list.

Note: Each column in the Member Data table can have its own type of editing mode. The
Active column turns into a checkbox for yes/no selections.  The Section Name column
turns into a button so you can select or add a section from the Section list. See
descriptions for each item below.

Adding & Deleting Members

To add a member click the [Add Member] button. You will be prompted for three pieces of
information:

1)  A label for the member.
2)  The member's "I" joint number.
3)  The member's "J" joint number.
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In the screen capture below you will notice a button to the right of the joint label entries.

Just click in the "I" or "J" joint entry and click the [Lookup Joints] button .
This will display a window where you can scroll through the list of created joints and select
one. Simply click on one of the listed joints and then click [Select].

To delete a member, select the member and click [Delete Member]. After you approve
the deletion, that member and all loads applied to that member will be deleted.
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Generating Members

You can use the [Generate] button to initiate the automatic generation of members. This
is a simple process that automates member creation by generating members between
existing nodes in the specified order. 

Note: This tool will generate new members, but it will not generate new nodes.

Detailed Item Descriptions  (see 2 screen captures below)

Member Label
This label can be any combination of letters and numbers. It is common to use
numbers for joints and letters for members, but a very convenient member labeling
convention is to use the I and J joint numbers separated by a dash. So the member
between joint 5 and 12 would be labeled "5-12".

The member label can ONLY be specified when Adding the member. After that point,
the name can't be changed unless the member is deleted and added again.
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Active
This item is a yes/no selection. When you click on it or [Tab] to it, the entry changes to
a checkbox. When the box is checked, the member will be considered active,
meaning that it will contribute stiffness to the model. When the box is not checked, the
member will be considered inactive, meaning that it will be ignored in the analysis and
will not contribute stiffness to the model.

Weak Orientation
This item allows the member to be rotated so that its strong axis is in the plane of the
truss or frame.  By default. the member is assumed to be oriented so that its strong
axis is perpendicular to the plane of the truss or frame.
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Section Name
This establishes what section is to be used for that member. When you click on it or
[Tab] to it, the entry changes to a button labeled Lookup.

When you click the [Lookup] button, a selection window appears as shown below:

On this window you can scroll through the sections you have already added to the
section list.



Calculation Modules 566

© 2024  ENERCALC, LLC

Note that the sections are listed with both Section labels and Group labels. A Group
label is used when you want to have more than one member have the same section
properties. In the screen capture above, notice that there are groups named "Chord",
"Diagonal", and "Vertical", all of which have the same section assigned to them. This
offers two convenient benefits:

· First, it provides a handy way to manage multiple sets of members, some of which
may have the same section.

· Second, by assigning a group name to the appropriate members in the model, it is
possible to change the AISC or NDS section assigned to all members of that group
by simply assigning a new section to the group, rather than having to assign the new
section to many individual members.

The [+Add Section] button provides access to the built-in section property databases.
It displays the screen below, which allows you  to either type in a typical section name
or click a button and display the database to select the desired section from the
database.
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Joints
These two columns let you specify and change the I and J end joints of a member.
When you click on these columns, the entry will change to a [Lookup] button as
shown below:

Clicking that button displays a window where you can scroll through the joint list and
click to identify the desired joint.
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I & J End Conditions
These six columns allow you to specify how the ends of the member are attached to
the joints. When you click on or [Tab] to one of these columns, the entry will change to
a drop-down list box offering appropriate fixity options:

In order to most efficiently describe the I & J End Conditions, it helps to introduce the
concept of the member local axis system. Each member can be thought of as having
its own x, y, and z coordinate axes that are mutually perpendicular and follow the right-
hand rule. The orientation of the member local axes can be determined as follows:

1. The local x axis is always parallel to a vector from the "I" node to the "J" node.
(This axis is parallel to the longitudinal axis of the member.)

2. The local z axis is always parallel to the Global Z axis and points out of the plane
of the screen. 

3. The local y axis can be found by taking the vector cross product of local z cross
local x. (Envision using the right hand to rotate the local z axis into the local x axis,
and the right thumb will automatically indicate the positive direction of the local y
axis.)

Note: It is important to understand that I & J End Conditions are defined with respect to
the member local axes, not the Global axis system.
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A "Fixed" status for a particular end of a member, for a particular degree of freedom
(X, Y or Z) means that end of the member is locked to the joint for that degree of
freedom. A "Free" or "Pinned" status means that end of the member is disconnected
from the joint for that degree of freedom. Here are some examples:

X, Y, Z Setting How it will work

Fixed, Fixed, Fixed The member is locked to the joint. If this joint was
completely restrained to the boundary, then this end
of the member would have an X and Y force reaction
and a Z moment reaction.

Fixed, Fixed, Pinned The member is locked to the joint in its local X and Y
directions, meaning that this end of the member
cannot translate with respect to the joint, however,
this end of the member is free to rotate independently
of the joint about the member's local Z axis (which is
always parallel to the Global Z axis).

Fixed, Free, Fixed The member is locked to the joint with respect to
translation in the local X axis direction. It is
disconnected from the joint with respect to
translation in the local Y axis direction. It is locked to
the joint with respect to rotation about the member's
local Z axis.

If this member is oriented horizontally, then this
combination of end conditions could be thought of as
a vertical roller. When a member is in the horizontal
orientation, its member local axes are parallel to the
corresponding Global axes. Therefore, the fixed
condition in the local X axis direction means that this
end of this horizontal member cannot move left or
right in the Global X direction. The free condition in
the local Y direction means that this end of this
horizontal member is free to move up and down in
the Global Y direction. Finally, the fixed condition
about the local Z axis means that this end of the
member is fixed against rotation about the local Z
axis, which is parallel to the Global Z axis.  
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Along the bottom of the list is a set of buttons that allows you to quickly set the Z-axis
rotation end conditions. Clicking one of these buttons will set the end releases for both
ends of the member that is currently selected in the list.

NOTE! A truss connection is unique. You must look at the joint where the truss
members intersect. If they are all free to rotate, you can set the "X" and "Y" conditions
of all member ends at that joint to "Fixed". And for all "Z" conditions you can set them
to "Pinned" so they can rotate freely.  Then for each joint you can set its "X" and "Y"
restraint to "Free" (assuming it is not a support location) and set its "Z" restraint to
"Fixed", so that the joint will be stable.

Length
This value is automatically calculated for you from the distance between the I and J
joints.
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Unbraced Length
Enter the unbraced compression edge length that should be used for allowable stress
analysis of this member. Entering a "-1" instructs the program to consider the full
length of the member to be unbraced. This is a convenience, so the actual member
length does not need to be determined and entered for unbraced members.

Any other number (0.00 or greater) is used as the unbraced length.  Note that the
unbraced length can be assigned a value that is greater than the node-to-node length
of a member.

Lu-y is used as the unbraced compression edge length for flexural design.  It is also
used in K-y * Lu-y to define the unbraced length for column buckling about the y axis of
the member.

Lu-z is used in Kz * Lu-z to define the unbraced length for column buckling about the z
axis of the member.

As of July 2023 the program now collects an Lb value for each member.  Lb defines
the unbraced length to use in determination of the flexural capacity of the member. 
(Previously the module was interpreting the value of Lu-z to serve double-duty as the
unbraced length for column buckling about the Z axis as well as unbraced length for
flexure.  Decoupling this forced relationship allows greater flexibility in modeling design
conditions.)

Slenderness
This entry is a simple multiplier to be applied to the Unbraced Length you have
entered.

Cm & Cb
You can specify these values for use in allowable stress calculations.
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Default Member Orientation

Based on the concept of the member local axis system introduced above, it is now
meaningful to describe the default orientation of the various sections that can be
assigned to a member in a 2D Frame Analysis model.  Of most interest is the default
orientation of steel sections.  When a steel section is assigned to a member, it will be
assumed to be oriented as shown in the following diagram, which references the
member local Z axis, the axis that is perpendicular to the plane of the model by default:

Member Loads

Member Loads 

This tab provides the input locations for all member loads applied to the frame EXCEPT
member self weights. Member self weight loads can be automatically generated using the
controls on the Load Combinations tab.

Select Member: lists all members in the model. This is where you click to select a
member for which to add/delete/modify loads. This selection controls what is visible on the
other two lists and in the graphic image at the bottom. The column labeled # Lds indicates
the number and type of loads that have been applied to each member.  "P" represents a
point load, and "D" is for distributed loads. "1-P, 2-D" means that the member has one
point load and two distributed loads applied to it.

Point Loads for Member X: shows the point loads that are applied to the selected
member.
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Distributed Loads for Member X: shows the distributed loads that are applied to the
selected member.

At the bottom is a sketch showing the member and applied loads for reference.
 

When you click on any item in the two load entry lists, that location in the list will change
into a data entry item. The columns in the list have their own specific entry types that will
be described below.

Point Loads Entry List

Active
This is a Yes/No checkbox that allows you to turn the load on and off. This is useful
when you want to quickly see the effect of removing the load without actually having to
delete the load and then potentially have to redefine the load at a later time.
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Direction
This specifies the direction of application of the load. Here is a description of each
direction:

Global X: This point load acts in a direction parallel to the Global X Axis. Entering a
positive value will apply the load to the right (in the positive X direction).

Global Y: This point load acts in a direction parallel to the Global Y Axis. The algebraic
sign on the magnitude will affect the direction of application based on the Applied
Global Y Load Sign Convention setting on the General tab as follows:

When the Applied Global Y Load Sign Convention is set to "Global +Y Loads act
towards +Y (Upward)", then loads applied in the Global Y direction with a positive
algebraic sign act upward, and loads applied in the Global Y direction with a
negative algebraic sign act downward.

When the Applied Global Y Load Sign Convention is set to "Global +Y Loads act
towards -Y (Downward)", then loads applied in the Global Y direction with a
positive algebraic sign act downward, and loads applied in the Global Y direction
with a negative algebraic sign act upward.

In order to most efficiently describe the direction of application of the "Local" load
types, it helps to refer to the member local axis system. Each member can be thought
of as having its own x, y, and z coordinate axes that are mutually perpendicular and
follow the right-hand rule. The orientation of the member local axes can be determined
as follows:

1. The local x axis is always parallel to a vector from the "I" node to the "J" node.
(This axis is parallel to the longitudinal axis of the member.)

2. The local z axis is always parallel to the Global Z axis. 
3. The local y axis can be found by taking the vector cross product of local z cross

local x.  (Envision using the right hand to rotate the local z axis into the local x
axis, and the right thumb will automatically indicate the positive direction of the
local y axis.)

Local x: This point load acts parallel to the member's local x axis. If this load is
specified with a positive magnitude, the load will act in the positive direction of the local
x axis. If this load is specified with a negative magnitude, the load will act in the
negative direction of the local x axis.

Local y: This point load acts parallel to the member's local y axis. If this load is
specified with a positive magnitude, the load will act in the positive direction of the local
y axis. If this load is specified with a negative magnitude, the load will act in the
negative direction of the local y axis. 

It should now be obvious that it is VERY important to have a thorough understanding of
member orientation when using "Local" load types.
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Moment: This specifies that the load is a concentrated moment. Positive moments
follow the right-hand rule and apply a counter-clockwise rotational force to the member
(when viewing the model from the positive Z direction).

Temperature: This is used to specify temperatures at particular locations along the
length of a member. The module then uses these spot temperatures, in conjunction
with the joint temperatures specified in the Joint Data list, to establish temperature
gradients along the member(s). The module will calculate the effects of the specified
temperature gradient from the end joint to the location along the member at which the
temperature was specified. If you apply more temperature loads, the gradients are
developed between each adjacent point of temperature load.

Location
This specifies the distance from the "I" joint where the point load is located.

Load Type & Magnitude
You can enter seven different types of loads on the frame and combine them using the
factors on the Load Combinations tab.

Distributed Load Entry List

Active
This is a Yes/No checkbox that allows you to turn the load on and off. This is useful
when you want to quickly see the effect of removing the load.
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Direction
This specifies the direction of application of the load. 

Here is a description of the different directions:

Global X: This load acts in a direction parallel to the Global X Axis and is distributed
along the full length of the member. If the member is sloped, the load will be applied for
the full length of the member. So if a member has a 10-foot rise and a 10-foot run, the
length of the load will equal 14.14 feet. Entering a positive value will apply the load to
the right (in the positive X direction). 

Global Y: This load acts in a direction parallel to the Global Y Axis and is distributed
along the full length of the member. If the member is sloped, the load will be applied for
the full length of the member. So if a member has a 10-foot rise and a 10-foot run, the
length of the load will equal 14.14 feet. The algebraic sign on the magnitude will affect
the direction of application based on the Applied Global Y Load Sign Convention
setting on the General tab as follows:

When the Applied Global Y Load Sign Convention is set to "Global +Y Loads act
towards +Y (Upward)", then loads applied in the Global Y direction with a positive
algebraic sign act upward, and loads applied in the Global Y direction with a
negative algebraic sign act downward.

When the Applied Global Y Load Sign Convention is set to "Global +Y Loads act
towards -Y (Downward)", then loads applied in the Global Y direction with a
positive algebraic sign act downward, and loads applied in the Global Y direction
with a negative algebraic sign act upward.

Projected X: This load acts in a direction parallel to the Global X Axis, but it is applied
only to the length of the member projected onto the Global Y Axis.  So if a member has
a 10-foot rise and a 20-foot run, the length of the load will equal 10.00 feet (the rise of
the member).
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Projected Y:  This load acts in a direction parallel to the Global Y Axis, but it is applied
only to the length of the member projected onto the Global X axis.  So if a member has
a 10-foot rise and a 20-foot run, the length of the load will equal 20.00 feet (the run of
the member).

In order to most efficiently describe the direction of application of the "Local" load
types, it helps to refer to the member local axis system. Each member can be thought
of as having its own x, y, and z coordinate axes that are mutually perpendicular and
follow the right-hand rule. The orientation of the member local axes can be determined
as follows:

1. The local x axis is always parallel to a vector from the "I" node to the "J" node.
(This axis is parallel to the longitudinal axis of the member.)

2. The local z axis is always parallel to the Global Z axis.
3. The local y axis can be found by taking the vector cross product of local z cross

local x.  (Envision using the right hand to rotate the local z axis into the local x
axis, and the right thumb will automatically indicate the positive direction of the
local y axis.)

Local x: This distributed load acts parallel to the member's local x axis. If this load is
specified with a positive magnitude, the load will act in the positive direction of the local
x axis. If this load is specified with a negative magnitude, the load will act in the
negative direction of the local x axis.

Local y: This distributed load acts parallel to the member's local y axis. If this load is
specified with a positive magnitude, the load will act in the positive direction of the local
y axis. If this load is specified with a negative magnitude, the load will act in the
negative direction of the local y axis. 

It should now be obvious that it is VERY important to have a thorough understanding of
member orientation when using "Local" load types.

Temperature: This is used to specify temperatures at particular locations along the
length of a member. The module then uses these spot temperatures, in conjunction
with the joint temperatures specified in the Joint Data list, to establish temperature
gradients along the member(s). The module will calculate the effects of the specified
temperature gradient from the end joint to the location along the member at which the
temperature was specified. If you apply more temperature loads, the gradients are
developed between each adjacent point of temperature load.

Location - Start, End
This specifies the distance from the "I" joint to the beginning and end of the load.
Leaving BOTH values as zero (0.0) will cause the load to be applied to the full length
of the member.

Load Type & Magnitude
You can enter seven different types of loads on the frame and combine them using the
values on the Load Combinations tab.
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Member Forces

This tab allows you to review the final calculated forces for a member. 

To review member forces, first click the member of interest in the Select Member list.
Next, click on a load combination in the Select Load Comb. list.  The member end forces
will be displayed for the chosen load combination, and a table of member forces at
increments along the length of the member will be shown.

This tab provides a more simplified view of member forces than the large tables displayed
on the Results tab.
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13.2.2.4   Sections & Materials

Need more? Ask Us a Question

The two tabs under Sections & Materials provide the ability to define the section properties
and material properties for the members used in the frame.

Section Data

The Section Data tab allows you to specify sections to be used for the frame.

Section Label vs. Group Label

These two ways of labeling a section are very helpful and should be understood.

The Section Label is the actual name of the section, whether it is an AISC section name
like W14x22 or a wood section like 4x10. The Section Label always represents something
that can be retrieved from the internal databases. 

It can also be the name of a section that you create by entering a name and some
properties.

The Group Label lets you associate a section name with a label that is meaningful to you
and that can be used on multiple members. This makes it so you can easily revise the
section that is assigned to a set of members without the need to change the section name
individually for all the members where it is used.

For example, say that members 1,3,5,7,9,11,13,15 and 17 will all use the same section.
You don't know which AISC section will be selected, but you DO know it will be the same
section. You can assign a preliminary section name of HSS 3x3x1/4 and a group label of
"diagonal_1". If the frame analysis shows that the HSS section fails, you can simply
change it to a different section (with new properties). Because that section is linked to

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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those members with the group label, it simplifies the section assignment and modification
for the entire group.

Adding and Deleting Sections 

When you click the [Add Section] button, the following window appears:

To select a section from the built-in AISC or NDS databases, just click the appropriate tab
and either type in the section name or click the [Lookup] button.

If you want to add your own section name and type in the properties, click the User Defined
tab, type in the desired section name, and click [OK].

 
[Delete Section] will delete the section you've highlighted in the list. Any members using
that section will be changed to reference the Default section.

Editing the Table 

Section Label
When you click on the entries in this column the entry position will change to a button
labeled [Lookup]. This button provides access to the built-in section databases.
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Group Label
When you click on the entries in this column the entry position changes to a text
editing box.

Material
When you click on the entries in this column the entry position changes to a [Lookup]
button. This button provides access to a list of the material properties that you have
already defined on the Materials tab.

Section property values
These entry columns change to numeric entries when selected to allow entry of the
values.

Material Data

This screen provides the ability to define the material values used by the sections you
define.

Clicking [Add General Material] displays the following input box for you to enter the
material name:

To add a new material, enter the name of the material and then click [OK].  The new
material will appear in the Materials list on the Material Data tab.
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Clicking [Add Wood Material] displays the Wood Reference Design Values database
where you can select a wood species and grade combination:

To select a wood material to use in the current calculation, click on the desired material in
the Wood Reference Design Values database and then click [Select]. The new wood
material will appear in the Materials list on the Material Data tab as shown below:

Clicking on the Elastic Modulus, Density, Yield Stress and Thermal Coefficient entry items
will change them into numeric entry boxes where you can type in a value and press [Tab]
or click off of the value to complete the data entry.

Elastic Modulus
The elastic modulus defines how the members will react to forces by defining the
relationship between stress and strain.
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Density
The density entry is used only when the module calculates and applies member self
weights using the Member Self Weight entry column on the Load Combination tab.

Yield Stress
The use of this column and additional allowable stress information will be enhanced
as the module matures. For steel members this property is used to perform the AISC
member allowable stress evaluation. When wood stress evaluation is added, the
module will store other pertinent values from the built-in database.

Thermal Coefficient
This defines the rate of thermal expansion per degree of temperature change. This
value is only used when temperature loads are defined for a member.

Wood-Specific Values
The Wood-Specific Values are only populated when the selected material comes from
the Wood Reference Design Values database.

13.2.2.5   Load Combinations

This data table controls how all of the loads are combined, and also enables you to have
member self weight loads automatically considered in specified directions.  Note that there
is are three Load Combination tabs:

· ASD Load Combinations or LRFD Load Combinations (Based on your selection of
Design Method on the General tab.  Used for member design code checks.)

· Reaction Combinations (Always service level combinations. Used to calculate
reactions.)

· Deflection Combinations (Always service level combinations. Used to calculate
deflections.)
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Load Combination Set
The Select button is used to retrieve load combination sets from the built-in load
combination database and place them in the list. Clicking it will display a dropdown
menu listing the load combination sets currently included in the database.

Add (plus button)
This button adds a load combination line to the list. You can then edit the factors.

Delete (minus button)
This button deletes the currently selected load combination from the list.

This button allow you to edit the currently selected load combination.
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Description of columns in table

Run 
This column is a Yes/No toggle to control whether that load combination is used or
ignored.

This button allows you to change the Run setting for all the load combinations at once
using several options.

Load Combination
This is column represents the load combination. It consists of abbreviations for each
included load type along with the associated numeric values that represent the
respective load factors. You cannot directly edit this string. It is constructed
automatically based on the entries you make in the following columns.

Note in the following image how the Load Combination Name is constructed from the
specified values:
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Load Duration Factor (Not a load factor.  Applies to wood designs only.)
This value acts as a multiplier on the allowable stress for the corresponding load
combination.

Individual Load Factors
Enter the numeric value to be applied to each type of load.

0.2*SDS*Seismic Factor
When a value of Sds is specified, this column will report the additional component of
vertical load that is to be included due to seismic loading.

Member Self Weight
The controls at the bottom of the Load Combinations tabs indicate whether the
program should automatically apply member self weight.  Note that automatic
application of self-weight can be set up differently on the three Load Combination sub-
tabs, if desired.  Alternatively, there is a convenience button to copy the self-weight
settings from the first tab to the other two tabs, if the goal is to make them all the
same.

When self-weight is non-zero, the module will calculate the weight of each member
(as cross sectional area * density * length) and consider that weight during the
analysis.

Note that the controls allow for the self-weight to be assigned to the Dead Load or the
Seismic Load case, and to be assigned a direction and a percentage if desired.  This
makes it possible to model, say, 30% of the self-weight as an applied lateral load to be
considered a Seismic Load.

13.2.2.6   Wood Design

The 2D Frame module now incorporates wood stress checking according based on ASD
or LRFD methods according to NDS methods.

Adjustment Factors for Sawn Lumber

The module only collects CD or Lambda from the user.

The module assumes a value of 1.0 for CM, Ct, Cfu, Ci, Cr and CT.
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The module calculates values for CL, CF, and CP.  

The bearing area factor Cb never comes into play in the functions performed within

this module.

Adjustment Factors for Glued Laminated Timber

The module only collects CD or Lambda from the user.

The module assumes a value of 1.0 for CM, Ct, Cfu, Cc, CI, and Cvr.

The module calculates values for CL, CV, and CP.  

The bearing area factor Cb never comes into play in the functions performed within

this module.

13.2.2.7   Results

Need more? Ask Us a Question

The Results tab provides extensive lists of detailed and summarized results from the
frame analysis and the design checks.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Extreme Values

Joint Displacements & Reactions

This list summarizes the extreme joint displacements and support reactions. 

For each joint there is a four-line result display. The first line shows the joint label and the
maximum values for each displacement and reaction direction. The second line indicates
the load combinations that create the maximum values. The third line indicates the
minimum (most negative) values for each displacement and reaction direction. The fourth
line indicates the load combinations that create the minimum values.



ENERCALC SEL589

© 2024  ENERCALC, LLC

Member Forces

This table summarizes the extreme forces that occur anywhere along the length of each
member. (The detailed forces ALONG the length of the member are given in another list
within this Results section.)

For each member there is a four-line result display. The first line shows the member label
and the maximum member force values that occur anywhere along the length of the
member. The second line indicates the load combinations that create the maximum
values. The third line indicates the minimum (most negative) member force values that
occur anywhere along the length of the member. The fourth line indicates the load
combinations that create the minimum values.

Stress Checks

The Stress Checks tab is only displayed when the Member Stress Check Status item on
the General tab has been set to ASD or LRFD stress checks.
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For each member this list shows the following information:
· member label

· section or group label

· material

· governing load combination that results in the maximum Axial plus Bending stress ratio

· maximum stress ratio for the Axial plus Bending check

· pass/fail status for the Axial plus Bending check

· location along the member length where the critical Axial plus Bending result was found
to occur

· governing load combination that results in the maximum Shear stress ratio

· maximum stress ratio for the Shear check

· pass/fail status for the Shear check

· location along the member length where the critical Shear result was found to occur.

The image below shows the results for the steel members used in this frame:
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Joint Displacements & Reactions

This list summarizes the joint displacements resulting from each load combination.

Joint displacements are reported with respect to the global coordinate system.

Clicking on the [+] icon to the left of each combination will expand the sub-list to show the
detailed values.
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Member End Forces

This list summarizes the member end forces resulting from each load combination.

Clicking on the [+] icon to the left of each combination will expand the sub-list to show the
detailed values.
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Member Details

This list gives a very detailed presentation of the member forces and member deflections
at small increments along the member length.

The list is a tree with two sub-levels:
· The main level allows a choice of the load combination. 

· The next level down offers the choice of which member to observe. 

Click on the [+] icons to expand the list to show more details. Click on the [-] icon will
compress the level.
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Note that the Member Deflections provided in this list are reported relative to the
straight-line chord drawn between the deflected position of the two end nodes of
the member.  In other words, these Member Deflections will ALWAYS report a
value of zero at both ends of all members.

Member Check Results

The Member Check Results tab is only shown when the Member Stress Check Status
item on the General tab has been set to ASD or LRFD stress checks.  The image below
shows the results for the steel members used in this frame:
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Stress Check Results

For each member this list shows the following information:
· member label

· section or group label

· material

· governing load combination that results in the maximum stress ratios

· maximum stress ratio for the Axial plus Bending check

· pass/fail status for the Axial plus Bending check

· location along the member length where the critical Axial plus Bending result was found
to occur

· maximum stress ratio for the Shear check

· pass/fail status for the Shear check

· location along the member length where the critical Shear result was found to occur.

Steel Details

This list pertains only to the stress checks for steel members, and it provides detailed
information about the stress checks at small increments along the length of each member.

Wood Details

This list pertains only to the stress checks for wood members, and it provides detailed
information about the stress checks at small increments along the length of each member.
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Sign Convention

Coordinate Axis Convention

The right-hand rule states that if you take the vector cross product of X cross Y, the result is
in the Z direction.  This is what is used to establish the positive Z direction if you know the
positive X and Y directions.  It applies to the Global Coordinate Axis system and the member
local coordinate axis system in the 2-D Frame Analysis module,  in the 2-D Frame Analysis
module.

The Global Coordinate Axis system is oriented such that X points to the right, Y points
upward, and Z is perpendicular to the screen in the 2-D Frame Analysis module.

The member local coordinate axis system is established as follows.  A vector from the I node
to the J node establishes the member local x axis.  The vector cross product of local x cross
Global Y produces the member local z direction.  This works for all member orientations
except for vertically oriented members, because it is not possible to take the vector cross
product of two parallel vectors.  So in those cases the module adopts the convention that the
member local z axis will be parallel to the Global Z axis.  These are just mathematical rules
that establish that member local z will be perpendicular to the screen (unless you have
specified that the member is working in weak axis bending).  The local z axis is
perpendicular to the web of a wide flange section.  It typically represents the “strong” axis of a
member.  Finally, we need to establish the orientation of the local y axis.  Vector cross
product rules for a right-hand coordinate system also state that local z cross local x
produces local y.  So this pins down the orientation of the local y axis.  The local y axis of a
wide flange member lies in the plane of the web and is mutually perpendicular to the local x
and local z axes.  For a horizontally oriented beam member, the local y axis points straight
up, parallel to the Global Y axis.

Result Sign Convention

Now for the sign conventions of the various results that are available.

Joint Displacements 

Joint Displacements are reported with respect to the Global Coordinate Axis system.  A
positive displacement indicates a displacement in the direction of the positive corresponding
axis.  A positive rotation indicates a positive rotation about the Global Z axis.  (Using the
thumb of the right hand, point the thumb in the direction of the positive Global Z axis, and the
natural curl of the right fingers will indicate the direction of a positive rotation.)
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Reactions

Reactions are also reported with respect to the Global Coordinate Axis system.  A positive
force reaction indicates a force in the direction of the positive corresponding axis.  A positive
moment reaction indicates a positive moment about the Global Z axis.  (Using the thumb of
the right hand, point the thumb in the direction of the positive Global Z axis, and the natural
curl of the right fingers will indicate the direction of a positive moment.)

Member End Forces

Member End Forces are reported with respect to the member local coordinate axis system. 
A positive value of axial load at the I end of the member means that the force acts in the
member local x direction, so it is pushing into the starting end of the member, so it
represents a compressive force.  Likewise, a negative value of axial load at the J end of the
member means that the force acts in the member local -x direction, so it is pushing into the
ending end of the member, so again this represents a compressive force.

Shears are also reported with respect to the member local coordinate axis system.  A
positive value of shear at the I end of the member means that the force acts in the member
local y direction.  Likewise, a negative value of shear at the J end of the member means that
the force acts in the member local -y direction.

A positive value of moment at either end of the member means that the moment acts in the
member local z direction.  (Using the thumb of the right hand, point the thumb in the direction
of the positive Global Z axis, and the natural curl of the right fingers will indicate the direction
of a positive moment.)  

Member Forces at Sections

The physical sense of the member forces at sections can best be established by relating to
the physical sense of the member end forces at the starting end of the member as described
above.  

Deflections (Relative to member ends)

The deflections relative to member ends are measured parallel to the member local y axis
and are referenced from the straight-line chord connecting the undeflected end node
locations.  Positive values represent deflections in the positive local y axis direction from that
straight-line chord.
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13.2.2.8   Frame Sketch

This tab provides a graphical display of the frame. You can use various check boxes,
displacement magnification and load combination selection items to control the display.

13.2.2.9   Diagrams

This tab allows you to display axial load, moment, shear and deflection diagrams for each
individual member in the frame.
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Select Load Combination
This box lists all of the load combinations that are being run. Click on any of the
available load combinations in the list to view diagrams based on that load
combination.

Select Member
This box lists all of the members in the frame. Click on any of the members in the list
to view diagrams for that member.

Tabs Summary, Axial, Shear, Moment, Deflection
These tabs let you explore the force details for the selected member and load
combination in different ways.

When the All tab is selected, the extreme values of axial load, moment, shear, and
deflection are presented for the currently selected member.

The other tabs provide detailed list of the values for the currently selected which are
used to create the respective diagrams.
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13.2.2.10   Reports

This tab lets you select what data to print from the frame analysis.

Under Output Data you have the choice of compressing the output to an Envelope Only
status. If Envelope Only is not checked the full details will be printed which can results in
many pages of output. It is advisable to look at a print preview to see what it generates.

Using Envelope Only will examine each table and print only the extreme values for each
load combination.

13.2.3  Torsional Analysis of Rigid Diphragm

Need more? Ask Us a Question

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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This module provides horizontal force distribution analysis for a rigid diaphragm laterally
supported by up to 160 resisting elements (walls, columns or generic resisting elements).

The lateral shear force is applied to the rigid diaphragm, and that force is distributed to all
elements after the rotational stiffness analysis has been completed.

All lateral forces are distributed to each element on the basis of relative rigidities and
resisting element locations. Lateral shear forces, direct torsional forces, and accidental
eccentricity torsional forces are considered after determining the location of the center of
rigidity.

The module provides analysis for one level only. For structures where elements are
symmetrically placed on many levels, a calculation may be performed for each level and
results added to determine shears and overturning moments for each element. When
determining center of mass (where the lateral force is applied) on successively lower
levels when elements are NOT all aligned vertically, a new center of mass position should
be calculated based upon element forces acting from the diaphragm from the level above
and combined with the force at that level.

A very unique capability of this module is to have the applied lateral load applied at angular
increments for a full 360 degree rotation. The prior version of this module in our Version 5.8
software only applied the lateral load at 90 degree increments. Because seismic or wind
loads can occur at any angle, we provide the ability for the user to define the angles at
which the lateral load is applied to the rigid diaphragm for distribution to the resisting
elements.  

When the lateral force is rotated around the specified number of angular increments, the
user has two options for specifying the magnitude of the force to consider at each angular
orientation.  One option is to specify the magnitude of the applied lateral force and an
optional orthogonal force magnitude that will be considered to act concurrently.  When this
option is selected, the program uses the same magnitude for the resultant lateral force at
all angular increments, and that magnitude is calculated as the SRSS of the applied lateral
force and the orthogonal force. The second option is to specify the magnitude of the
applied lateral force when the force points in the X direction and the magnitude of the
applied lateral force when the force points in the Y direction. When this option is selected,
the program considers the lateral force to vary in an elliptical manner as the angular
orientation of the force changes.  When the force is considered to act at the zero-degree
orientation (to the right on the plan view), the magnitude will be exactly equal to the
specified lateral force in the X direction.  As the angular orientation changes (positive
angles measured CCW from the +X axis), the lateral force will vary in that elliptical
manner.  When the force is considered to act at the 90-degree orientation, the lateral force
will be exactly equal to the specified force in the Y direction, and so on.

Another unique feature is the handling of the accidental eccentricity. The code specifies
that an accidental eccentricity must be considered, as it will have an effect on the total
torsional moment applied to the diaphragm. The minimum eccentricity is typically specified
as 5% of the building dimension measured perpendicular to the direction of load
application. To thoroughly address the eccentricity requirements, this module creates an
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ellipse measuring 5% (or the specified value) of the building dimension on each axis,
around which the lateral load is applied.  

Technical note: Prior to build 6.15.7.24, this module neglected the shear due to the
torsional component of load if it was of the opposite algebraic sign to the direct shear
component, because considering that component would reduce the total shear on the
particular element being considered.  However, build 6.15.7.24 introduced a user option to
change this behavior.  It appears in the form of a checkbox labeled "Neglect torsional
shear component when it reduces total shear in element".  If this option is selected, the
program will operate in the way that it used to prior to build 6.15.7.24.  If this option is
DEselected, the program will always consider the shears due to torsion (inherent and
accidental), even if they are of opposite algebraic sign to the direct shears and therefore
tend to reduce the total shears in an element.

So to recap.....the applied lateral load is applied at the angular increments you specify for a
full 360 degrees, and this is performed for the number of angular locations you specify
around the minimum eccentricity ellipse. This means if you use 15 degree angular
increments for load direction and 15 degree increments for accidental eccentricity, then
the lateral load is actually applied (360/15+1) * (360/15+1) = 625 times in various locations
and directions. This can provide a very accurate calculation of applied torsions and direct
shears to all resisting elements connected to a rigid diaphragm.

Basic Usage

· The most important step for successful use of this module is to properly enter the X
and Y location of the center of rigidity of each resisting element and its angle in
degrees counterclockwise from a normal Cartesian "0" degree orientation.

· For each resisting element, its center of rigidity will be at the centroid of the element.
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· Default angular orientation of elements is as follows:

· Walls: When rotation is zero, length (local y) is parallel to Global X (points right on the
screen), and local x points downward on the screen.

· Bending Members: When rotation is zero, local y is parallel to Global X (points right on
the screen), and local x points downward on the screen.

· Generic Resisting Elements: When rotation is zero, local y is parallel to Global X
(points right on the screen), and local x points downward on the screen.

· When rotation angles are applied to resisting elements, the angle increases positively
in a counterclockwise direction.  Enter all angles as positive.

· Lateral shears are typically the force at the diaphragm level due to wind or seismic
forces at that level. Location of Shear Application specifies the X-Y coordinates of the
center of the load ellipse where the lateral shears act. If lateral forces must be added
to the diaphragm from the level above or below, you must combine all forces to
calculate an adjusted mass application point. Maximum Dimensions are used to
calculate the minimum additional eccentricity that will be added to and subtracted
from the inherent eccentricity to calculate governing forces for each resisting
element.

· When defining walls as resisting elements, the thickness, length, and height are
required for each wall providing lateral support to the diaphragm. These values are
used with the elastic modulus to establish the relative stiffness of each wall. For other
resisting elements you can enter the section information or just enter the resisting
element deflection under the same load for all elements.

· The Elastic Modulus does not have to be an exact value if all of the elements are of
identical construction. In this situation, it may be simpler to just use a value of 1. 

· X & Y Distances for each resisting element define the location of the center of
stiffness of each element in plan view. This location will be used when combining all
stiffnesses and calculating the overall center of rigidity for all elements acting as a
system.

· Enter the fixity condition that best describes the element's top and bottom restraint
against rotation about the longitudinal and transverse axes. Fix-Pin would be
appropriate for an inverted pendulum condition (where walls or columns cantilever up
from a fixed base condition, but are free to rotate at their tops). Fix-Pin would also be
appropriate for a moment frame structure with pinned column bases (a structure that
behaves like a table). Fix-Fix would be appropriate for conditions where both the tops
and the bottoms of the columns and/or walls are fixed against rotation about their
longitudinal and transverse axes. This setting results in double curvature in the
vertical lateral force resisting elements.
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Unique Features

This module uses a numerical approach to determine center of rigidity location and to
distribute lateral forces to each resisting element. Because resisting elements may be
located at any angle, a rigorous stiffness analysis is performed, calculating each element's
stiffness about both axes and combining the stiffnesses of all the elements to determine a
center of rigidity location.
 

Coordinate System

Please note that a strict X-Y coordinate system should be used to ensure that the analysis
is properly carried out. When setting up a model, remember that Global X increases to the
right and Global Y increases up the screen. 
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Dimensions & Loads 

Loading

Specify Primary & Orthogonal Force

Applied Lateral Force
This is the main force applied to the rigid diaphragm. The location of
application is defined by the load ellipse, the center of which is specified in
the input item labeled Location of Shear Application. 
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Additional Orthogonal Force
This is an optional force that is applied at a 90-degree angle to the main
force. Some codes specify that this force must be applied concurrently
with the main force. 

Maximum Load Used for Analysis
This is the resultant force applied to the diaphragm, calculated as

sqrt(Main2 + Orthogonal2).

Specify Nonconcurrent X & Y Forces

Applied Lateral Force X Direction
This is the magnitude of the lateral force applied to the rigid diaphragm
when the load is oriented at exactly zero or 180 degrees. 

Applied Lateral Force Y Direction
This is the magnitude of the lateral force applied to the rigid diaphragm
when the load is oriented at exactly 90 or 270 degrees. 

When the load orientation is anywhere between the cardinal directions, the
magnitude of the applied lateral force is determined by assuming that the
lateral force follows a smoothly varying elliptical function.

The location of application is defined by the load ellipse, the center of which
is specified in the input item labeled Location of Shear Application. 

Load Angular Increment
This module allows the force to be applied to the rigid diaphragm in almost all
angular directions. 

According to the entry for angular increment, the module will apply the load to the
diaphragm at multiple angular increments. For example, if you select "15 deg", the
module will apply the lateral load at 0, 15, 30 degrees, etc. When the Load Angular
Increment is set to smaller values, it will result in slightly longer calculation times, but
it wall also allow the module to "zero in" more accurately on the actual maximum
shear forces in all of the resisting elements.

Note that there is also an option named "Specify". This allows you to specify an
angular increment for the direction of load.
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Accidental Eccentricity Angular Increment
Most building codes require the consideration of an "accidental eccentricity". This is
a prescribed additional amount of moment arm that must be compounded with the
inherent eccentricity that already exists in the system; i.e. the distance between the
center of rigidity and the center of mass for seismic loads or the distance between
the center of rigidity and the center of exposure for wind loads. This additional
eccentricity accounts for the variability of the exact location of the center of rigidity in
normal as-built conditions. 

Normally an "X direction" and a "Y direction" accidental eccentricity would be
determined as a function (typically 5%) of the overall building dimension
perpendicular to each direction. Then, the X directed force would be applied at two
locations: 
· center of mass PLUS "Y direction" eccentricity, and

· center of mass MINUS "Y direction"  eccentricity. 

And the Y directed force would be applied at two locations:
· center of mass PLUS "X direction"  eccentricity, and

· center of mass MINUS "X direction"  eccentricity.

However, in this module the "X direction" and "Y direction" eccentricities are used to
specify the dimensions of an ellipse that encircles the center of mass. This ellipse
creates a continuous path that smoothly incorporates the "X direction" and "Y
direction" eccentricities.  In this way, it defines all possible locations where the load
should be applied to account for all possible accidental eccentricity locations.

The entry for Accidental Eccentricity Angular Increment specifies the angular
increment that will be used to subdivide the ellipse into a number of locations where
the force will be applied to the diaphragm.

Summary of Angular Increment & Accidental Eccentricity Angular Increment
The module applies the lateral load at the "Load Angular Increments" at each location
of "Accidental Eccentricity Angular Increment" to generate an extensive set of results
from which the maximum force values for each resisting element may be inspected.

For example, setting both "Load Angular Increment" and "Accidental Eccentricity
Angular Increment" to 15 degrees tells the module to run (360/15 + 1) * (360/15 + 1)
= 625 separate analyses of force distributions to the resisting elements. 

Location of Shear Application
This specifies the X and Y location of the center of mass. The Accidental
Eccentricity ellipse will be circumscribed around this location.

Accidental Torsion Values
Accidental torsion is defined as a percentage of overall constructed diaphragm
dimension in each of two orthogonal directions. Therefore enter the necessary
eccentricity percentage and both maximum diaphragm dimensions here. 
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When Stiffness deflections are 0.00, assume completely flexible
Note the option named "When Stiffness deflections are 0.00, assume completely
flexible".  This option can be used if your intent is to specify that an element is
completely flexible in the weak direction. In this situation, you would need to specify
an infinite deflection in that direction. So as a convenience, the system has been
configured such that when this option is selected, it will interpret a deflection value of
0.00 as meaning that the element is completely flexible in that direction (i.e. has no
ability to resist an applied force in that direction).

Resisting Elements
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Resisting Element Type
This module allows you to use three types of resisting elements. 

Walls: Use the Walls tab to define a wall as a resisting element. The wall must be
rectangular in plan and must have a non-zero height. The selections for "Fix" and
"Pin" will alter the equation used to calculate deflection in BOTH directions of the wall
(unless the option is selected to "Consider all minor axis wall stiffnesses to be
negligible"). Using the entered height, length, thickness, and modulus of elasticity for
bending and shear, the module will calculate the bending and shear stiffness of the
wall and report the deflection for a unit 1 kip applied load. 

Note: The option to "Consider all minor axis wall stiffnesses to be negligible" allows
walls to be modeled with a weak spring stiffness resisting flexure about the weak
axis.  It will tend to minimize the stiffness of walls about that axis, so they will not pick
up much loading in the weak direction.

Bending Members: Use the Bending Members tab to define a bending member
(such as a column) as a resisting element. This will be a linear member whose
stiffness is specified simply by its X and Y axis moments of inertia. You must also
provide a value for the modulus of elasticity of the Bending Member for bending.
Finally, you must make a fixity selection, which dictates the equation used to
calculate deflection in BOTH directions of the member (unless the option is selected
to "Consider all minor axis beam stiffnesses to be negligible"). Using these settings,
the module will calculate the bending stiffness of the member and report the
deflection for a unit 1 kip applied load.

Generic Resisting Elements: Use the Generic Resisting Elements tab to specify a
generic resisting element whose lateral deflection is known for an applied 1 kip load.
This selection is intended for complex resisting elements like braced or moment
frames, where another analysis module has determined the unit deflection. 

Add Element & Delete Element Buttons
Use the [Add Element] and [DeleteElement] buttons to add a new resisting
element or delete the one currently highlighted in the list.

Element Data
This area allows you to specify a label and location of the center of resistance for a
resisting element.

Resisting Element List
This is the list that you create to define the resisting element locations that give
lateral force resistance to the rigid diaphragm. 

This table serves to give a summary of the deflections, location and major axis angle
for each element. When you click to highlight a line in the table, the information for
that resisting element is brought into the variables on the input area.
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Summary Maximums

Please note that a STRICT X-Y coordinate system should be used to ensure that the
analysis is properly carried out. When setting up an X-Y coordinate axis, please follow the
standard Cartesian model with the diaphragm. 

Recall that the module calculates the forces to each resisting element by rotating the force
about its point of application. That point of application is in increments around an accidental
eccentricity ellipse. 

This Summary Maximums tab provides the maximum forces for each resisting element
along the major and minor axis of the element.

Force Envelope Detail

This tab provides the main table that shows all of the force calculations for each resisting
element. It is tree structured, so clicking the [+] sign to the left of each item name will
expand the result set for that item.
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In the image below we see that the data for the wall labeled "D" is expanded. Below "Label
: D" we see many lines labeled "0 deg".  These are the results for the load applied at an
orientation of 0 degrees. On each "0 deg" line, observe that the "X Ecc" and "Y Ecc" values
are changing. These values are the locations of the applied load as it moves its way
around the accidental eccentricity ellipse. The note at the top of the table indicates that the
analysis is based on 15-degree "Eccentricity Location" increments. This implies that there
will be (360 degrees/15 degrees) = 24 lines of data based on the "0 deg" force orientation.
Then, if we scrolled down through the table, we would see that the load application angle
has also been set to change in 15-degree increments as well.

Note that direct shear is always considered as a positive value, and the algebraic sign on
the torsional shear component will be positive if its effect is additive to the effects of the
direct shear, or negative if its effects are subtractive from the direct shear.  The
algebraic sign on the torsional shear component does NOT indicate its direction with
respect to the overall Cartesian coordinate system.
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2D Sketch
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3D Rendering

Analysis Procedure
Please see the following description for the procedure used to calculate the system
stiffness matrix and resolve the forces for each resisting element.
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13.2.4  General Section Property Calculator

Need more? Ask Us a Question

Overview

This module determines section properties for built-up sections with rectangles, hollow
circles, solid circles, standard AISC steel sections and general multi-sided solid shapes.

AISC sections can be recalled from the database files and can be included in the built-up
section. All sections from the 13th Edition AISC Steel Construction Manual are available,
and can be reoriented as necessary. 

The calculated section property values include: area, moments of inertia, center of gravity
location, extreme fiber distances, section moduli, and radius of gyration.

Basic Usage

· Before starting data entry, be sure you have set up an X-Y coordinate system to
consistently reference all component locations.

· For each rectangular shape, enter the height, width, and center of area measured from
the datum.

· Hollow circular sections are entered by specifying the outside radius and thickness. Solid
circular sections are entered by specifying the outside radius and setting the thickness to
zero.

· For AISC sections, you can use the Xcg and Ycg input fields to locate the section's
centroid position with respect to the datum. The module knows the centroid location of
AISC members with respect to their own extreme fiber locations. However, you need to

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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enter the location of the member's centroid in relation to the other members in the built-
up section. Be careful, as this can be tricky when entering channels, angles, and tee
sections that are rotated.

· A unique feature allows the user to specify that AISC sections can be rotated in one-
degree increments, steel angle sections can also be mirrored about their Y axis, and the
entire built-up section can be rotated to any desired angle.

 
Assumptions & Limitations

The module operates on a simple calculation procedure:

· Calculate the moment of inertia of each shape,

· Calculate the neutral axis of the group of shapes, and

· Calculate the moment of inertia of the group using I + A*D2 equations.

More complex analysis such as polar moment of inertia, plastic moduli, and buckling
constants are beyond the scope of the module at this time but continuing development will
add these items in future updates. 

Rolled Section / Table

This tab enables you to specify up to 10 sections from the AISC Edition database to use in
a built-up member.
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The square buttons across the top of the tab are used to represent the component
sections that comprise your built-up shape. When a section has been specified for a
particular button, a small green upward facing triangle will be shown under the
corresponding button. Click on any button to add a section or view and modify the section
that has already been assigned to that button. 

Note: It is important to understand that the numbered buttons on the various tabs DO NOT
represent different built-up shapes. Instead, each instance of this module only creates
ONE built-up shape, and the overall built-up shape consists of a composite of ALL
sections that currently exist on ANY buttons in the Rolled Section / Table tab, the
Rectangular & Circular tab, and the General Shapes tab.

To insert an AISC section you can:
· Type in the section name and press [Tab].  The module will search the database and

retrieve the information.
· Use the [Browse Steel Sections] button to display the steel database where you can

navigate and select the desired section.

Rotation Angle: Counter-Clockwise
If you need to rotate a section, click one of the four angular rotation buttons.

Rotate Section 180 degrees about its own y-y Axis
This checkbox option will only be displayed for single-angle sections. It offers the
ability to mirror a single-angle section if needed.

Xcg & Ycg
Enter the location of the section's centroidal axis measured from the datum (the origin
of your assumed X-Y Cartesian coordinate system).

Section Properties
These values will be filled in after you make your choice from the AISC database.
HOWEVER you can alter these values yourself. Of particular importance for
unsymmetrical sections is entering the correct "Xbar" and "Ybar" location. This is the
distance from the lower-left edge of the section, measured upwards and to the right, to
the centroidal axis position of the section.
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Steel Section Database
Click the [Browse Steel Sections] button to display the AISC database window:
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Rectangular & Circular

This tab allows you to specify simple rectangular and circular shapes. 

The square buttons across the top of the tab are used to represent the component
sections that comprise your built-up shape. When a section has been specified for a
particular button, a small green upward facing triangle will be shown under the
corresponding button. Click on any button to add a section or view and modify the section
that has already been assigned to that button.

Not Used / Rectangular / Circular
Select the shape you wish to use for this item.

Rectangular Data Entry
When a rectangular shape is chosen the data entry consists of height and width.
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Circular Data Entry
When a circular shape is selected the data entry consists of Outside Radius and Wall
Thickness (not inside radius). To model a solid circular section, enter the appropriate
Outside Radius and set the Wall Thickness to zero.  

Xcg & Ycg
Enter the location of the section's centroidal axis measured from the datum (the origin
of your assumed X-Y Cartesian coordinate system).
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General Shapes 

This tab allows you to select from a number of common polygonal shapes. With each
selection the reference drawing and data entry prompts will change.

The square buttons across the top of the tab are used to represent the component
sections that comprise your built-up shape. When a section has been specified for a
particular button, a small green upward facing triangle will be shown under the
corresponding button. Click on any button to add a section or view and modify the
section that has already been assigned to that button.

Xcg & Ycg
Enter the location of the section's centroidal axis measured from the datum (the origin
of your assumed X-Y Cartesian coordinate system).
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Rotation Angle: Counter-Clockwise
For these shapes you can rotate the section in one-degree increments. Positive
angles represent counter-clockwise rotation.

Calculations

Detailed Properties Table
This table summarizes each of the component items you have added to the section. It
reports their individual locations, properties and maximum distance from CG for each
of the four edges.

Note: This table scrolls to the right. Just use the scroll bar along the bottom of the
table.
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Total Area
The total area of all defined shapes, including the area of any AISC sections which
have been included in the built-up shape.

Inertia: Ixx & Iyy

The overall moment of inertia of the composite section is determined by applying the
following equation to all the defined shapes:
                             Ixx = Iox + (A * d

y
2) and Iyy = Ioy + (A * d

x
2)

where  d  = Distance from the shape's C.G. to the overall C.G. of the composite
section, measured in the direction indicated by the subscript.

Section Modulus: Sxx and Syy
These values are the calculated section moduli of the composite section. The values
are determined by dividing Ixx or Iyy by the extreme fiber distances above, below, right,
and left of the center of gravity of the section.

Radius of Gyration
The radius of gyration of the composite section is determined using the typical
equation: rxx = (Ixx/A)½  and ryy = (Iyy/A)½.

Max Distance from CG
For each of the sections in the built-up shape, these columns report the distance from
the extreme fibers of that section to the C.G. of the composite section.
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Sketch

13.2.5  General Beam Analysis

Need more? Ask Us a Question

The General Beam Analysis module offers beam analysis functionality but does not
incorporate any design processes. In this way, it can be a useful tool for situations where
only analysis results are desired, such as shear, moment, reactions, and deflections.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General tab:

The General Data tab allows you to set the span conditions, span lengths, and support
conditions in much the same way that this information is provided in the other beam
modules. Refer to the Beams  topic for additional explanation. In addition to these pieces
of data, the General Data tab also provides input fields for the elastic modulus for bending,
and the cross sectional area and moment of inertia of each span of the beam, as shown
below:

Span Loads tab:

The Span Loads tab allows you to specify loads on one span at a time. The behavior of the
tools on this tab is identical to the tools described for use in the other beam modules.

Refer to the 
Beams

 topic for additional explanation.

633
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Loads All Spans tab:

The Loads All Spans tab allows you to specify loads on all spans at the same time. The
behavior of the tools on this tab is identical to the tools described for use in the other beam

modules. Refer to the 
Beams

 topic for additional explanation.

Load Combinations tab:

The Load Combinations tab provides a view of the load combinations that will be analyzed.
It also offers the ability to:

· Select a different set of load combinations,

· Modify the values used as load factors, and

· Turn certain combinations on and off.

Refer to the 
Beams

 topic for additional explanation.

The General Beam Analysis module offers output options that are analogous to the output
options provided by the other beam modules, with the exception that no design results are
provided.

The right half of the screen is dedicated to the display of results. The horizontal strip of
tabs in the upper right-hand corner of the display allows you to choose between
Calculations, 2D Sketch, Diagram and 3D Rendering as explained below.
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Calculations:

The Calculations tab offers four sub-tabs:

Summary Results: Displays extreme moments, maximum shear, extreme deflections and
extreme reactions.



ENERCALC SEL631

© 2024  ENERCALC, LLC

Maximum Combinations: Displays extreme moments and shears, on a span-by-span
basis, for all load combinations.

M-V-D: Summary:  Displays moment, shear, and deflections at small increments along all
spans. Moment and shear are displayed for all load combinations.  Deflection is displayed
for service load combinations only.  
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Support Reactions:  Displays support reactions for all supports, for all load combinations.

2D:

Displays a sketch of the beam, indicating span lengths, support conditions, and applied
loads.
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Diagram:

Displays a graphic depiction of the beam with superimposed graphs of Moment, Shear, or
Deflection for a selected load combination, or for an envelope of all load combinations.

13.3 Beams

Overview

There is one main module for designing Steel, Concrete and Wood beams.  There are
separate modules for Composite Steel Beams, Steel Beams with Torsional Loads, and
one for Masonry Lintels.
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This section deals ONLY with typical single- or multi-span Steel, Concrete & Wood
beams.

The presentation screen is divided into three areas: Beam representation &
modification,  Data Entry & Calculation Results as illustrated in the screen capture
below:

(1) Beam representation & modification: This area allows you to create and modify the
beam layout.

Click on the support icons  to select the type of support fixity: Fixed, Pinned, or
Free.
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Click on the [+/-] icon  to display a window to add or delete beam spans: 
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Click on the beam representation to change the beam specific data on the Beam Span
Data and Span Loads tabs.

(2) Data Entry: This set of tabs is where you enter all information for the beam. These
tabs will show different information according to material type selected. See the specific
chapters for the items provided for each material. Click one of the following to jump:
Wood    Steel    Concrete   723 666 699
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Here is a summary of the purpose of each tab:

General 

Beam Material
Clicking one of these buttons changes the material type used for the beam.

Compression Edge Lateral Bracing
These selections control how the module will evaluate the lateral compression edge
bracing for the design.  When Define Bracing Span-by-Span is selected, the
unbraced  length is defined on a span-by-span basis on the Beam Span Data tab. 
When any of the other options are selected, the unbraced length is defined here on the
General tab, and that definition is applied to all spans of the beam.

Design Method
For wood & steel you can select ASD or LRFD design methods. Concrete design is
always ultimate strength (LRFD).

Design Values
Specify material-specific design values.
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Beam Span Data

This tab is used to define span length and beam section information:

Select Span 
These buttons allow you to select which span the values in the data entry area apply
to.

Span Length
This is where you define the length of the currently selected span.

Deflection Ratios
These are used as the basis for the deflection design check and also as the starting
point for automatic member selection.

Section Name & Buttons
For steel and wood you can enter the standard beam section designation. You can
also type in the section name and the module will search the built-in database for a
match. If a match is found, the section properties will be loaded from the database and
they will appear on the Properties tab.
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Click the button indicated below to open the section database for rolled steel shapes:
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The database contains an extensive number of standard shapes commonly used in
the USA.

Click the button indicated below to display the Steel Member Design dialog:
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This provides control over the type of member to be selected and various stress ratio,
deflection ratio and size limits to respect during the automatic member selection
process.

The Quick-List provides a fast way to select a member section from the database.
Just select the desired edition of the database, click the type of member, scroll
through the list and click on your selection.
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Compression Edge Lateral Bracing
When you have selected Define Bracing Span-by-Span on the General tab you will
see the following bracing options on the Beam Span Data tab:

These selections control how the module will evaluate the lateral compression edge
bracing for the beam span selected above.

The top row has common selections for fully-braced conditions as well as options to
divide the selected span into segments of equal braced length.

The Define Spacing option lets you set a starting point and subsequent spacing for the
bracing within the selected span:

The Define Locations option lets you set up to three specific bracing locations
referenced from the left end of the selected span:
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Span Loads

This tab is used to specify loads FOR THE SELECTED SPAN ONLY (except as noted
below) using the tools shown on the following screen capture:

Use the [Add Load], [Copy Load] and [Delete Load] buttons to add, copy, or delete loads
on the selected span.

Use the Load Type selections to specify the type of load that will be added. This selection
affects the currently highlighted item in the table of loads. The data entry areas below
will change based on the type of load selected.

The Auto Add Beam Weight option will calculate the weight of the beam and add it to your
applied loads as a uniform dead load on the beam. Note that this option applies to the
FULL LENGTH of the beam...it is NOT a setting that can be set on a span-by-span basis.

The Auto Unbalanced Live Load Placement option is a VERY powerful selection. When
you have two to five beam spans, you can select this item and the module will
automatically generate load combinations for all possible permutations of patterned live
load being placed on alternate spans. For instance, on a two-span beam, it would create
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conditions that place live load on both spans, live load on the left span only, and live load on
the right span only. That is a total of three permutations of live load, and it will do this for
ALL of the load combinations that are selected to run.

NOTE: This can significantly increase recalculation time needed for beams with many
spans, hence it is limited to beams with two to five spans.

Load classifications are: D: Dead,  Lr: Roof Live,  L: Live,  S: Snow,  W: Wind,  E:
Seismic,  H: Earth Pressure

Loads that get patterned with this feature:  Lr: Roof Live,  L: Live

Loads All Spans

This tab offers tools that are used to specify loads with spacings or lengths that might
cause them to overlap multiple spans as shown in the screen capture below:
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Click the load type button on the left and the appropriate load entry items will appear to
allow you to define the magnitude, location and extent of the load. With all load items set to
[None], the tab will be almost entirely blank.

Start Dist and End Dist defines the application distance from the FAR LEFT end of the
beam.  For a beam with two 20' spans where you want to apply a uniform load 5' in from
each end use Start Dist = 5.00  and  End Dist = 35.00.

The third item allows you to define repeating point loads or moments.  You define the
position of the first load and the spacing increment thereafter.

The last item allows you to define repeating loads on EACH span. Load specification is for
the load in EACH span.  For example, consider a two-span beam where the first span is
25' and the second span is 45'. Selecting [1/3 Points] will place loads at 8.33', 16.66' from
the left support of the first span and at 15' and 30' from the left support of the second span.
The "Specify" option allows you to provide a unique spacing measured from the left end of
each span.

Although this tab is not typically used for single-span beams, the tools are perfectly
applicable to single-span beams.
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Load Combinations

This tab is used to specify the load combinations that will be run for the analysis of this
beam, as shown in the screen capture below:

 

The [Select] button is used to retrieve load combinations sets from the Load
Combination  database.

The icon with the delta symbol is used to edit the load combination values. Click on the
delta symbol, and the multipliers for the currently selected load combination can be
revised. After you change an item's values, click OK to save the change and view the
revised load combination in the list.

Specify the magnitude of SDS and/or Rho to automatically integrate the associated

additional internal factor in the load combinations.

The option labeled [Automatically create combination using opposite sign for] triggers
the module to create additional load combinations with the "W" and/or "E" factors set to

77
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negative values. This has the effect of reversing the direction of application of the wind and
seismic loads that have been applied to the member.

(3) Calculation Result: This set of tabs at the top of the right side of the screen allows
you to select the desired results for review:  

Calculations provides several tabs that let you review the numeric detail of the
calculation. The left-most tab is always the Summary Results where the concise
design is given.

      See the individual sections for each material type for specific discussions of these
result sections.

2D provides a scale illustration of the item you are designing, including an indication of
support conditions and applied load magnitudes.
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Diagram provides a moment, shear, or deflection diagram for the item you are
designing.
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3D displays a 3D rendering of the item you are designing, including an indication of
support conditions, bracing and applied load magnitudes.

13.3.1  Multiple Simple Beam

Need more? Ask Us a Question

This module is specifically designed to provide rapid analysis and design of simple beams.
For complex, multi-span beams please use the other beam modules for wood, steel and
concrete beams.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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This module has a row of buttons above the beam graphical representation that allows you
to add and select up to 12 beams to design. This can be seen in the screen capture below:

Looking at the screen capture above you can see:

(1) The highlighted beam button indicates the currently selected beam for which data is
displayed.

(2)   The button labeled [Beam 2] represents the second beam that was defined. Clicking
on that button will save all of the data for [Beam 1] and display all the data for [Beam 2].

(3)  [Add] is used to add another beam to this calculation. When two beams have already
been defined, clicking [Add] will add a button labeled [Beam 3].

(4) [Delete Bm X] is used to delete the noted beam. It will delete the beam that is
currently selected.

Directly below the band of beam selection buttons is the graphic that shows the basic
layout of the currently selected beam. See below for a more detailed description.

Note: In this module, the beam span length is always specified on the beam layout
graphic.

Beam Layout Graphic

This area shows a graphic representation of the selected beam. There are several
variations of beams that you can specify using the [Add Cant] buttons and also by clicking
on the end support graphics.
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Here is a basic simple span beam:

Clicking on the right [Add Cant] button in the image above adds a single cantilever at the
right support as shown below:

Clicking on the left support icon in the image above displays a selection box so you can
select a fixed end. Doing this sets the left support to fixed as shown below:

Clicking on the left [Add Cant] button in the image above adds a single cantilever at the left
support, resulting in the double cantilever as shown below:

Note that adding the cantilever on the left also had the effect of automatically revising the
left support back to a pinned condition.

General Tab

This tab is where you select the beam material, allowable stresses, beam size, and set
the beam bracing layout.
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For steel and wood you can select ASD or LRFD design methods. For concrete, only
strength design is available.

Steel Specific Tab Items

Design Values: This area enables you to enter the yield strength and elastic modulus
of the steel. The paper-with-hand icon gives you access to the available AISC steel
stress grades.
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Quick-List Tab: This tab provides quick access to the built-in 13th Edition AISC steel
section list. Clicking a section name like [W] or [HP] in the Select AISC Type category
will display all the steel sections of that type in the list to the right.

Properties Tab: This tab provides a [View Section Properties] button that when
clicked displays all of the design values for the AISC section you have selected.
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Bracing Tab: This tab allows you to select how your beam is braced against lateral-
torsional buckling.  Defined brace points are automatically assumed to brace both the
top and the bottom flanges.

The first line offers the most basic options.....fully unbraced or fully braced.

The next line offers uniform brace spacing options. 

The last two buttons offer the ability to specify brace spacings from a starting point or
enable you to specify selected brace points, as shown below:
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Wood Specific Tab Items
Design Values: This area enables you to specify the design values for the wood

species & grade you want to use. Click the  button to access the built-in NDS
allowable stresses database.
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Quick-List Tab: This tab provides quick access to the database of wood sections.
Clicking a section type button like [Sawn-General] or [TJ:Microllam] in the Select
Type category will display all the sections of that type in the list to the right.

Properties Tab: This tab provides the values for the wood section you have chosen.
You can enter different numbers here to modify the section.

Bracing Tab: See information provided above in the Steel section for a summary of
bracing options.
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Concrete Specific Tab Items

Design Values: This area enables you to enter concrete and reinforcing strengths for
the beam. In addition you can specify the stirrup size and Phi values.
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Span Data

When a concrete beam is chosen, a new tab named Span Data will be added to the
user interface (see below). This tab is where you specify the beam cross section and
reinforcing. This tab will only be shown when the material is set to concrete.
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Beam Shape: You can select between 4 beam shapes: 
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On the right side of the tab you can specify up to 6 bars set (quantity, size, vertical
location and start/stop endpoints). 
Each bar set is referenced on the sketch with a color shown as a dot to the left of the
set description.

The column highlighted in light blue titled "Dist of bar center....from...." is how you set
the vertical position of the bars set in the beam. 

When you look at the top one you can read it as "The top bar set is 3 inches from the
bottom of the beam". Note that the module will know whether the bars are in tension or
compression and handle the calculations properly.

The item named Bar Position This Span defines the starting and ending location of the
bar's ends with respect to this span's left support. Using these starting and ending
locations you can fine tune the bar layout and end cutoffs.

The data in the screen capture below shows that bar set #1 runs from the left end (0.0
ft) to 20.0 ft from the left support.  
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Results Tabs
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And for concrete beams these two additional sub-tabs are also visible:
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2D
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Diagram
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3D Rendering

13.3.2  Steel Beam

Need more? Ask Us a Question

In this section, for each input tab we will review only the items that are unique to the
STEEL material type.

For general information on the typical data input for all beams see the Beams  topic.633
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This module offers complete design of single and multi-span steel members. Among its
capabilities are:

· Single or multi-span beams.

· End fixity can be pinned, fixed, free or a combination.

· Steel member analysis and design are according to AISC 360.

· ASD or LRFD design methods can be selected.

· A complete steel section database is provided.

· Unbraced compression edge lengths can be specified in a variety of ways.

· Automatic member selection is provided.

General

When steel is used, this tab includes input fields to set the values for yield stress and
elastic modulus, as well as an option to set the Cb factor equal to 1, as shown in the
screen capture below:

If Cb is not forced to 1, the program automatically calculates Cb based on the moment and
direction of curvature at various locations along the beam. 
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For convenience the module includes a built-in steel database. Click the  button to
the right of the Fy entry and you will see the following table, which offers a number of
commonly used steel grades:
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Beam Span Data

When steel is selected, the beam size selection is specifically for steel. You can select a
section in 4 ways:
1 - Simply type the AISC name into the Steel Section Name field and press [Tab].

2 - Click the   button and select from the built-in AISC section database.
3 - Click the [Auto Select] button to have the module evaluate steel sections from the
database according to your criteria.
4 - Select a steel section from the Quick-List tab as shown below:

Span Loads

No differences from other materials.

Loads All Spans

No differences from other materials.

Load Combinations

No differences from other materials.

Results Tab

This set of tabs provides detailed results for the current calculation. The tabs in the upper
right-hand corner of the screen allow you to select the major areas available for review:
Calculations, 2D Sketch, Diagram and 3D Rendering.
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The Calculations tab offers the following results options:

Summary Results provides details for shear, moment and deflection for the governing
load combinations.
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Max. Combinations provides detailed results for each beam segment for each load
combination. The leftmost column lists the load combinations and the unbraced length
being considered.

These results are a consolidation of the highly detailed incremental results on the M-V-
D Summary tab.

M-V-D Summary - Shears & Moments shows highly detailed moment and shear
information for each beam and for each load combination.  For multi-span beams
using Automatic Unbalanced Live Load Placement there may be thousands of lines of
results.
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M-V-D Summary - Deflections shows highly detailed deflection results for all load
combinations.

Support Reactions shows reactions for each support for each load condition.
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The 2D Sketch tab provides a graphic representation of the beam currently being designed:
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The Diagram tab offers the ability to view shear, moment, and deflection diagrams for
selected load combinations:
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The 3D Rendering offers a 3D view of the beam with many display controls:
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13.3.3  Composite Steel Beam

Need more? Ask Us a Question

This module provides analysis and design of AISC steel sections acting compositely with a
concrete slab that is continuously connected to the compression flange of the beam with
suitable shear connectors.

Features of the module include:
· The concrete slab can be either full depth or cast over formed steel decking, with rib

orientation perpendicular or parallel to the beam.
· Stud capacity can be calculated by the module using standard AISC procedure.

· Normal or lightweight concrete may be used for both strength and deflection
calculations.

· Both shored and unshored construction techniques can be analyzed by the module.

· ASD or LRFD design methods can be chosen.

· Flexible specification of shear studs is available.

· Very flexible loading specification, including the ability to specify construction loads
(applied to pre-composite checks only), loads that apply to both the pre-composite
and post-composite checks (always applied), and loads that are only applicable to the
post-composite checks (applied after curing).

· Extensive load combination capability.

· Can use many sections from the AISC databases.

General  

This tab gathers all input except for the beam section size and loads.

The Analysis Method category offers an option of ASD or LRFD methods.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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The Composite Data category offers all of the necessary input fields to completely specify
the slab, its effective width, stud information and metal deck specification (if applicable).



Calculation Modules 678

© 2024  ENERCALC, LLC

For Qn you can enter the value directly or click the  button to display the stud capacity
calculation dialog:

When you click the checkbox for Slab on Metal Deck, the associated input fields appear to
allow the selection of a manufactured deck product, or the manual specification of the
required deck properties.
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Click the  button to display the metal deck selection window as shown below, or
simply enter the deck cross section data in the dimension input fields:

Partial Composite Action

This category provides three ways to have the module calculate stud requirements.

Full Composite tells the module to use the number of studs necessary to provide full
Vh shear resistance for the slab to beam connection.

Specify % Composite allows the user to enter a percentage of maximum composite
action. The module will then determine the number of studs needed for that Vh' and
complete the bending capacity calculations.

Calc Min Studs tells the module to calculate the minimum number of studs (greater
than 25% composite per code recommendations) that will adequately supply the
required moment capacity based on the applied moment.
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Span & Section Data 

This is basically the same tab used for a normal steel beam except that there is no ability
to specify unbraced compression flange lengths.  For regions of positive moment, the top
flange is considered to be continuously braced by its composite connection to the concrete
slab. 

Note:  Use caution in situations where the applied loading may result in regions of negative
moment, because this module considers the bottom flange to be continuously braced.
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Span Loads

This tab is basically the same as the normal load entry for other beam design modules
except for two differences:

1 - There are two checkboxes that allow the user to indicate whether the module should
automatically calculate and apply the beam self weight and slab self weight.

2 - There are three "Load Application" options that allow the user to specify the sequencing
of the specified loads as follows:

· Non-Composite Section - Removed before curing:  Dead Load and/or Live Load
that will be considered in the pre-composite checks, but not in the post-composite
checks.

Use this load application type to specify temporary Construction Live Load or
Construction Dead Load that will be removed before the concrete cures.  Do NOT use
this load application type to specify permanent loads like the weight of the concrete fill
on the metal deck.  That type of load should be specified using the next option.

· Applied to Non-Composite Section - Remains after curing:  Dead Load that will be
considered in the pre-composite AND the post-composite checks.  

Use this option for loads that will be in place while the section is non-composite and will
REMAIN in place after composite action is achieved.  Examples might include the
weight of the concrete fill on the metal deck or the self-weight of the steel beam.

· Applied to Composite Section Only:  Any type of load that will be superimposed on
the cured composite section.  These will only be considered in the post-composite
checks.  

Use this option for loads that will be placed on the structure only after composite action
has developed. Some examples might include the weight of architectural floor finishes
and occupancy live load.
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Load Combinations

The function of the Load Combinations tab in the Composite Steel Beam module is the
same as in other beam modules.

Results Tabs: This set of tabs provides detailed results for the current calculation. The tabs
in the upper right-hand corner of the screen allow the user to select the four
major areas available for review: Calculations, 2D Sketch, Diagram, and 3D
Rendering.

The Calculations tab offers the following results options:

Summary Results tab presents the maximum/governing ratio values from all of the results
presented on the Max. Combinations tab. The module looks for the maximum bending
stress ratio and presents the components that are calculated to create that ratio.

For the bending stress item the module reports the Pre-Composite bending ratio, which
considers all loads specified to be applied to the beam before curing. The resulting
moment is compared to the capacity of the steel section acting alone (non-compositely).
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For the item reported as Composite, the module considers all loads specified to be applied
to the composite section.  That moment is then compared to the full composite section
moment capacity for the percentage of shear connection specified.

The results indicate the load combination that creates the governing values along with the
span id and location at which the governing ratio was found to occur.

The module calculates the maximum total deflection as the sum of the deflection of the
non-composite steel section resisting all of the loads that are specified as Pre & Post
Composite (always applied) plus the deflection of the composite section resisting all of the
loads that are specified as Post Composite Only (applied after curing).

Note! The screen shown below, which gives information for Construction loads, is only for
unshored beams. For shored beams the Construction portion of moments is not
applicable, so it is not shown.
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Max Combinations tab presents in more concise detail the bending and shear values for
all load combinations. 

Studs tab presents the shear connector requirements for all span sections. When point
loads are present, this chart may list more detailed spacing requirements because of the
shear change between applied point loads.
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M-V Summary presents shear and moment results. This screen will take on four slightly
different forms depending upon the selection of Analysis Method (ASD or LRFD) and
shoring (shored or unshored).  The example shown below is for an ASD unshored
design.  

Deflections tab has two versions, one for shored and one for unshored construction. The
only differences are the load combinations and the explanations of load applications listed.
 The unshored version is shown below.

In the Unshored Service Deflections table, the columns warrant some detailed
explanation:

The column labeled "Pre-Composite" shows the deflection of the bare steel beam
subjected to all loads that are specified to act on the bare steel beam.  This would include
all loads defined using the "Non-Composite - Removed before curing" option and all loads
defined using the "Non-Composite - Remains after curing" option on the Span Loads tab.
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The column labeled "Non-Composite Removed" shows the deflection of the bare steel
beam due all loads defined using the "Non-Composite - Removed before curing" option on
the Span Loads tab.  Since these loads are removed before the beam reaches its service
condition, these construction load deflections are removed from the total deflection, so
that the Total deflection represents a correct net total deflection in the service condition.

The column labeled "Added Post Composite" shows the deflection of the composite
section due to the loads that are superimposed on the section after it has achieved
composite action.  This would include all loads defined using the "Applied to Composite
Section Only" option on the Span Loads tab.

The column labeled "Final" is calculated by adding the value in the "Pre-Composite"
column to the value in the "Added Post Composite" column and then netting out the value
in the "Non-Composite Removed" column.  This way, the "Total" deflection represents the
full anticipated in-service deflection considering all permanent loads and properly
accounting for their sequence of application.
  

Reactions tab has two versions, one for shored and one for unshored construction. The
only differences are the load combinations and the explanations of load applications listed.
 The unshored version is shown below.
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Properties tab shows the calculations for transformed section properties calculated in
increments of 1% shear connection, from 100% down to the code minimum 25%. "I Lower
Bound" and "I Constant Stiffness" are terms described in AISC 360.

The 2D Sketch tab provides two ways to view a graphic representation of the beam currently
being designed:

Span & Loads tab:
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Cross Section tab:
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The Diagram tab offers the ability to view shear, moment, and deflection diagrams for
selected load combinations:
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The 3D Rendering tab displays a 3D view of the beam and offers display options:

13.3.4  Steel Beam with Torsional Loads

The Steel Beam with Torsional Loads module offers the ability to analyze and design a
single-span steel beam for applied loads that create shear, bending, and torsion. It can be a
useful tool for situations where beams have concentrated or distributed loads that are
applied eccentrically, or where beams are subjected to torsional moments.
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General:

The General tab allows you to set the span length, and support conditions in much the
same way that this information is provided in the other beam modules. Refer to the
Beams  topic for additional explanation, but remember that this particular module is
limited to single-span conditions. In addition to these pieces of data, the General Data tab
also provides input fields for the compression edge lateral bracing condition, the design
method, material properties, and an option to force the Cb value to 1.0, as shown below:

633
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Beam Span Data:

The Beam Span Data tab is used to specify the span length, the allowable deflection ratios,
and to select the steel section under consideration.
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Span Loads:

The Span Loads tab allows you to specify loads on one span at a time. The behavior of the
tools on this tab is very similar to the tools described for use in the other beam modules,
except that it introduces the ability to specify load eccentricities and the ability to indicate
that concentrated moments should be considered as torsional moments. Refer to the
Beams  topic for additional explanation.633
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Load Combinations tab:

The Load Combinations tab provides a view of the load combinations that will be analyzed.
It also offers the ability to:

· Select a different set of load combinations,

· Modify the values used as load factors, and

· Turn certain combinations on and off.

Refer to the Beams  topic for additional explanation.

The Steel Beam with Torsional Loads module offers output options that are analogous to
the output options provided by the other beam modules, with the exception that the results
include torsional design considerations.

The right half of the screen is dedicated to the display of results. The strip of tabs in the top
right-hand corner of the display allows you to choose between Calculations, 2D Sketch,
Diagram and 3D Rendering as explained below:

633
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Calculations:

The Calculations tab offers four sub-tabs:

Summary Results: Displays extreme flange normal stress, extreme flange and web shear
stress, extreme deflections, extreme rotations, and extreme reactions.
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Maximum Combinations: Displays maximum stress ratio, extreme moments and shears,
flange normal stresses due to bending and due to torsion, flange shear stress due to
torsion, web shear stress due to bending and due to torsion, for all load combinations.

M-V-D: Summary > Shears & Moments:  Displays moment, shear, unbraced length, flange
normal stress, flange shear stress, and web shear stress at small increments along all
spans. Moment, shear, and stresses are displayed for all load combinations.

M-V-D: Summary > Deflections & Rotations:  Displays deflections and rotations at small
increments along all spans. Deflection is displayed for service load combinations only.  
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Support Reactions:  Displays support reactions for all supports, for all load combinations.

2D Sketch:

Displays a sketch of the beam, indicating span lengths, support conditions, and applied
loads.
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Diagram:

Displays a graphic depiction of the beam with superimposed graphs of Moment, Shear,
Deflection or Rotation for a selected load combination, or for an envelope of all load
combinations.
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3D Rendering:

Displays a 3D graphic depiction of the beam many display options:

13.3.5  Concrete Beam

Need more? Ask Us a Question

In this section, for each input tab we will review only the items that are unique to the
CONCRETE material type.

General

The concrete beam module handles single- and multiple-span beams using ONE cross
section shape. That shape can have up to six groups of reinforcing per span, and the
reinforcing can vary on a span-by-span basis.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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This tab collects all the required rebar, concrete strength and elastic modulus entries,
shear stirrup data, strength reduction factors and deflection criteria to check.

NOTE: It is important to know how this module operates with regard to beam stiffness
along the span, and how this affects multi-span beams. This module divides each span
into a series of segments. The effective moment of inertia for each segment (for each load
combination) is calculated using the actual unfactored moment on that segment. Thus the
module creates a very accurate variable stiffness model of the beam based on actual
moments.  For multiple-span beams, this will affect the relative stiffness of each beam
span. Thus the moment distribution across multiple spans will be properly performed. This
will affect factored load moments and shears and service load level deflections and
reactions.
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Beam Span Data

This tab has some pieces of input that are constant for all spans and some that can vary
on a span-by-span basis.

The cross section shape and dimensions are the same for all spans.

When you click on a span (for multi-span beams), the span length and rebar layout will
update to display the arrangement that is specific to that span.

On the bottom of this tab you can specify up to 6 bar sets (quantity, size, vertical location
and start/stop endpoints). Each bar set is referenced on the sketch with a color shown as
a dot to the left of the set description.

The column titled "Dist of bar center....from...." is how you set the vertical position of the
bar sets in the beam. When you look at the top one, you can read it as "The top bar set is 3
inches from the bottom of the beam". Note that the module will know whether the bars are
in tension or compression and will handle the calculations properly.
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The item labeled Bar Position This Span defines the starting and ending location of the bar
ends with respect to the left end of each respective span. The data in the screen capture
below shows that bar set #1 and #2 run from the left end (0.0 ft) to 24.0 ft from the left end
of Span 1.  Using these starting and ending locations you can fine tune the bar layout and
end cutoffs.

Note: The module will report an error message if any beam segments are found to be
completely unreinforced.  Therefore, it is imperative that the rebar be defined in such a way
as to prevent completely unreinforced segments.  This includes the short segments at the
extreme ends of a beam, where rebar is typically terminated.  Remember that this module
is an analysis tool, not a detailing tool, so don't be tempted to define rebar as starting or
ending short of the physical end of the beam. The button labeled "FL" adjacent to each
rebar definition has been provided as a convenient way to indicate to the program that the
selected rebar runs the Full Length of the span.

Important:  Bars are assumed to be fully-effective at the locations where they are defined.
 This can be seen from the capacity diagram.  So in situations where development must
be considered, the user must understand this behavior and should define bar locations
accordingly.

Span Loads

No differences from other materials.

All Span Loads

No differences from other materials.

Load Combinations

No differences from other materials.
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Results Tabs

This set of tabs provides detailed results for the current calculation. The tabs in the upper
right-hand corner of the screen allow you to select the four major areas available for
review: Calculations, 2D Sketch, Diagram and 3D Rendering.

The Calculations tab offers the following results options:

Summary Results provides details for shear, moment and deflection for the governing
load combinations. Shear results are not shown here...they are summarized on a
separate tab that gives the required stirrup layout.
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Max. Combinations provides detailed results for each beam segment for each load
combination. 

These results are a consolidation to the highly detailed incremental results on the M-V-
D Summary tab.

M-V-D Summary - LRFD Shears & Moments shows highly detailed moment and
shear results for each beam and for each load combination. For multi-span beams
using Automatic Unbalanced Live Load Placement there may be thousands of lines of
results.
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M-V-D Summary - Deflections shows highly detailed deflection results for all load
combinations. When each load combination is expanded by clicking the [+] icon, you
will see the deflections along the entire beam. You will also see the effective moment
of inertia used in that region. (Remember that the effective moment of inertia is
calculated based on service-level moments at many locations along the length of each
span.)

M-V-D Summary - Cross Section Values shows the moment capacities and
moment of inertia for all of the identified cross sections. The  module has examined all
of the spans you defined and looked for identical reinforcing layouts. It has eliminated
the duplicates, and for simplicity, it only lists the unique reinforced cross sections
here.
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M-V-D Summary - Design Shear shows the shear stirrup requirements along the
span(s) as required by the governing load combinations that generate the highest
shear at each section.

The column labeled Comment indicates the ACI code condition that governs the
requirement for shear reinforcing at each design location.

Support Reactions shows reactions for each support for each load condition.
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The 2D Sketch tab provides a graphic representation of the beam currently being designed:
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The Diagram tab offers the ability to view shear, moment, and deflection diagrams for
selected load combinations, as well as a moment envelope:
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The 3D Rendering tab offers a 3D view of the beam, with controls to display options:

13.3.6  Masonry Beam

Need more? Ask Us a Question

This module provides analysis and design for masonry beams and lintels subject to vertical
and lateral loads. Beams can have fixed or pinned ends for most typical conditions, and the
user can specify rebar sets within the depth of the beam.

Vertical loads can be dead and live uniform and concentrated loads. A beam can have up to
four loads of each type, and the uniform loads can be full or partial length.

The module also provides analysis for both seismic and wind loads.  Wind load can be
specified as well as seismic factors that apply to the beam's weight.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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To allow the module to model different masonry block types, you can specify either
lightweight or medium weight block, and additionally enter a self-weight multiplication factor.

For both the vertical and lateral bending and shear directions, the module calculates
allowable bending moments and shear stresses. Also, for both directions, actual moments
and shears due to all entered loads are calculated. Final results consist of combined stress
ratio calculations for all combinations or dead, live, seismic, and wind vertical and lateral
moments and shears.

Unique Features

· This module calculates all vertical and lateral moments and shears and combines
them for all possible stress ratios. This provides a thorough evaluation of combined
stresses for seismic and wind design.

· The module also provides the ability to modify the material weight, automatically
reverse seismic and/or wind loadings, and model both fix-fix and pin-pin end fixity
conditions.

Assumptions & Limitations

When the beam's fixity is set to Fixed, both vertical and lateral bending are considered
fixed.
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General & Materials

This tab provides data entry for the beam dimensions, material properties and lateral
loads.

Span and Lintel Depth are used to calculate the beam bending and shears.

Thickness is the nominal masonry thickness. The true thickness is determined from
internal tables. 

End Fixity controls whether the analysis will consider the lintel to be pinned or fixed. 

Beam is Fully Braced dictates whether the module checks the unbraced length or
not.

Auto add beam self weight as Dead Load tells the module to calculate the member
self-weight and add it as a uniform vertical load across the full span.

Calculate Shear at d/2 from edge controls the critical location for the shear check.

Material Data defines the allowable stresses for masonry and reinforcing steel.  

Wall Weight Multiplier allows the user to factor the lintel self-weight that is pulled
from internal tables.

Block Type selects the density of the CMU used for self-weight.

Modulus of Rupture collects MOR for masonry.

Design Method provides the option to select Allowable Stress Design or Strength
Design.
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Reinforcing 

This tab allows you to specify the longitudinal reinforcing in the beam.

Note: All longitudinal reinforcing bars are assumed to be fully developed. No
attempt is made to compare the moment diagram with a longitudinal rebar
development diagram, so engineering judgment should be applied in situations
where end fixity is assumed and/or where heavy concentrated loads cause
significant moments at locations close to the development zone of the provided
reinforcement. 

Rebar Size 
Enter the rebar size used for all longitudinal bar sets to be used in the lintel.
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Bars Each Face (checkbox)

Selected implies that the lintel is reinforced with two layers of reinforcing separated by
the value specified in the "Bar Spacing" input.

Deselected implies that the lintel is reinforced with one layer of reinforcing located at
the middle of the width of the lintel.

The beam below DOES have bars each face:

The beam below does NOT have bars each face:

Bar Spacing 
This is the clear distance between the bars on each face in a bar set. It is assumed
that the bar set is centered within the width of the lintel.  The value of "d" used for
lateral bending strength calculations is calculated as: Actual Masonry Thickness -
(Actual Masonry Thickness - Bar Spacing) / 2
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# Bars Each Location
Enter the number of individual rebars to consider at each reinforced location.

The beam below has one bar at each reinforced location:

The beam below has three bars at each reinforced location:

Rebar Distance from Top & Bottom of Beam to Centerline of rebar group 
Distance from the top and bottom of the member to the center of area of the
respective bar set. These distances will be used as "d" for vertical bending strength
calculations.
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# Bar Sets 
Enter the number of bar sets in the lintel.  A value of one indicates that the lintel has
bottom reinforcing only.

The beam below has one bar set:

The beam below has two bar sets:

The beam below has three bar sets:
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Shear Reinforcement
When you click [Yes] you can specify the vertical shear reinforcement used in the
lintel. The results will then reflect the allowable & actual shear stress ratios.

Loads

This tab allows you to specify all loads applied to the lintel.  The Point Loads and
Distributed Loads categories are assumed to be vertical loads.  The Lateral Loads
category allows you to specify wind and seismic loads that are applied horizontally,
perpendicular to the span of the lintel. Seismic Weight factor is a multiplier applied to the
lintel self-weight to create a laterally applied uniform load.
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Load Combinations 

This is the typical load combination tab used throughout SEL.

Output & Graphics Tabs

Results

This tab summarizes the calculated moments, shears and combined stress ratios for the
lintel.
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Ratios for bending and shear are provided for both vertical and lateral load applications as
well as an SRSS calculation for combined vertical & lateral stresses from the controlling
load combination.

M & V Results

This tab provides full details for all actual and allowable stresses for all load combinations.
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Design Values Tab

This tab summarizes allowable stress calculations.  When ASD is used, the tab looks like
this:

And when SD is used, the tab looks like this:
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2D Sketch (Span & Loads subtab)
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2D Sketch (Cross Section subtab)
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3D Rendering

13.3.7  Wood Beam

Need more? Ask Us a Question

In this section, for each input tab we will review only the items that are unique to the
WOOD material type.

For general information on the typical data input for all beams see the Beams  topic.633
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This module offers complete design of single and multi-span wood members. Among its
capabilities are:

· Single or multi-span beams.

· End fixity can be pinned, fixed, free or a combination thereof.

· Analysis is according to NDS. 

· ASD or LRFD design methods can be selected.  Values of K
F
 and phi are

automatically determined and applied for the LRFD method.
· A complete wood section database is provided. This includes sawn, glued-

laminated and selected engineered wood products.
· A complete wood species database is provided. All values are per the latest NDS.

· Unbraced compression edge lengths can be specified in a variety of ways.

· Automatic member selection is provided.

· You can specify values for C
M
, C

t
 and C

r
. 

· C
F
 or C

V
 is automatically provided. In the case of C

F
, the value is also based on

species stress grade.  Note:  2018 NDS allows Cv to be greater than OR less than
1.0 for EWP.  But some EWP manufacturers limit their values of Cv to be <= 1.0. 
So as of January 12, 2023, ENERCALC SEL conservatively limits the value of Cv to
be <= 1.0 for EWPs.

General



ENERCALC SEL725

© 2024  ENERCALC, LLC

Beam Material

Clicking one of these buttons changes the material type used for the beam.

Design Method

For wood & steel you can select ASD or LRFD design methods. Concrete design
always uses ultimate strength design (LRFD).

Design Values
This section is used to specify the type of wood that will be used.  Use the

 button to access the standard wood reference
design values database and select a material.
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These values can be edited right on the screen. HOWEVER there are other pieces of
information, such as size factors for certain sizes of members, that are stored
separately.
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Beam Span Data

This tab is used to define span length and section information for the beam:
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The button indicated in the screen capture below is used to display the Wood
Section Database. 



ENERCALC SEL729

© 2024  ENERCALC, LLC

The Wood Section Database contains an extensive number of solid-sawn
members, glulam members, and engineered wood products commonly used in
the USA.

The button shown bubbled in the screen capture below is used to display the
Wood Member Design dialog. 
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The Wood Member Design dialog allows you to choose the type of member to be
selected and to specify limits on the permissible stress ratio, deflection ratio and
selected member size.

Note: The factor named Maximum Stress Ratio does not act as a multiplier on the
specified deflection ratios.

Span Loads

No differences from other materials.

Loads All Spans 

No differences from other materials.

Load Combinations

For wood members you will see entries for load duration factors. When ASD is used, the
Load Duration Factor is referred to as CD.  When LRFD is used, the Load Duration Factor

is referred to as  l.
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Note that CD and l can be automatically set for all load combinations by clicking the Auto

Set button button at the top of the column of values.  When that button is clicked, the
program will automatically determine the proper value for CD or l according to the NDS

based on the shortest duration load type included in each of the load combinations.
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Results Tabs: This set of tabs provides detailed results for the current calculation. The tabs
in the upper right-hand corner of the screen allow you to select the major areas available for
review: Calculations, 2D Sketch, Diagram and 3D Rendering.

The Calculations tab offers the following results options:

Summary Results provides details for shear, moment and deflection for the governing
load combinations.
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Max. Combinations provides detailed results for each beam segment for each load
combination. The leftmost column lists the load combinations and the unbraced length
being considered.

These results are a consolidation of the highly detailed incremental results presented
on the M-V-D Summary tab.

M-V-D Summary - Shears & Moments shows highly detailed moment and shear
information for each beam and for each load combination.  For multi-span beams
using Automatic Unbalanced Live Load Placement there may be thousands of lines of
results.
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M-V-D Summary - Deflections shows highly detailed deflection results for all load
combinations.

Support Reactions shows reactions for each support for each load condition.
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The 2D Sketch tab provides a graphic representation of the beam currently being designed:
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The Diagram tab offers the ability to view shear, moment, and deflection diagrams for
selected load combinations:
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The 3D Rendering tab provides a graphic representation of the beam currently being
designed, and offers many display options:
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REPORTS

Below is a typical Wood Beam printed report:

13.3.8  Wood Ledger

Need more? Ask Us a Question

The wood ledger module provides the ability to calculate moments and shears in the
ledger, as well as actual and allowable bearing loads on the attaching bolts.

The module allows the ledger to be attached to concrete or another wood member, and it
automatically calculates the proper allowable bolt values.

All calculations are according to NDS and IBC.  Allowable bolt capacity at an angle to the
grain is calculated using Hankinson's formula.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General

This tab collects information on the ledger size and stress grade, and bolt information.  

Ledger Data: Enter the actual dimensions (not nominal) and the wood species of the
ledger. The specific gravity will be retrieved from the internal databases (you can also
revise the specific gravity).

ASD or LRFD: Select the design method to be used. Load factoring and allowable stress
calculations will applied accordingly.  Values of K

F
 and phi are automatically determined

and applied for the LRFD method.

Wood Stress Grade: Use the [Browse] button to access the built-in NDS reference
design values database and retrieve the Fb and Fv values. You can also edit these values
separately.
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Bolting Data: Enter the bolt diameter and spacing. The yield strength of the bolt is fixed at
45 ksi in this module to remain consistent with the assumptions in the NDS.



ENERCALC SEL741

© 2024  ENERCALC, LLC

When ledger is "Attached to Wood"

When the user specifies that the ledger is attached to wood, the display will change to
allow the width and species of the supporting member to be entered.
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The following sketch clarifies the width dimension required for a wood supporting
member:

Loads

This tab allows you to apply vertical and horizontal loads to the ledger.  All loads are
assumed to act in the plane of the wall.  Vertical loads might come from gravity loading on
supported members.  Horizontal loading might come from diaphragm action, such as the
floor system dragging lateral wind or seismic load into the ledger.  When both vertical and
horizontal loads are applied, the resulting load will be at an angle to the bolt that is
somewhere between 0 degrees (for purely horizontal loading) and 90 degrees (for purely
vertical loading).

One set of uniform load values can be specified, and it will be considered to act
consistently along all areas of the ledger. For calculations purposes, this module considers
the ledger a continuous beam over multiple supports.

One set of repeating point loads can be specified, where the input collects the magnitude,
the starting location, and the spacing between subsequent loads. The module will consider
all locations of the point loads over enough ledger spans between bolts to determine the
governing case. For example, say your ledger bolting is set to 36" and the point load is set
to 15". There will be multiple point loads between bolts, and on the NEXT span, the point
loads will be in different relative positions with respect to the bolts. The module analyzes all
conditions of that bolt pattern over enough ledger spans to determine the governing point
load offset.
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One set of horizontal (lateral) shear loads is allowed, in order to simulate wind or seismic
load applied to the ledger and acting in the plane of the supporting wall.

Load Combinations Tab

This is the typical load combination tab with entries for load duration factors C
D
 (ASD) and

l (LRFD).
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Selecting the [Auto Reverse Wind Factors] and/or [Auto Reverse Seismic Factors]
buttons creates additional load combinations that insert "-W" and "-E" whenever W and E
are used.

Results 

This set of tabs provides detailed results for the current calculation. The tabs in the upper
right-hand corner of the screen allow you to select the three major areas available for review:
Calculations, 2D Sketch and 3D Rendering.

The Calculations tab offers the following results options:

Results tab presents a summary of the design for the current member by reporting the
following:

Maximum Ledger Bending shows the load combination, applied moment and actual and
allowable bending stresses. Note that no slenderness is considered for the flexural design
of the ledger, as it is assumed to be fully braced.

Maximum Ledger Shear shows the load combination, applied shear and actual and
allowable shear stresses for vertical loads only. These stresses are taken at the point of
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bolt support of the ledger and no subtraction of uniform loads within a distance "ledger
depth" from that support is considered.

Maximum Bolt Bearing Summary  Shows the vertical and horizontal components of
force acting on the bolt for the governing condition. "Allow Diagonal Bolt Force" is the result
of allowable parallel to grain and perpendicular to grain bolt capacities used for the "Angle
of Resultant" in a Hankinson formula calculation.

Dowel Bearing Strengths give the allowable stress and resulting allowable bolt bearing
stress considering NDS procedures and strengths and bolt size the user has entered.
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M & V Details tab summarizes the design values according to load combination for
moment, shear and bolt forces.
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Allowable Bolt Capacity tab provides the details of the bolt capacities according to the
chosen NDS calculation method.
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The 2D Sketch tab provides a graphic representation of the ledger currently being designed:
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The 3D Rendering tab displays a 3D graphic of the member and offers display options:
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13.3.9  Flitch Plated Wood Beam

The Flitch Plated Wood Beam module provides an efficient way to evaluate a simply-
supported wood beam reinforced with one or more steel flitch plates.  It allows both ASD
and LRFD, but for simplicity it assumes that the values are already factored appropriately
and combined.  The module then performs the load distribution to determine the
percentage of load attributable to the wood member(s) and to the steel plate(s).  Finally,
the specified bolts are checked for bearing in accordance with NDS requirements. 

 

Design Method

Specify ASD or LRFD.

Wood Members

Specify depth and thickness of one individual wood lamination.  

Number of laminations input allows multiple of the defined individual wood lamination.  

Dowel bearing strength of wood comes from NDS Table 12.3.3, which is provided for
convenience with a click of the related help button.

E wood is the modulus of elasticity that will be used.  Enter the value of E', as no further
adjustment factors are applied to this value.
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Steel Plate

Specify the depth and thickness of one individual steel plate. 

Number of steel plates input allows multiple of the defined individual steel plate.  

Number of shear planes affects the bolt bearing calculation.

Specify yield strength and modulus of elasticity of the steel plate(s).

Bolts - General

Specify the bolt diameter.

Specify the bolt bending yield strength.  

Bolts at Bearing

Specify the number of bolts in each vertical row at the bearing and the spacing within those
vertical rows.  Then specify the number of vertical rows that occur at each bearing and the
spacing between those rows.
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Loads

Specify the design loads.  

If ASD is used, the input represents the maximum moment, maximum shear, maximum
change in shear due to service-level load combinations, and the Load Duration factor, Cd. 

If LRFD is used, the input represents the maximum moment, maximum shear, maximum
change in shear due to strength-level load combinations, and the Load Duration factor,
Lambda.

Note that the following screen capture is NOT from the Flitch Plated Wood Beam
module.  It is from the Wood Beam module, which supports full loading functions
and displays shear diagrams.  The screen capture is included to illustrate one
method of determining the input value "Maximum Change in Shear" as required by
the Flitch Plated Wood Beam module.

Load Distribution

The Load Distribution category presents the calculations to determine the relative flexural
stiffness of the wood and the steel based on transformed moments of inertia.  It also
shows the calculations to determine the relative shear force distribution between the steel
and the wood.  

Note:  The wood members are always conservatively designed to carry the full
shear force, because common practice is to detail the steel flitch plates slightly
shorter than the wood member to avoid conflicts at the bearing.  Therefore the
wood must always carry the full shear force at the bearing.
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Design Loads

The Design Loads section applies the relative percentages determined in the Load
Distribution section to proportion the design moment and design shear between the wood
and the steel.

Section Properties

Section properties of the steel plate are presented.

Group Action Factor

The Group Action Factor section reports the values of Cg (for the capacity of bolts in the
interior of the span) and Cg_bearing (for the capacity of bolts at the bearings).  It also
displays the variables used in determining the two group action factors.  

Note:  A staggered pattern is assumed for the "interior'' bolts, so there are never
two bolts in a row in the direction of the force leading to Cg = 1. Stacked bolts only
occur near the bearings, so Cg_bearing may have a value less than 1.0.

Plate Flexural Capacity

The Plate Flexural Capacity section presents the calcs to determine the flexural capacity of
the plate.  The value of Ma or Mu attributable to the plate is reported for easy verification of
the flexural capacity.   

Note:  Flexural buckling is assumed to be prevented by adequate bracing.

Plate Shear Capacity

The Plate Shear Capacity section presents the calcs to determine the shear capacity of
the plate.  The value of Va or Vu attributable to the plate is reported for easy verification of
the shear capacity.   

Wood Shear Check

The Wood Shear Check section echoes the design shear force required of the wood
member(s).  This is convenient for running a quick check on the wood shear capacity by
hand, or in the Wood Beam module.
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Bolt Bearing Checks in the Interior of the Span

This section determines the capacity of the individual bolts in the staggered pattern in the
interior of the span (not at the bearings).  It presents the variables used in the checks of the
various bolt failure modes, along with the capacities associated with each failure mode. 
The value of Z' is the lowest of ZIm', ZIs', ZII', ZIIIm', ZIIIs' and ZIV'.  Using the Max change in
Shear input value, this section reports a theoretical maximum permissible spacing of the
bolts in the interior of the span, assuming that the bolts must transfer the "Steel bending
stiffness" percentage of the "Max change in Shear" from the wood to the steel plate(s).

Bolt Bearing Checks at the End of the Span

This section determines the capacity of the individual bolts in the pattern at the end of the
span (at the bearings).  Values are reported for each individual failure mode.  The value of
Z' Bearing is the lowest of ZIm' Bearing, ZIs' Bearing, ZII' Bearing, ZIIIm' Bearing, ZIIIs'
Bearing and ZIV' Bearing.  It also presents the capacity of the entire pattern at the bearing,
and reports the load on those bolts for easy comparison.

Reference Sketch

The reference sketch is provided to clarify the dimensions collected in the input.

13.4 Columns

ENERCALC SEL has a single basic column design module that supports Wood, Steel,
Concrete and Masonry material types.

There are some portions of the graphical user interface that remain consistent for all
materials, and this topic will focus on those items.  For detailed information about each of
the material-specific calculation modules, please review the respective topics below. 

Note: The Column modules are not intended for the design of tension members.  Column
modules should not be applied in situations where the member experiences net tension. 
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General 

The screen capture below shows the portions of the General tab that remain constant for
all four material types.

You can easily select a different column material by clicking one of the four material
buttons. When you do, the program will load the user interface that is specific to the
chosen material.

Overall Column Height is the total height of the column and does not have anything to do
with slenderness lengths. This length is used for three things:

· to describe the overall height of the column for the purpose of calculating self weight
(if specified),

· to locate the topmost point of load application, and 

· to perform the bending analysis when lateral loads are applied.

Rotational End Fixities let you specify how the ends of the columns are or are not
attached to boundary conditions.  Each condition explicitly describes the translational and
rotational boundary conditions at both the top and bottom of the column.
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Vertical Loads

Vertical loads can be applied to any location along the height of the column. You use this
tab to build a table of applied loads with the [Add], [Copy] and [Delete] buttons.

Include Self Weight option tells the module to automatically calculate the weight of
the column and add it as an additional dead load (which will be factored per "D" load
combination factor and applied at the top of the column).

Description lets you describe each load you are applying.

Load Eccentricity has "X" and "Y" eccentricity locations so the loads can create Y-Y
and X-X axis moments respectively.

Location from Base is where you specify the vertical location of the axial load with
respect to the bottom of the column.
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Lateral Loads

On this tab you can specify loads that will be applied along the X or Y axes of the column
(non-axial loads).

Note!  Moments applied at fixed ends have no effect on column design, and will
be ignored, producing no effect on the column, and will also NOT appear as
reactions.

Applied Load Type & Values has a drop-down list box where you can choose Full
Uniform, Partial Uniform, Point Load and Moment load types.

Description lets you describe each load you are applying.

Moment Axis is where you specify about which column axis the load creates its
applied moment.

Location from Base is where you specify the vertical location of the lateral load with
respect to the bottom of the column.
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Load Combination Tab

This tab allows you to specify the load combinations to use for the analysis. The tabs
change appearance slightly between ASD and LRFD selections. There are also optional
load duration factor entries for wood and masonry design.



ENERCALC SEL759

© 2024  ENERCALC, LLC

Please see the screen captures below for variations based on the selected material.

Steel ASD
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Steel LRFD
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Concrete LRFD
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Wood ASD
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Wood LRFD
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Masonry ASD
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Masonry SD

13.4.1  All Columns

The following topics generally apply to all column types except where noted specifically.

13.4.1.1   Column Slenderness

Need more? Ask Us a Question          

The Slenderness tab allows you to specify the column bracing, which will be considered in
axial capacity calculations.

In most of the column modules there are two tabs: "Buckling ABOUT X-X" and
"Buckling ABOUT Y-Y".  Let's start with the all-important definition of the axis
reference for slenderness.  Note that the nomenclature used to define column
slenderness was updated in May 2023 to bring ENERCALC in concert with the way
the industry defines column buckling.  Prior to May 2023, ENERCALC used
definitions that referred to "buckling IN THE DIRECTION OF" an axis.  After the
change made in May 2023, ENERCALC uses definitions that refer to "buckling
ABOUT" an axis.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Buckling failure of a column can be thought of as an uncontrolled and excessive deflection
about a particular axis.  When defining slenderness, one of the important values is the
distance between points that brace the column against buckling about a particular axis.

The column modules ask you to specify the distance between points of bracing that
prevent column buckling about the member's local X-X or Y-Y axis.

(The X-X axis is always parallel to the "width" dimension of the column. The Y-Y axis is
always parallel to the "depth" dimension of the column.)

In addition to preventing column buckling about an axis, any brace that is defined in the
column modules will ALSO be interpreted as a brace that stabilizes the compression
flange of the column against lateral torsional buckling in the flexural design.  Here's where
things get fun.  When we define the spacing of bracing that is effective in resisting column
buckling about the Y axis, that bracing is in place to prevent the column from translating
in the X axis direction, like this:
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In the screen capture immediately below, we have selected [Fully braced "X" Axis]. This
means that the column is fully braced against buckling about its X-X axis, which is parallel
to the width dimension. 

All materials, column fully braced

This selection sets the column as fully braced, and no slenderness effects will be
evaluated.
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All materials, typical simple slenderness specification

This selection allows you to enter the unbraced length to use for the column
slenderness calculation.  Also available are selections for the typical effective length
multipliers ("K" factors) for various end conditions.

Note! End fixity is specified on a different tab in the column modules. These
slenderness factors do not alter the end fixity you specified for the column, nor do they
get determined automatically by the end fixities that you specified. 
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All materials, typical slenderness with user-defined effective length factor "K"

This selection allows you to enter the unbraced height and the effective length factor
"K" to use for the column slenderness calculation.

Note! End fixity is specified on a different tab in the column modules. These
slenderness factors do not alter the end fixity you specified for the column, nor do they
get determined automatically by the end fixities that you specified.



Calculation Modules 770

© 2024  ENERCALC, LLC

All Materials, non-sway slenderness calculation by calculating K based on stiffness
of adjacent members

There is also an option to Compute K using adjacent members.  This advanced
selection lets you select the framing condition above and below the column, and using
the entered lengths and EI values, it will use standard equations for Non-Sway
columns to calculate the effective "K" factor.

Keep in mind that this option is used to define the relative stiffnesses of the framing in
the plane of buckling that is being considered.  For example, when using the X-X Axis
Column Slenderness tab, the plane under consideration is the plane in which the
column's X-X axis lies.  

13.4.1.2   Beam Stability (in Steel Column and Wood Column modules)

Older versions of the column modules only had the Column Slenderness tab input to take
some sort of guess as to what the bracing condition is for defining the lateral-torsional
buckling strength.  But there may be times where the bracing that is effective in resisting
Euler (column) buckling would not be considered as effective in resisting lateral-torsional
buckling.  So the Beam Stability tab allows the user to more effectively define the column
and the bracing for all of its failure modes. 

In the Wood Column module, the program evaluates the dimensions of the column
member and offers an input for the unbraced length to apply when evaluating flexure about
the strong axis of the member.
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The tab for the weak axis simply indicates that lateral-torsional buckling is not a
consideration when flexure occurs about the weak axis.
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13.4.2  Steel Column

Need more? Ask Us a Question

This module designs steel columns that are subject to axial loads and lateral bending
loads about both axes.

The user can select ASD or LRFD methods and has access to a complete database of
steel section sizes.

All calculations are according to AISC 360.

The screen capture below shows the full screen for steel column design. See items below
for descriptions of items that are specific to the steel column design module.

For general description of the module, end fixity, loads, and load combinations click
here . For slenderness description click here .

General

The area indicated in the screen capture below is specific to the steel column selection.
Here you can specify ASD or LRFD design procedure and specify the yield strength and
elastic modulus of the steel member to be used.

754 765
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Click the button to display the Steel Fy Selections dialog to select a
standard grade.

Column Data

All items on this tab are specific to a steel column.
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The item circled in red  is where you can type in the typical section name, press [Tab], and
the section will be searched and retrieved from the built-in database. Or you can click the

button, and you can select a section from the built-in AISC database.

The items circled in blue are the section properties for the section you have chosen.

The item circled in green is the Quick-List". Click on one of the many buttons with a
section letter and the full list of those sections will be displayed to the right. Simply click on
a section and it will be assigned to the red and blue areas.
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The button circled in pink will display the Steel Member Design dialog (see below).

This tool checks all of the steel sections for the selected type (W is selected in this case). 
A section will be judged to pass if the maximum stress ratio entered is not exceeded
and the depth measurements and depth class are not exceeded.

The term "Depth Class" refers to the nominal dimension of the family to which the section
belongs (ex: W14).  It does not refer to the actual depth of the section.  All sections starting
with "W14" are of the "14" depth class.

Results

This tab provides a summary of the stress ratios, reactions and deflections for the column.

Max Axial + Bending Stress Ratio is the governing load combination for the column.
Listed is the governing load load combination, the AISC formulas that are used, and the
location of the maximum stress ratio above the base of the column.  Please note that the
maximum stress ratio is being reported (along with its location) because it governs the
overall design, even though it may not necessarily be the highest axial stress or the highest
bending stress experienced anywhere in the column.

Max Shear Stress Ratio will probably never govern for a normally loaded column design.
 But it is presented here with the governing load combination, location and allowable/actual
stress values.

Lateral Load Reactions and Deflections are the result of applied lateral loads.
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Design Maximum Combinations

This tab lists the resulting maximum stress ratios for each load combination. This list is
created by examining the detailed list (on the next tab) and determining the governing
stress ratios for each load combination.
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Detailed Results - Shears & Moments

This tab lists the detailed results at small increments along the height of the column, for
each load combination.
For consistency, all of the column headings are taken directly from AISC.

Note! This list scrolls to the right to display more information.

Detailed Results - Service Load Deflections

This tab reports the deflections at incremental locations along the height of the column, for
each service load condition (i.e. for individual load cases and for a set of built-in service
load combinations), along each axis.
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Pn - Mnx - Mny Values

This tab provides capacity envelope data.

Reactions 

This tab provides the lateral (non-axial) reactions for individual load cases and for a set of
built-in service load combinations, along each axis.
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2D Sketch
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Diagrams (Axial-Shear-Moment-Deflection) 

This tab provides comprehensive charting capability to view graphs of Axial load, Shear,
Moment, and Deflection along the length of the member. Note that the graphs are oriented
such that the right end of the graph represents the column base, and the left end of the
graph represents the column top. This was done to maximize the scale of the graph based
on the screen area available.
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3D Rendering 

This tab displays the 3D rendering of the column and offers various display options.
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13.4.3  Wood Column

Need more? Ask Us a Question

This module designs wood columns that are subject to axial loads and lateral bending
loads about both axes.

The user can select ASD or LRFD design methods and has access to a large built-in
database of wood sizes and NDS species stress grades.  Values of K

F
 and phi are

automatically determined and applied for the LRFD method.

All calculations are according to the NDS code.

The screen capture below shows the full screen for wood column design. See items below
for descriptions of items that are specific to the Wood Column module.

For general description of the module, end fixity, loads, and load combinations click
here . For slenderness description click here .754 765
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General

The Design Stresses area bubbled in the screen capture below is unique to the wood
column selection. This area enables you to specify the base design values for the wood
species and grade of interest.

You can either enter these values manually, or you can click the button to display
the Wood Stress Database.
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Column Data 

All of the information on this tab is unique to a wood column.

The area bubbled in red is where you specify the column cross section. Use the 
button to display the built-in database of wood sections (solid-sawn, glulam, and
engineered wood products are available). You can also enter the values manually.

The area bubbled in blue provides allowable stress modification factors that you can
specify. Please note that C

F
 or C

V
 values are automatically filled in. C

F
 values are

determined from the size and stress grade of the member (No. 1 and Utility grades have
different values). C

V
 values are calculated when a glu-lam section is specified.  Note that

this section allows for the specification of the Repetitive Member factor.  If the Repetitive
Member factor option is selected, the program then offers the option to specify a value for
the Wall Stud Repetitive Member Factor as defined by the NDS Special Design Provisions
for Wind and Seismic (SDPWS).  If the option is selected to specify a Wall Stud Repetitive
Member Factor, it will only be applied to load combinations that include wind.  Be sure to
review the appropriate section of SDPWS for requirements on the use of this factor, as
well as the values to be used for various sizes of dimension lumber.

The area in green provides quick access to the built-in wood section database. Simply
click the button of the section type and the list on the right will be populated automatically
from the appropriate database. Then just click on a section to have its data loaded into the
entries in the red area.
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Note:  The flat use factor will only be applied if it is specified by the user.  In addition, it is
important to understand how the factor will be applied in situations where built-up columns
are designed.  The flat use factor is supposed to be applied when bending occurs about
the weak axis of the individual laminations.  But the program does not actually
understand the orientation of individual laminations in a built-up column as of July 2018.  So
for consistency, the program is set up to look at the overall dimensions of a built-up
column cross section, and then to apply the flat use factor only when considering bending
about the overall weak axis.  This requires the designer's consideration, because the weak
axis of the overall built-up section may or may not correspond to the weak axis of the
individual laminations.
 

Results

This tab provides a summary of the stress ratios, reactions and deflections for the column.
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Max Axial + Bending Stress Ratio is the governing load combination for the column.
Listed is the governing load load combination, the NDS formulas that is used and the
location of the maximum stress ratio above the base of the column. Please note maximum
stress ratio is what is being reported because it governs the design.....not necessarily the
highest axial or bending stress.

Max Shear Stress Ratio will probably never govern for a column design but is presented
here with the governing load combination, location and allowable/actual stress values.

Lateral Load Reactions and Deflections are the result of applied lateral loads.
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Design Maximum Combinations

This tab lists the resulting maximum stress ratios for each load combination. This list is
created by examining the detailed list (on the next tab) and determining the governing
stress ratios for each load combination.

Detailed Results - Shears

This tab lists the detailed shear results at small increments along the height of the column
for each load combination. 

Note! This list scrolls to the right to display more information.



Calculation Modules 788

© 2024  ENERCALC, LLC

Detailed Results - Axial

This tab lists the detailed axial results at small increments along the height of the column
for each load combination. 

Detailed Results - X-X Moments

This tab lists the detailed X axis moment results at small increments along the height of
the column for each load combination. 
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Detailed Results - Y-Y Moments

This tab lists the detailed Y axis moment results at small increments along the height of
the column for each load combination. 

Detailed Results - Service Load Deflections

This tab reports the deflections at incremental locations along the height of the column, for
each service load condition (i.e. for individual load cases and for a set of built-in service
load combinations), along each axis.
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Reactions 

This tab provides reactions for individual load cases and for service load combinations,
along each axis.
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2D Sketch
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Diagrams - A-V-M-D Diagrams

This tab provides comprehensive charting capability to view graphs of axial load, shear,
moment, and deflection along the length of the member. Note that the graphs are oriented
such that the right end of the graph represents the column base, and the left end of the
graph represents the column top. This was done to maximize the scale of the graph based
on the screen area available.
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Diagrams - Pn-Pnx-Mny Diagrams

This tab allows you to see the moment capacities about each axis given a certain
allowable axial load.

This is mostly for reference and can be considered a reverse application of the load
capacity calculations.
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3D Rendering
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13.4.4  Concrete Column

Need more? Ask Us a Question

This module designs concrete columns that are subject to axial loads and lateral bending
loads about both axes.

The module only uses strength design for concrete.

All calculations are according to the referenced version of ACI 318 based on the selected
governing building code.

The screen capture below shows the full screen for concrete column design. See items
below for descriptions of items that are specific to the concrete column design module.

For general description of the module, end fixity, loads, and load combinations click
here . For slenderness description click here .754 765
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General

The area indicated in the screen capture below is specific to the concrete column
selection. 

The two buttons and 
immediately set the value for elastic modulus "E" to the values as described on the button.
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Concrete Shape

This tab is specific to the concrete column selection. It allows you to select from 12
different column shapes. Simply click the button surrounding the column shape icon and
the screen below will change to allow specific data input for measurements and reinforcing
layout.

Following the screen capture below we will show ALL the data input areas for ALL the
column shapes with descriptions as needed.

Note that this module does a very detailed biaxial analysis of the column cross section
using exact numerical methods.
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Circular Column
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Square Column
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Rectangular Column
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Trapezoidal Column
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"L" Shaped Column
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"Z" Shaped Column
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Six Sided Column
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"T" Shaped Column
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"I" Shaped Column
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Cross Shaped Column
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Octagon Column
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Rectangular Tube Column
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Results
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Design Results - Load Combination Summary

Design Results - Load Combination Results

Note:  The value of Euler Buckling load (Pc) is calculated using the following formula from
ACI 318 Section R6.6.4.4.4:  EI = 0.25E

c
I
g
.
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A-M-V-D Results - Strength Design Results

A-M-V-D Results - Service Load Deflections

Note:  Deflections are based on Ig.

P-Mx-My Capacities
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Section Properties

Reactions
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2D Sketch
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Diagrams - P-M Diagrams
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Diagrams - A-V-M-D Diagrams
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3D Rendering

Theoretical Basis

Click here to view Concrete Column Module Theoretical Basis.

13.4.4.1   Sign Convention for Concrete Column

Coordinate Axis System (Column in Plan View)

http://www.enercalc.com/pdf/ENERCALC_Biaxial_Concrete_Solver_Basis.pdf
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Applied Axial Load Sign Convention

Applied axial loads are treated as downward loads.  They act in the same direction as
gravity.

Applied Shear Load Sign Convention

Applied shear loads respect the logical convention.
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Positive shears act in the positive direction of the selected axis.

Negative shears act in the negative direction of the selected axis.

Applied Moment Sign Convention

Applied moments follow the right hand rule. 

To visualize the direction of action of a positive Mx, point your right thumb in the +X
direction, and the natural curl of your right fingers will indicate the direction of action of a
positive Mx.  

To visualize the direction of action of a negative Mx, point your right thumb in the -X
direction, and the natural curl of your right fingers will indicate the direction of action of a
negative Mx.   

To visualize the direction of action of a positive My, point your right thumb in the +Y
direction, and the natural curl of your right fingers will indicate the direction of action of a
positive My.  

To visualize the direction of action of a negative My, point your right thumb in the -Y
direction, and the natural curl of your right fingers will indicate the direction of action of a
negative My.

Internal Axial Loads Sign Convention

Internal axial loads reported on Calculations > AMVD Results > Strength Design Results
follow the convention that positive values represent compression.

Internal Moments Sign Convention

Internal moments reported on Calculations > AMVD Results > Strength Design Results
follow this convention:

A positive Mx means the +Y surface is in tension, and the -Y surface is in compression.

A negative Mx means the -Y surface is in tension, and the +Y surface is in compression.

A positive My means the +X surface is in tension, and the -X surface is in compression.

A negative My means the -X surface is in tension, and the +X surface is in compression.

Reactions Sign Convention

Axial reactions are reported as positive when they are upward.
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Moment Reactions follow the right-hand rule explained above in Applied Moment Sign
Convention

13.4.5  Masonry Column

Need more? Ask Us a Question

This module designs masonry columns that are subject to axial loads and lateral bending
loads about one axis.

The user can select ASD or LRFD methods.

All calculations are according to the ACI 530 or TMS 402, depending upon whether IBC
2015 or IBC 2018 has been selected as the governing building code.

The screen capture below shows the full screen for masonry column design. See items
below for descriptions of items that are specific to the masonry column design module.

For general description of the module, end fixity, loads, and load combinations click
here . For slenderness description click here .754 765

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General 

The area shown in the screen capture below is specific to the masonry column selection.
You have the choice of using Working Stress or Strength Design methods.

The design method is selected with the toggle shown above in the red bubble.  Material
properties are collected in the area shown in the blue bubble above.

The column capacity is determined by creating a P-M interaction diagram, so that the
effect of compressive force is included in the calculation of allowable moment capacity.
For working stress this will result in significantly higher capacities than the older methods
that calculated an actual stress ratio using (fa/Fa + fb/Fb).
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Column Data 

All of the information on this tab is specific to masonry column design.

This tab collects the cross section size, reinforcing, and orientation of the column.

Section definition is made easy by buttons for the common nominal dimensions of a
masonry column. Click the Width and Depth buttons and you will see the actual dimension
appear in the bottom of the area. Note that "Width" is parallel to the "x-x" axis and "Depth"
is parallel to the "y-y" axis.

In the lower right you can specify the bar size and bar count to be used on each face of the
column.

The graphic will change accordingly as your input changes.
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Results

Design Maximum Combinations

This tab summarizes the maximum stress ratios for each load combination.
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A-M-D Results: Strength

This tab presents the very detailed allowable and actual values for each load combination.

A-M-D Results: Service Load Deflections

This tab summarizes the lateral deflections of the column at increments along its height.
These values will be nonzero only if lateral loads are applied or the axial load is applied with
an eccentricity.



Calculation Modules 836

© 2024  ENERCALC, LLC

P-M Surface Data

This tab lists the full analysis results for the column.

Reactions

This tab reports axial reactions and lateral reactions.
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2D Sketch
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A-V-M-D Diagrams
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Pn-Mnx Diagram
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3D Rendering

13.5 Foundations

Please select a subtopic.
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13.5.1  General Footing

Need more? Ask Us a Question

This module provides analysis of a rectangular footing with applied axial load, overburden,
moment and shear loads.

The module allows you to move the axial load application position off-center of the footing,
and provides automatic calculation of allowable soil bearing pressure increases based on
footing dimensions and/or depth below surface.

The module checks service load soil pressure, overturning stability, sliding stability, flexure
at each of the four pedestal faces, 1-way shear at 'd' from each of the four pedestal faces,
and punching shear along a perimeter located 'd/2' from the pedestal faces.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General

Click to Calculate (Button is only visible when biaxial analysis is selected)
Due to the iterative nature of the calculations that are required for a biaxial analysis, it
would be undesirable to rerun the entire analysis and design every time an input
parameter changes.  So for reasons of efficiency, the program automatically goes into
manual recalculation mode when biaxial analysis is selected.  Click this button any
time you wish to recalculate with the current input parameters.

f'c
28-day compressive strength of the concrete.

fy
Yield point stress of reinforcing.
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Ec
Modulus of elasticity of concrete.

Concrete Density
The density of the concrete is used to calculate the self-weight of the pedestal and
footing when that option is selected.  Note that code modifications for lightweight
concrete are not applied in this module.  The purpose of this input is mainly to allow
the user to specify something in the range of 145 to 150 pcf. 

Phi Values
Enter the capacity reduction values to be applied to Vn and Mn.

Biaxial Analysis
Select Yes or No to indicate if a biaxial analysis is to be performed.  If a biaxial analysis
is performed, the solution will consider moments applied simultaneously about the two
orthogonal axes of the footing.  If a biaxial analysis is NOT performed, the solution will
consider moments applied about the two orthogonal axes to be acting non-
concurrently.

Amount of Edge Length for M & V (Only displayed when biaxial analysis is
selected)

When calculating shear and moment for footings where the maximum soil pressure
values occur at the corners, this value specifies the fraction (as a decimal) of the
footing dimension from the edge to use when calculating moments and shears due to
variable soil pressure in that region.  A smaller value for this variable will produce a
more conservative design, because it will focus on a narrower strip which is
experiencing the highest soil bearing pressure.

Ignore Checks for Sliding

Select this option if sliding is not a design consideration for any particular reason.

Consider footing weight when determining soil bearing pressure
Select this option to have the module calculate the self-weight of the footing and apply
it as a downward load when determining soil bearing pressures. The self-weight will
be multiplied by the dead load factor in each of the Soil Bearing Pressure load
combinations.  

Note: This option should generally be selected.  Deselecting this option can
lead to incorrect soil bearing pressure calculations in footings with moment.  If
the goal is to try to compare soil bearing pressures to net allowable pressures,
then it would be advisable to use the option on the Soil Allowables tab to
"Increase Bearing by Footing Weight" or adjust the allowable bearing pressure
manually if the design parameters warrant further adjustment.
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Consider footing weight when determining sliding, overturning and uplift
Select this option to have the module calculate the self-weight of the footing and apply
it as a downward load when determining sliding, overturning and uplift factors of
safety.  The self-weight will be multiplied by the dead load factor in each of the Stability
load combinations.

Min Steel Ratio - Temperature/Shrinkage
Enter the minimum ratio for temperature/shrinkage steel, calculated using the full
footing thickness. This will trigger a warning message if the section is under-
reinforced.

Note: This check is performed assuming that only one mat of the defined rebar will be
provided.  If the design has net uplift, such that a top mat is warranted, or if a top mat
will be provided anyway, then be aware that the program will still only consider the
contribution of one mat toward meeting the Temperature & Shrinkage requirement.  In
this case, it may be more convenient to set the T&S ratio to a value that represents
one-half of the total, knowing that the two mats will be sufficient to provide the full
amount required.

Minimum overturning safety factor
Enter the minimum allowable ratio of resisting moment to overturning moment.  If the
actual ratio is less than the specified minimum ratio, it will trigger a message that
overturning stability is not satisfied.

Minimum sliding safety factor
Enter the minimum allowable ratio of resisting force to sliding force.  If the actual ratio
is less than the specified minimum ratio, it will trigger a message that sliding stability
is not satisfied.

Consider ACI 10.5.1 & 10.5.3 as minimum reinforcing
Select this checkbox if you wish to have the module consider ACI 318 Sections 10.5.1
and 10.5.3 in the determination of minimum reinforcing.
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Soil Allowable Values

Allowable Soil Bearing
Enter the allowable soil bearing pressure that the soil can resist. This is a service load
resistance and will be compared to calculated service load soil pressures (loads not
factored as in strength design).

Soil density
Enter the density of the soil in pcf.

Footing base depth below soil surface
The distance from the bottom of the footing to the top of the soil. This value is used to
determine allowable soil bearing pressure increases and soil passive sliding
resistance, but it is not used in any other calculations in this module.
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Increase bearing by footing weight
Click [Yes] to tell the module to calculate the weight of one square foot (plan view) of
footing weight and add it to the allowable soil bearing value. This has the effect of not
penalizing the soil for the self weight of the footing, and is useful for situations where
the geotechnical engineering report provides allowable net bearing pressures.

Soil passive sliding resistance
Enter the value of passive soil pressure resistance to sliding. This value will be used
to determine a component of sliding resistance that is generated by the passive
pressure of the soil.  The sliding resistance due to passive pressure is then added to
the sliding resistance due to friction to determine the total resistance to sliding for
each load combination.

Coefficient of Soil/Concrete Friction
Enter the coefficient of friction between soil and footing to use in sliding resistance
calculations.

Soil Bearing Increase
This section allows you to specify some dimensions that, when exceeded, will
automatically increase the allowable soil bearing pressure.

Increases based on footing depth: Provides a method to automatically apply
increases to the basic allowable soil bearing
pressure based on footing depth below some
reference depth. Collects the following
parameters:  

Allowable pressure increase per foot: Specifies the amount that the basic
allowable soil bearing pressure can be
increased for each foot of depth below
some reference depth.

When base of footing is below: Specifies the required depth in order to start
realizing incremental increases in the allowable
soil bearing pressure on the basis of footing
depth.

Example: Assume the following: Basic Allowable Soil Bearing Pressure = 3 ksf.
Footing base is 6'-0" below soil surface. The Geotechnical report specifies that a 0.15
ksf increase in bearing pressure is allowed for each foot of depth when the base is
deeper than 4' below top of soil. Since you've indicated that the footing is 6' below the
soil surface, the module will automatically calculate the adjusted allowable soil bearing
pressure to be 3 ksf + (6' - 4') * 0.15 ksf = 3.30 ksf.
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Increases based on footing plan dimension: Provides a method to automatically
apply increases to the basic allowable
soil bearing pressure based on footing
dimensions greater than some
reference dimension. Collects the
following parameters:

Allowable pressure increase per foot: Specifies the amount that the basic
allowable soil bearing pressure can be
increased for each foot of length or width
greater than some reference dimension.

When maximum length or width is greater than: Specifies the required
dimension in order to start
realizing incremental
increases in the allowable soil
bearing pressure on the basis
of footing dimension.

Example: Assume the following: Basic Allowable Soil Bearing Pressure = 3 ksf.
Footing measures 12'-0" x 6'-0". The geotechnical report specifies that a 0.15 ksf
increase in soil bearing pressure is allowed for each foot when the largest plan
dimension of the footing is greater than 4'. The module will automatically calculate the
adjusted allowable soil bearing pressure to be 3 ksf + (12' - 4') * 0.15 ksf = 4.2 ksf.

Note: Increases based on footing depth and plan dimensions are cumulative.

Maximum Allowed Bearing Pressure:  Allows the specification of an upper limit on the
soil bearing pressure that cannot be exceeded,
regardless of the above increases.

Adjusted Soil Bearing Pressure:  Reports the allowable soil bearing pressure adjusted
for footing weight and depth and dimensions as
specified.
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Footing Data

This tab is where you enter the footing and pedestal dimensions.

Width, Length & Thickness: defines the overall dimensions of the footing

Load Location: defines the offset from the center of the footing where the axial load is
applied. If a biaxial analysis is NOT being used, then only one direction can be used.

Pedestal dimensions: If a concrete pedestal bears on the footing, its dimensions can
be specified here. The px and pz dimensions are used to define the locations on all
four sides where one-way shear, two-way shear and bending moment are calculated.
If you enter a nonzero height, then you can choose to have the weight of that prism
calculated and added as dead load. Any applied overburden loads will be omitted from
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the area defined as the pedestal dimension along the xx and yy axis, regardless of the
specified height of the prism.

Note: If no pedestal is defined, then the load location will be treated as the face of the
pedestal when determining the critical locations to check shear and flexure.

Rebar Definitions:  Specify the number and size of rebar parallel to each axis.

Rebar Location:  Specify the distance from the center of the rebar to the bottom
surface of the footing.  Note that this is the dimension to the center
of the rebar, not the clear cover.

Note: Bars are assumed to be fully developed at the locations where they are required.
 It is the engineer's responsibility to validate that assumption.  The program is not
taking rebar development length into consideration.

Consider Pedestal Weight When Determining: This option allows the user to
specify whether or not the self-weight of the pedestal is to be considered when
determining the soil bearing pressure, and separately, whether or not the self-weight
of the pedestal is to be considered when performing the checks for sliding,
overturning, and uplift.
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Applied Loads

This tab allows you to specify the axial load, shear, and moment applied to the pedestal, as
well as an overburden load applied to the entire plan dimension of the footing (except the
area designated as the pedestal).

Enter vertical loads with a positive sign for downward direction.  Shear loads are applied at
the location of the pedestal. If the pedestal is specified to have a height, the shear will be
applied at that height and will create a moment on the footing equal to Shear Load *
(Footing Thickness + Pedestal Height).

Note! This module will not allow a net uplift on the footing. If the result of the factored axial
loads (dead, live, wind, etc) produces a negative load sign, the module will not recalculate
and will notify you of which load combination resulted in net uplift.
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Load Combinations

The Load Combination tab offers three subtabs:  LRFD Load Combinations, Soil Pressure
Combinations, and Stability Combinations.  They are all based on the selected Load
Combination Set.

The LRFD load combinations are used to calculate moments and shears in the footing for
use in determining stresses and required reinforcing.  The combinations on this tab are at
the strength-level.

The combinations on the other two tabs are at the service-level, and are used for checking
soil bearing pressure and stability, respectively.

Note: The General Footing module is applying the factored loads to the footing and
determining a different eccentricity than was determined using the service loads for the soil
bearing pressure check.
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Results

This tab provides a summary of all calculated values. The stress ratios, applied &
allowable values and load combination for those governing values are reported.
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Soil Pressures

This tab summarizes the calculated service load soil bearing pressure for moments &
shears applied about the specified axis, for each load combination.

Overturning & Sliding Stability 

This tab provides the calculations for overturning and resisting moment of the footing about
each axis for each load combination, and sliding and resisting forces in each direction for
each load combination. 

Note that the program is set up to look for overturning and resisting forces individually.  For
example, take the situation where the footing is subjected to equal and opposite shears at
a given elevation.  Common sense dictates that these forces cancel each other, and the
footing experiences no net applied overturning moment from them.  But the program treats
one of the two equal and opposite forces as an overturning force, and the other as a
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resisting force.  So for these two forces, there IS a net overturning moment reported, but
the resisting moment ALSO considers the effect of the opposing load, so the accounting
used to determine the overturning ratio is proper.

Footing Bending 

This tab provides a summary of the calculated factored load moment at all four edges of
the pedestal perimeter for each load combination.  It indicates whether the named load
combination produces tension on the top surface of the footing or the bottom.

Note: In cases where tension occurs on the top of the footing, the flexural check will be
based on the assumption that the defined rebar mat is provided on the top surface of the
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footing.  The user must review the results and determine if any load combinations actually
require a top mat of reinforcing, or if the footing could be reinforced with a bottom mat only.

Footing Shear 

This tab provides a summary of the calculated factored load shear at all four edges of the
pedestal perimeter for each load combination. Two-way or punching shear is also
calculated.
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2D Sketch
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Diagram
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3D Rendering

13.5.2  General Footing by FEM

The General Footing by FEM module is useful for footings of a variety of shapes and
supporting up to five pedestals.  
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The module gathers geometric info, soil properties, and loading data, and then generates a
finite element model that is analyzed behind the scenes in ENERCALC 3D.  The results
are then passed back to the module for review and refinement.

This process allows for considerably more flexibility than some of the other footing
modules.  For example, this module supports many common shapes of footings.  It also
allows square, rectangular and round pedestals to be modeled, and the square and
rectangular pedestals can even be rotated.  A full biaxial analysis is performed using
compression-only springs for each load combination, including service-level combinations
for soil pressure evaluation and stability checks, and strength-level combinations for
concrete design.

The module allows the user to control the mesh density, and to review the resulting mesh
that is automatically created prior to running the analysis.  It also offers two options for the
stiffness of the footing.  One option is to use the calculated stiffness based on material
properties, thickness, and specified cracking factors.  A second option is to consider the
footing as a "Rigid Body", which evaluates the footing as if it was an infinitely stiff plate.

General Tab

Concrete & Rebar Properties

Enter material properties and design parameters.  Note that code modifications for
lightweight concrete are not applied in this module.  The purpose of this input is mainly to
allow the user to specify something in the range of 145 to 150 pcf. 
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Stability Settings

Set minimum allowable factors of safety for sliding and overturning checks.

Soil Design Values

Specify allowable soil bearing pressure, subgrade modulus, soil density, coefficient of
friction and passive pressure.  

Footing Tab

Footing Shape

Select the desired footing shape and specify the data necessary to define the plan
dimensions of the footing.

Suggested Footing Target Element Size

The module suggests a value to be used as the Footing Target Element Size.  The value
generally represents one-fiftieth of the longest dimension of the footing.  

Footing Target Element Size

This field is used to specify the desired target size of the finite elements that will be used to
model the footing.  Note that this input is specified in units of inches, and that this is only a
target size.  The meshing procedure will attempt to achieve this size for as many elements
as possible, but it is not a rule or a limit.  The smaller the target element size, the larger the
model (roughly a squared function).

Footing Thickness

Specify the thickness of the footing in units of inches.

Footing Stiffness

This section offers two options.  The first is to treat the footing as a rigid body.  The second
is to consider the actual stiffness of the footing based on thickness, material properties,
and the specified cracking factor.
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Pedestals & Applied Loads Tab

Pedestal Selection

Click the desired button to enter geometric and loading data for a particular pedestal.  Up to
five pedestals can be specified per footing.

Description

The description field is available for a text description of each individual pedestal.

Shape

The shape dropdown list box offers Unused, Square, Rectangular and Round.  Dimension
fields are displayed based on the selected shape.  Note that pedestal dimensions are
always collected in units of inches, even if the "pedestal" is long, like a wall.  Enter the
Pedestal Height (in inches) above the top of the footing.

Pedestal Centroid to Footing Datum

This area collects dimensions to locate the centroid of the pedestal.  Note that dimensions
are in units of feet, and that the pedestal outline is visible on the Mesh Plot for reference.

Punching Shear Perimeter Adjustment Factor 

This factor acts as a multiplier on the calculated punching perimeter.  The punching
perimeter is calculated as follows:

· Square Pedestal:  4 * (d/2 + Pedestal dim + d/2)

· Rectangular Pedestal:   2 * [(d/2 + Pedestal X dim + d/2) + (d/2 + Pedestal Z dim + d/2)]

· Round Pedestal:   pi * (d/2 + diameter + d/2)

So by applying the Punching Shear Perimeter Adjustment Factor to the calculated
punching perimeter, it is possible to account for situations where the punching perimeter
falls partially outside the footing, such as in corner and edge conditions.  Note that this
factor is separate and distinct from the Punching Alpha s Factor described in the next
section.  For example, if it is determined that only three quarters of the calculated punching
perimeter actually falls within the footprint of the footing for a particular corner or edge
column, then the Punching Shear Perimeter Adjustment Factor can be specified as 0.75
for that column.
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Note that the module collects clear cover, not an actual value of d.  And the size of the bars
is not known.  So the program makes an allowance of 1/2 inch for the rebar radius when
calculating d.  The value of d is calculated as Footing Thickness minus clear cover minus
an additional one-half inch to account for the radius of the rebar.  

Punching Alpha s Factor

Based on the position of a pedestal (interior, edge, or corner), ACI requires the use of a
specific value for the Alpha s factor: 40, 30 or 20 respectively.

CW Rotation

This field allows square and rectangular pedestals to be rotated by a specified number of
degrees.  Positive = CW.  Negative = CCW.

Loads

Loads can be specified for each of the primary load types.  Positive values of Py act
downward.  Positive Mxx and Mzz tend to create higher soil pressure on the positive X and
positive Z sides of the footing, respectively.  Positive Vx and positive Vz act in the positive X
and positive Z directions, respectively.  Moment and shear can be defined with respect to
the footing axis system or the pedestal axis system.  Overburden DL can be specified over
the entire footing.  It can also be omitted at the footprint of pedestals.

Loading is facilitated by the fact that the module allows up to four independent wind load
cases and four independent seismic load cases for each model.  This means that one
calculation can include cases such as:

1. Net wind to the East,
2. Net wind to the West,
3. Net wind to the North, and
4. Net wind to the South.

It could also be set up to run:

1. Net wind in the East-West direction with positive internal pressure,
2. Net wind in the East-West direction with negative internal pressure,
3. Net wind in the North-South direction with positive internal pressure, and
4. Net wind in the North-South direction with negative internal pressure.
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Likewise, this increased loading capacity means that a single calculation could include
seismic load cases such as:

1. Seismic in the East-West direction with positive eccentricity,
2. Seismic in the East-West direction with negative eccentricity,
3. Seismic in the North-South direction with positive eccentricity, and
4. Seismic in the North-South direction with negative eccentricity.

It could also be set up to run:

1. 100% Seismic in the East-West direction with a concurrent 30% seismic to the North,
2. 100% Seismic in the East-West direction with a concurrent 30% seismic to the South,
3. 100% Seismic in the North-South direction with a concurrent 30% seismic to the East,

and
4. 100% Seismic in the North-South direction with a concurrent 30% seismic to the

West.

Note:  Footing self-weight is applied automatically as Dead Load.  Pedestal self-
weight is not automatically accounted for.
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Suggested Target Mesh Element Size

The module suggests a value to be used as the Target Mesh Element Size at the pedestal
footprint.  

Footing Target Element Size

This field is used to specify the desired target mesh element size of the finite elements that
will be used to model the footing within the footprint of the selected pedestal.  Note that this
input is specified in units of inches, and that this is only a target size.  The meshing
procedure will attempt to achieve this size for as many elements as possible, but it is not a
rule or a limit.  The smaller the target element size, the larger the model (roughly a squared
function).

Load Combinations Tab

Select the desired load combination set with the Select button.  Specify Sds and Rho
values to be incorporated into the generated load combinations if desired.  Combination
sets are automatically generated for strength-level (concrete design), and service-level
(soil pressure, sliding, overturning).  Each load combination in each set can be individually
modified and/or turned on or off as desired. 

Calculations Tab

Results

Displays a summary of failure modes, factors of safety or utilization ratios, design values,
and governing load combinations.

Soil Pressure

Reports the maximum soil pressure and associated load combination, as well as soil
pressures for each shell for each load combination.

Settlement

Reports the maximum settlement and associated load combination, as well as settlement
for each node for each load combination.

Actual Mu & Vu



ENERCALC SEL865

© 2024  ENERCALC, LLC

Reports the maximum Mxx, Myy, Vxx and Vyy with associated load combinations, as well
as values of Mxx, Myy, Vxx and Vyy for each shell for each load combination.

Wood-Armer Results

Reports envelope results of Wood-Armer moments and required areas of steel for the top
surface and the bottom surface at each edge of each shell. 

Technical Note:

The General Footing x FEM module uses ENERCALC 3D as the underlying solver.

ENERCALC 3D refers to shell edges as follows.  The X edge of the shell is the edge that
the local X axis protrudes through, and the Y edge of the shell is the edge that the local Y
axis protrudes through.

When ENERCALC 3D refers to shell moments, it uses the following convention.  Mx
represents the moment on the X edge of the shell, and My represents the moment on the Y
edge of the shell.
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The General Footing by FEM module automatically orients all shells so that their local X
axis coincides with the global X axis (both in direction and in algebraic sense).  Following
the right-hand rule, this also means that the local Y axis is parallel to the global Z axis, and
the positive sense of the local Y axis points in the opposite direction from the positive
sense of the global Z axis, as shown in the image above.

Wood-Armer moments Mux are not moments about the global X axis.  Instead, they act on
the X edge of the shell, meaning that they would be resisted by reinforcing steel placed
parallel to the global X axis (perpendicular to the global Z axis), as shown below. 
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Likewise, Wood-Armer moments Muy act on the Y edge of the shell, meaning that they act
about the local and global X axis, and would be resisted by reinforcing steel placed parallel
to the local y (global Z) axis, as shown below.  
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Overturning

Reports the overall overturning stability ratio and the associated load combination and
orientation of the overturning axis.  Also reports the controlling overturning ratio for each
load combination, including the overturning moment, the resisting moment, and the
orientation of the overturning axis. 

Overturning is evaluated about many axes starting with the axis oriented at zero degrees,
represented by the red line in the screen capture below.  The blue line represents a CCW
orientation of 45 degrees.  Green represents the 90 degree orientation, etc.

Sliding

Reports the lowest sliding ratio and the associated load combination.  Also reports the
sliding ratio for each load combination, including the vertical load, friction coefficient, sliding
resistance, and applied force. 

Punching
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Reports the punching shear and resistance.

Shell Info

Reports the area and bounding node info for each shell in the model.

3D Tab

Displays a 3D rendering of the footing.  Display options allow control over the individual
elements to be shown.

Mesh Plot Tab

Displays a graphical depiction of the underlying finite element model mesh.  Click the
Regenerate button to refresh the mesh display.

Stress Plots Tab

Displays plots that graphically depict soil pressure, pure flexural moments, Wood-Armer
design moments, and area of steel required to satisfy Wood-Armer moments.
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13.5.3  Wall Footing

Need more? Ask Us a Question

This module provides analysis of a unit strip of a continuous wall footing.

Axial load, moment, and shear loads can be applied.  Overburden loads can be specified,
and will apply to the surface area of the footing (except the area covered by the wall).  The
module also provides automatic calculation of allowable soil bearing pressure increases
based on footing width and/or depth below surface.

The module checks service load soil pressure, overturning stability, sliding stability, uplift
stability, footing flexure and one-way footing shear.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General

This tab collects material property values, strength reduction factors, and other settings
that influence the design.

f'c
28-day compressive strength of the concrete.

fy
Yield point stress of reinforcing.

Ec
Modulus of elasticity of concrete.
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Concrete Density
The density of the concrete is used to calculate the self weight of the footing when the
option is selected.  Note that code modifications for lightweight concrete are not
applied in this module.  The purpose of this input is mainly to allow the user to specify
something in the range of 145 to 150 pcf. 

Phi Values
Enter the capacity reduction values to be applied to Vn and Mn.

Include footing weight as dead load
Click [Yes] to have the module calculate the weight of the footing and apply it as a
downward load. The footing self weight will be multiplied by the dead load factor in
each load combination.

Min Steel Ratio - Temperature/Shrinkage Reinf.
Enter the minimum ratio for temperature/shrinkage steel, calculated using the footing
thickness. This will trigger a warning message if the section is under-reinforced.

Minimum Overturning Safety Factor
Enter the minimum allowable ratio of resisting moment to overturning moment.  If the
actual ratio is less than the specified minimum ratio, it will trigger a message that
overturning stability is not satisfied.

Minimum Sliding Safety Factor
Enter the minimum allowable ratio of resisting force to sliding force.  If the actual ratio
is less than the specified minimum ratio, it will trigger a message that sliding stability
is not satisfied.

Consider ACI 9.6.1.2 & 9.6.1.3 as minimum reinforcing
Select this checkbox if you wish to have the module consider ACI 318 Sections 9.6.1.2
and 9.6.1.3 in the determination of minimum reinforcing.
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Soil Allowables

Allowable Soil Bearing Pressure
Enter the allowable soil bearing pressure. This is a service load resistance and will be
compared to calculated service load soil pressures (loads not factored as in strength
design).

Increase Bearing by Footing Weight
Click [Yes] to tell the module to calculate the weight of one square foot (plan view) of
footing and add it to the allowable soil bearing value. This has the effect of not
penalizing the soil for the self weight of the footing, and is useful for situations where
the geotechnical engineering report provides allowable net bearing pressures.
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Soil Passive Sliding Resistance
Enter the value of passive soil pressure resistance to sliding. This value will be used
to determine a component of sliding resistance that is generated by the passive
pressure of the soil.  The sliding resistance due to passive pressure is then added to
the sliding resistance due to friction to determine the total resistance to sliding for
each load combination.

Coefficient of Soil/Concrete Friction
Enter the coefficient of friction between soil and footing to use in sliding resistance
calculations.

Soil Bearing Increase
This section allows you to specify some dimensions that, when exceeded, will
automatically increase the allowable soil bearing pressure.

Footing base depth below soil surface: The distance from the bottom of the footing
to the top of the soil. This value is used to determine allowable soil bearing pressure
increases and soil passive sliding resistance, but it is NOT used in any other
calculations in this module.

Increases based on footing depth: Provides a method to automatically apply
increases to the basic allowable soil bearing pressure based on footing depth below
some reference depth. Collects the following parameters:  

Allowable pressure increase per foot: Specifies the amount that the basic
allowable soil bearing pressure can be increased for each foot of depth below
some reference depth.

When base of footing is below: Specifies the required depth in order to start
realizing incremental increases in the allowable soil bearing pressure on the basis
of footing depth.

Example: Assume the following: Basic Allowable Soil Bearing Pressure = 3 ksf.
Footing base is 6'-0" below soil surface. The Geotechnical report specifies that a
0.15 ksf increase in bearing pressure is allowed for each foot of depth when the
base is deeper than 4' below top of soil. Since you've indicated that the footing is 6'
below the soil surface, the module will automatically calculate the adjusted
allowable soil bearing pressure to be 3 ksf + (6' - 4') * 0.15 ksf = 3.30 ksf.
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Increases based on footing width: Provides a method to automatically apply
increases to the basic allowable soil bearing pressure based on footing width greater
than some reference dimension. Collects the following parameters:

Allowable pressure increase per foot: Specifies the amount that the basic
allowable soil bearing pressure can be increased for each foot of width greater
than some reference dimension.

When maximum length or width is greater than: Specifies the required
dimension in order to start realizing incremental increases in the allowable soil
bearing pressure on the basis of footing width.

Example: Assume the following: Basic Allowable Soil Bearing Pressure = 3 ksf.
Footing measures 6'-0" wide. The Geotechnical report specifies that a 0.15 ksf
increase in soil bearing pressure is allowed for each foot when the width of the
footing is greater than 4'-0". The module will automatically calculate the adjusted
allowable soil bearing pressure to be 3 ksf + (6' - 4') * 0.15 ksf = 3.3 ksf.

Maximum Allowed Bearing Pressure: Provides a way to specify an upper limit on
the adjusted allowable bearing pressure.

Note: Increases based on footing depth and width are cumulative.

Footing & Reinforcing

Dimensions

Footing Width:  Define the width of the footing.

Wall Width:  Define the width of the supported wall.

Wall center offset from footing centerline: Define the dimension between the
centerline of the wall and the centerline
of the footing.  Positive offsets shift the
wall toward the right edge of the footing.

Footing Thickness:  Define the thickness of the footing.

Auto Calculate Footing Size & Thickness:  Provides an automated routine to
increase footing dimensions until soil
pressures are satisfied and one-way
shear is acceptable.

Note: Any applied overburden loads will be omitted from the area occupied by the wall.
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Reinforcing 

Reinforcing Bar Size:  Indicate the rebar size to consider for the bars that run
parallel to the footing width.

Rebar Spacing:  Provides an option to either specify an explicit value for the rebar
spacing, or to specify the number of bars in a 12-inch length.

Rebar Center to Concrete Edge @ Bottom:  Specify the clear cover plus 1/2 the
diameter of the rebar.



Calculation Modules 878

© 2024  ENERCALC, LLC

Applied Loads 

Vertical Load
Provides input fields for vertical loads.  Vertical loads are specified in units of kips per
foot, and they are considered to act at the center of the width of the wall.  Overburden
loads are specified in units of kips per square foot, and they are considered to act on
the top surface area of the footing, excluding the area occupied by the wall.

Overburden
Provides input fields for overburden pressures.  Overburden pressures are specified
in units of kips per square foot, and they are considered to act at the top surface area
of the footing, excluding the area occupied by the wall.
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Moments  
Provides input fields for moments.  Moments are specified in units of foot kips per foot.
 

Shears
Provides input fields for shears.  Shears are specified in units of kips per foot, and
they are considered to act at the height specified in the field named Shear
application above top of footing.  Shears will produce a moment equal to the shear
force times the distance from the bottom of the footing to the location of application of
the shear force.

Load Combinations

The Load Combinations tab is used to specify the load combinations to be used in the
design.  The LRFD Load Combinations tab controls the combinations that are used for
reinforced concrete design checks.  The Soil Pressure Combinations tab controls the
combinations that are used for evaluating soil bearing pressure.   A Soil Increase factor
can be applied on a load combination by load combination basis, as permitted by the
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geotechnical engineering report.  The Stability Combinations tab controls the load
combinations that are used to perform the serviceability checks for Overturning, Sliding,
and Uplift.  

These tabs allow the user to select from load combination sets that are supplied with the
program or to select from custom load combination sets that have been created and
saved on the user's machine.  It is also possible to unlock the selected load combination
set and make edits to the factors directly in this view.

The user has control over which combinations are run and which are ignored.   Finally,
these tabs allow the user to specify whether the program should consider the algebraic
sign of the specified load factors on wind loads and seismic loads to be reversible or not. 
This can be a convenient way to ensure that these loads are investigated as acting in both
positive and negative directions, if that is the design intent.  Note, however, that if selected,
the algebraic sign reversal will be applied to ALL wind loads and/or ALL seismic loads
including horizontally AND vertically applied loads.

Calculations

Results 

This tab summarizes the controlling values (highest utilization ratio) for each design
consideration, from all of the load combinations that have been run.  For the controlling
load combination, it presents the Applied load, the Capacity or available resisting load,
the ratio of the Applied to the Capacity, and the governing load combination that
produces this controlling ratio. 



ENERCALC SEL881

© 2024  ENERCALC, LLC

Soil Pressures 

For each service load combination, this tab presents the total vertical load, the
resultant eccentricity, the soil pressures on the left and the right ends of the footing,
the allowable soil pressure, and the ratio of the actual to the allowable soil pressure.

Overturning & Sliding Stability - Overturning Results

For each service load combination, this tab presents the overturning moment, the
resisting moment and the ratio of the resisting to overturning moment about the left
and right edges of the footing.  
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Overturning & Sliding Stability - Sliding Results

For each service load combination, this tab presents the sliding force, the resisting
force, and the ratio of the resisting to sliding force. 

Footing Bending 

This tab reports the results of the flexural design on a load combination by load
combination basis.
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Footing Shear tab

This tab reports the results of the shear design on a load combination by load
combination basis.
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2D Sketch

This tab presents plan and section views of the footing:
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3D Rendering

This tab presents the 3D rendering of the footing:

13.5.4  Combined Footing

Need more? Ask Us a Question

This module provides analysis of a rectangular footing with two applied axial, moment and
shear loads.  Overburden loads can also be specified, and will apply to the surface area of
the footing (except the areas covered by the two piers).  The module allows you to position
the application of the pier loads as necessary, and provides automatic calculation of
allowable soil bearing pressure increases based on footing dimensions and/or depth below
surface.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help


Calculation Modules 886

© 2024  ENERCALC, LLC

The module checks service load soil pressure, overturning stability, sliding stability, uplift
stability, flexure left and right of each pedestal, 1-way shear at 'd' from each of the
pedestals, and punching shear along a perimeter located 'd/2' from the pedestal faces. 
The module does not evaluate the footing for flexure about the Length axis.

General
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f'c
28-day compressive strength of the concrete.

fy
Yield point stress of reinforcing.

Ec
Modulus of elasticity of concrete.

Concrete Density
The density of the concrete is used to calculate the self weight of the pedestals and
footing when those options are selected.  Note that code modifications for lightweight
concrete are not applied in this module.  The purpose of this input is mainly to allow
the user to specify something in the range of 145 to 150 pcf. 

Phi Values
Enter the capacity reduction values to be applied to Vn and Mn.

Soil Density
Enter the density of soil in units of lb per cubic ft.

Include footing weight as dead load
Click [Yes] to have the module calculate the weight of the footing and apply it as a
downward load. The footing self weight will be multiplied by the dead load factor in
each load combination.

Include pedestal weight as dead load
Click [Yes] to have the module calculate the weight of the pedestals and apply it as
downward loads. The pedestal self weight will be multiplied by the dead load factor in
each load combination.

Min Steel Ratio - Temperature/Shrinkage
Enter the minimum ratio for temperature/shrinkage steel, calculated using the footing
thickness. This will trigger a warning message if the section is under-reinforced.

Check Min As % for 50% Top and 50% Bottom
This is a convenience option to tell the program that a top and a bottom mat of
reinforcing will be specified full length, so the minimum steel ratio entered above can
be split, half on the top, half on the bottom.

Minimum Overturning Safety Factor
Enter the minimum allowable ratio of resisting moment to overturning moment.  If the
actual ratio is less than the specified minimum ratio, it will trigger a message that
overturning stability is not satisfied.
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Minimum Sliding Safety Factor
Enter the minimum allowable ratio of resisting force to sliding force.  If the actual ratio
is less than the specified minimum ratio, it will trigger a message that sliding stability
is not satisfied.

Reduce overturning effects for seismic combinations in accordance with ASCE 7
Section 12.13.4

Select this option to apply the provisions of the referenced section of ASCE 7.

Consider ACI 9.6.1.2 & 9.6.1.3 as minimum reinforcing
Select this checkbox if you wish to have the module consider ACI 318 Sections 9.6.1.2
and 9.6.1.3 in the determination of minimum reinforcing.

Soil Values

Allowable Soil Bearing
Enter the allowable soil bearing pressure that the soil can resist. This is a service load
resistance and will be compared to calculated service load soil pressures.
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Soil Passive Sliding Resistance
Enter the value of passive soil pressure resistance to sliding. This value will be used
to determine a component of sliding resistance that is generated by the passive
pressure of the soil.  The sliding resistance due to passive pressure is then added to
the sliding resistance due to friction to determine the total resistance to sliding for
each load combination.

Coefficient of Soil/Concrete Friction
Enter the coefficient of friction between soil and footing to use in sliding resistance
calculations.

Soil Bearing Increase
This section allows you to specify some dimensions that, when exceeded, will
automatically increase the allowable soil bearing pressure.

Increases based on footing depth: Provides a method to automatically apply
increases to the basic allowable soil bearing pressure based on footing depth below
some reference depth. Collects the following parameters:  

Allowable pressure increase per foot: Specifies the amount that the basic
allowable soil bearing pressure can be increased for each foot of depth below
some reference depth.

When base of footing is below: Specifies the required depth in order to start
realizing incremental increases in the allowable soil bearing pressure on the basis
of footing depth.

Example: Assume the following: Basic Allowable Soil Bearing Pressure = 3 ksf.
Footing base is 6'-0" below soil surface. The Geotechnical report specifies that a
0.15 ksf increase in bearing pressure is allowed for each foot of depth when the
base is deeper than 4' below top of soil. Since you've indicated that the footing is 6'
below the soil surface, the module will automatically calculate the adjusted
allowable soil bearing pressure to be 3 ksf + (6' - 4') * 0.15 ksf = 3.30 ksf.
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Increases based on footing plan dimension: Provides a method to automatically
apply increases to the basic allowable soil bearing pressure based on footing
dimensions greater than some reference dimension. Collects the following
parameters:

Allowable pressure increase per foot: Specifies the amount that the basic
allowable soil bearing pressure can be increased for each foot of width or length
greater than some reference dimension.

When maximum length or width is greater than: Specifies the required
dimension in order to start realizing incremental increases in the allowable soil
bearing pressure on the basis of footing dimension.

Example: Assume the following: Basic Allowable Soil Bearing Pressure = 3 ksf.
Footing measures 12'-0" x 6'-0". The Geotechnical report specifies that a 0.15 ksf
increase in soil bearing pressure is allowed for each foot when the largest plan
dimension of the footing is greater than 4'. The module will automatically calculate
the adjusted allowable soil bearing pressure to be 3 ksf + (12' - 4') * 0.15 ksf = 4.2
ksf.

Maximum Allowed Bearing Pressure: Provides a way to specify an upper limit on
the adjusted allowable bearing pressure.

Note: Increases based on footing depth and plan dimensions are cumulative.

Increase Bearing by Footing Weight
Click [Yes] to tell the module to calculate the weight of one square foot (plan view) of
footing and add it to the allowable soil bearing value. This has the effect of not
penalizing the soil for the self weight of the footing, and is useful for situations where
the geotechnical engineering report provides allowable net bearing pressures.
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Footing Size & Reinforcing

Dimensions tab

Projection on Left, Distance Between Columns, Projection on Right:  Define the
dimensions of the footing in the Length direction.

Footing Width:  Define the dimension of the Width direction.

Footing Thickness:  Define the total thickness of the footing.

Footing base depth below soil surface: The distance from the bottom of the footing
to the top of the soil. This value is used to determine allowable soil bearing pressure
increases and soil passive sliding resistance, but it is not used in any other
calculations in this module.
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Pedestal dimensions: If concrete pedestals bear on the footing, their dimensions can
be specified here.  Pedestals are assumed to be square, and they are assumed to be
centered on the Width dimension of the footing.

Note: Any applied overburden loads will be omitted from the area occupied by the
pedestals.

Reinforcing tab

Reinforcing parallel to the Length dimension can be defined separately for the left and
right projections of the footing and for the area between the columns.  Input fields are
provided to define top bars and bottom bars separately.
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Note: Bars are assumed to be fully developed at the locations where they are required.
 It is the engineer's responsibility to validate that assumption.  The program is not
taking rebar development length into consideration.

Applied Loads

The Applied Loads tab provides sub-tabs for Column #1 (the column on the left), Column
#2 (the column on the right), and Overburden.  The two column load tabs offer input fields
for vertical loads, moment about the Width axis, and shear in the Length direction.  The
Overburden tab provides input fields for a uniform vertical pressure that will be applied to
the entire surface area of the footing with the exception of the areas occupied by the
pedestals.
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Load Combinations

The Load Combinations tab is used to specify the load combinations to be used in the
design.  The Service Combinations tab controls the load combinations that are used to
perform the serviceability checks for Soil Bearing, Overturning, Sliding, and Uplift.  The
Factored Combinations tab controls the load combinations that are used to perform the
strength checks for Flexure, One-Way Shear, and Two-Way Punching Shear.

These tabs allow the user to select from load combination sets that are supplied with the
program or to select from custom load combination sets that have been created and
saved on the user's machine.  It is also possible to unlock the selected load combination
set and make edits to the factors directly in this view. The user has control over which
combinations are run and which are ignored.  A Soil Increase factor can be applied on a
load combination by load combination basis, as permitted by the geotechnical engineering
report.  

Finally, this tab allows the user to specify whether the program should consider the
algebraic sign of the specified load factors on wind loads and seismic loads to be
reversible or not.  This can be a convenient way to ensure that these loads are investigated
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as acting in both positive and negative directions, if that is the design intent.  Note,
however, that if selected, the algebraic sign reversal will be applied to ALL wind loads
and/or ALL seismic loads including horizontally AND vertically applied loads.

Calculations

Results

This tab summarizes the controlling values (highest utilization ratio) for each design
consideration, from all of the load combinations that have been run.  For the controlling
load combination, it presents the Applied load, the Capacity or available resisting load,
the ratio of the Applied to the Capacity, and the governing load combination that
produces this controlling ratio. 
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Soil Pressures

For each service load combination, this tab presents the total vertical load, the
resultant eccentricity, the soil pressures on the left and the right ends of the footing,
the allowable soil pressure, and the ratio of the actual to the allowable soil pressure.

Overturning & Sliding Stability
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For each service load combination, this tab presents the overturning moment, the
resisting moment and the ratio of the resisting to overturning moment about the left
and right edges of the footing.  It also reports the sliding force, the resisting force, and
the ratio of the resisting to sliding force. 

Note that the program is set up to look for overturning and resisting forces individually.
 For example, take the situation where the footing is subjected to equal and opposite
shears at a given elevation.  Common sense dictates that these forces cancel each
other, and the footing experiences no net applied overturning moment from them.  But
the program treats one of the two equal and opposite forces as an overturning force,
and the other as a resisting force.  So for these two forces, there IS a net overturning
moment reported, but the resisting moment ALSO considers the effect of the
opposing load, so the accounting used to determine the overturning ratio is proper.

Footing Bending

This tab reports the results of the flexural design on a load combination by load
combination basis, at small increments along the length of the footing.
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Footing Shear 

This tab reports the results of the one-way and two-way shear design on a load
combination by load combination basis.

2D Sketch - Plan

This tab provides a plan view of the footing with rebar callouts and overall dimensions.
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2D Sketch - Elevation

This tab provides an elevation view of the footing with rebar callouts and overall
dimensions.



Calculation Modules 900

© 2024  ENERCALC, LLC

3D Rendering

This tab provides a 3D rendering of the footing with various view options.

13.5.5  Beam on Elastic Foundation

Need more? Ask Us a Question

The Beam on Elastic Foundation module is a single-span version of the Concrete Beam
module that provides special support conditions to represent an idealized, compression-
only, continuous elastic support.

The significant variation between the Beam on Elastic Foundation module and the
Concrete Beam module is the fact that the Beam on Elastic Foundation module collects a
Soil Subgrade Modulus for use in modeling the spring support.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Note that code modifications for lightweight concrete are not applied in this module.  The
purpose of this input is mainly to allow the user to specify something in the range of 145 to
150 pcf. 

Note:  This module will stop if it finds any locations where the soil springs tend to
go into tension, so be sure to use realistic load combinations.  For instance, don't
run +W Only or +Lr Only, without the corresponding dead load that would also be
applied concurrently.  Also be careful when allowing automatic reversals of wind or
seismic loads that could result in net tension at the soil interface.

Refer to the Concrete Beam module information in this document for other details.  

13.5.6  Pole Footing Embedded in Soil

Need more? Ask Us a Question

This module determines actual soil pressures and required depths for pole footings
primarily supporting lateral loads. 

Such footings are commonly called "flagpole footings".

Since applied top moment generates lateral soil pressures that usually govern the design,
these footings typically have a depth/width ratio of 2:1 and greater.

Cases with and without lateral restraint at the ground surface are allowed. Evaluation of
actual and allowable pressures is in accordance with the IBC Section entitled "Embedded
posts and poles".

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General  

Pole Footing Shape
Use this section to specify whether the pole is round or rectangular (assumed
square). 

Footing Width/Diameter
Enter the width or diameter of the pole footing. Width is measured perpendicular to
force direction. If the pole is specified as square, the module will multiply the value
entered for footing width 1.41 to determine an equivalent width dimension for
calculations.
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Restraint at Ground Surface
Specify whether the footing is free at the ground surface or restrained and cannot
translate. A restrained footing indicates that a concrete slab or other rigid element
prevents translation of the pole footing at the ground surface, but does not prevent
rotation. When specifying a restrained footing, you must assure yourself that the final
force required to provide the restraint can actually be developed by the restraining
construction. 

When ground surface restraint is present, the lateral pressure value at the bottom of
the pole will govern the design.

Operation Mode
This setting provides an option to select from two different modes of operation as
follows:

Calculate Minimum Depth: In this mode, the module will iterate to determine the
minimum embedment depth required to make the actual lateral soil pressure lower
than the allowable soil pressure.

Find Lateral Pressure for Given Depth: In this mode, the module will calculate the
lateral earth pressures caused by the specified pole size, embedment depth and
applied loads. When this option is selected, a Pole Footing Embedment Depth input
field will appear as shown below:

Allowable Pressure Limit
Two options are provided as indicated below:
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Limit only by "Max. Passive": Solves for a design that allows the passive pressure
to approach the value specified in the Allowable Lateral Passive Pressure field below
(limited to the value specified in the Maximum Lateral Pressure Limit field).

Example:  Assume allowable lateral passive pressure is 200 psf/ft with an upper limit
of 3000 psf.
  

When the Limit only by "Max. Passive" option is selected, the solution will progress
as follows:
· The program will start with a shallow assumed depth and calculate the 1/3

embedment depth.
· Then it will calculate an allowable lateral passive pressure for that 1/3 embedment

depth.
· Next, the program will compare this calculated allowable lateral passive pressure

value to the specified upper limit on the allowable passive pressure and select the
smaller of the two.

· The IBC formula is then used to determine the actual pressure for the assumed
embedment depth.

· If the actual pressure is higher than the allowable pressure, the program increments
the length and repeats the above process.

· For illustration, assume that the iterations have progressed to the point where the
embedment depth is now 42 feet. 

· The program will calculate the 1/3 embedment depth as (42 feet / 3) = 14 feet.

· Then it will calculate an allowable lateral passive pressure of (200 psf/ft * 14 ft) =
2800 psf.

· Next, the program will compare this calculated allowable lateral passive pressure
value to the specified upper limit on the allowable passive pressure and determine
that 2800 psf < 3000 psf, therefore it will use 2800 psf as the Allowable Lateral
Passive Pressure.

· When the program finds an embedment depth for which the actual pressure is
lower than the allowable pressure, it rounds the embedment depth up slightly and
reports that value.
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Use limit of 12 ft (per IBC): Solves for a design that achieves a passive pressure
that does not exceed the Allowable Lateral Passive Pressure, where the Allowable
Lateral Passive Pressure is calculated based on 1/3 of the embedment depth but not
to exceed 12 feet (and limited to the value specified in the Maximum Lateral Pressure
Limit field).

Example:  Assume allowable lateral passive pressure is 200 psf/ft with an upper limit
of 3000 psf.
  

When the Use limit of 12 ft (per IBC) option is selected, the solution will progress as
follows:
· The program will start with a shallow assumed depth and calculate the 1/3

embedment depth.
· Next, it will compare the 1/3 embedment depth to 12 feet and base the allowable

lateral passive pressure calculation on the smaller of the two.
· Next, the program will compare this calculated allowable lateral passive pressure

value to the specified upper limit on the allowable passive pressure and select the
smaller of the two.

· The IBC formula is then used to determine the actual pressure for the assumed
embedment depth.

· If the actual pressure is higher than the allowable pressure, the program increments
the length and repeats the above process.

· For illustration, assume that the iterations have progressed to the point where the
embedment depth is now 42 feet. 

· The program will calculate the 1/3 embedment depth as (42 feet / 3) = 14 feet.

· Next, it will compare the 1/3 embedment depth to 12 feet and determine that 14 feet
> 12 feet, therefore it will base the allowable lateral passive pressure calculation on
12 feet.

· Then it will calculate an allowable lateral passive pressure of (200 psf/ft * 12 ft) =
2400 psf.

· Next, the program will compare this calculated allowable lateral passive pressure
value to the specified upper limit on the allowable passive pressure and determine
that 2400 psf < 3000 psf, therefore it will use 2400 psf as the Allowable Lateral
Passive Pressure.

· When the program finds an embedment depth for which the actual pressure is
lower than the allowable pressure, it rounds the embedment depth up slightly and
reports that value.

Allowable Lateral Passive Pressure
The allowable lateral passive pressure that the soil can withstand. This value is
entered as pounds per square foot per foot of embedment depth.

Maximum Lateral Pressure Limit
This value is used to specify an upper limit on the Allowable Lateral Passive Pressure,
so that it does not increase in an uncontrolled manner as the embedment depth
increases. This value is entered as pounds per square foot.
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Applied Loads 

This module allows many types of loads to be applied to a pole footing embedded in soil.

Lateral Concentrated Loads
Module allows one concentrated load with various load types to be applied at a
specified distance above the surface of the soil.

Lateral Distributed Loads
You can apply a uniform lateral load to the pole by specifying the magnitude of the load
and the starting and ending locations.

Applied Moments (Only displayed when restraint at ground surface exists)
You can apply a concentrated moment. No "height" entry is required, because it is
purely a rotational force.

Vertical Load
You can also apply a vertical load so that the module can calculate the vertical bearing
load on the footing for each load combination.
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Load Combinations 

Use this tab to specify the load combinations you want the module to analyze.
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Calculations 

The calculations tab provides a summary of the results.

The table reports the resulting forces, moments and required depth for each load
combination.

The Controlling Values area provides information for the most severe load combination.
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2D Sketch
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3D Rendering
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13.5.7  Pile Group Analysis

Need more? Ask Us a Question

This module considers a concentrated load applied to a rigid pile cap and distributes it to a
group of piles. 

Force distribution is performed assuming a rigid pile cap and that all piles have equal
vertical load resistance. Distribution of loads to each pile due to the effect of load
eccentricity is determined using a skew bending analysis. This considers simultaneous
action about both X and Y axes. The module is also an efficient method for determining
loads on a pile group in the as-driven arrangement.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General 

NOTE! Establish an X & Y Coordinate system prior to entering pile and load
locations.  Module requires a 2-dimensional pile group to be defined.  It will not
report results for a collinear group, i.e. a single line of piles.

Total Applied Axial Load
Enter the total vertical load to be distributed to the piles in the pile group using the
coordinate system you have defined. 

Note: Only vertical loads are allowed; no lateral shears.

X & Y Distance to Load
Enter the distance from the X & Y datum (0,0) to the location of the applied vertical
load.
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Number of Piles
This entry defines the number of piles in the group. As you change the number of
piles, the number of data entry locations will match the specified number of piles.

Pile Locations: distance from Datum to the pile
Enter the distance from the X & Y datum (0,0) to the center of each pile location.

Load Combination to use
This selection will switch the load combinations shown on the Load Combinations tab
between Service and Factored design combinations.

Load Combinations 

This tab allows you to specify the load combinations to be considered.



Calculation Modules 914

© 2024  ENERCALC, LLC

Results 

This tab summarizes the overall calculated values for the pile group and lists the
maximum factored load for each pile and the load combination that produced the
maximum load.



ENERCALC SEL915

© 2024  ENERCALC, LLC

Detailed Results 

This tab gives the detailed calculations for each pile for each load combination. It
indicates the Direct force as well as the component of axial load that is due to the net
moment applied to the entire group. This latter effect will be observed for any pile that
is located at a distance from the center of gravity of the pile group.
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2D Sketch
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Design Basis: 
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13.5.8  Point Load on Slab

Need more? Ask Us a Question

This module calculates the capacity of an unreinforced concrete slab to support isolated
concentrated loads. Typical use is for legs of storage racks not supported by a building
structure, and is not within the scope of the ACI code.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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The design method is based on the recent research of Shentu, Jiang and Hsu. For further
information see (1) "Load carrying capacity for concrete slabs on grade" in the ASCE
Journal of Structural Engineering January 1997; (2) Acceptable Design & Analysis methods
for use of slabs-on-grade foundations, City of Los Angeles LAMC91.1806 and (3) Seismic
considerations for steel storage racks, FEMA 460 September 2005.

The work of Shentu and colleagues has shown that load carrying capacity, verified with test
results, can be very closely predicted using the formulas given below.

Rather than historical elastic methods, the method used here is elasto-plastic which is
more applicable to ultimate capacity determination.

Allowable load capacity is given by this equation:

Pn = 1.72 [(ks R1 / Ec) 10,000 + 3.60] * ft' * d
2

Where
ks is the modulus of subgrade reaction of the soil, pci

R1 is sqrt(Plate Width * Plate Length) / 2, inches

Ec is the concrete elastic modulus, psi

ft' is the tensile strength of the concrete = 7.5 sqrt(f'c), psi

d is the slab thickness, inches

The above equation assumes that the load acting on the slab is unique and no other nearby
loads are affecting the calculation.

To assist in the evaluation of slabs-on-grade, this module also provides a calculation of the
distance that the closest load may be without affecting the calculated slab capacity. The
calculation given below is based on research of Packard, Pickett & Ray and more recently
by Spears and Panarese. It is also discussed in ACI 360R-92(4).

In this module the distance is calculated as 1.5 * "Radius of Relative Stiffness" given by the
following equation:

b = [ Ec d3 / (12 * (1-u2) * ks)] 0.25

Where
b is the radius of relative stiffness
Ec is the concrete elastic modulus, psi

d is the slab thickness, inches
u is Poisson's ratio which is set to 0.15 in this module
ks is the modulus of subgrade reaction of the soil, pci
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Additionally this module allows the user to enter a Factor of Safety that is used when the
module reports the adequacy of each applied load.

General

This module is designed to allow the user to create a table of loads applied to a particular
concrete slab and supporting soil with one set of material properties. 

You can then use the [Add], [Edit] and [Delete] buttons to add a set of applied loads and
base plate dimensions. From this data all load combinations are used to determine the
maximum axial force. For the plate dimension you specify, the maximum load capacity for
the point load application is calculated and compared with your required factor of safety.

The option for ASD or LRFD analysis only changes the load combination set used.
Because this is a non-ACI design process, you need to enter a Factor of Safety to
determine the final design status. Research material suggests a F.S. of 3.0.

The only item that may not be self-explanatory is R1, which is sqrt(Plate Width * Plate

Length) / 2 in units of inches.
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Load Combinations

13.6 Walls

Please select a subtopic.

13.6.1  Slender Walls

Please select a subtopic.
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13.6.1.1   Concrete Slender Wall

Need more? Ask Us a Question

This program provides analysis of concrete wall panels that stand vertically and have
applied vertical and out-of-plane lateral loads.

The wall panel is analyzed using strength design procedures. Out-of-plane moments
within the wall are created by eccentric axial loads, applied lateral loads, lateral self weight
loads and moments induced due to the wall weight acting at an eccentricity when it
deflects (P-Delta moments).

The ACI slender wall procedure, introduced in ACI 318-99, was first adopted by the IBC
2000 and subsequent code editions. As quoted in ACI 318R-05 Commentary, Section 14.8
is based on the corresponding requirements in 1997 UBC and experimental research
presented in the 1982 "Test Report by SCCACI-SEAOSC".  Analytical study of the current
IBC/ACI provisions for concrete wall panels showed the ACI procedure does not
correspond to a bilinear load-deflection characteristic observed in the SEAOSC tests and
significantly underestimates the service load deflection. 

The ENERCALC Concrete Slender Wall program uses basic principles of structural
mechanics to model the wall as a series of beam segments. For each segment the actual
moment is used to calculate member stiffness using the I

ef f ectiv e
 equations developed by

Peter H. Bischoff. Since these changes to wall stiffness affect the wall deflection profile,
the program performs an iterative analysis of calculating moments (including P-Delta
effects).  The results are deflection curves almost exactly matching the SCCACI-SEAOSC
test results. This makes this program far more accurate at calculating wall deflections and
P-Delta effects than the simple equations in the ACI code.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Capabilities

This module provides these capabilities:
· One or two story slender tilt-up concrete walls

· Iterative process accounts for P-delta (12 iterations are used)

· Optional parapet

· Axial loads with optional eccentricities

· Wind, seismic and user defined lateral loads creating bending on the wall panel

· Variable strip width to model the wall panel

· Temperature differential can be specified across thickness of wall to add curvature

· Rebar location at center of wall or two layers of reinforcing at each side

· Bottom of wall can be fixed or pinned for moment resistance

· Top of wall can be pinned or free

· A reveal can be defined and cross section properties modified for reduced thickness and
optionally add rebar

· The effects of wall openings can be addressed by modeling the solid panel between or
adjacent to openings and then using superposition to apply the loads above and below
openings.
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General

Material Properties
f'c

28-day compressive strength of the concrete.

Fy
Yield point stress of reinforcing
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Ec
Modulus of elasticity of concrete. You can enter the value or click the
["57"] button to set Ec = 57000 * sqrt(f'c), or click the

["33"]  button to set Ec = 33 * sqrt(f'c) * ConcWeight1.5.

Fr: Rupture Modulus
Multiplier used in the expression to define the modulus of rupture for the concrete. 5.0
is the original recommended multiplier that was developed as a result of the SEAOSC
slender wall tests of the early 1980s.  7.5 is the multiplier provided by ACI 318.
 

Concrete Wt
Weight of concrete in pounds per cubic foot.

Lambda
Factor to account for lightweight concrete.

Max Pu/Ag = f'c * <entry>
Enter a multiplier less than 1.0 which will be applied to f'c to determine the maximum
allowable factored axial stress.

Thickness & Rebar

Wall Thickness
Total wall thickness

Bar Location
You can select bar placement at the center of the wall thickness or at each face.
When selecting "Each Face" the module performs calculations considering both bars,
unless the option is also selected to Ignore compression in rebar. 

Rebar "d" Distance
Enter the distance between the outside surface of the wall to the centerline of the
rebar. For bars each face this measurement can be from either face.

Wall Weight
The internally calculated wall weight considering the concrete weight and wall
thickness entered.

Bar Size
Enter the US customary rebar size number.
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Rebar [Spacing] / [# in Width]
These two options indicate how you will specify the rebar quantity in your design strip.

[Spacing] will change the entry so that you can enter a spacing in inches for the rebar.

[# in Width] changes the entry so you can enter the number of bars in your design
strip, where the width of the design strip is entered on the Dimensions tab. 

Note:  When using the "Each Face" option, the "# Bars in Width" specifies the number
of bars on each face within the design strip width.

Analysis Settings

Ieff used for Deflection
The module offers the option to use I

ef f ectiv e
 based on the moment in the individual wall

elements or to use I
cracked

 for the full height of the wall.

Temperature Differential across thickness
This input is used to describe the temperature change between each face of the wall.
A temperature change induces a slight curvature into the wall because the hotter side
expands, resulting in a slightly higher out-of-plane deflection. 

Minimum Vertical Steel: %/100
Minimum steel as a percentage of the gross wall area.

Minimum Allowed (Span/Deflection) Ratio
This setting establishes the minimum allowable ratio of span length to service load
deflection. If a lower actual Span/Deflection ratio occurs (meaning greater deflection),
a warning message will be displayed.

Apply 0.75 Factor used in ACI Eq. 14-5 & 14-6
Please see the code reference for an explanation of this factor. It is typically not used
in this module because it is a calibration factor used to curve fit deflection calculations
with ACI approximate formulas.

Number of wall elements for FE solver to use
This module divides the wall design strip into segments from the base to the top for
analysis purposes. Use this entry to define the number of segments to use.
Experience demonstrates that approximately 30-40 segments gives a good balance
between the iterative P-Delta analysis reaching convergence and excessive
calculation time.
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Dimensions

Clear Height
Span of the wall between the base and the first lateral support. For one-story walls this
is the top support. For 2-story walls this prompt will change to be "1st story height".

Parapet Height
Distance the wall extends above the topmost lateral support (i.e. extension above the
clear height for one-story wall, extension above the 2nd story height for 2-story walls).

Wall Support Conditions
Controls how the top and bottom of the wall are restrained for moments and lateral
movement.
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  [Top & Bottom Pinned]
Base of wall is restrained against movement out of plane and vertically, rotates freely.
Top of wall restrained against out of plane movement and can move vertically and
rotate freely.

  [Top Pinned, Bottom Fixed]
Base of wall is restrained against movement about all three axes. Top of wall
restrained against out of plane movement and can move vertically and rotate freely.

  [Top Free, Bottom Fixed]
Base of wall is restrained against movement about all three axes. Top of wall is
completely free making this a cantilevered wall.

Reveal Data
A reveal is a portion of the wall that is recessed from the rest of the surface. It is
formed by placing thin blockout material (typically styrofoam) in the forms prior to
concrete placement. It is used to create architectural effects. The reveal reduces the
structural thickness of the wall. This module calculates section properties for this
reduced section in the portion of the wall where the reveal has been formed.

   Reveal Depth
Depth of reveal measured from outside face of wall. A 1" reveal in a 6" wall gives a net
structural thickness of 5".

   Reveal Start Location, Reveal End Location
Distances measured upwards from bottom of wall that define the start and end points
of the reveal.

Reveal Rebar
This selection defines how the module should consider the reveal area to be
reinforced.
No Change means that the reinforcing stays where it is as defined by the "Rebar 'd'
Distance" entered on the General tab. This option results in an offset rebar location
within the remaining structural thickness, because the reveal takes away part of the
concrete.
Drape Bars tells the module to move the rebar inward to give the same dimension
between the rebar and face of wall. For walls with bars at "Center" this moves the bar
to the center of the remaining structural thickness. When bars are specified on each
face, this option moves only one of the bars inward.
Add Bars enables you to add additional reinforcing in the area of the reveal. The
location of the main rebar is as described in the "No Change" option above.
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Design Width of wall portion ("strip width")
This module performs its analysis for this width. Results are for either this width or a
12" width as noted where the results are provided.

Note that applied loads either are applied to the entire strip width (as for concentrated
vertical and lateral loads) or are entered on a per-foot basis when they are uniform
loads.

Two Story...
When a two-story wall is selected, this tab changes slightly to provide the 2nd story
height and remove the pure cantilevered support option.
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1st Story Height
Distance from the bottom of the wall to the first lateral support.

2nd Story Height
Distance from the first lateral support to the top lateral support.

Loads - Vertical 

A variety of vertical loads are available. Note the hints describing whether the load is per
foot or on the entire strip width.

All loads that are entered on this tab will be multiplied by the load factors specified on the
Load Combination sub-tabs.  So these magnitudes should be specified with those load
factors in mind.
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Ledger Load
This is a per-foot vertical load applied to the wall at an optional eccentricity. So if you
have a 48" strip width and specify a 1 k/ft dead load then the strip will have a total of 4
kip applied due to the 1 k/ft entry.

Eccentricity
Describes an offset from the mid-thickness of the wall panel, which is the default
location of application of a vertical load. Enter this value as a positive number
when the load is shifted toward the inside of the wall.

Concentric Load
This is a per-foot vertical load applied concentrically to the wall. So if you have a 48"
strip width and specify a 1 k/ft dead load then the strip will have a total of 4 kip applied
due to the 1 k/ft entry.

Mid-Height Vertical Uniform Load
This load entry is only shown for 2-story walls. It allows you to specify two uniform
loads applied at the "1st Story" height, one of which can have an eccentricity from the
wall center.

Concentrated Loads
These are single concentrated vertical loads applied to the wall "strip width" with an
optional eccentricity.
 
Distance from Base is the height at which the load is applied.

Eccentricity describes an offset from the mid-thickness of the wall panel, which is the
default location of application of a vertical load. Enter this value as a positive number
when the load is shifted toward the inside of the wall.

Loads - Lateral

Lateral loads are applied perpendicular to the plane of the wall and are almost always
seismic or wind. These loads create out of plane deflection of the wall, which the module
will use to develop P-Delta effects to calculate secondary moments in the wall. Recall that
this module divides the wall into small segments and calculates the allowable and actual
forces and deflections for each small segment. In this way the lateral loads are properly
modeled on what is effectively a beam with variable stiffness due to the state of cracking in
each segment.
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All loads that are entered on this tab will be multiplied by the load factors specified on the
Load Combination sub-tabs.  So these magnitudes should be specified with those load
factors in mind.  All lateral loads must be entered as positive values.

Full area WIND Load
Enter the wind load that will be applied to the wall in the out-of-plane direction. This
load will only be applied to one surface of the wall, and as such, the magnitude must
take into consideration both the internal and external pressures.

Wall Weight SEISMIC Load
This section offers three options to specify the seismic load that will be applied to the
wall in the out-of-plane direction:

Enter Lateral Load: This entry is a simple net load applied to the wall (but will still be
factored by the load combination factors for "E").



ENERCALC SEL933

© 2024  ENERCALC, LLC

Enter Wall Weight Factor: Enter a number that will be multiplied by the self-weight of
the wall. For example, if you enter 0.25 and the wall weighs 80 psf, then a 20.00 psf
out-of-plane load will be calculated and applied to the wall using the load combination
factors for "E".

Enter SDS per ASCE-05: Enter the (S
DS

 * I) value as prescribed by the ASCE code for

the building location. The minimum calculated load value of 10 psf or (0.4 * Value
Entered * Wall Weight) will be applied to the wall using the load combination factors
for "E".

Fp
This is the actual seismic load applied perpendicular to the plane of the wall, which
represents the wall's seismic self weight load.

Concentrated Lateral Loads
This is an added lateral load applied perpendicular to the plane of the wall. It acts on
the full "Strip Width" and is factored by the load combination factors corresponding to
the type of load.

Distributed Lateral Loads
This is an added lateral uniform load applied out-of-plane to the wall. It acts on the full
"Strip Width" and is factored by the load combination factors corresponding to the type
of load.  You also enter the start and end distance of the load extent above the base of
the wall.
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Load Combinations

Typical load combination information as used throughout ENERCALC SEL.
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Summary

This tab presents the critical results as calculated by the module.

Maximum Bending Stress Ratio
The module looks at the detailed results for ALL strength design load combinations at
all "segments" in the wall and pulls out the maximum factored load bending stress
ratio to present here as the governing condition.

Minimum Deflection Ratio
The module looks at the detailed results for ALL service load combinations at all
"segments" in the wall and pulls out the minimum service load deflection ratio
(meaning maximum deflection) to present here as the governing condition.

Moment Capacity Check
For the condition of maximum bending stress ratio, the actual applied and allowable
bending moments are given along with the governing load combination.
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Axial Load Check
The module checks the actual axial stress in all segments for all load combinations
and gives the maximum actual stress Pu/Ag. The allowable value is the result of the
user's entry for maximum percentage of f'c to use.

Service Deflection Check
For the condition of minimum deflection ratio (meaning maximum deflection) the ratio,
deflection, allowable minimum ratio, allowable deflection (based on allowable ratio)
and governing load combination are reported.

Reinforcing Limit Check
The module checks all portions of the wall for reinforcing (including differently
reinforced first and second stories and reveal areas). It reports the maximum
reinforcing ratio and compares it with the maximum percentage of balanced section
analysis As allowed.

Minimum Moment Check
ACI specifies that a wall section in bending shall have a minimum strength phiMn that
is greater than the cracking strength Mcr = Sgross * Fr.

Maximum Reactions
This gives a summary of the maximum reactions (both out-of-plane and vertical) along
with the load combination that creates them.
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Maximum Combinations

This tab provides a summary of the governing values for each load combination for both
factored load axial & bending and service load deflections.

Factored Load Maximum Moments for Load Combinations: The module looks
through the result set for each load combination and identifies the location above the
base of the wall at which the maximum condition is found. Note that "Aseff" is the
effective area of steel and is influenced by the axial compression in that segment.

Service Load Maximum Deflections for Load Combinations: The module looks
through the result set for each load combination and identifies the location above the
base of the wall at which the maximum out-of-plane deflection is found. The value for
"Ieff" is specific to the segment at that location and is based on the actual moment and
Bischoff's equation for calculating effective moment of inertia.
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Strength Design Results

This tab provides an extremely detailed summary of the factored axial load, moments,
effective steel area and moment of inertia at each wall analysis segment for each load
combination.

Service Load Deflections

This tab provides an extremely detailed summary of the service axial load, moments,
effective moment of inertia and calculated deflection at each wall analysis segment for
each load combination.
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Reactions

This tab gives a summary of out-of-plane and vertical base reactions for each service load
combination.
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2D Sketch
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Diagram
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3D Rendering
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13.6.1.2   Masonry Slender Wall

Need more? Ask Us a Question

This module provides design and analysis according to the new provisions for design of
masonry walls, using the P-Delta deflection considerations now included in the IBC.

This method lifts the restriction on H/t ratios, and performs wall analysis using the
principles of ultimate strength design.  The design method is very similar to that of the
Concrete Slender Wall module.

This module uses a variable width strip of wall section to represent a typical section of
wall.  The module has the ability to apply a lateral wind load, seismic load, partial length
uniform lateral load, and a lateral point load to the clear span of the wall section.  This
variety of loadings should take care of almost every lateral loading case possible. 

The user may specify masonry and reinforcing strengths, seismic factor, wind load,
vertical and lateral loads, vertical load eccentricities, and wall construction.  The module
determines the wall capacity, actual deflections considering P-Delta effects, and solves for
the final moments obtained through iteration of the P-Delta effects.  Deflection analysis is
provided for both service and factored load cases.

The user reaches a final design by modifying wall thickness, rebar size, and rebar spacing
until no overstress condition exists and the deflection limits prescribed in the code are
satisfied.

This module uses basic principles of structural mechanics to model the wall as a series of
beam segments.  For each segment the actual moment is used to calculate member
stiffness using the I

ef f ectiv e
 equations developed by Peter H. Bischoff.  Since these changes

to wall stiffness affect the wall deflection profile, the program performs an iterative analysis
of calculating moments (including P-Delta effects).  The results are deflection curves

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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almost exactly matching the SCCACI-SEAOSC test results. This makes this module far
more accurate at calculating wall deflections and P-Delta effects than the simple equations
in the ACI code.

Capabilities

This module provides these capabilities:
· One or two story slender masonry walls

· Iterative process accounts for P-delta

· Optional parapet

· Axial loads with optional eccentricities

· Wind, seismic and user defined lateral loads creating bending on the wall panel

· Variable strip width to model the wall panel

· Temperature differential can be specified across thickness of wall to add curvature
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General

Material Properties

f'm
Enter the allowable masonry strength to be used in the analysis. The allowable
bending and axial stresses calculated from f'm are outlined in a later section.

fy
Yield point stress of reinforcing.
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fr - Rupture & fr-Table
Modulus of rupture for the masonry wall system.

Em = f'm * [value]
The modulus of elasticity of the masonry wall system is specified by this value acting
as a multiplier to f'm.

Grout Density
Choose from two different options for the density of the grout.

Block Weight
Select light, medium and normal weight block. The weight of a completed wall is
determined from the masonry database, depending on the block weight, grout density,
and grouted cell spacing. To view the database values click Databases > Concrete
Masonry Unit Data from the main menu. Here is what you will see: 

Thickness & Rebar

Nominal Thickness
Select the nominal thickness for the concrete masonry units used in the wall
construction. This selection will pull the values for wall weight, equivalent solid
thickness and Igross from the masonry database (see above).

Actual Thickness
The actual wall thickness for the nominal selection.

Rebar "d" Distance
Enter the distance from the extreme compression fiber to the center of the rebar.

Solid Grouted
Select this checkbox if the wall is to be grouted solid . If unchecked the module will
calculate the wall weight considering that grouted cells only occur at the spacing of the
reinforcing.
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Wall Weight
Weight of wall as retrieved from the masonry database.  Value is based on specified
wall thickness, grout density, block type, and grouting frequency.

Rebar Size & Spacing
Enter the rebar size and spacing.

Analysis Settings

Ieff used for deflection 
The module always performs an iterative analysis for moments and deflections using
progressively greater wall deflections due to increasing P-Delta effects.

Temperature Differential across thickness
This input is used to describe the temperature change between each face of the wall.
A temperature change induces a slight curvature into the wall because the hotter side
expands, resulting in a slightly higher out-of-plane deflection. 

Enter temperature differentials as positive values.  The effects of a specified
temperature differential are always additive with the bending and deflection resulting
from other applied loads.

Minimum Vertical Steel: %/100
Minimum steel percentage as a portion of the gross wall area.

Minimum Allowed (Span/Deflection) Ratio
This setting establishes the minimum allowable ratio of span length to service load
deflection. If a lower actual Span/Deflection ratio occurs (meaning greater deflection),
a warning message will be displayed.

Number of wall elements for FE solver to use
This module divides the wall design strip into segments from the base to the top for
analysis purposes. Use this entry to define the number of segments to use.
Experience demonstrates that approximately 30-40 segments gives a good balance
between the iterative P-Delta analysis reaching convergence and excessive
calculation time.
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Dimensions

Clear Height
Span of the wall between the base and the first lateral support. For one story walls this
is the top support. For 2 story walls this is this prompt will change to be "1st story
height".

Parapet Height
Distance the wall extends above the topmost lateral support (clear height for one story
wall, 2nd story height for 2 story walls)

Wall Support Conditions
Controls how the top and bottom of the wall are restrained for moments and lateral
movement.

  [Top & Bottom Pinned]
Base of wall is restrained against movement out of plane and vertically, rotates freely.
Top of wall restrained against out of plane movement and can move vertically and
rotate freely.

  [Top Pinned, Bottom Fixed]
Base of wall is restrained against movement about all three axes. Top of wall
restrained against out of plane movement and can move vertically and rotate freely.
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  [Top Free, Bottom Fixed]
Base of wall is restrained against movement about all three axes. Top of wall is
completely free making this a cantilevered wall.

Design Width of wall portion ("strip width")

This module performs its analysis for this width. Results are for either for this width or
a 12" width as noted where the results are provided.

Note that applied loads either are applied to the entire strip width (as for concentrated
vertical and lateral loads) or are entered on a per-foot basis when they are uniform
loads.

Two Story...
When a two story wall is selected this tab changes slightly to provide the 2nd story
height and remove the Fixed-Free support option.

1st Story Height
Distance from the bottom of the wall to the first lateral support.

2nd Story Height
Distance from the first lateral support to the top lateral support.
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Loads - Vertical 

A variety of vertical loads are available. Note the hint describing whether the load is per foot
or on the entire strip width.

All loads that are entered on this tab will be multiplied by the load factors specified on the
Load Combination sub-tabs.  So these magnitudes should be specified with those load
factors in mind.  

Ledger Load
This is a per-foot vertical load applied to the wall at an optional eccentricity. So if you
have a 48" strip width and specify a 1 k/ft dead load then the strip will have a total of 4
kip applied due to the 1 k/ft entry.
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Concentric Load
This is a per-foot vertical load applied concentrically to the wall. So if you have a 48"
strip width and specify a 1 k/ft dead load then the strip will have a total of 4 kip applied
due to the 1 k/ft entry.

Mid-Height Vertical Uniform Load
This load entry is only shown for 2-story walls. It allows you to specify two uniform
loads applied at the "1st Story" height, one of which can have an eccentricity from the
wall center.

Concentrated Loads
These are single concentrated vertical loads applied to the wall "strip width" with an
optional eccentricity.
 
Distance from Base is the height at which the load is applied.

Eccentricity describes an offset from the mid-thickness of the wall panel, which is the
default location of application of a vertical load. Enter this value as a positive number
when the load is shifted toward the inside of the wall.

Loads - Lateral 

Lateral loads are applied perpendicular to the plane of the wall and are almost always
seismic or wind. These loads create out-of-plane deflection of the wall, which the module
will use to develop P-Delta effects to calculate secondary moments in the wall. Recall from
other explanations that the module divides the wall into small segments and calculates the
allowable and actual forces and deflections for each small segment. In this way the lateral
loads are properly modeled on what is a beam with variable stiffness due to the state of
cracking in each segment.
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All loads that are entered on this tab will be multiplied by the load factors specified on the
Load Combination sub-tabs.  So these magnitudes should be specified with those load
factors in mind.  All lateral loads must be entered as positive values.

Full area WIND Load
Enter the wind load that will be applied to the wall in the out-of-plane direction. This
load will only be applied to one surface of the wall, and as such, the magnitude must
take into consideration both the internal and external pressures.

Wall weight seismic load
This section offers three options to specify the seismic load that will be internally
applied to the wall in the out-of-plane direction:

Enter Lateral Load: This entry is a simple net load applied to the wall (but will still be
factored by the load combination factors for "E").
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Enter Wall Weight Factor: Enter a number that will be multiplied by the self-weight of
the wall. For example, if you enter 0.25 and the wall weighs 80 psf, then a 20.00 psf
out-of-plane load will be calculated and applied to the wall using the load combination
factors for "E".

Enter SDS per ASCE 7: Enter the (S
DS

 * I) value as prescribed by the ASCE code for

the building location. The minimum calculated load value of 10 psf or (0.4 * Value
Entered * Wall Weight) will be applied to the wall using the load combination factors
for "E".

Fp
This is the actual seismic load applied perpendicular to the plane of the wall, which
represents the wall's seismic self weight load.

Concentrated Lateral Loads
This is an added lateral load applied perpendicular to the plane of the wall. It acts on
the full "Strip Width" and is factored by the load combination factors corresponding to
the type of load.

Distributed Lateral Loads
This is an added lateral uniform load applied perpendicular to the plane of the wall. It
acts on the full "Strip Width" and is factored by the load combination factors
corresponding to the type of load.

You also enter the start and end distance of the load extent above the base of the wall.
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Load Combinations

Typical load combination information as used throughout ENERCALC SEL.
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Summary 

This tab presents the critical results as calculated by the module.

Maximum Bending Stress Ratio
The module looks at the detailed results for ALL strength design load combinations at
all "segments" in the wall and pulls out the maximum factored load bending stress
ratio to present here as the governing condition.

Minimum Deflection Ratio
The module looks at the detailed results for ALL service load combinations at all
"segments" in the wall and pulls out the minimum service load deflection ratio
(meaning maximum deflection) to present here as the governing condition.

Moment Capacity Check
For the condition of maximum bending stress ratio, the actual applied and allowable
bending moments are given along with the governing load combination.
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Axial Load Check
The module checks the factored axial stress in all segments for all load combinations
and gives the maximum actual stress Pu/Ag. The allowable value is the result of the
wall slenderness.  If the slenderness is less than or equal to 30, the allowable value of
factored axial stress is 0.20f'm.  If the slenderness is greater than 30, the allowable
value of factored axial stress is 0.05f'm.

Service Deflection Check
For the condition of minimum deflection ratio (meaning maximum deflection) the ratio,
deflection, allowable minimum ratio, allowable deflection (based on allowable ratio)
and governing load combination are reported.

Reinforcing Limit Check
The module checks all portions of the wall for reinforcing (including differently
reinforced first and second stories) and reports the maximum reinforcing ratio and
compares it with the maximum percentage of balanced section analysis As allowed.

Minimum Moment Check
ACI specifies that a wall section in bending shall have a minimum strength Mn that is
greater than the cracking strength Mcr = Sgross * fr.

Maximum Reactions
This gives a summary of the maximum reactions (both out-of-plane and vertical) along
with the load combination that creates them.
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Maximum Combinations

This tab provides a summary of the governing values for each load combination for both
factored load axial & bending and service load deflections.

Factored Load Maximum Moments for Load Combinations: The module looks
through the result set for each load combination and identifies the location above the
base of the wall at which the maximum condition is found. Note that "Aseff" is the
effective area of steel and is influenced by the axial compression in that segment.

Service Load Maximum Deflections for Load Combinations: The module looks
through the result set for each load combination and identifies the location above the
base of the wall at which the maximum out-of-plane deflection is found. The value for
"Ieff" is specific to the segment at that location and is based on the actual moment and
Bischoff's equation for calculating effective moment of inertia.
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Strength Design Results

This tab provides an extremely detailed summary of the factored axial load, moments,
effective steel area and moment of inertia at each wall analysis segment for each load
combination.
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Service Load Deflections

This tab provides an extremely detailed summary of the service axial load, moments,
effective moment of inertia and calculated deflection at each wall analysis segment for
each load combination.

Reactions

This tab gives a summary of out-of-plane and vertical base reactions for each service load
combination.
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2D Sketch
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Diagram
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3D Rendering

13.6.2  Shear Walls

Please select a subtopic.
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13.6.2.1   Concrete Shear Wall

Need more? Ask Us a Question

This module allows the design of concrete shear walls including multi-story walls with no
openings but with up to five levels of differing length, height and thickness.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General 

Length specifies the total length of the lowest level of the wall.

Height specifies the total height of the wall. On the next tab you can divide that total
height into up to five different wall portions.

f'c is the concrete strength.

fy is the yield stress of rebar.

Ec is the bending modulus of elasticity.

Ev is the shear modulus of elasticity.

SDS and R are used to calculate the in-plane portion of the wall weight to be applied

as a seismic load.

Default Rebar Sizes & Spacing: specify size, spacing, and cover for horizontal and
vertical rebar.  These inputs are used for drawing the graphics to scale, as well as for
determining limiting reinforcing percentages.
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Story Data

This tab is where you specify the distinct wall levels for the wall.

Analysis Height locates the bottom edge of the wall section and is where the
maximum shear and bending stress will be calculated.  This is the user-defined height
at which the analysis of a particular wall section will be performed. All moments,
shears, and vertical loads at this height will be calculated using all applied lateral and
vertical loads and the wall self weight above this point. The other wall data items
specified in the same column will be used between this analysis height and the next
higher level indicated in the column to the right.
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ALWAYS DEFINE ANALYSIS HEIGHTS IN INCREASING ORDER FROM LEFT TO
RIGHT. This is needed due to the manner in which the module calculates the heights
by comparing heights of adjacent sections.

Wall Offset is the distance that this wall section is offset from the left-most edge of
the bottom-most wall section.  Please refer to the diagram to further understand this
item. Because this module can be used with a walls that have their length changes
with height, you must enter the offset from the bottom wall section to the LEFT EDGE
of the wall section. This enables the module to calculate the actual X-Distance to the
center of gravity of the wall.

Wall Length is the length of the wall section. Maximum length is the overall wall length
- offset.  Enter the length to be used in the analysis of the particular wall section.
Please note that if the Wall length + Offset is greater than the Wall Length + Offset for
the level below, this indicates that the section OVERHANGS the section below it. This
is not allowed.

Wall thickness is the thickness of this wall section.  Enter the thickness to be used in
the analysis of a particular wall section. This thickness will be used only between the
Analysis Height for that section up to the analysis of the next higher section (or Total
Wall Height if it is the highest section).

Effective Depth locates the tension rebar in the panel, and is used to calculate
"shear depth" for calculation of actual shear stresses.  As with beams, the Effective
Depth in a shear wall is measured from the compression edge of the wall to the
centroid of the tension chord rebar.

Loads

This main tab has four sub-tabs that allow you to enter four types of loads.

Vertical loads can be of dead, live, roof live and snow types.

Lateral loads can be of seismic and wind types.

Add wall weight to dead loads will tell the module to calculate the weight of the wall
above each analysis height and include it in the vertical dead loads to calculate applied
axial stress. It also is used for footing design when that option is selected.

Add wall weight as SEISMIC load will calculate the wall self weight, apply the lateral
weight seismic factor and "E" load combination factor. The resulting load will be applied at
the wall center to calculate shear and overturning due to that portion of the wall. This is
used for values at the analysis height, for the effect of that level's seismic weight on the
levels below, and for footing overturning and sliding calculations.
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Vertical Point Loads
Use this tab to apply point loads to the wall. You can specify an "X" and "Y" distance
from the lower-left corner of the lower wall so that the load can be located anywhere
on the defined walls.
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Use the [Add] and [Edit] buttons to change the values of applied loads. Clicking either
button displays this window:
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Vertical Uniform Loads
Use this tab to apply uniform loads to the wall. You can specify a "Y" distance from the
bottom of the lower wall so that the load can be located at any height.



Calculation Modules 970

© 2024  ENERCALC, LLC

Use the [Add] and [Edit] buttons to change the values of applied loads. Clicking either
button displays this window:
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Lateral Point Loads
Use this tab to apply point lateral loads to the wall. You can specify a "Y" distance from
the bottom of the lower wall so that the load can be located at any height.



Calculation Modules 972

© 2024  ENERCALC, LLC

Use the [Add] and [Edit] buttons to change the values of applied loads. Clicking either
button displays this window:
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Lateral Uniform Loads

Use this tab to apply uniform lateral loads to the wall. You can specify a Start and End
location to define the extent of the lateral load.



Calculation Modules 974

© 2024  ENERCALC, LLC

Use the [Add] and [Edit] buttons to change the values of applied loads. Clicking either
button displays this window:
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Footing

Optional tab to design a footing that behaves as a continuous grade beam that cantilevers
past the end of the wall.

Specify geometry, allowable soil pressure, and material properties to arrive at checks for
soil pressure and footing flexure.

Specify a Footing:  If this checkbox is selected, then the input fields for defining a footing
are displayed.  Note:  This checkbox also causes some footing-related input to be shown
or hidden as appropriate on the Loads tab.

Projection @ Left:  Enter the projection of the footing beyond the left end of the wall in
units of ft.

Wall Length:  The program reports the shear wall length in units of ft for reference.

Projection @ Right:  Enter the projection of the footing beyond the right end of the wall in
units of ft.

Footing Length:  The program reports the footing length in units of ft for reference.

Width:  Specify the width of the footing in units of ft.  This is the dimension perpendicular to
the wall length.

Thickness:  Enter the thickness of the footing in units of inches.

Allowable Soil Pressure:  Specify the allowable soil bearing pressure in units of ksf.

f'c:  Specify the compressive stress of concrete in units of ksi.
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Fy:  Specify the yield stress of rebar in units of ksi.

Rebar Cover:  Specify the cover over rebar in units of inches.  The program will use this
value and a 1/2" allowance for the rebar size to calculate the effective depth of the
concrete section.

Note: Rebar is assumed to exist only at the bottom of the footing to resist tensile forces
from the vertical loads and increased pressure due to overturning forces. Tension in
the top of the footing in cases where no upward soil pressure exists and the footing
weight creates a downward net force IS IGNORED.

Minimum Steel Reinforcing Percentage Based on Thickness:  Specify the minimum
permissible ratio of rebar area to gross area of concrete.

Reduce overturning effects for seismic combinations per ASCE 7-16 Section
12.13.4:  Applies the referenced reduction in overturning force for seismic load
combinations when selected.
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Load Combinations

The typical load combination tab for strength design of concrete is provided.
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Stresses

Provides a summary of each level.

In the top portion you will see the calculated shear, moment and axial loads at the analysis
height you have specified. These values are due to wall self weight and applied vertical and
lateral loads from that analysis height and above.

In the bottom portion of the screen, the unit shear stresses, shear steel required and end
reinforcing for bending tension in that wall section are reported. All calculations are per ACI.
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Forces

This tab provides the detailed force values for each wall level and for each load
combination.



Calculation Modules 980

© 2024  ENERCALC, LLC

Footing & Stability

Footing Design Combination Pressures:  Reports the maximum factored soil
pressures at the left and right sides of the footing, along with the load combination
responsible for producing each of those pressures.  These are used in the reinforced
concrete design calculations for the footing.

Footing One-Way Shear Check:  Reports the results of the one-way shear calculation for
both ends of the footing.

For footings designed per ACI 318-14 and earlier, the nominal shear strength is f * 2 *

l * sqrt(f'c), where f = 0.75. 

For footings designed per ACI 318-19, the nominal shear strength is per the one-way
shear strength provisions of §22.5 and Table 22.5.5.1 (as referenced by §13.3.6.1 and
§7.5.3.1) and f = 0.75. One way shear capacity assumes no transverse footing
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reinforcement. Therefore, A
v
 is less than A

v ,min
, and equations (a) and (b) from Table

22.5.5.1 need not be considered.

Footing Bending Design:  Reports the results of the flexural analysis and design
including recommended reinforcing options to satisfy the required area of steel.

Soil Pressure Combination Pressures:  Reports the maximum unfactored soil
pressures at the left and right sides of the footing, along with the load combination
responsible for producing each of those pressures.  Unfactored soil pressures are
compared to the allowable soil bearing pressure provided by the user.

Overturning Stability:  Reports the overturning analysis performed about each end of the
footing including the overturning moment, the resisting moment, the stability ratio, and the
governing load combination.
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2D Sketch
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3D Rendering
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13.6.2.2   Masonry Shear Wall

General

This module allows the design of masonry shear walls including multi-story walls with no
openings but with up to five levels of differing length, height, thickness, grouting and
reinforcing patterns.

The wall will be composed of two zones:  

Chord Zone:  The areas at both ends of each level that contain chord rebar in every cell. 
(Always solid grouted.)

Field of Wall:  The area between chord zones that may have a different reinforcing/grouting
pattern.  (May be partially-grouted or solid-grouted.)

Convenience Features

The module collects data on a level-by-level basis to allow the user to account for varying
reinforcing and grouting patterns.  It also allows some convenience features such as the
ability to specify:

· reinforcing and grouting that can vary from one story to the next,

· wall offsets to account for conditions where the length of wall at one story is shorter
than the length of the wall below,

· a continuous footing,

· solid grouting,

· chord rebar that is different from the rebar in the field of the wall,

· bond beams and/or horizontal joint reinforcing for shear reinforcing.

Limitations

Masonry Shear Wall does not allow for the design of openings.  It also does not allow for
the design of special boundary elements, but it does incorporate the checks to verify that
special boundary elements are or are not required.

General
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Collects overall wall length and height, material properties, and strength reduction factors.

Story Data
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Select checkboxes as necessary to specify the number of stories.  Shear wall is assumed
to be laterally braced at each defined story level.

Analysis Height:  The heights at which the story framing is assumed to brace the
shear wall.

Wall Offset:  A lateral offset dimension that can be used to shift the left edge of
the wall at the selected level.

Wall Length:  The distance from the left end of the wall to the right end, at the
selected level.  This can be used to shift the right edge of the wall.
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Effective Depth:  The dimension from the compression edge of the wall to the
centroid of the chord steel.

Nominal Block Width:  Use the dropdown to select the block width.

Solid Grout:  Reinforced cells will always be assumed to be grouted, but this
option provides a way to tell the program that ALL cells in the
selected level will be grouted, regardless of whether they contain
rebar or not.

Vertical Bar Size:  Use the dropdown to select the size of the vertical rebar that will be
used in the field of the wall.

Vertical Bar Spacing:  Specify the spacing of vertical rebar in the field of the wall.

Horizontal Joint Reinforcing (HJR) Area:  Specify the effective cross-sectional area
of one piece of horizontal joint reinforcing,
if it is to be considered as shear
reinforcing.

Horizontal Joint Reinforcing (HJR) Spacing:  Specify the vertical spacing of horizontal
joint reinforcing, if it is to be considered as
shear reinforcing.

Bond Beam Reinforcing Area:  Specify the effective cross-sectional area
of rebar in one bond beam, if it is to be
considered as shear reinforcing.

Spacing of Bond Beams:  Specify the vertical spacing of bond beam
reinforcing, if it is to be considered as
shear reinforcing.

Vertical Rebar Size (Chords):  Use the dropdown to select the size of
the vertical rebar that will be used in each
solid-grouted chord cell.

# Chord Cells @ each End:  Specify the number of solid-grouted
reinforced chord cells at each end of the
selected level.

Loads
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Use the tabs to specify magnitude and location of:

· Vertical Point Loads

· Vertical Uniform Loads

· Lateral Point Loads, and

· Lateral Uniform Loads.

Also offers the option to automatically consider wall weight as vertical dead load and/or
automatically calculate seismic load due to wall weight.

Footing
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Optional tab to design a footing that behaves as a continuous grade beam that cantilevers
past the end of the wall.

Specify geometry, allowable soil pressure, and material properties to arrive at checks for
soil pressure and footing flexure.

Specify a Footing:  If this checkbox is selected, then the input fields for defining a footing
are displayed.  Note:  This checkbox also causes some footing-related input to be shown
or hidden as appropriate on the Loads tab.

Allowable Soil Pressure:  Specify the allowable soil bearing pressure in units of ksf.

Projection @ Left:  Enter the projection of the footing beyond the left end of the wall in
units of ft.

Wall Length:  The program reports the shear wall length in units of ft for reference.

Projection @ Right:  Enter the projection of the footing beyond the right end of the wall in
units of ft.

Footing Length:  The program reports the footing length in units of ft for reference.

Width:  Specify the width of the footing in units of ft.  This is the dimension perpendicular to
the wall length.

Thickness:  Enter the thickness of the footing in units of inches.

f'c:  Specify the compressive stress of concrete in units of ksi.

Fy:  Specify the yield stress of rebar in units of ksi.
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Rebar Cover:  Specify the cover over rebar in units of inches.  The program will use this
value and a 1/2" allowance for the rebar size to calculate the effective depth of the
concrete section.

Note: Rebar is assumed to exist only at the bottom of the footing to resist tensile forces
from the vertical loads and increased pressure due to overturning forces. Tension in
the top of the footing in cases where no upward soil pressure exists and the footing
weight creates a downward net force IS IGNORED.

Minimum Steel Reinforcing Percentage Based on Thickness:  Specify the minimum
permissible ratio of rebar area to gross area of concrete.

Concrete Density:  Specify the density of concrete in units of pcf.

Reduce overturning effects for seismic combinations per ASCE 7-16 Section
12.13.4:  Applies the referenced reduction in overturning force for seismic load
combinations when selected.

Load Combinations
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Collects settings that control how load combinations will be generated and applied to the
analysis/design of:

· Masonry and reinforcing

· Footing and reinforcing

· Stability

· Soil Pressure
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Output

Shear Design

Reports:
· Need for special boundary elements

· Factored shear force and controlling load combination

· Shear strength from masonry

· Shear strength from reinforcing

· Limiting shear strength

· Design shear strength

· Design ratio

· Code requirements for area and spacing of vertical rebar. 
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Axial Design

Reports:
· H/d ratio

· Factored axial load and controlling load combination

· Design axial load

· Design ratio

Flexural Design

Reports:
· Length of chord zone

· Comparison of length of chord zone to "a" dimension

· "d" dimension

· Comparison of As flex to As max

· Factored moment and controlling load combination

· Design moment

· Design ratio
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Force Summary Table

For each load combination, this table reports:
· Vu

· Mu

· Pu

· Eccentricity

· Overturning Ratio

· Uplift
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Footing & Stability

Footing Design Combination Pressures:  Reports the maximum factored soil
pressures at the left and right sides of the footing, along with the load combination
responsible for producing each of those pressures.  These are used in the reinforced
concrete design calculations for the footing.

Footing One-Way Shear Check:  Reports the results of the one-way shear calculation for
both ends of the footing.

For footings designed per ACI 318-14 and earlier, the nominal shear strength is f * 2 *

l * sqrt(f'c), where f = 0.75. 

For footings designed per ACI 318-19, the nominal shear strength is per the one-way
shear strength provisions of §22.5 and Table 22.5.5.1 (as referenced by §13.3.6.1 and
§7.5.3.1) and f = 0.75. One way shear capacity assumes no transverse footing
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reinforcement. Therefore, A
v
 is less than A

v ,min
, and equations (a) and (b) from Table

22.5.5.1 need not be considered.

Footing Bending Design:  Reports the results of the flexural analysis and design
including recommended reinforcing options to satisfy the required area of steel.

Soil Pressure Combination Pressures:  Reports the maximum unfactored soil
pressures at the left and right sides of the footing, along with the load combination
responsible for producing each of those pressures.  Unfactored soil pressures are
compared to the allowable soil bearing pressure provided by the user.

Overturning Stability:  Reports the overturning analysis performed about each end of the
footing including the overturning moment, the resisting moment, the stability ratio, and the
governing load combination.

13.6.2.3   Wood Shear Wall

Basis

The NDS Special Design Provisions for Wind & Seismic allows for three approaches to
wood shear wall design:

1. Force Transfer Shear Walls
2. Perforated Shear Walls 
3. Individual Full-Height Wall Segment Shear Walls.

Force Transfer Shear Walls and Perforated Shear Walls allow the designer to use more
favorable analysis assumptions, and offers some benefits in terms of construction details.
 But it comes at a cost of the designer having to perform more calculations and designs to
follow the load path through all of the headers, jambs, sills, etc., and their connections.

At present, the Wood Shear Wall module implements the Individual Full-Height Wall
Segment Shear Walls method.  This is the most straightforward method from the design
standpoint.  This method still requires the evaluation of h/b ratios to decide whether to
eliminate slender segments or suffer the imposed reduction on the nominal shear capacity
based on the slenderness of each panel in the wall.  This method does not require
consideration of the reduction factor (Co) that applies to Perforated Shear Walls. 

Section 4.3.2.1 of SDPWS 2021 refers to Section 4.3.3, for the reduction due to aspect
ratio.  But the implementation within ENERCALC SEL goes a little further by allowing the
user to specify openings.  The module then takes the defined openings and considers only
the solid stacked portions of remaining wall as being effective at resisting lateral loads.  So
the module actually applies the 2b/h reduction as permitted in Exception 1 in Section
4.3.5.5.1, rather than using the aspect ratio formula in Section 4.3.3.  It is always more
conservative than the adjustment in 4.3.3, but it allows the module to handle shear walls in
a line because, by definition within the module, all segments will be “sheathed with the
same materials and construction”.  
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Overview

The Wood Shear Wall module allows the user to define overall geometry, openings (if
any), sheathing type, chord member species, grade, and size, applied loads, and a footing
(if desired).  The module then evaluates the resulting shear panels, chords, and footing (if
defined).

Sheathing is evaluated for aspect ratio and unit shear due to load combinations that
include either wind or seismic.  The module considers the selected sheathing type,
sheathing thickness, fastener size, blocking condition, and the species of the supporting
framing.  It then automatically incorporates any necessary adjustments to the nominal unit
shear values from the Special Design Provisions for Wind and Seismic on the basis of
sheathing type, aspect ratio, and the species of the supporting framing.  The result is a
required fastener spacing for each panel in the wall.

Chords are evaluated for tension and compression due to load combinations that include
either wind or seismic.  The moment in a given shear panel is assumed to be coupled out
at the location of the chords, resulting in tension and compression forces.  Any applied
vertical loads that may be present are combined with the wind or seismic chord forces,
and the resulting loads on the chords are evaluated as per the requirements of the NDS.

Footings (if defined) are evaluated for soil bearing pressure, overturning, and one-way
shear and flexure of the cantilevered end projection.  

There are certain items that are not explicitly evaluated by this module, and the user should
be aware of the following exclusions: bending or shear in the top plate, bearing on the top
plate, out of plane design of the wall sheathing or framing, gravity-only loading on the
common studs or chords, bearing on the bottom plate, design of anchorage hardware or
connections.
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Workflow Process

The general workflow proceeds as follows:

1. The overall height and length of the shear wall are defined on the General tab, along
with selections such as the Seismic Design Category, the Design Method, and the
Framing and Chord Species and Grade.

2. The sheathing type, thickness, fastener size and blocking conditions is selected on the
Sheathing tab.  This tab also allows for the specification of sheathing on the second
side of the framing when necessary.  

3. The chord size is specified on a level-by-level basis on the Chords tab.  This tab also
allows for the specification of the bracing assumption to be applied in the compression
design of the chords.

4. If openings are present in the wall, they can be defined on the Openings tab.  
5. Loads of many types can be defined and applied on the Loads tab.
6. If a continuous footing design is desired, the footing geometry and material properties

can be entered on the Footing tab.
7. The Load Combinations tab allows for the definition of the load combinations that will be

used for the design.  
8. The results for the shear panels, chords, and footing (if designed) can be reviewed in

the Results panel in the lower portion of the screen.

General

Description:  Enter a free-form description of the current wall design for reference.

Total Wall Length:  Enter the overall length of the shear wall in units of feet.

Stud Spacing:  Enter the typical stud spacing in inches.

Story Heights:  Enter the heights of up to five stories in units of feet.  Whenever a value is
entered, the input field for the next story height is displayed in case it is needed.  The total
accumulated height is automatically reported.

Seismic Design Category:  Enter the appropriate Seismic Design Category for the wall
being designed.  This is used to check the selected sheathing type to be sure it is
permissible for use in that SDS according to the Special Design Provisions for Wind and
Seismic.

Design Method:  Select ASD or LRFD to dictate which method will be applied when
designing shear panels and chords.  Footing design (when requested) is always by LRFD
methods.

Framing & Chord Material:  Use the icon to access the Wood Reference Design Values
database in order to select the species and grade of wood used for the chords and
common framing in the wall.
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Sheathing

Select SDPWS Construction Table:  Choose the table from which the sheathing will be
selected.

Select Main Sheathing:  Select a tabular entry to represent the sheathing type, sheathing
thickness, fastener size/penetration, and in some cases the blocking condition.

Nominal Shear Capacities:  The program displays the nominal shear capacities for
seismic design and for wind design directly from the selected table.  These are nominal
values which still need to be modified for use in design, such as with a phi factor or factor
of safety and with any applicable adjustments such as for aspect ratio or specific gravity of
the supporting framing.

Table 4.3A Footnote 2 is applicable:  (Only visible for some sheathing selections)  Use
this checkbox to indicate if a specific condition exists as described in detail in the
referenced footnote in Table 4.3A of the Special Design Provisions for Wind and Seismic.

Sheathing is Blocked:  (Only visible for some sheathing selections)  Use this checkbox
to indicate if the sheathing is blocked or not.  This setting has an effect on some of the
allowable aspect ratios.

Sheathing on 2nd Side:  Use this checkbox to indicate that there is sheathing of some
sort on the other side of the framing.

Use Same as Main Sheathing:  A convenience option that automatically sets the
Sheathing on 2nd Side to be identical to the sheathing on the Main side.

Note:  If sheathing is specified on the second side, and if the sheathing comes from the
same Construction Table as the Main Sheathing, then the blocking setting for the 2nd side
will automatically be assumed to be the same as the blocking setting for the Main side.

Chords

The Chords tab will automatically display one row of chord definition data for each story
that was defined on the General tab.

Chord Member Size:  Use the drop-down list box to select the size of the sawn lumber
member(s) that will be used at the chord locations for the given level.  Note that the
program will automatically determine the number of chord members required at each
location.  So for example, if the wall was generally going to be constructed of 2x4 framing,
then this input should be set to "2x4".  Once the analysis and design has been completed,
the program will report how many 2x4s should be ganged together to safely resist the
imposed chord forces at each location.

CF: Size Factor:  Enter the appropriate Size Factor for the chord member size, species,
and grade being entered.
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Area per Chord:  The program reports that cross sectional area of one member of the
selected size for reference.

Maximum Chord Stress Ratio:  Enter the maximum permissible chord stress ratio. 
Typically 1.0 using current design methods and load combinations.

Wood Chord Strength Calculation:  This setting offers two options for defining the
bracing of chord members when the allowable compression stress is calculated:

· The option named "Treat all chords as fully braced about both axes" implies that all
chords are braced against column buckling.  The physical model for this option might be
a situation where chord members always occur at "L" or "T" shaped intersections, such
that the sheathing prevents buckling in the plane of the shear wall, and the intersecting
wall prevents buckling out of the plane of the shear wall.  (These conditions are probably
not common.)  

· The option named "Assume all chords unbraced out of plane of wall for story height"
implies that the sheathing prevents buckling in the plane of the shear wall, but nothing
prohibits column buckling of the chord member out of the plane of the wall.  This is the
condition for the chords at the end of an isolated straight panel of wall where no
perpendicular walls intersect the shear wall at the chord locations.

Openings

The Openings tab allows openings to be defined in the shear wall.

Add:  The Add button opens the Add Opening dialog.  The dialog automatically numbers
the openings that are added, and it collects the geometric information necessary to locate
and size the opening.  The Add Opening dialog also checks the alignment of defined
openings to ensure that all jambs are aligned.

Edit:  By selecting an existing opening in the list, the Edit button allows the selected
opening to be revised.

Delete:  By selecting an existing opening in the list, the Delete button allows the selected
opening to be removed.

Renumber:  The Renumber button allows existing openings to be renumbered in a logical
order by working from left to right and then from bottom to top.

The graphic display offers checkboxes to independently display or hide:
· Openings

· Shear Panel callouts

· Chord graphics and callouts

· Panel and opening dimensions

· All loads 
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Note:  This module is predicated on the design assumptions of the Individual Full-Height
Wall Segment Shear Walls method.  This method disregards the shear resistance of
portions of shear walls above and below openings.  This leads to two important
considerations regarding the use of openings:

1. In multi-story models, any opening in one story must not partially overlap an opening in
a different story.  If they overlap at all, they must match exactly.  Envision vertical lines
at the jambs of an opening, and project them to the top and bottom of the entire wall. 
Those jamb reference lines must not cross any other opening.  If anything, they can
only align with other jambs. The Add Opening dialog will warn if this condition is being
violated by having partially-overlapping openings in any story.  This may require
enlarging some openings so that they respect the jamb locations of adjacent openings,
or it may require applying the module only to the solid portions of the wall that remain
after the openings have been omitted.

2. The presence of an opening within a given story, creates a zone that is ineffective at
resisting shear.  The ineffective zone is defined by the width of the opening and it
extends for the full height of that story.  This means that it is not necessary to model
stacked openings within a given story.  In fact, doings so will cause an error.  
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See the following diagrams for some acceptable and unacceptable opening geometries:

NG - Jambs of openings do NOT align

Here is how to fix it:

OK - Jambs of openings align properly
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NG - Opening crosses top of story

Here is how to fix it:

OK - Large opening modeled as 2 separate openings
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NG - Stacked openings within a story

Here is how to fix it:

OK - One opening accomplishes the task

Note:  When using the self-weight functions for Dead Load and for seismic load, the
program does not deduct any weight for openings.  In other words, the program assumes
that the unit weight of the window, door, louver, etc. in the opening, is approximately the
same as the unit weight of the wood-framed construction it is replacing.
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Loads tab

The Loads tab provides several sub-tabs for the convenient definition of many different
types of loads that could potentially act on a shear wall system.

General

The Wall Self Weight category offers inputs for the following:

Consider Wall Weight:  This category provides options to automatically consider the wall
self-weight:
· As vertical Dead load - a way to request that the program use the unit weight described

above to calculate a dead load 
· As Seismic load - a way to request that the program use the unit weight described above

to calculate a lateral seismic load using the value of Cs described below

Weight:  (Only displayed when one of the options above has been selected.)  Enter the
unit weight of shear wall construction in psf.

Cs: Seismic Response Coefficient:  (Only displayed when the "As Seismic load" option
above has been selected.)  Collects the value of Cs by which the unit weight would be
multiplied to determine the seismic load due to the self-weight of the wall if that option is
selected.

Soil over Footing: category is only displayed if the "Specify a Footing" option is selected
on the Footing tab.  This category offers inputs for the following:

Soil depth over footing:  Enter the depth of soil above the top of the footing in units of
inches.  This value is used to determine loading on concrete footings when one is
designed.  This value will affect the reinforced concrete design, the soil bearing pressure,
and the overturning ratio.  

Soil density:  Enter the density of soil above the top of the footing in units of pcf.  This
value is used to determine loading on concrete footings when one is designed.  This value
will affect the reinforced concrete design, the soil bearing pressure, and the overturning
ratio.  If no footing design is requested, this value has no influence on the remaining
calculations.

Added Overburden Load over Footing: category is only displayed if the "Specify a
Footing" option is selected on the Footing tab.  This category allows the user to specify
superimposed load on the top of the footing for all of the common load cases.  This value
will affect the reinforced concrete design, the soil bearing pressure, and the overturning
ratio.
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Vertical Point

Add:  The Add button opens the Add Point Load dialog.  The dialog allows vertical point
loads of all load cases to be defined and located with respect to the lower left corner of the
wall.  Note:  Positive magnitudes are assumed to act downward.

Edit:  By selecting an existing load in the list, the Edit button allows the selected load to be
revised.

Delete:  By selecting an existing load in the list, the Delete button allows the load opening
to be removed.

Vertical Uniform

Add:  The Add button opens the Add Uniform Load dialog.  The dialog allows vertical
uniform loads of all load cases to be defined and located with respect to the lower left
corner of the wall.  Note:  Uniform loads can be specified as partial-length loads by
specifying the start and end locations of the load with respect to the left edge of the wall. 
Positive magnitudes are assumed to act downward.

Edit:  By selecting an existing load in the list, the Edit button allows the selected load to be
revised.

Delete:  By selecting an existing load in the list, the Delete button allows the load opening
to be removed.

Lateral Point

Add:  The Add button opens the Add Point Load dialog.  The dialog allows lateral point
loads of all load cases to be defined and located with respect to the lower edge of the wall.
 Note:  Positive magnitudes are assumed to act to the right.

Edit:  By selecting an existing load in the list, the Edit button allows the selected load to be
revised.

Delete:  By selecting an existing load in the list, the Delete button allows the load opening
to be removed.
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Lateral Uniform

Add:  The Add button opens the Add Uniform Load dialog.  The dialog allows lateral
uniform loads of all load cases to be defined and located with respect to the lower edge of
the wall.  Note:  Uniform loads can be specified as partial-height loads by specifying the
start and end locations of the load with respect to the bottom edge of the wall.  Positive
magnitudes are assumed to act to the right.

Edit:  By selecting an existing load in the list, the Edit button allows the selected load to be
revised.

Delete:  By selecting an existing load in the list, the Delete button allows the load opening
to be removed.

The graphic display offers checkboxes to independently display or hide:
· Openings

· Shear Panel callouts

· Chord graphics and callouts

· Panel and opening dimensions

· All loads - otherwise only the loads associated with the selected tab are displayed

Footing

Specify a Footing:  If this checkbox is selected, then the input fields for defining a footing
are displayed.  Note:  This checkbox also causes some footing-related input to be shown
or hidden as appropriate on the Loads tab.

Allowable Soil Pressure:  Specify the allowable soil bearing pressure in units of ksf.

f'c:  Specify the compressive stress of concrete in units of ksi.

Fy:  Specify the yield stress of rebar in units of ksi.

Rebar Cover:  Specify the cover over rebar in units of inches.  The program will use this
value and a 1/2" allowance for the rebar size to calculate the effective depth of the
concrete section.

Note: Rebar is assumed to exist only at the bottom of the footing to resist tensile forces
from the vertical loads and increased pressure due to overturning forces. Tension in
the top of the footing in cases where no upward soil pressure exists and the footing
weight creates a downward net force IS IGNORED.

Minimum Steel Reinforcing Percentage Based on Thickness:  Specify the minimum
permissible ratio of rebar area to gross area of concrete.

Concrete Density:  Specify the density of concrete in units of pcf.
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Footing Width:  Specify the width of the footing in units of ft.  This is the dimension
perpendicular to the wall length.

Footing Thickness:  Enter the thickness of the footing in units of inches.

Projection @ Left:  Enter the projection of the footing beyond the left end of the wall in
units of ft.

Wall Length:  The program reports the shear wall length in units of ft for reference.

Projection @ Right:  Enter the projection of the footing beyond the right end of the wall in
units of ft.

Footing Length:  The program reports the footing length in units of ft for reference.

Reduce overturning effects for seismic combinations per ASCE 7-16 Section
12.13.4:  Applies the referenced reduction in overturning force for seismic load
combinations when selected.

Load Combinations 

The Load Combinations tab indicates the currently selected load combination set.  The
load combination set can be changed by clicking the Select button.  

The Load Combinations tab has up to four sub-tabs: 

· LRFD Load Combinations or ASD Load Combinations (depending upon the selected
Design Method), 

· Stability Combinations (only shown if a footing is designed)

· Soil Pressure Combinations (only shown if a footing is designed), and 

· Footing Design Combinations (only shown if a footing is designed).

LRFD Load Combinations or ASD Load Combinations

This tab offers strength-level or service level combinations from the selected load
combination set. These load combinations will be used for wood design.

A selected checkbox in the "Run" column indicates that the associated load combination
will be considered.  The "Run" button offers quick convenience options for changing the
selection status of many load combinations at one time.

The C
D
 column is only visible when the ASD Design Method is selected.  It indicates the

value of the Load Duration Factor for each load combination.  Click the C
D
 button to quickly

set the values of C
D
 for all load combinations based on the load case with the shortest

duration.
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The Lambda column is only visible when the LRFD Design Method is selected.  It indicates
the value of the Time Effect Factor for each load combination.  Click the Lambda button to
quickly set the values of Lambda for all load combinations based on Table N3.

Auto Reverse Wind:  Select this button to instruct the module to also consider the
algebraic negative of the defined Wind loads.  (This may be useful for quickly creating a
load combinations that reverse the direction of application of applied wind loads by creating
a "sister" load combination that uses the negative version of the wind component for each
load combo that normally incorporates +W.)

Auto Reverse Seismic:  Select this button to instruct the module to also consider the
algebraic negative of the defined Seismic loads.  (This may be useful for quickly creating a
load combinations that reverse the direction of application of applied seismic loads by
creating a "sister" load combination that uses the negative version of the seismic
component for each load combo that normally incorporates +E.)

Stability Combinations (only shown if a footing is designed)

This tab offers service level combinations from the selected load combination set. These
load combinations will be used for evaluating sliding and overturning of a footing.

Soil Pressure Combinations (only shown if a footing is designed)

This tab offers service level combinations from the selected load combination set. These
load combinations will be used for evaluating soil bearing pressure.

Footing Design Combinations (only shown if a footing is designed)

This tab offers strength-level combinations from the selected load combination set. These
load combinations will be used for concrete footing design.
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The right-hand portion of the screen offers the following options for reviewing results:

Shear Panel Design

Summary

On a panel-by-panel, level-by-level basis, the Summary tab presents the following
information:

Max Shear:  Reports the maximum shear force and the load combination associated with
that maximum shear force.

# of Sides:  Indicates the number of sides to which sheathing has been applied.  Will either
be 1 or 2.

Shear Summary & Attachment:  Reports the actual unit shear, the allowable unit shear, the
design status, and the required attachment pattern.

Height/Width Ratio:  Reports the actual height-to-width ratio, the allowable height-to-width
ratio for Side 1 (Main Sheathing), the allowable height-to-width ratio for Side 2 (2nd Side
Sheathing), and notes regarding the status of the height-to-width ratio and any necessary
adjustments.

Detail by Panel ID

On a panel-by-panel, load combination-by-load combination basis, the Detail by Panel ID
tab presents the following information:

Panel Data:  Reports the story in which the panel exists, the distance from the left edge of
the overall wall to the left edge of the panel, the width of the panel, the distance from the
bottom edge of the overall wall to the bottom edge of the panel, the height of the panel, and
the height-to-width ratio of the panel.

width, and the maximum unit shear.

Capacity Factors:  Reports phi for LRFD designs or the reciprocal of the Factor of Safety
for ASD designs, a capacity adjustment factor due to aspect ratio of the sheathing on the
Main Sheathing side of the wall, a capacity adjustment factor due to aspect ratio of the
sheathing on the 2nd Side of the wall, and a capacity adjustment factor due to the specific
gravity of the framing.

Adjusted Allowable Shear:  Reports the allowable unit shears for all relevant fastener
spacings incorporating any applicable capacity adjustment factors.  In situations where two
sides of sheathing are being considered, this table will correctly determine the capacity
considering both sides of sheathing by applying the rules of 4.3.3.3 and 4.3.3.3.2.

Panel Moment:  Reports the moment in the panel.
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Chord ID:  Reports the identifying labels for the chords at the left and at the right end of
each panel.

Detail by Load Combination

On a load combination-by-load combination, panel-by-panel basis, the Detail by Load
Combination tab presents the following information:

Shear Force = shear tributary to each panel

Chord Design

Chord Data

For each chord in the wall, the Chord Data tab presents the following information:

Location:  Reports the Level in which the chord occurs and the distance from the left edge
of the overall wall to the chord.

Chord Design:  Reports the chord force associated with the controlling design ratio, the
load combination responsible for producing the controlling design ratio, then number of
chord members required to resist the applied load, the size of the chord member indicated
by the user, the governing design ratio, the governing design consideration (tension or
compression), and the design status.

Chord Compression Stress:  Reports the maximum chord compression force, the load
combination responsible for producing the maximum chord compression force, the
maximum compressive stress, and the allowable compressive stress.

Chord Tension Stress:  Reports the maximum chord tension force, the load combination
responsible for producing the maximum chord tension force, the maximum tensile stress,
and the allowable tensile stress.

Chord Forces by Chord ID

For each chord in the wall, on a load combination-by-load combination basis the Chord
Forces by Chord ID tab presents the following information:

Story:  The story in which the chord occurs.

ID:  The identification label assigned to the chord.

Axial:  Reports the load in the chord due to the sum of applied vertical loads, the load in the
chord that can be added or subtracted due to the overturning moment in the panel, the
force with the largest (tendency for) tension, and the force with the largest (tendency for)
compression.
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Chord Location:  Reports the distance from the left edge of the overall shear wall to the
chord location, the distance from the bottom edge of the overall shear wall to the bottom of
the chord, and the distance from the bottom edge of the overall shear wall to the top of the
chord.

Footing & Stability

Footing Design Combination Pressures:  Reports the maximum factored soil pressures at
the left and right sides of the footing, along with the load combination responsible for
producing each of those pressures.  These are used in the reinforced concrete design
calculations for the footing.

Footing One-Way Shear Check:  Reports the results of the one-way shear calculation for
both ends of the footing.

For footings designed per ACI 318-14 and earlier, the nominal shear strength is f * 2 *

l * sqrt(f'c), where f = 0.75. 

For footings designed per ACI 318-19, the nominal shear strength is per the one-way
shear strength provisions of §22.5 and Table 22.5.5.1 (as referenced by §13.3.6.1 and
§7.5.3.1) and f = 0.75. One way shear capacity assumes no transverse footing
reinforcement. Therefore, A

v
 is less than A

v ,min
, and equations (a) and (b) from Table

22.5.5.1 need not be considered.

Footing Bending Design:  Reports the results of the flexural analysis and design including
recommended reinforcing options to satisfy the required area of steel.

Soil Pressure Combination Pressures:  Reports the maximum unfactored soil pressures
at the left and right sides of the footing, along with the load combination responsible for
producing each of those pressures.  Unfactored soil pressures are compared to the
allowable soil bearing pressure provided by the user.

Overturning Stability:  Reports the overturning analysis performed about each end of the
footing including the overturning moment, the resisting moment, the stability ratio, and the
governing load combination.

Sketch

The sketch tab provides a convenient graphical view of the shear wall with options to
selectively view or hide the following:
· Openings

· Shear Panel callouts

· Chord graphics and callouts

· Panel and opening dimensions

· All loads
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Aspect Ratio Adjustment Options

NDS Aspect Ratio Adjustment Options

NDS is clear that Wood Structural Panels must have an aspect ratio adjustment factor
applied when the aspect ratio (h/b) of the effective panel is greater than 2.  

Structural Fiberboard panels must have an aspect ratio adjustment factor applied when the
aspect ratio (h/b) of the effective panel is greater than 1.

NDS also provides an exception to the normal adjustment formulas that allows the
designer to distribute shear to multiple panels in a wall in proportion to the individual shear
capacities of the full height segments (as opposed to proportioning in terms of stiffness). 

As of 7/24/2023, the Wood Shear Wall module does not have the ability to consider
stiffness.  So in walls with openings, it may make sense to use the exception to avoid
having to do additional hand calculations.  In walls with no openings, it may be permissible
to use the standard aspect ratio adjustment (more liberal).

13.7 Earth Retention

As of Build 20, ENERCALC SEL includes all retaining wall modules that were in Build 11 of
RetainPro, along with the Retaining Wall Equation editor, making short work of your
retaining wall analysis and design tasks.
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13.7.1  All Retaining Walls

The following topics generally apply to all wall types except where noted specifically.

13.7.1.1   General Tab

The General tab collects basic wall geometry, soil values, and certain design assumptions.
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General Data

Retained Height:

This is the height of retained earth measured from top of footing to the top of soil behind the
stem (over the heel). When the backfill is sloped, the soil will slope away and upwards from
this height. 

The actual retained height used for overturning and soil pressure calculations will be the
retained height projected at the vertical plane of the back of the heel, but for stem moments,
no such increase will be made. 

Using the spin-buttons you can vary this in 0.25-foot increments (or you can type in any
number). After each entry you can press the tab key to advance to the next entry, or use your
mouse to position the cursor in the next input field.

Wall Height above Retained Soil:

Use this entry to specify if the wall extends above the retained height. This entry is typically
used to define a "screen wall" projection. This extension can be used as a weightless "Fence"
or a concrete or masonry stem section without any soil retained behind it. You can enter wind
load on this projection using the entry "Wind on Stem above soil" on the "Loads" tab. We'll
handle the fence when we get to the STEM design screen. TOTAL HEIGHT OF WALL =
“RETAINED HEIGHT” + WALL HEIGHT ABOVE RETAINED SOIL”.

Height of Soil over Toe:

Measured from top of footing to top of soil on toe side, this may vary from a few inches to a
few feet depending upon site conditions. (Note that it is input in inches.) It is used to calculate
passive soil resistance (but its effective depth can be modified by the "Ht. to Neglect" entry on
the Footing > Key Dimensions & Sliding tab). This depth of soil is also used to calculate a
resisting moment, and reduce net lateral sliding force. You can negate the latter effects on the
Options screen.

Top Lateral Restraint Height  (For the Restrained Retaining Wall module only):

Define the height from top of footing to the elevation of the lateral support.
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Soil Slope (Not in Restrained Retaining Wall module):

You may enter any backfill slope behind the wall. Use the drop-down menu or type the slope
as a ratio in the form of Horiz/Vert. The soil must be level or slope upward. Negative backfill
slopes (grade sloping downward, away from the wall) are not allowed.

The program will use this slope to 1) include the weight of a triangular wedge of soil over the
heel as vertical load, and 2) compute overturning based upon an assumed vertical plane at
the back face of the footing extending from the bottom of the footing to ground surface – a
steeper slope will result in a higher overturning moment. The program will not accept a backfill
slope steeper than the angle of internal friction.

When the EFP method is used, the program will NOT change the EFP based on soil slope. 
All it does with the slope is:
· calculate the retained height at the back of the heel, which might be greater because of the

sloped soil, and
· add a surcharge due to the weight of the triangular prism of soil on top.  

When the Coulomb method is used, the final calculated pressures do include the effect of the
slope on those Coulomb equations.

Water Table Height over Heel (Not in Restrained Retaining Wall module):

If a portion of the retained height is below a water table, the active pressure of the saturated
soil will increase below that level. This additional pressure for the saturated soil is equal to the
pressure of water, plus the submerged weight of the soil (its saturated weight - 62.4), plus the
surcharge of the soil above the water table. The program does not collect a saturated weight
of soil, so instead it conservatively approximates the buoyant or submerged weight of a soil
as 62% of its dry unit weight.

If you want to design for a water table condition, enter the maximum height from bottom of
footing to water table level. The program will then compute the added pressures for saturated
soil on the heel side of the footing, including buoyancy effect, to calculate increased moments
and shears on the stem, and overturning. Don’t enter a height more than the retained height,
and keep in mind that this feature automatically assumes that the liquid is water. If the water
table is near the top of the retained height, it may be advisable to use the saturated soil
density and active pressure for the full retained height instead of specifying a water table
height. 

Soil Values

Allowable Soil Bearing:

The maximum allowable soil bearing pressure for static conditions. Using the spin buttons
you can vary the value in increments. Usual values for this vary from 1,000 psf to 4,000 psf or
more.
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Lateral Pressure Method:

Here you can choose between E.F.P. or Coulomb formula. EFP refers to "Equivalent Fluid
Pressure," where you can enter a lateral soil pressure in psf per foot of depth. "Coulomb"
instructs the program to use the Coulomb method to calculate active and passive soil
pressures using an entered angle of internal friction for the soil. When Coulomb is chosen,
the Ka*Density value for active pressure is computed. 
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When the EFP Method is selected:

Active Soil Pressure - Heel Side:

Enter the equivalent fluid pressure (EFP) for the soil being retained that acts to overturn and
slide the wall toward the toe side. This pressure acts on the stem for stem section
calculations, and on the total footing+wall+slope height for overturning, sliding, and soil
pressure calculations.

Commonly used values, assuming an angle of internal friction of 34°, are 30 pcf for a level
backfill; 35 pcf for a 4:1 slope; 38 pcf for a 3:1 slope; 43 pcf for a 2:1 slope; and 55 pcf for a
1.5:1 slope. These values are usually provided by the geotechnical engineer.

When the EFP method is used the value entered is the horizontal component of the active
earth pressure, commonly called the lateral earth pressure. Because active pressure is
always due to an active soil wedge there are horizontal and vertical components. Using the
specified horizontal component and the soil density, the program iterates for a value of an
effective soil friction angle (“Phi”, the angle of internal friction) using the Coulomb equation. 
Once Phi is known, the program can calculate a vertical component of the active pressure
and provide options to have this vertical component applied at the plane of retained earth,
which is always considered to be at the rear of the heel.  The user can choose to apply this
force for overturning resistance, sliding resistance, and/or for soil pressure calculations, by
checking the boxes in the category named "Use of vertical component of active lateral soil
pressure". 

Passive Pressure:

This is the resistance of the soil in front of the wall and footing to being pushed against to
resist sliding. Its value is in psf per foot of depth (pcf). This value is usually obtained from the
geotechnical engineer. Its value usually varies from 100 pcf to about 350 pcf.

Soil Density (heel side):

Enter the soil density for all earth (or water if applicable) above the heel of the footing. This
weight is used to calculate overturning resistance forces and soil pressures using the weight
of the soil block over the projecting heel of the footing. When surcharges are applied over the
soil, the surcharges are transformed to equivalent uniform lateral loads acting on the wall by
the ratio force = (Surcharge/ Density)*Lateral Load. Input this value in lbs. per cubic foot.
Usual values are 110 pcf to 120 pcf. More if saturated soil. Water is usually assumed to be 64
pcf.

Soil Density (toe side):

Enter the soil density on the toe side, which may be different than the heel side. When
surcharges are applied over the soil on the toe side, the surcharge is transformed to
equivalent uniform lateral loads acting on the wall by the ratio force = (Surcharge/ Density)
*Lateral Load. Input this value in lbs. per cubic foot. Usual values are 110 pcf to 120 pcf. 
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When the Coulomb Method is selected:

Soil Friction Angle:

This value is entered in degrees and is the angle of internal friction of the soil. This value is
usually provided by a geotechnical engineer from soils tests, but can also be found in
reference books or building codes for various typical soil classifications. This value is used
along with Soil Density within the standard Coulomb equations to determine "Ka" and "Kp"
multipliers of density to give active and passive soil pressure values.

Active Pressure (or At-Rest Pressure for Restrained Walls):

This value will be computed using the Coulomb formulas. This represents the lateral earth
pressure acting to slide and overturn the wall toward the toe side.  The result will be
presented in units of psf/ft.  This pressure acts on the stem for stem section calculations, and
on the total footing+wall+slope height for overturning, sliding, and soil pressure calculations.

When the retained soil is sloped, a vertical component of the lateral earth pressure over the
heel can be applied vertically downward in the plane of the back of the footing. You can
choose to apply this force for overturning resistance, sliding resistance, and/or for soil
pressure calculations, by checking the boxes on the Options tab. 

Passive Soil Pressure:

This value will also be computed using the Coulomb formulas. This is the resistance of the
soil in front of the wall to being pushed against to resist sliding. Its value is in psf per foot of
depth (pcf).  Common values usually vary from 100 pcf to about 350 pcf.

Soil Density (heel side):

Enter the soil density for all earth (or water if applicable) above the heel of the footing. This
weight is used to calculate overturning resistance forces and soil pressures using the weight
of the soil block over the projecting heel of the footing. When surcharges are applied over the
soil, the surcharges are transformed to equivalent uniform lateral loads acting on the wall by
the ratio force = (Surcharge/ Density)*Lateral Load. Input this value in lbs. per cubic foot.
Usual values are 110 pcf to 120 pcf. More if saturated soil. Water is usually assumed to be 64
pcf.

Soil Density (toe side):

Enter the soil density on the toe side, which may be different than the heel side. When
surcharges are applied over the soil on the toe side, the surcharge is transformed to
equivalent uniform lateral loads acting on the wall by the ratio force = (Surcharge/ Density)
*Lateral Load. Input this value in lbs. per cubic foot. Usual values are 110 pcf to 120 pcf. 
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Soil Spring Reaction Modulus

Enter the spring constant to be used to determine the tilt of the wall.

Use of Vertical Component (Not in Restrained Retaining Wall module)

Use of vertical component of active lateral soil pressure

This category offers the following three options for considering the vertical component of
active lateral soil pressure:

· Use for Soil Pressure

· Use for Sliding Resistance

· Use for Overturning Resistance

When used, the vertical component of the lateral pressure is applied at a vertical plane at the
back of the footing as follows:

When EFP is used, the program will backsolve the Rankine equation to find the equivalent
internal friction angle, phi.  When the Coulomb method is used, the phi angle is specified by
the user.

In configurations where there is no heel projection beyond the soil face of the stem, the failure
plane is assumed to be at the soil-wall interface, so the program uses phi/2 for the soil-wall
friction angle.

In configurations where there is a heel projection beyond the soil face of the stem, the failure
plane is assumed to be at the end of the heel, which will be a vertical plane up through the
soil.  This will be a soil-on-soil interface, so the program uses phi as the friction angle to
determine the vertical component.
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13.7.1.2   Loads Tab

The Loads tab collects the data required to define the applicable vertical and lateral loads, and
the seismic design criteria, if applicable.

Loads

Surcharges

This surcharge is treated as additional soil weight – if the surcharge is 240 psf and the density
is 120 pcf, then the program uses two feet of additional soil. Similarly, if 50 psf is added for
the weight of a slab over the footing, this will be equivalent to 0.41 feet of soil (50 / 120). This
surcharge will affect sliding resistance and passive pressure at the toe. Consider this if
modeling a point load toe surcharge.

When a heel surcharge is defined, it is considered to be uniformly applied to the top surface
of the soil over the heel. It may be entered whether or not the ground surface is sloped. This
surcharge is always taken as a vertical force. This surcharge is divided by the soil density and
multiplied by the Active Pressure coefficient to create a uniform lateral load applied to the wall.
You can choose to use this surcharge to resist sliding and overturning by checking the option
box adjacent to the load input field. Typical live load surcharges are 100 psf for light traffic and
parking, and 250 psf for highway traffic.

Both the toe surcharge and the heel surcharge have associated checkboxes that can be used
to dictate whether the respective surcharges should be considered as resisting sliding and
overturning of the wall.
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Axial Load Applied to Top of Stem

These loads are considered uniformly distributed along the length of the wall. They are applied
to the top of the topmost stem section. The dead and live loads are used to calculate stem
design values and factored soil reaction pressures used for footing design. Only the dead
load is used to resist overturning and sliding of the retaining wall. AVOID A HIGH AXIAL LOAD
(say over 3 kips plf Total Load) SINCE IT COULD CAUSE A REVERSAL OF BENDING IN
THE HEEL.

Since slenderness ratios (h/t) for retaining walls are generally small, usually less than 10, and
axial stresses are low, slenderness effects are checked but usually have a small effect.

Consider a point load (such as a beam reaction) applied to the top of a wall. The intensity of
that point load will decrease at locations that are more distant from the point of application,
because the lateral distribution width will increase as one moves away from the point of
application.  For this reason, the intensity of the axial load felt at the base of the stem will be
significantly less than the intensity immediately beneath the beam bearing. To account for this
effect, the magnitude of the axial point load entered should be reduced proportionately (since
the input actually represents a uniformly distributed load along the length of the wall). But the
top of the wall may need to be checked for localized stress by appended calculations.

The input for axial load applied to the top of the stem allows the load magnitudes to be defined
as either Dead Load or Live Load.  The load will be factored accordingly.  This type of load
also allows the specification of an eccentricity value, where the eccentricity is defined with
respect to the centerline of the uppermost stem section. Positive values of eccentricity move
the load toward the toe, causing bending moments that are additive to those caused by the
lateral soil pressure over the heel. Negative eccentricities are  accepted in the Restrained
Retaining Wall module, where tension is already expected on the toe side.  But negative
eccentricities are not accepted in the Cantilevered Retaining Wall module.

Adjacent Footing Data

This entry gives you the option of placing a footing (line or square) adjacent and parallel to the
back face of the wall, and have its effect on the wall included in both the vertical and horizontal
forces on the wall and footing. Refer to the Reference Diagram for locations where input
measurements should be taken. 

Adjacent Footing Loads will be factored by the Live Load factor for strength design.

For "Line (Strip) Load" the entry is the total load per ft. parallel to the wall (not psf).

If the adjacent footing is specified as "Square Footing" (not line load), the load entered should
be the adjacent footing load divided by its dimension parallel to the wall, giving a pounds per
lineal foot value, as for a continuous (line) footing. 

A Boussinesq analysis is used to calculate the vertical and lateral pressures acting on the
stem and footing. The program uses equation (11-20a) in Bowles’ Foundation Analysis and

Design, 5th Edition, McGraw-Hill, page 630. 
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When the Boussinesq analysis is used, the program may require additional computing time
(hundreds of internal calculations are done after each entry), depending upon the speed of
your computer. To avoid this delay (which occurs any time any entry is changed) we suggest
you use a vertical load of zero until your data entry is nearly finalized. Then enter the actual
footing load and modify your final values. 

For adjacent truck or highway loading, it may be preferable to use a heel surcharge (uniform)
of 250 psf (or more) instead of treating it as an "adjacent footing."

It is generally not necessary to use this feature if the adjacent footing load is farther from the
stem than the retained height, less the depth of the adjacent footing below the retained height,
since at this distance it will not have significant effect on the wall.

Footing Width: Width of the adjacent footing measured perpendicular to the wall.
This is necessary to create a one-foot long by Width wide area over
which the load is applied.

Footing Eccentricity: This entry is provided in case the soil pressure under the adjacent
footing is not uniform. Enter the eccentricity of the resultant force
under the adjacent footing from the centerline of the adjacent footing.
Positive eccentricity is toward the toe, resulting in greater pressure
at the side of the adjacent footing closest to the stem. (An
eccentricity value of zero means that the adjacent footing load will
be considered to act at the center of the adjacent footing.) The
program will use the vertical load and eccentricity and create a
trapezoidal pressure distribution under the adjacent footing for use
with the Boussinesq analysis of vertical and lateral pressures. 

Wall to Footing Centerline Distance: This is the distance from the center of the
adjacent footing to the back face of the stem at
the retained height. The nearest edge of the
footing should be at least a foot away from the
wall face – otherwise suggest using an equivalent
heel surcharge instead. Do not use a horizontal
distance greater than the vertical distance from
the top of the footing to the bottom of the adjacent
footing, since the effect on the wall will be
insignificant.

Footing Type: This drop down menu selection allows you to enter either an isolated
footing using the "Square Footing" selection, or a continuous footing using
the "Line Load" selection.

Footing Base Above/Below Retained Height: Use this entry to locate the bottom of
the adjacent footing with respect to the
Retained Height. Entering a negative
number places the footing below the
elevation of the soil measured at the
back of the wall. A positive entry would
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typically only be used when the soil is
sloped and the footing resides "uphill"
from the retained height elevation. To
insert a negative number, first type the
number, then press the "-" (minus)
sign. 

Note: If the "Adjacent Footing" is another retaining wall at a higher elevation, the
Boussenesq analysis may be used for the vertical load applied to the soil from the
adjacent retaining wall footing, however the design must also consider the lateral
(sliding) loads from that adjacent wall. This load could be applied as "Added Lateral
Load", however this is at the discretion of the designer and is not within the scope of
the program. Caution is urged for this condition. See discussion in the companion
book: Basics of Retaining Wall Design. The designer should be advised that the
program does not incorporate  any form of global stability analysis.

Poisson’s Ratio: Since the resulting pressures are sensitive to Poisson’s Ratio, there is
an entry allowing you to specify a ratio from 0.30 to 0.55. This value
should be provided by the geotechnical engineer. A value of 0.50 is
often assumed.

Applied Lateral Load on Stem

This input allows you to specify an additional uniformly distributed lateral load applied to the
stem.  This is generally not the preferred method of applying seismic load.  Use the Seismic
sub-tab instead.

This entry can be useful for a point load, such as due to an impact of a car or similar force. 
When used in this way, it may be easiest to enter the load as a one-foot high increment, and
specify the "Height to Bottom" and "Height to Top" to define a one-foot high strip of application.

This load will be factored by whatever value is specified in the adjacent Load factor input. To
apply an additional factor (such as an impact factor), increase the applied load proportionately
(e.g. an impact load of 1000 lbs requiring an impact factor of 2.0 would be entered as 2,000
lbs). You may need to do several designs to check multiple load combinations.

Use engineering judgment when applying a point lateral load.  The magnitude may be able to
be reduced to account for the fact that the load distributes horizontally at levels below the
point of application, so its intensity reduces at elevations below the point of application. 

Height to Top: Defines the upper extent of the applied lateral load measured from the
top of the footing. Do not enter a dimension higher than the top of the
wall ("Retained Height" plus "Wall height above retained soil").

Height to Bottom: Defines the lower extent of the applied lateral load measured from the
top of the footing.
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Load Factor: Will be applied to the lateral load when performing strength design
checks.  It is not applied for service level load checks such as sliding,
overturning, or  soil bearing pressure checks.

Wind on Stem above Soil: Will be applied to that part of the stem projecting above the
retained height defined by the entry "Wall height above
retained soil." It is used to generate sliding force, overturning
moment, stem design moment and shear, and soil pressures.
  

Wind Type: Note that recent building codes have started to determine wind forces at
the strength level as opposed to at the traditional service level. 
Consequently the program allows the user to indicate whether the
specified wind pressure is at the Strength-Level or at the Service-Level.

When performing a design based on IBC 2012 / CBC 2013 or later:

· The wind should be entered as a Strength-Level load.

· When designing a masonry stem by strength design methodology or a concrete
stem, the wind load factor (which should be 1.0) will be applied to the specified
wind loads.  

· When designing a masonry stem by ASD methodology, the wind load factor is not
used, and the specified wind loads will be reduced to a service level by multiplying
the specified pressure by 0.6.

· Regardless of the stem construction, when determining service-level soil bearing
pressure and when performing sliding and overturning checks, the specified wind
loads will be reduced to a service level by multiplying the specified pressure by
0.6.

When performing a design based on codes earlier than IBC 2012 / CBC 2013:

· The wind should be entered as a Service-Level load.

· When designing a masonry stem by strength design methodology or a concrete
stem, the wind load factor (which should be 1.6) will be applied to the specified
wind loads.  

· When designing a masonry stem by ASD methodology, the wind load factor is not
used, and the specified wind loads will be used exactly as specified.

· Regardless of the stem construction, when determining service-level soil bearing
pressure and when performing sliding and overturning checks, the specified wind
loads will be used exactly as specified.
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Seismic Loads

You can choose to apply seismic force from lateral earth pressure and/or from wall self-
weight.

Seismic Lateral Earth Pressure

This category is used to specify whether seismic lateral earth pressure is to be considered or
not.  If it is to be considered, the program offers the option of two different methods:
· Mononobe-Okabe/Seed-Whitman procedure, or

· Simplified procedure per Geotechnical report
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Mononobe-Okabe/Seed-Whitman Procedure

By entering kh the program will calculate KAE and KA using the Mononobe-Okabe/Seed-

Whitman equations for a yielding wall (cantilevered). 

If it is a non-yielding wall (restrained) the added lateral force per square foot is computed
using Fw = kh(density)(retained height), in psf. Common kh values range from 0.05 to 0.30,

depending upon area seismicity. Some sources indicate that kh = SDS / 2.5, but jurisdictions

and interpretations vary.

Both the static soil pressure component and the added seismic component will be displayed.
The resultant seismic component is assumed to act at 0.6 x retained height.  The seismic
component is assumed to vary from an intensity of X at the bottom of footing to an intensity of
4X at the top of the retained height.

Mononobe-Okabe/Seed-Whitman Methodology

Two excellent references on the subject include Basics of Retaining Wall Design 11th Edition
by Hugh Brooks and Seismic Earth Pressures on Deep Building Basements by Lew, et al.

The program computes KAE (coefficient for combined active and earthquake forces) per the

Coulomb formula, modified by Mononobe-Okabe/Seed-Whitman, to account for earthquake
loading, where the term q is the angle whose tangent is the horizontal ground acceleration.

(Note that if Kh = 0, q = 0, then KAE = KA.) Vertical acceleration is neglected, resulting in a

more conservative KAE.

KAE =   active earth pressure coefficient, static+seismic

Where q = tan-1 Kh, a = wall slope to horizontal (90 degrees for a vertical face), f = angle of

internal friction, b = backfill slope, and d = wall friction angle.

For a vertical wall face and d assumed to be f/2, KAE becomes:

https://www.amazon.com/Basics-Retaining-Wall-Design-11th/dp/0976836475
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The values KAE and KA are displayed.

For the horizontal component, the forces are multiplied by cos δ (wall/soil interface angle).

Total force (active and seismic) = PAE =  0.5(g) KAE H2 where g = soil density and H =

retained height.

Since the total force PAE consists of two components, static (PA, as previously computed for

static forces) with triangular distribution and the earthquake (PAE - PA) with an inverted semi-

triangular distribution with an assumed point of application at 0.60 x height, the combined
(static and EQ) point of application is determined by 

                               

which is displayed as "Ht. to static + EQ point of appl."

Total base shear for both static force and added seismic force are displayed.

From Seismic Earth Pressures on Deep Building Basements by Lew, et al:

If the Mononobe-Okabe analysis is used to determine the lateral seismic earth pressure, the
lateral earth pressure should consist of the static active earth pressure and the seismic
increment of earth pressure as discussed in the previous section. Presumably, the load
factor of 1.6 in Eq. (8) would be applicable to the total earth pressure in this case. However,
as noted above, a reduced load factor would be appropriate when considering the transitory
nature of the seismic component and the low likelihood of the load maxima occurring
simultaneously. Accordingly a lower load factor of 1.0 is proposed to be applied to the seismic
increment component of earth pressure while the 1.6 load factor is applied to the static active
pressure component. To facilitate such loading combination the geotechnical engineers would
have to separate earth pressure components attributable to the active earth pressure
condition and the seismic increment of earth pressure when using the M-O method.



ENERCALC SEL1029

© 2024  ENERCALC, LLC

Simplified procedure per Geotechnical report

Use this method if a geotechnical report specifies added seismic load as a factor multiplied
by the retained height, such as X*H, where X is the multiplier and H is the retained height,
enter that multiplier here.  Using this method, the seismic lateral force will be applied uniformly
over the retained height.  Since this is a factored force it will be reduced by 0.7 for use in
sliding, overturning, and soil bearing calculations.

Seismic due to stem Self-Weight

If you indicate that you want the program to consider the seismic effect due to the self-weight
of the stem, then you will specify a value for the factor Fp/Wp, which will be used to calculate
a uniform seismic force in psf (kh x (wall weight). If the wall has multiple stem sections, each

will be calculated separately and accumulated for the base shear and moment.

NOTE:  The kh values entered are the design accelerations (not necessarily peak

ground acceleration as may be given in a geotechnical report) and must be
determined per procedures in the applicable code. The program then applies the
appropriate Load Factors (1.0 for concrete design and 0.7 for serviceability checks).

13.7.1.3   Stem Tab

The Stem tab collects the data required to define the stem geometry, reinforcing, and design
heights.

The layout and content of this tab will vary depending upon which type of wall is being
designed.  Refer to the subsequent topics in this section of the User's Manual for wall-specific
details on the various parameters that are collected on this tab.
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Stem Tab for Cantilevered Retaining Wall

When a Cantilevered Retaining Wall is defined, the Stem tab will appear as shown below:

Stem Design Parameters

Material: Use the drop-down list box to select Masonry, Concrete, Fence, or None.
Fence is only allowed on top of the wall, higher than the Retained Height,
and is considered weightless. Use None to disable the stem section.

Thickness: Use the spinners to set the thickness of Concrete wall segments.  Use the
drop-down list box to set the thickness of Masonry wall segments. For
segments defined as "Fence" the thickness input is unavailable.

Wall Weight: This displayed value is based upon wall data within the program.  A
multiplier input field is provided if it becomes necessary to adjust the data.
 See Appendix C for masonry wall weights.

Design Method: When a masonry stem section is chosen, this allows a choice of ASD or
LRFD (Allowable Stress Design or Load and Resistance Factor Design).
When the latter is selected the input notations change (e.g. fs  to fy) and

all calculations are based upon LRFD.

Rebar Size: Make your selection from the drop-down list box for bar sizes #3 to #10.
“Soft Metric” sizes will be displayed in parentheses.

Rebar Spacing: Use the spinners to set the rebar spacing in Concrete wall segments. 
Use the drop-down list box to set the rebar spacing in Masonry wall
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segments. For segments defined as "Fence" the rebar spacing input is
unavailable.

Rebar Position: Chose between Center or Edge. If Center is chosen, the rebar d distance
will be 1/2 the actual wall thickness. If Edge is chosen the rebar will be
located at the heel side of the stem as defined below.

For masonry wall segments, the program contains a table of the
appropriate "d" values to use for various block sizes and center/edge
locations, as shown in the table below.

Default Values of Rebar Position for Masonry Wall Segments

Thickness Rebar Depth (in)

Center Edge

6" 2.75" 2.75"

8" 3.75" 5.25"

10" 4.75" 7.25"

12" 5.75" 9.0"

14" 6.75" 11.0"

16" 7.75" 13.0"

For concrete wall segments, the "edge" rebar depth is always stem
thickness less 1.5" for #5 and smaller bars (stem thickness less 2" for #6
or larger), less one-half the bar diameter.

Specify Position: Click this box to enter an explicit "d" value for the particular stem
segment.

f'm: For Masonry stem segments, enter the compressive strength of
masonry in units of psi. This input is not applicable to Concrete stem
segments.

f'c: For Concrete stem segments, enter the compressive strength of
concrete in units of psi. This input is not applicable to Masonry stem
segments.

Fs: For ASD masonry design, select the allowable steel stress, based on

working stress design, which should be used for design of the
masonry stem segment. The drop-down list box allows quick
selection of common values. This input is not applicable to LRFD
masonry design or to concrete design. 
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Fy: For LRFD masonry design and for concrete design, select the rebar
yield stress to used for design of the indicated stem segment. The
drop-down list box allows quick selection of common values. This
input is not applicable to ASD masonry design.

CMU weight type: (Applies to Masonry stem segments only.) This input provides a drop-
down list box that offers the common CMU weights. 

Concrete Density: (Applies to Concrete stem segments only.) This input provides
spinners to define the unit weight of the concrete for a particular stem
segment. 

Solid Grouting: This applies to masonry only, and if this box is checked the weight of
the wall will be based upon industry standard values for the weights of
solid-grouted walls of lightweight, medium weight, or normal weight
block based on the selection for CMU weight type.

If this box is not checked, the program will calculate the weight based
upon grouting of only cells containing reinforcing. 

This also affects equivalent solid thickness for stem shear
calculations, and area for axial stress calculations (combined with
moment for masonry stems).

Em = f'm *: This input collects the value by which the compressive strength of
masonry is multiplied to arrive at the value of the modulus of elasticity
for masonry. IBC ’06 specifies Em = 900*f’m which is the default

value.

"n", Modular Ratio: This is calculated by the program as Es/Em. 

Equivalent Solid Thickness: For partially-grouted masonry stem segments (those
where solid grouting has not been specified) the equivalent
solid thickness is generated from an internal database as
shown below:

Grout Spacing

Thickness
(inches)

8" 16" 24" 32" 40" 48"

6 5.6 4.5 4.1 3.9 3.8 3.7

8 7.6 5.8 5.2 4.9 4.7 4.6

10 9.6 7.2 6.3 5.9 5.7 5.5

12 11.6 8.5 7.5 7.0 6.7 6.5
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14 13.6 9.9 8.7 8.1 7.6 7.4

16 15.6 11.6 10.1 9.5 8.6 8.3

Stem Design Height Above Footing: 

IMPORTANT!  The term “Stem Design Height” refers to a height above the top of the footing
(i.e. above the base of the stem). It is the height above the bottom of the stem where you want
the program to compute moments and shears. 

You can divide the stem into a maximum of five segments (increments of height). Each
increment can represent a change in material (concrete, masonry, or fence), thickness,
reinforcing size or spacing.

For most walls, only two or three changes in stem sections are used. For example, it would
be logical to place a Stem Design Height at the top of the dowels projecting into the stem from
the footing and perhaps at another location farther up the wall where a more economical
section is desired.

Bottom: You must start your stem design here, at the base (height above footing = 0.00),
where the stem moment and shear is maximum. You can manipulate the bar sizes, spacing,
and position, as well as the wall material and thickness until the Summary box indicates an
acceptable stress ratio (the higher and closer to 1.0, the more efficient). 

To check the wall at a higher Design Height, such as where reinforcing or thickness can be
reduced, click the Insert Stem button and enter the next higher design height. Advance the
spin button to the desired height above the top of the footing or enter it by typing. This will
create a new 2nd section that you can now design.

Continue this way, clicking Insert Stem after each stem section design is completed, up to a
maximum of five heights. A new Design Height should only be entered when you want to
change the material, thickness, or reinforcing, and should never be less than about two-foot
intervals.

Summary

The summary box indicates the design shears and moments in the selected stem segment,
and the interaction ratio for that segment. 

For stem segments of Masonry that are designed according to ASD, the Summary indicates
actual and allowable moments, total applied shear force, applied shear stress and allowable
shear stress, and rebar lap splice lengths.

For stem segments of Concrete or of Masonry that are designed according to LRFD, the
Summary indicates factored applied moment and the nominal moment capacity, the total
applied shear force, the factored applied shear stress and the nominal shear stress, and
rebar lap splice lengths. 
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See additional detail in the section named "Summary Section of Stem Tab".

Design Options

The last section offers the following design options:

· Reduce lap splice by stress ratio (This option is provided for informational purposes only. 
Use engineering judgment with the application of this option, as it is contrary to current
building codes and design standards.)

· Reduce hook embedment by % rebar stress

· Compute lap lengths per IBC modifications to ACI 530.  As of build 20.22.10.9, this is
automatically selected, because IBC is clear that this is mandatory. 

Summary Section of Stem Tab

The summary section indicates the results of the Stem design at-a-glance.

Interaction Ratio: The interaction ratio indicates the efficiency of your design, not to
exceed 1.0.

For masonry using ASD this is the computed ratio of fa/Fa + fb/Fb. 

For concrete and masonry using LRFD it is Mactual/Mallowable.

The weight of the stem will be included only if there is added axial
load. For masonry stems, Fa is calculated by considering the wall as

unsupported with "K" = 2.0. Since even a very small axial load will
activate the unsupported height/slenderness calculation for masonry
stems, we suggest you do not enter an axial load unless it is
significant (e.g. greater than, say, 3000 plf.).

Actual Moment: This is the maximum moment due to the lateral pressures and applied
loads above the "Design Height" location entered. Note that when
concrete is used, all soil pressures and loads are factored per default
Load Factors for evaluation of moments and shears. 

Allowable Moment: This is the allowable moment capacity. It is Allowable Stress Design
(ASD) for masonry, or based upon Strength Design for concrete and
when LRFD is specified for masonry. For concrete strength design,
the maximum reinforcing steel percentage is controlled by equilibrium
at the prescribed strain limits. 

Total Force: This is the total lateral force from loads applied above the "Check
Design at Height" location entered. This force is factored for concrete
and masonry using the LRFD method. Forces applied to compute
overturning, sliding, and soil pressure are not factored. 
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Actual Shear: For masonry, the effective thickness is used to calculate the actual
shear.  The effective thickness is the actual "d" distance for the
moment applied, considering partial or full grouting (equivalent solid
thickness is not used).  In other words, the unit shear is determined by
dividing the total lateral force of the stem cross section by the product
of "d" * 12" unit width strip.  Shears are calculated at the "Design
height" location entered, not at distance "d" above design height.
Concrete stems use an area of "d" x 12" for the shear area, and
masonry stems use "d" x 12".

Allowable Shear: For masonry designed by ASD, the allowable shear stress varies
between 3*sqrt(f'm) and 2*sqrt(f'm) as a function of M/(Vd).  No
contribution of shear strength is assumed from reinforcing steel in a
retaining wall.  

For masonry designed by LRFD, the nominal shear strength varies
between 6*Anv*sqrt(f'm) and 4*Anv*sqrt(f'm) as a function of M/(Vd). 
Again, no contribution of shear strength is assumed from reinforcing
steel in a retaining wall.

For concrete designed per ACI 318-14 and earlier, the nominal shear
strength is 2*l*sqrt(f'c).

For concrete designed per ACI 318-19, the nominal shear strength is
per the one-way shear strength provisions of §22.5 and Table 22.5.5.1
(as referenced by §13.3.6.1 and §7.5.3.1). Concrete stems are
assumed to be unreinforced for out-of-plane shear. Therefore, A

v
 is

less than A
v ,min

, and equations (a) and (b) from Table 22.5.5.1 need

not be considered.

Rebar Lap & Embedment Lengths: 

Regardless of the stem material, there are two fundamental lengths to calculate:  lap splice
length and development length.  These values are summarized in the "Rebar Lap &
Embedment Lengths" table, which can be accessed from the button on the Stem tab.  As of
build 20.22.10.9, this table is only available in the Cantilevered Retaining Wall module.
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The following presents the formulas used and the limits applied to generate the values in that
table:

Straight Development Length of Rebar in Concrete:  (Applies to all referenced codes)

ld calc = (3/40) * (fy / sqrt(f'c)) * (psis / 2.5) * (bar size / 8)  

psis = 0.8 for bar sizes #6 and smaller, 1.0 for bar sizes #7 and larger

ld report = ld calc but not less than 12 inches

(This is Eq. (25.4.2.3a) from ACI 318-14 and Eq. (25.4.2.4a) from ACI 318-19 with appropriate
assumptions for bar location, clear cover, spacing, transverse reinforcing, and epoxy
coating.)

Lap Splice Length of Rebar in Concrete:  (Applies to all referenced codes)

ls = 1.3 * ld calc but not less than 12 inches
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Hooked Embedment of Rebar in Concrete:  (Applies to all referenced codes)

ldh calc = 0.02 * (fy / sqrt(f'c)) * (bar size / 8) * 0.7 

ldh report = ldh calc but not less than the larger of 8 bar diameters or 6 inches

Note:  IBC 2021 references ACI 318-19.  ACI 318-19 Section 25.4.10 prohibits the use of the
(As required / As provided) term:

In codes prior to IBC 2021, the following formula was used:

ldh calc = 0.02 * (fy / sqrt(f'c)) * (bar size / 8) * 0.7 * (As required / As provided)
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Where (As required / As provided) = the ratio of required to provided area of rebar (this is a

user option checkbox)

Development Length of Rebar in Masonry designed by ASD:  (Applies to all referenced
codes)

ld calc = (0.002) * (bar size / 8) * fs 

fs = actual stress in rebar

ld report = ld calc but not less than 12 inches

(This is the IBC equation.)

Lap Splice Length of Rebar in Masonry designed by ASD:  (Applies to all referenced
codes)

ls = Factor * ld calc but not less than 12 inches or 40 bar diameters

Factor = 1.5 in regions where design tensile stresses in reinforcement are greater than 0.8 *
fs, otherwise 1.0.  

(As of build 20.22.10.9, the program conservatively assumes a value of 1.5 for the "Factor"
referenced above.)

Development Length of Rebar in Masonry designed by LRFD:  (Applies to all referenced
codes)

ld calc = (0.13) * (bar size / 8) 2̂ * fy * gamma / (K * sqrt(f'm))

gamma = 1.0 for #3 through #5 bars, 1.3 for #6 through #7 bars, and 1.5 for #8 through #9
bars

K = 1.5 for #3 through #5 bars, 2.0 for #6 through #9 bars

ld report = ld calc but not less than 12 inches

 
(This is the ACI equation by direct reference from IBC.  The value of K has conservatively
been set to the required clear cover for the selected bar exposed to earth.)
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Lap Splice Length of Rebar in Masonry designed by LRFD:  (Applies to all referenced
codes)
 
ls = 1.0 * ld calc but not less than 12 inches and need not be GREATER than 72 bar

diameters

General Notes on Rebar Lap & Embedment Lengths:

For concrete stems, a Class B lap splice is assumed, therefore the lap length is the bar
development length x 1.3. Concrete is assumed to be normal weight, and bars are assumed
to be plain (not epoxy coated).

Concrete development lengths are computed per ACI 318.

For the bottom Design Height only (Ht. = 0.00), this displays the required hooked bar
embedment into the footing. It assumes a bar with a 90° bend and at least a 12-diameter
extension.  

The minimum footing thickness required is based upon this embedment depth plus the
clearance you have specified below the bar (usually 3 inches). If this totals more than the
footing thickness you have chosen, a warning message will be displayed.

Note that if the bar extends straight down into a key, it must be embedded by a depth equal to
the development length.

The program does not reduce embedment length by stress level unless the user selects the
checkbox labeled Reduce Hook Embedment by Percent Rebar Stress.

The program never reduces lap splice lengths by the stress ratio.  It is not permitted by the
referenced codes.
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Stem Tab for Tapered Stem Retaining Wall

Tapered Stem Retaining Walls are cantilevered retaining walls where the soil face is battered
to achieve a variable thickness from the base of the stem to the top of the stem.

When a Tapered Stem Retaining Wall is defined, the Stem tab will appear as shown below:

Note: Taper can only apply to the inside face (the face against the soil).

Material: The Material will automatically be defined as Concrete, since masonry
cannot be tapered.

Thickness: Top and Base: Enter the stem thickness at the top and at the bottom.

f’c and Fy: Enter concrete strength and rebar yield stress.

Rebar Cover: Select the rebar clear cover to consider in the design.

Stem Design: Stem design will automatically be performed at the bottom of the stem
(interface with the footing).  In addition, you can specify two additional
heights above the base to check moments and shears. These are
identified as "@ Height #2" and "@ Height #1", where the latter is the
lower height.

Ht. Above Footing: Specify two heights above the top of footing elevation where a stem
design should be performed (such as where it would be desirable to
change the rebar pattern or size for economy). Height #2 is highest
and Height at Stem Base will be fixed at 0.00. The #1 height should be
located at a distance above the top of the footing that is at least equal
to the lap splice length for the dowels.
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Rebar Depth "d": This will be computed based upon the heights you have chosen, the
specified wall taper, and the specified Rebar Cover. The program
automatically uses the specified clear cover and one-half of a bar
diameter when determining "d".

Rebar Size: Use the drop-down list box to select the desired rebar size.

Rebar Spacing: Use the spinners to set the desired rebar spacing.  (The maximum
permissible spacing is 18 inches, which is in accordance with ACI.)

Max. Permissible Spacing: This is the maximum permissible spacing for the rebar size
selected.  This is based on the strength calculation, but it will
stop at an upper limit of 18 inches in accordance with ACI.

Mu: These are factored moments at the heights you have selected. These will be based

on the load factors that you specify on the Load Factors tab. Compare these values
with Design Moment as described below, to verify adequacy of your design at the
selected height location.

fMn: This is the design moment strength, which will be based upon the bar sizes and

spacings you established, along with wall geometry, concrete strength, etc.

Status: This indicates whether each stem design is OK at the specified height.  If there is a

problem, this will display a descriptive message such as "Mu > Phi *  Mn" or "As <

min" or "As > max" or "Ftg. Rebar Embed!".

Rebar Lap Req'd: This is the lap splice length required based on the bar size used at the
specified Design Height. It is the development length of the bar multiplied
by 1.3 (assuming a Class B splice) and without adjustment for stress
level.

Rebar Hook Development Length into Footing: 

This is the hooked development length that is required for the bar size specified at the stem
base.  It is based on the assumption that the bar is hooked into the footing with a 90° bend
and minimum 12 db bar extension.  The calculated values is also based on the assumption

that the side cover (normal to the plane of the hook) is not less than 2.5 inches and that the
cover on the extension beyond the hook is not less than 2 inches.  These latter assumptions
facilitate the application of a factor of 0.7 to the calculated value of ldh. 

Shear at Section: This is the total factored shear at the indicated height.

Vu: Factored shear stress at designated height computed by Shear at

Section / (12 *  "d").



Calculation Modules 1042

© 2024  ENERCALC, LLC

fVn: For concrete designed per ACI 318-14 and earlier, the nominal shear

strength is 2*l*sqrt(f'c).

For concrete designed per ACI 318-19, the nominal shear strength is
per the one-way shear strength provisions of §22.5 and Table 22.5.5.1
(as referenced by §13.3.6.1 and §7.5.3.1). Concrete stems are
assumed to be unreinforced for out-of-plane shear. Therefore, A

v
 is less

than A
v ,min

, and equations (a) and (b) from Table 22.5.5.1 need not be

considered.

Option to reduce hooked bar embedment depth: When the checkbox is checked the
program will reduce the hooked
embedment depth by the
considering the ratio of (As
required)/(As provided).

Concrete Density: Use the spinners to set the unit weight of the concrete.

Stem Tab for Gravity Retaining Wall

When a Gravity Retaining Wall is defined, the Stem tab will appear as shown below:

Gravity walls may have one or both sides tapered and are assumed to be proportioned such
that no reinforcing is required since every section is primarily in compression. Any solid
homogeneous material may be used. Reinforcing can be added if there is any tension in the
cross section, but the program does not compute this requirement.
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Material: Use this drop-down list box to specify the material being
considered.

Wall Weight: Enter the weight of the wall material in pcf. Generally this will be
the weight of concrete or rubble (approximately 145 pcf).

Front Batter Distance: Enter the offset of the front face at top of the wall from the front
face at the base.  Value should be greater than or equal to zero.

Thickness at Top: Enter the thickness of the top of the wall.

Back Batter Distance: Enter the offset of the back face at the top of the wall from the
back face at the base.  Value should be greater than or equal to
zero.

F’c Max. Compression: Enter your criteria for the maximum permissible compressive
stress on the wall. Usually varies from 100 psi to over 700 psi. 

Ft  Max. Tension: Enter your criteria for the maximum permissible tensile stress on
the wall. Usually varies from about 15 psi to 40 psi. Generally
gravity walls are designed such that there is no tension – the full
cross section is in compression.

Stem Design

Stem design will automatically be performed at the bottom of the stem (interface with the
footing).  In addition, you can specify two additional heights above the base to check stresses.
These are identified as "@ Height #2" and "@ Height #1", where the latter is the lower height.

Height Above Footing: Specify two heights above the top of footing elevation where
stem stresses should be checked. Height #2 is highest and
@Stem Base will be fixed at 0.00. 

Wall Thickness @ Height: Displays the calculated values of wall thickness at the heights
you have specified for analysis. 

Section Modulus: Displays the computed section modulus at the heights
selected for analysis.

Moment @ Height: Displays the moment at the designated design heights.

Vertical Load @ Height: Displays the summation of vertical loads above designated
height.

Maximum Tension / Compression Stress: Displays extreme tension and compression
stresses based on interaction formulas.
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Status: Indicates "OK" if not tension exists.  If tension exists but it does not
exceed the user-specified threshold then the status indicates "Tension
Exists".  If tension exists to a degree that exceeds the user-specified
threshold then the status indicates "Tension Exceeded". If
compression exists to a degree that exceeds the user-specified
threshold then the status indicates "Compression Exceeded".

Shear @ Section: Displays total shear force at the designated height.

Actual Unit Shear: Displays the calculated shear stress at the designated height.
Compare this with the allowable shear for the material you have
selected.

Stem Tab for Restrained Retaining Wall

When a Restrained Retaining Wall is defined, the Stem tab will appear as shown below:

Note: The lateral support should be near the top of the wall, although some extension of the
wall above the support is permitted by the program. You have the option of fixing the base (as
for a cantilevered wall) or assuming it pinned. Intermediate degrees of fixity are not permitted.
The program will compute moments, shears, and stresses at three locations: base (negative
moment if fixed; zero moment if pinned), maximum positive moment between base and
lateral support, and at the point of lateral support. 

Material: Select Masonry or Concrete. Only one material can be used,
and must be of constant thickness.
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Stem Base Fixed to Footing: Clicking this box will model the stem as being fully fixed
at the base (connection to the footing). If unchecked, the
stem will be considered pinned to the footing (no
moment fixity).

Stem Thickness: The program only permits a constant thickness throughout the
height of the wall.  Enter the stem thickness of a concrete
stem, or select the thickness of a masonry stem from the
drop-down list box offering common CMU sizes.

Design Method: (Only applies to Masonry stems) Select the design method to
be used, either ASD or LRFD.

Block Weight Multiplier: (Only applies to Masonry stems) Provides a multiplier input
field in case it becomes necessary to adjust the data. See
Appendix C for masonry wall weights.

Solid Grouted Block: (Only applies to Masonry stems) If this box is checked the
weight of the wall will be based upon industry standard values
for the weights of solid-grouted walls of lightweight, medium
weight, or normal weight block based on the selection for CMU
weight type.  If this box is not checked, the program will look up
the weight based upon grouting of only cells containing
reinforcing. This also affects equivalent solid thickness for
stem shear calculations, and area for axial stress calculations
(combined with moment for masonry stems).

f'm: For Masonry stem segments, enter the compressive strength of
masonry in units of psi. This input is not applicable to Concrete stem
segments.

f'c: For Concrete stem segments, enter the compressive strength of
concrete in units of psi. This input is not applicable to Masonry stem
segments.

Fs: For ASD masonry design, select the allowable steel stress, based on

working stress design, which should be used for design of the masonry
stem segment. The drop-down list box allows quick selection of
common values. This input is not applicable to LRFD masonry design
or to concrete design. 

Fy: For LRFD masonry design and for concrete design, select the rebar
yield stress to used for design of the indicated stem segment. The
drop-down list box allows quick selection of common values. This input
is not applicable to ASD masonry design.
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Em = f'm *: This input collects the value by which the compressive strength of
masonry is multiplied to arrive at the value of the modulus of elasticity
for masonry. IBC specifies Em = 900*f’m which is the default value.

CMU Type: (Applies to Masonry stem segments only.) This input provides a drop-
down list box that offers the common CMU weights. 

Concrete Density: (Applies to Concrete stems only.) This input provides spinners to define
the unit weight of the concrete for the stem.

Rebar Cover: This appears if a concrete stem is chosen and lets you enter desired
cover on toe and earth side. The cover is used to calculate the "d"
dimension when the rebar is specified to be in the "Edge" position of
Concrete stems in the Stem Design category, which is explained in
more detail below.  When the rebar is specified to be in the "Edge"
position of Masonry stems, the program uses tabular data on the
geometry of various CMU sizes to calculate the "d" dimension.  (Refer
to the "Stem Tab for Cantilevered Retaining Wall" topic for detailed
information regarding the calculated "d" dimension for Masonry stems.)

 

Stem Design

This allows you to design or check wall moment and shear at three locations: @ Top Support,
@ Mmax Between Ends, and @ Stem Base. If base is pinned, the entries under @ Stem

Base will be zero or dimmed.

Ht. Above Footing: This displays, from left to right, the distance from the top of footing up
to the lateral support, the distance from the top of footing up to the
point of maximum positive moment, and it displays 0.00 ft to represent
the design that is performed at the base of the stem.

Rebar Depth "d": From the thickness and center/edge condition, the program
determines the "d" dimension to be used for design (using internal
tables and default modifications). See Rebar Position above. For
concrete stems with bars in the "Edge" position, the program
automatically uses the specified clear cover and one-half of a bar
diameter when determining "d".

Rebar Size: Select from the drop-down list box.

Rebar Location: Choose Center or Edge placement.

Rebar Spacing: For Concrete stems, use the spinners to increment the rebar spacing.
For Masonry stems, use the drop-down list box to select a modular
spacing.

Rebar Placement: Serves as a convenient reminder to indicate which side of the wall the
specified rebar is considered to be placed on.
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Mu: (Only for Concrete Stems and for Masonry Stems designed according
to LRFD) Displays factored moments at the indicated locations with
(+) and (-) as applicable. For concrete stems and for masonry stems
designed according to LRFD, the moments will be factored by the
load factors specified on the Load Factors tab.

Actual Moment: (Only for Masonry Stems designed according to ASD) Displays actual
moments at the indicated locations with (+) and (-) as applicable.

fMn: (Only for Concrete Stems and for Masonry Stems designed according
to LRFD) This is the design moment strength, which will be based
upon the bar sizes and spacings you established, along with wall
geometry, concrete strength, etc.

Allowable Moment: (Only for Masonry Stems designed according to ASD) This is the
allowable moment capacity based upon the bar sizes and spacings
you established, along with wall geometry, concrete strength, etc.

Status: This indicates whether the stem design is OK at the specified height. 
If there is a problem, this will display a descriptive message such as
"Mu > Phi * Mn" or "As < min" or "As > max" or "Ftg. Rebar Embed!".

Rebar Lap Req'd: For masonry, the lap required is 48 bar diameters for Fs = 32,000 psi

and 40 diameters for Fs = 20,000 psi. For concrete, a Class B splice

is assumed, which multiplies the development length by 1.3 (See ACI
12.15.2), and excludes reduction for stress level.  Note: The program
does not compute or display bar cut-off points, which must be done
manually, or extend positive reinforcing so it is acceptable.

Rebar Hook Development Length into Footing: 

This is the hooked development length that is required for the bar size specified at the stem
base. It is based on the assumption that the bar is hooked into the footing with a 90° bend and
minimum 12 db bar extension.  The calculated values is also based on the assumption that

the side cover (normal to the plane of the hook) is not less than 2.5 inches and that the cover
on the extension beyond the hook is not less than 2 inches.  These latter assumptions

facilitate the application of a factor of 0.7 to the calculated value of ldh. 

Shear at Section: This is the total shear force at the indicated height (factored for
concrete or masonry designed according to LRFD).

Factored Shear Stress: (or Applied Shear Stress for Masonry Stems designed according
to ASD) Shear stress at designated height computed by Shear at
Section / (12 *  "d") (factored for concrete or masonry designed
according to LRFD).
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Design Shear Strength: (or Allowable Shear Stress for Masonry Stems designed
according to ASD) For masonry designed by ASD according to
TMS 402/ACI 530, the allowable shear stress varies between
3*sqrt(f'm) and 2*sqrt(f'm) as a function of M/(Vd).  No
contribution of shear strength is assumed from reinforcing steel
in a retaining wall.  

For masonry designed by LRFD according to TMS 402/ACI 530,
the nominal shear strength varies between 6*Anv*sqrt(f'm) and
4*Anv*sqrt(f'm) as a function of M/(Vd).  Again, no contribution of
shear strength is assumed from reinforcing steel in a retaining
wall.

For concrete designed per ACI 318-14 and earlier, the nominal
shear strength is 2*l*sqrt(f'c).

For concrete designed per ACI 318-19, the nominal shear
strength is per the one-way shear strength provisions of §22.5
and Table 22.5.5.1 (as referenced by §13.3.6.1 and §7.5.3.1).
Concrete stems are assumed to be unreinforced for out-of-plane
shear. Therefore, A

v
 is less than A

v ,min
, and equations (a) and (b)

from Table 22.5.5.1 need not be considered.
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13.7.1.4   Footing Tab

The Footing tab collects the data required to define the footing geometry and reinforcing, and
the key geometry and reinforcing if one is present. This is also where certain design decisions
can be made regarding how the program handles the sliding calculations.

Footing Design Sub-tab

Footing Size & Materials

Toe Width: This is the width of the Toe of the footing, and is measured from the
front edge of the footing to the front face of the stem. Can be set to
0.00 for a property line condition. All overturning and resisting
moments are taken about the bottom-front edge of the toe.

Heel Width: Distance from front face of stem to back of heel projection. If a
dimension is entered that is less than the stem width at the base, the
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program will automatically reset the heel dimension to at least the
stem width. For a property line at the rear face of the stem, set this
dimension to be equal to the stem width.

Total Footing Width: The calculated width of the footing, Toe Width + Heel Width.

Thickness: Total footing thickness, NOT including the key depth (if used). For
bending and shear design of the footing, the rebar depth "d" is taken
as Footing Depth - Rebar Cover - 0.5 * Bar Diameter. If footing
thickness is inadequate for shear capacity a red warning indicator will
appear.

The footing thickness must be greater than the hooked rebar
embedment length required for the bottom stem reinforcing + rebar
cover. The program adds the calculated hooked bar embedment from
the Stem screen and adds it to the rebar cover you have chosen for
the bottom of the footing (usually 3"). If the specified thickness is
inadequate, increase the thickness, or change the stem dowels.

Center Stem on Footing: Clicking this bar will adjust the toe and heel widths you have
entered so the stem is centered on the footing but the overall
footing width remains the same.

Automatic Width Design: Clicking this button will cause the program to iterate footing
widths until the soil pressure and footing strength are
acceptable. (Note:  This function does not optimize for
overturning stability or sliding stability, so those will need
to be checked after using this option.)  You can select either
a fixed toe or heel distance, or balance the toe and heel
dimensions. You can also select whether the resultant must be
within the middle third of the footing. After clicking “Design,” the
widths required will be displayed. Automatic footing design is
not available for Restrained Walls, Gravity Walls, or Segmental
Walls.

f'c: Enter concrete compressive stress for footing.

Fy: Allowable rebar yield stress to be used for design of footing

bending reinforcement.

Rebar Cover in Heel/Toe: Distance from the face of concrete to edge of rebar. The
program will add 0.5 * Bar Diameter to this value and subtract
the result from the footing thickness to determine the bending
"d" distance.
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Minimum As Ratio for Toe, Heel & Key:

Enter the absolute minimum permissible ratio of working steel in the footing. If the % steel
required by stress analysis is less than 200/Fy, the minimum of (200/Fy -or- 1.333 * bending

percentage required) is calculated and compared with the Minimum As% entered here, and

the greater of the two is used to calculate rebar spacing requirements.

Minimum As Ratio for Temperature & Shrinkage Bars: 

Enter the minimum steel percentage to address temperature and shrinkage requirements in
the footing (commonly 0.0018 Ag for Fy= 60,000 psi). This value will be multiplied by the

gross cross-sectional area of the footing to produce recommendations for longitudinal
reinforcing in the footing (perpendicular to a section view of the footing).

Neglect Upward Pressure at Heel: 

For heel calculations you may choose to neglect the upward soil pressure, typically resulting
in greater heel moment. If this box is checked the Mu for upward loads will be zero.

Footing Rebar Requirements

Rebar at Stem Base: This is a reminder of the size and spacing of the reinforcing
used at the bottom of the stem, to make it easier to select toe
reinforcing to match (toe reinforcing is usually the bottom
stem dowel bars bent toward the toe).
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Toe Reinforcing Options: This list provides options for reinforcing sizes and spacing for
the toe bars (located in the bottom of the footing). Typically the
toe bars are extensions of the stem dowels, which are bent
out toward the toe. Therefore, you will probably just want to
verify that the stem dowel bar size and spacing would also be
adequate for use in the toe.

Toe shear stress is calculated using the sum of upward and
downward forces acting on the toe.  The summation only
considers those forces that are farther than the d dimension
from the face of the stem.

NOTE: If structural plain concrete is appropriate in the
designer's judgment, the rebar size can be set to "None". 
This will trigger the program to calculate the moment capacity
for structural plain concrete using the footing modulus of

rupture Fr
  = Φ5l(f’c)1/2 times the section modulus, with 2”

deducted from the thickness for crack allowance per code. 
The design status will report on the adequacy of the design. 
However, the designer may consider it prudent to add
reinforcing regardless of the theoretical flexural capacity.  Be
sure to check code limitations on the use of structural
plain concrete.

Heel Reinforcing Options: This list provides options for acceptable sizes and spacing for
heel bars (located in the top of the footing). It is desirable to
select a spacing that is modular with the stem dowel bars for
ease of construction. Note: The program does not calculate
the heel bar development length inward from the back face of
the stem (where the moment is maximum). You can refer to
Appendix B for development lengths in concrete, which can be
adjusted for the stress level in the heel bars. When detailing
footing reinforcing it is important to consider and specify
development lengths for both toe and heel bars.

NOTE: If structural plain concrete is appropriate in the
designer's judgment, the rebar size can be set to "None". 
This will trigger the program to calculate the moment capacity
for structural plain concrete using the footing modulus of

rupture Fr
  = Φ5l(f’c)1/2 times the section modulus, with 2”

deducted from the thickness for crack allowance per code. 
The design status will report on the adequacy of the design. 
However, the designer may consider it prudent to add
reinforcing regardless of the theoretical flexural capacity.  Be
sure to check code limitations on the use of structural
plain concrete. 
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Rebar Selections: Use these three size and spacing entries to select your toe,
heel, and if applicable, key reinforcing. The "Max @" message
tells you the maximum spacing allowed for the bar selected.

Key Design & Sliding Options

This screen is used to indicate whether a key is to be used, and if so, specify its dimensions.
 This screen also collects information about the design intent for the sliding check, and
presents a summary of the sliding forces.

Slab is present to resist all sliding forces: Provides a way to communicate to the program
that sliding is not a design consideration,
because in the designer's judgment, sliding is
completely precluded, such as by a slab on
grade on the toe side of the wall that prevents
sliding altogether. If this option is selected, the
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lateral sliding force is displayed for checking the
resistance offered by the slab, and the slab is
assumed to be at the top of the footing, but not
higher.

Key Dimensions

Key Depth: Depth of the key below the bottom of footing. The bottom of the key is
used as the lower horizontal plane for determining the size of the passive
pressure block from the soil in front of the footing. Adjust this depth so the
sliding safety factor is acceptable, but not less than 1.5.

Key Width: Width of the key, measured along the same direction as the footing width.
This is usually 12"-14", but generally not less than one-half the key depth
so flexural stresses in the key are usually minimal.

Key Location: Enter the distance from the front edge of the toe to the front of the key. Do
not enter a distance greater than the footing width minus key width.

Align with Stem: Click this button to align the front edge of key with the front of the stem. If
the key width is then set to a value that is reasonably close to the stem
width, the stem bars may be able to be extended down into the key to
facilitate rebar development.

Apply active pressure behind key: When this option is selected, the program will consider
the driving force to extend all the way to the bottom of
the key.  If this option is NOT selected, then the driving
force will not extend below the bottom of the footing.  

Note: IBC 2015 was worded in such a way as to
confuse this issue and imply that it was a requirement
that active pressure must extend to the bottom of any
key.  The actual intent was expanded upon in
subsequent documents to clarify that the intent was to
require active pressure to extend to the bottom of a
key in situations where it could be reasonably
anticipated that the soil on the low side of the wall
(providing passive resistance) might be removed
during the service life of the wall, such as in a scour
condition.  This verbiage was revised in IBC 2018 to
remove the ambiguity.

Sliding Resistance Method: Enter whether sliding resistance will be by friction and
passive pressure or by cohesion and passive
pressure.

Soil Over Toe to Neglect for Sliding Resistance: Since the soil over the toe of the
footing may be loose and
uncompacted, it may have little or no
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passive resistance. This entry gives
the option to neglect some portion of
the Height of Soil Over Toe entered
in the General tab. You can neglect
the soil over toe plus the footing
thickness, if desired.

% Passive Usable for Sliding Resistance: Enter a value from zero to 100% to indicate the
percentage of the calculated passive pressure
that will be used as resistance in the sliding
calculation. This may be a stated restriction in
the geotechnical report. 

Footing/Soil Friction Factor: Enter the friction factor here. It usually varies
from 0.25 to 0.45, and is generally provided by
the geotechnical engineer.

% Friction Usable for Sliding Resistance: Enter a value from zero to 100% to indicate the
percentage of the calculated friction force that
will be used as resistance in the sliding
calculation. This may be a stated restriction in
the geotechnical report.

Summary of Sliding Forces

Lateral Force @ Base of Footing: This is the total lateral force against the stem and
footing which causes the wall to slide and which must
be resisted.

Less Passive Pressure Force: This uses the allowable passive pressure in pcf and
the available depth ("footing thickness" plus "soil
above toe" less "height to neglect") multiplied by the
"percent usable" you specified to compute the total
passive resistance. Weight due to toe surcharge, if
applicable, will also be incorporated into the
calculation of the passive force. If a key is used, the
available passive pressure depth will be to the bottom
of the key.

Less Friction Force: This is the total vertical reaction multiplied by the
friction factor, and then multiplied by the "percent
usable" you specified.

Added Resisting Force Required: If this value is indicated as 0.0 lbs., then there is no
requirement for additional resisting force in order to
achieve a static balance of forces, but it does not
necessarily mean that there is an adequate factor of
safety against sliding. Watch the Sliding Ratio on the
Results tab, Summary sub-tab for an adequate value
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(usually 1.5). Consider adding a key or modifying
footing geometry if required.

Added Resisting Force Required for 1.5:1 Factor of Safety: 

This is the additional resisting force that would be required in order to achieve a 1.5 safety
factor. If this value is indicated as 0.0 lbs., then the Siding Ratio is already 1.5 or greater.

Key Rebar Requirement

Key Reinforcing: This area indicates the permissible spacing values for a variety
of logical rebar sizes, and allows the user to specify the size and
spacing of the rebar in the key. 

Sliding Factor of Safety: This reports the ratio of passive and friction resistance to the total
lateral force. This should be at least 1.5, or 1.1 if seismic is
activated.

NOTE: If lateral restraint is provided by an abutting floor slab (by checking the "Slab
is present..." box), the sliding factor of safety will not be displayed, but the “Lateral
Force @ Base of Footing” will be displayed for checking restraint adequacy of the
slab.
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Pier Design

Checking the Use Pier Foundation checkbox (on the sub-tabs under the Footing tab) will
replace the Key Design & Sliding Options sub-tab with the Pier Design sub-tab as shown
below:  

This allows you to use drilled cast-in-place concrete piers spaced in a single row along the
length of the wall. The default is without lateral support at the footing level. If lateral support is
available, such as an abutting slab at the footing level, check the box labeled "Lateral support
at Top of Pier". The Key Dimensions & Sliding tab is not applicable when piers are used so
the Key Dimensions & Sliding Options tab is not displayed when the Use Pier Foundation
checkbox is checked. However, the Footing Design tab does remain active, so you can adjust
the footing dimensions as necessary for the piers, and adjust as needed for torsion
resistance (see below).
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Lateral Support at Top of Pier: Provides a way to specify that there is lateral restraint at
or near the top of the pier. If this option is checked, the
program will offer a related item named "Assumed Fixity
Below Embed"

Vert. Load from Wall, plf: Displays the total vertical load imposed upon the piers
from the wall above, including the footing weight. It
matches the total vertical load from the Resisting
Moment summary.

Lateral Load from Wall, plf: Displays the net sliding force and matches the total
force shown on the Overturning Moments summary for
the wall.

Added Lateral at Top of Pier, lbs: The geotechnical engineer may recommend an added
lateral force at or near the top of the pier (sometimes
termed “creep”). This may be a triangular force but for
simplicity it is assumed to act at the top of the pier.

End Soil Bearing Allow, psf: Allowable end bearing pressure at bottom of pier.

Pier Skin Friction, psf: If applicable, enter the allowable skin friction on the pier
for added vertical load capacity. This may require
conversion from a friction angle.

Allow. Passive Pressure, pcf: This is used to define the variation in allowable passive
pressure with depth.  

Apply Safety Factor to Allowable Passive Pressure: Allows the user to use a drop-down
list box to select a safety factor that
will be applied to the calculated
passive pressure.

Actual Passive Pressure, pcf: Reports the value of Allowable Passive Pressure in pcf
divided by the safety factor selected above.

Max. Allow. Passive Pressure, psf: Specifies the upper limit on the allowable passive
pressure. The allowable passive pressure will increase
with depth until it reaches this value, at which point the
allowable passive pressure will remain constant at this
value.

Diameter Multiplier for Pass. Resistance: The geotechnical engineer may permit a
multiplier to the diameter for greater effective
passive resistance. The default is 1.0.

Footing Toe to CL Pier, ft: Distance from the toe to the centerline of the
pier.
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Center Pier on Footing (button): Convenient way to automatically center the pier on the
footing.

Eccentricity of Vertical Load to CL Pier, ft: Distance from the centerline of the pier to
the resultant vertical load.

Load Factor for Pier Design: Select a single load factor that will be applied to all pier
loads to perform the reinforced concrete design.

Pier Spacing, ft: Center to center spacing of piers.

f'c, psi: Specified compressive strength of concrete.

Fy, psi: Yield strength of rebar.

Suggested Diameter, in: Diameter required based upon applied Vertical Load and the
allowable end soil bearing pressure. 

Diameter Used, in: If skin friction is used (activated by checkbox below) the diameter
can be adjusted provided Total Bearing Capacity exceeds Total
Vert. Load to Pier.

Effective Embedment Required, ft: This uses the “pole embedment” equations per
Section 1807.3 of IBC to determine the required pier
embedment depth based upon the passive pressure
entered and the applied moment to pier. The
embedment depth will vary depending upon whether
the checkbox for lateral support at top is checked.

Ignore Passive Pressure from Pier Top, ft: Since the soil near the top of a drilled pier
may be disturbed and uncompacted, it may
have little or no passive resistance. This
entry gives the option to neglect the passive
pressure over the specified height at the top
of the drilled pier.

Total Embedment Required, ft: Displays the sum of "Effective Embedment Required" plus
"Ignore Passive Pressure from Pier Top".

Effective Embedment Used, ft: Input a depth of embedment considered to be effective
below the section where passive pressure is being
ignored.

Total Embedment Used, ft: Displays the sum of "Effective Embedment Used" plus
"Ignore Passive Pressure from Pier Top".

Location of point of inflection: Use the drop-down list box to select the ratio of depth-to-
inflection to effective embedment depth. Tests suggest 1/6
is reasonable; 1/3 is conservative. This will be used to
calculate the maximum moment applied to pier.  The
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resulting length will be measured below the zone where
passive pressure is ignored (if any).

Apply Skin Friction (with option to ignore some length of skin friction): Check this if skin
friction is
to be used
to increase
vertical
capacity of
pier. If
selected,
there is an
entry for
depth to be
ignored for
skin
friction.

No. of Bars (circular): Select the number of bars. They are assumed to be in
a circular pattern.

Size of Rebar: Select size of bars to use in the circular pattern.

Applied Moment at Pier Top, ft-lbs: Displays the wall overturning moment multiplied by the
pier spacing.

Pier Design Mu, ft-lbs: This is the total factored design moment applied to the
pier.

Design Pier Mom., phi Mn, ft-lbs: Displays the design moment capacity of the pier using
the strength values input and a phi factor of 0.90.  This
uses the Whitney Approximation method which is
slightly conservative.

Applied Shear at Pier Top, lbs: Displays the Lateral Load from Wall multiplied by the
pier spacing.

Factored Shear in Pier, lbs: Displays the total factored design shear applied to the
pier.  It includes lateral load from the wall, and
additional shear due to the pier reacting out the applied
moment.
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Actual Shear, Vu, psi: Displays factored shear stress determined using

Whitney Equivalent Rectangular Section.  
Width = b = 0.8 * Diam.  
Area of Whitney Equivalent Rectangular Section =
Area of circular pier 
H = Area / b
d = 0.67 * H
Aeff = b * d

Allow. Shear, phi Vn, psi: Displays design shear strength using a phi value of 0.75:  phi

vn = 0.75*2*(fc)1/2

Total Vert. Load to Pier, lbs: Displays the Vertical Load from Wall multiplied by the pier
spacing.

Total Vertical Capacity, lbs: This combines both end bearing capacity and skin friction, as
applicable.

Axial Stress, fa, psi: This is the total vertical load / pier area. This is for reference
only since it is not considered a critical design consideration.

Footing Torsion, Tu, ft-lbs: Displays factored torsional force in footing, which is calculated
as moment from wall multiplied by one-half pier spacing.

Footing Torsion Allow., phi Tn, ft-lbs: Displays torsional design strength of the footing
based on Section 22.7.4 from ACI 318-14 or -19. 

For more information on pier foundation design see Basics of Retaining Wall Design,

11th Edition
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13.7.1.5   Load Factors

This tab allows the code-specified load factors to be reviewed and edited if necessary.
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Load Type / Load Factors

For each type of load (DL, LL, etc) the default factor will be displayed. These values can be
edited for the current design.  If desired, the edit values can be made the default for future
designs by clicking the button labeled "Set These Factors As Defaults".  Remember to
review these factors for each new design since they are editable.

The factors shown on this tab apply to Strength Design (concrete stem sections and footing,
and masonry design when LRFD is selected). For Allowable Strength Design for masonry,
factors are generally set to 1.0 except that the earthquake factor (E) is 0.7, and for IBC 2012
and later, the wind load factor (W) is set to 0.6 to convert strength-level loads to service-level
loads.

13.7.1.6   Results Tabs

Summary

This screen summarizes the footing/soil bearing results obtained from previous screens,
including a message whether the resultant is within or outside the middle third of the footing. 
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This is not an input screen. It's strictly for your review, and it does not appear if a pier is
specified.

Stability Ratios: These are displayed for both overturning and sliding.

Soil Loading Results

Soil Pressure @ Toe and Heel: This is the resulting soil pressure for both the toe and
heel based on service loads. If the eccentricity is outside
the middle third, the heel pressure will show 0.00, and
the program will calculate the toe pressure assuming no
tension at the heel.

Allowable Soil Pressure: This is for reference as entered on the General tab.

Total Bearing Load: This is the sum of all vertical forces.

Resultant Eccentricity: Distance from center of footing to the resultant of the soil
pressure distribution.

Eccentricity Within/Outside Middle Third: If the eccentricity is greater than one-sixth the
footing width, the resultant is outside the
middle third. (If outside the middle third, the
program computes the toe soil pressure
assuming no tension at the heel.)
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Footing Results

ACI Factored Soil Pressure @ Toe and Heel: ACI load factors are applied to all loads to
determine total vertical load for soil pressure
used in calculating footing moments and
shears. This load is then applied at the
same eccentricity calculated for service load
soil pressures to yield the factored soil
pressures for footing design using LRFD
design principles. 

Note that since factored vertical loads are
applied at the non-factored resultant
eccentricity, a true 1.6 load factor applied to
lateral earth pressure is not used for footing
design.  ACI load factors are intended to give
conservative results for design. Calculation
of a factored load eccentricity would give soil
pressure diagrams that would not always
represent the actual soil pressure
distribution under the footing, and yield
unreasonable results. Factored lateral earth
pressure, however, is always used for
concrete stem design. 

Mu Design @ Toe/Heel: These are the factored moments at face of stem for toe and

heel moments. Since neither can be greater than the stem
base moment (factored if concrete stem), the latter may
govern. These moments will be reduced if you choose to
neglect the upward soil pressure on the Footing tab.  A
message will indicate which controls.

Shear @ Toe and Heel: These items report the factored shear stress from the one-way
action in the footing.  The toe shear stress is calculated at a
distance "d" (footing thickness - rebar cover) from the face of
the bottom stem segment.  (If "d" is greater than the projecting
toe length, then the one-way toe shear is reported as zero.) The
heel shear stress is calculated at the face of the stem. 

Allowable Footing Shear: For concrete designed per ACI 318-14 and earlier, the nominal

shear strength is 2*l*sqrt(f'c).

For concrete designed per ACI 318-19, the nominal shear
strength is per the one-way shear strength provisions of §22.5
and Table 22.5.5.1 (as referenced by §13.3.6.1 and §7.5.3.1).
Footings are assumed to be unreinforced for out-of-plane shear.
Therefore, A

v
 is less than A

v ,min
, and equations (a) and (b) from

Table 22.5.5.1 need not be considered.
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Sliding > Resisting Forces

This screen presents in tabular form each component contributing to resistance to sliding.
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Sliding > Sliding Forces

This screen presents in tabular form each component contributing to sliding force.
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Overturning > Resisting Moments

This screen presents in tabular form each component contributing to resisting moment, giving
weights and moment arms from the front edge of the toe to the centroid of the force.

Resisting/Overturning ratio is displayed.

The force and moment displayed at the bottom accounts for deduction of effect of vertical
component, if box on the General tab has been checked.

For calculating the vertical component, if checked on the General tab, and if the EFP method
was chosen, the program will back-solve using the Rankine formula to obtain an equivalent
internal friction angle.
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Overturning > Overturning Moments

This screen presents in tabular form each component acting horizontally to overturn the
wall/footing system. The centroid of each force is multiplied by its distance up from the
bottom of the footing. The Heel Active Pressure includes the effect of surcharges and water
table, if applicable, and its Distance is to the centroid of the total lateral force. 

The total overturning moment is displayed along with the Resisting/Overturning ratio. 
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Global Stability

This screen presents the driving force tending to cause a global stability (scooping) failure,
the force tending to resist the failure, and the ratio.

The Global Stability check follows the procedure in Principles of Foundation Engineering, 2nd
Edition, Das, where various circular failure planes are tested.  Each circle is broken into
slices of soil behind the wall and in front of the wall.  The weight of the soil slices is used to
calculate a total driving moment, tending to upset the stability.  And it is also used to
determine tangential frictional forces on each slice, tending to restore stability. 

This tab will not be displayed if a water table is specified, or if a pier foundation is specified.

Wall Tilt

This computes the horizontal displacement at the top of a wall caused by rotation due to
compression of the soil under the toe.

You must enter the modulus of subgrade reaction on the General tab. The program divides
the soil bearing stress in psi by the soil modulus (psi/inch) to quantify the displacement at the
footing. Then, assuming the wall and footing are rigid, the program determines the horizontal
displacement at the top of the wall based on the amount of rotation experienced at the
footing. 
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Note: This is approximate due to variation in soil pressure under the footing, and
does not include deflection of the stem due to lateral earth pressures. (The latter is
usually less than the "tilt" deflection, and if desired, must be done by hand
calculation, requiring investigation of cracked and uncracked moments of inertia.)

To mobilize the active pressure in retained earth, it is often considered that the deflection at
top must be greater than or equal to 0.005 x Htotal.

Stem Design Values

This tab was introduced in order to make it possible to view stem design values while the
input focus is on tabs other than the Stem tab.  This makes it easier to view the effects on
stem moment and shear while changing other parameters such as retained height, backfill
density, etc.  It also includes subtabs to view the Rebar Lap & Embedment Length table and
the Concrete Rebar Area Details table.
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13.7.1.7   Stability Tab (Restrained Walls only)

For Restrained Walls the Stability sub-tab will appear, summarizing the conditions regarding
base fixity and base lateral restraint.

A banner displays whether a slab is present to resist base sliding (box checked on Footing >
Key Design tab) and whether fixed or pinned at base, as previously selected on the Stem tab.

The reaction at the top restraint is displayed.

The Sliding forces are displayed.

For analyzing the stem, if it is assumed “pinned” at the bottom (option is located on the Stem
tab), and a slab is not present to resist sliding, then the theoretical overturning of the footing
due to the reaction at the base of the stem, is the horizontal reaction at the bottom of the stem
times the thickness of the footing.
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If slab restraint is provided, the moment applied to the footing is the total vertical load times its
eccentricity from the center of the footing. This moment is displayed (on the Stability tab) and
is used to compute soil pressure.

13.7.1.8   Construction Tab

This graphics screen displays a construction drawing showing the pertinent construction data
for the wall as you have entered it. It is automatically included in printed reports.  This graphic
is intended as a check of your input and is not editable. 

To print, use Print button at top left. Layers of information can be turned on and off by
checkboxes across the top of the drawing view.

This drawing will not depict the wall in a graphically correct way until sufficient data has been
entered. Only a default graphic will appear initially.
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13.7.1.9   Wall Loading Tab

This diagram displays the active or at-rest pressure distribution, the passive pressure
distribution, any applied loads that have been defined, and the maximum soil pressure
distribution. 

Loads are color-coded and may be turned on and off by using the checkboxes across the top
of the diagram. 

It is automatically included in printed reports.

This feature not available for segmental walls

This drawing will not depict the wall in a graphically correct way until sufficient data has been
entered. Only a default graphic will appear initially.
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13.7.1.10   Methodology / Analysis & Design Assumptions

GENERAL:

For cantilever walls the stem is fixed to the footing, the footing is free to rotate on the
supporting soil, and no lateral restraint can exist at or near the top of the wall (otherwise it is
not a cantilevered wall).

For restrained ("basement" or "tie-back") walls, the program assumes either 100% fixity at the
base, or pinned (zero rotational fixity). Lateral support is at or near the top, and
moment/shears are computed at the base, maximum positive, and at the upper support. The
program does not check flexural stress reduction for axial loads (the unity interaction formula)
since in most cases of basement walls the h/t ratio is below about 10 for masonry walls and
somewhat higher for concrete, and axial stresses are low. If axial stresses are considered
significant (say over 1000 lbs. per ft. length of wall), the interaction should be checked at the
point of maximum positive moment. 

For restrained walls, the program assumes that the restraint at or near the top is provided by
a continuous line of restraint, such as could be provided by continuous connection to a slab or
other diaphragm. If the connection between the retaining wall and the restraining diaphragm
occurs only at discrete points, the horizontal span of the wall between those tieback points
may become a design consideration. This potential failure mode would have to be checked by
supplemental hand calculations, as the program does not consider this type of behavior. 

References used for the development of this program are listed in Appendix E.

Stem design material is limited to concrete or concrete masonry. Design strength of concrete
and masonry may be specified. 

Conventional "heel" and "toe" terminology is used, whereby the "heel" side of the wall
supports the retained earth. In this program, the "heel" distance is measured from the front
face of the stem. 

Concrete design for stem and footing is based upon ultimate strength design (SD) using
factored loads. Factors for various building codes will be displayed on the Load Factors page,
and may be edited. Since they are editable, be sure to check them before starting a design
since you may have changed them. 

Masonry design is based upon the Allowable Stress Design (ASD) or Strength Design (SD),
as selected.

A geotechnical engineer will typically have determined design criteria (equivalent fluid
pressure, allowable soil bearing pressure, sliding coefficient, etc.). If this is not the case, you
can enter the angle of internal friction for the soil, and the program will compute the
corresponding active pressure, using the Coulomb formulas based upon the soil density and
backfill slope you have specified. If the Coulomb method is chosen, passive pressure will be
based upon the Rankine Formula, assuming a level toe-side backfill. 

Global stability is checked and reported for certain wall types.
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Weight of concrete block masonry can be lightweight, medium weight, or normal weight, per
the table in this User's Manual. Refer to Appendix C.

Horizontal temperature/shrinkage reinforcing is at the discretion of the designer. For
horizontal temperature and shrinkage reinforcing for various stems see Appendix A.  

Axial loads may be applied to the top of the stem but it is recommended that they do not
exceed about 3,000 lbs to avoid reversal of heel bending moment. Slenderness interaction
reductions for cantilevered walls are not calculated since h/t ratios are typically less than
about 12. Only "positive" eccentricities from the centerline of the top stem are accepted (i.e.
toward the toe), since negative eccentricity could lead to unconservative results.

Excessively high axial loads are not anticipated by the program and should not be applied if
they would cause tension in the bottom of the footing heel – the program assumes typical
retaining wall conditions where the heel moment causes tension at the top of the footing. If a
design requires a very high axial load, say, over 3 kips/lf, it is suggested to use footing design
software or hand calculations. 

Concrete block thicknesses of 6", 8", 10", 12", 14", and 16" are allowed in the program.

Bond stress masonry for masonry stems. Flexural bond is a slipping (grip) stress between
reinforcing and grout, resulting from the incremental change in moment from one point to
another, and is a function of the total shear at the section. The program does not specifically
check bond stress, but does use the formula m = M / (j d p db), and compares this with the

allowable development length. The formula for bond, relating to shear, is:  m = V / (So j d),

where So is the perimeter of the bar(s) per linear foot. “j” and “d” are the familiar terms. This

can be re-written to be approximately:   m = 0.35 V s / db j d, where “s” is the bar spacing in

feet and db is the bar diameter, if the designer wishes to check to the bond.

Bond stress in masonry retaining walls is of questionable significance since the bars are
customarily cast in grout which by code must be at least 2,000 psi, therefore comparable to
embedment in concrete. Furthermore, Amrein (see bibliography) quotes a research study
concluding the bond stress could be 400 psi based upon experimental studies showing
minimum achieved stresses of 1,000 psi, thereby giving the former value a safety factor of
2.5. 

This is probably a moot issue since rarely would bond stresses govern over shear stresses,
particularly if the stress level in the reinforcing is factored in. Additionally, development lengths
for reinforcing in masonry, and code required lap lengths, are considered quite conservative.

Stem reinforcing may be #4 through #10 bars. 

Critical section for bending in the footing is at the face of the stem for concrete and 1/4
nominal thickness within the wall for masonry stems. For shear, for both concrete and
masonry stems, the critical section is a distance "d" from the face of the stem toward the toe,
and at the face of the stem for the heel. The program does not calculate toe or heel bar
development lengths inward from the face of the stem (where the moment is maximum).
When selecting and detailing the arrangement of toe and heel bars this should be considered.
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Refer to Appendix B for development lengths in concrete, which can be adjusted for the
stress level.

The program calculates the bending in the key and determines whether reinforcing is
required. For determining section modulus, 3" is deducted from the key width per ACI
recommendation. If reinforcing is required, a message will appear. You can then change the
key dimensions until the message disappears, or use the rebar suggestions displayed. The
key moment and shear is produced by the passive resisting pressure acting against the key.

Slab restraint at the base can be specified on the Footing > Key Design & Sliding Options tab.
The program only allows this restraint to occur at the top of the footing – not higher.

RESTRAINED WALLS:

A vertical component of active pressure is not activated, whether or not it is checked on the
General tab, since the top of the wall is assumed not to deflect and thereby not activate such
force. Overturning moment is not applicable, and is therefore not displayed, since overturning
stability is by restraint at or near the top of the wall.
   
When 100% Fixity @ Base is selected soil pressures are assumed to be completely uniform. 

When 100% Fixity @ Base is not selected, and if slab restrains sliding, the soil pressures are
calculated considering the following effects:
· Moment on soil due to eccentricity of vertical loads.
 
When 100% Fixity @ Base is not selected, and if no slab restrains sliding, the soil pressures
are calculated considering the following effects:
· Moment on soil due to shear times the footing thickness.

· Moment on soil due to eccentricity of vertical loads.
 
Shear at base of stem is computed based on the summation of all lateral force above that
point. 

13.7.2  Gabion Retaining Wall

A gabion wall is a gravity wall constructed using prefabricated steel wire cages filled with rock.
 The cages are often 3 ft on a side and are infilled with stone as specified by the designer. In
lieu of rock filled gabion cages, large precast concrete blocks may be used.

This program assumes all cages or blocks to be of uniform height and infill density.  They can
either be assembled vertically or tilted backward by selecting either 3° or 6° tilt.  Maximum
allowed height is 18 ft.  A rule of thumb for the length of the bottom course is 75% of the
retained height.  The retained height is assumed to be the same height as the wall.  The
Coulomb equation is used for determining lateral earth pressure.  As of July 2016 the Gabion
Wall module uses the following values in the Coulomb equation:  Angle of soil face of wall is
equal to 90 degrees plus the user-specified wall tilt value, and the soil-wall friction angle is
equal to (2/3) Phi.
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This Gabion Wall program does not handle MSE (mechanically stabilized earth) walls, which
use geogrids.

Notes:

1. All courses are of the same height and infill density.
2. Concrete blocks may be used in lieu of gabion cages.
3. Coulomb equation is used for active pressure. 
4. This design is not valid for reinforced soils (Mechanically Stabilized Earth).  Consider

using Segmental Retaining Wall module instead.

General Input:

Course Height (Gabion/Block), In: Height of the gabion cages or block in inches.  This
can vary from one course to the next.

Retained Height, ft: Retained height in ft. which is also assumed to be
the top of the wall.

Wall Tilt from Vertical, deg: Select "None", 3°, or 6° backward tilt.

Surcharge, psf: Surcharge load if applicable.

Density, Gabion Infill or Block, pcf: Density of the infill or block.  A rock infill is typically
120pcf and concrete block is typically 140pcf.

Density of Backfill, pcf: Density of the backfill material, typically provided by
the geotechnical engineer.
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Backfill Slope, deg: If applicable, enter the backfill slope in degrees.

Embedment, in: Specifies the depth of embedment of the first
course.

Soil Friction Angle, Phi: Obtain this from the geotechnical engineer.

Ka (horiz): Computed using the Coulomb equation with
variables being phi, backfill slope and with wall/soil
friction angle assumed to be 0°.

Allowable Soil Bearing, psf: Obtain this value from the geotechnical engineer.

Coef. of Friction on Soil: As determined by the geotechnical engineer. 
Typically 0.25-0.50.  Used for the sliding check of
the first course.

Coef. of Interblock Friction: Coefficient of friction to resist sliding between cages
or blocks.  A value 0.70 is often used. Used for the
sliding checks above the first course.

Allowable Overturning Ratio: The minimum permissible ratio of resisting moment
divided by overturning moment.

Allowable Sliding Ratio: The minimum permissible ratio of sliding resistance
divided by sliding force.

Allowable Passive Pressure, pcf: (When a nonzero embedment is specified) 
Allowable passive resistance to sliding (when an
embedment is specified) as an equivalent fluid
pressure. 

Depth of Passive to Neglect, in: (When a nonzero embedment is specified)  An
option to specify a top layer of passive pressure to
disregard in the resistance calculation, as in cases
where it may be unreliable due to frost disturbance.

Gabion Courses Table:

Course: These are numbered in ascending order and cannot exceed 10.

Height: Measured from bottom of first (base) course.

Block Height: Height of the selected course.  Can vary from one course to another.

Offset: Horizontal offset measured from front edge of bottom course.

Length: Length of cages or blocks in course.
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Vertical: Accumulated vertical load from courses above.

Distance: Horizontal distance from front edge of bottom course to centroid of the
referenced course.

RM: Resisting moment at referenced course.

Lateral: Accumulated lateral force from earth pressure and surcharge at referenced
course.

OTM: Accumulated overturning moment above referenced course.

Stability Ratio: RM / OTM

Friction Force: Friction force at the specified course calculated as Vertical / Friction
Factor, where Friction Factor is Coefficient of Friction on Soil for the
calc at Course 1 and Coefficient of Interblock Friction for the calc at
courses above Course 1.

Passive Force: Allowable resisting force that can be generated from passive pressure
that is not neglected.  Only considered to benefit Course 1.

Friction + Passive: Simple sum of Friction Force plus Passive Force.

Sliding Ratio: Friction + Passive / Lateral.

Add, edit or delete courses using the buttons and input fields below the table. The first value
entered will automatically be the bottom layer. To delete a course highlight it and click Delete.

Summary Tab:

Overturning Ratio: Reports the minimum Stability Ratio as described above.

Sliding Table: Reports the Sliding Ratio and an OK/NG status for each course.

Act. Soil Bearing Pressure, psf: Computed using conventional statics and appears
in red if it exceeds the allowable soil bearing
specified.

Lateral Force, Earth: The total lateral force attributable to lateral earth
pressure.

Lateral Force, Surcharge: The total lateral force attributable to an applied
surcharge.

Total Lateral Force: Simple sum of Lateral Force, Earth plus Lateral Force,
Surcharge.
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Resisting Moment: The value of RM at Course 1.

Overturning Moment: The value of OTM at Course 1.

13.7.2.1   Methodology / Analysis & Design Assumptions

References used for the development of this program are listed in Appendix E.

13.7.3  Soldier Pile Retaining Wall

Soldier pile retaining walls, also called soldier beam walls, are generally used at construction
sites for temporary shoring. Steel piles are driven into the ground, or placed in drilled holes
filled with lean concrete, at a spacing such that lagging can be placed between the piles, and
the excavation can proceed down to the level of the finished grade on the low side. The
stability of a soldier pile retaining wall depends upon the active earth pressure being resisted
by passive pressure on the embedded section of the pile.  Pile spacing is typically 6 – 10 feet
on center.

This module is suitable for cantilevered soldier piles (no tie-backs) or soldier piles with tie-
backs.
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13.7.3.1   General Tab

Steel Design Method: Select ASD or LRFD methods for design of steel pile

Pile Section: Opens the Steel Section Database, allowing the selection
of common pile sections.

Retained Height, ft: Distance between the final excavated grade and the
retained height at the top grade.

Tie Usage: Select none, one, two, or three.  If any tie-backs are used,
they are located by their distance from the top of the pile.

Bottom of pile is assumed to be:  This is a conditional input.  It is only available when tie-
backs are used, which triggers a stiffness analysis using
ENERCALC SEL's 2D Frame program in the
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background.  The pile is modeled in segments from
spanning between tie-backs.  The bottom segment
spans from the lowest tie-back to the bottom of the
embedment depth.  This setting controls whether that
lowest support is considered fixed or pinned with regard
to rotation. 

Pile Spacing, ft: Center to center spacing of piles, typically 6 ft to 10 ft. 

Pile is encased in concrete: Select whether the steel pile is driven into the soil or placed
into a drilled hole and encased in lean concrete.

Pile Flange Width / Diameter of Encasement, in: If the pile is driven, enter the
flange width.  If the pile is set in
lean concrete in a drilled hole,
enter the hole diameter.

Total Pile Embedment, ft: Actual embedment, usually rounded from the required
embedment reported below.

Multiplier to Passive Wedge: This is an arching factor.  It takes the form of a multiplier
from 1.0 to 3.0 to be applied to the pile flange width or
drilled hole diameter due to wedging action and is usually
provided by the geotechnical engineer.

Pile Yield Stress, Fy: Yield stress of the selected pile section.

Unbraced Length for Soldier Pile: Allows the user to specify the unbraced length for steel
design purposes.  This is a conditional input.

If the pile is not tied back, the user can select:

· Consider pile unbraced for lateral torsional buckling

· Consider pile fully-braced for lateral torsional
buckling

If the pile is tied back, the user can select:

· Consider pile unbraced for lateral torsional buckling

· Consider pile to be braced at tieback locations

· Consider pile fully-braced for lateral torsional
buckling
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13.7.3.2   Lateral Earth Pressure Tab

Lateral Earth Pressure Method: This is a conditional input.  It is only available when tie-
backs are not used.  When it is available, it allows the
use of Rankine Active Pressure or Equivalent Fluid
Pressure methods.  When tie-backs are used, the
pressure is applied as described on the Soil Pressure
Reference tab.

EFP: Equivalent Fluid Pressure of the retained material, usually
obtained from the geotechnical engineer.

Soil Phi, degrees: Angle of internal friction of the retained material, usually
obtained from the geotechnical engineer.

Soil Density, pcf: Density of the retained soil, usually 100 to 130 pcf.
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Surcharge top of soil at retained side, psf: Surcharge on upper grade such as for
equipment, materials, or contingencies.

Backfill Slope, degrees: Slope of the backfill measured in degrees from horizontal.

Passive Pressure, psf/ft: Passive pressure in pcf.  When using Rankine active soil
pressure method, passive pressure is calculated as (1/Ka)
*(soil density).  When using EFP, the passive pressure is a
user input.

Apply S.F. to Passive Pressure: Safety factor that will be applied to the above passive
pressure, typically suggested by the geotechnical
engineer.

Neglect this height of Passive Pressure @ Top: Allows a specified height of passive
pressure to be ignored for
resistance, such as if the soil was
likely to be frost disturbed or
otherwise unsuitable to resist lateral
pressure.  Note that this input is
specified in units of inches.

Multiplier on Ka*Gamma*H: This is a conditional input.  It is only available when tie-
backs are used, and it allows the user to fine tune the
pressure value.  The Soil Pressure Reference tab shows
how the soil pressure distribution is developed. 

13.7.3.3   Lagging Tab

Use Lagging: Check this box if lagging is to be considered
between piles.
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Lagging Depth, ft: Depth below grade at which lagging pressure is to
be calculated based on the active soil pressure.   

Lagging Pressure @ Depth, psf: Pressure used in the design of horizontal wood
lagging between piles.

Lagging Moment @ Depth, ft-lbs: Moment computed assuming arching action and

using moment = 0.8 * wl2/8.

Lagging Shear @ Depth, lb/vertical ft: Shear computed using wl/2 where w is the
Lagging Pressure @ Depth determined above.

Lagging selection: Wood lagging selection, such as 4 in x 12 in.  No
design is performed based on this entry, but it is
printed in the calculation report for documentation
purposes.

13.7.3.4   Results Tabs
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Summary Tab

Soil Pressure Coefficients:

Ka (horiz) and Kp (Rankine) are computed automatically when using the Rankine method. 
Kp (Rankine) is calculated as 1/Ka for a backfill slope of
zero.
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Lateral Loads:

Pile Pa, lbs: Total lateral force due to earth pressure.

Pile Pw, lbs: Total lateral force due to surcharge if applicable.

Pile Total lateral, lbs: Sum of Pa + Pw

Moments & Shears:

Depth to Max M, ft: Distance below lower grade to point of maximum moment
in the pile.

Mmax in Pile (Service), ft-lbs: Maximum service level moment in the pile.

Vmax in Pile (Service), ft-lbs: Maximum service level shear in the pile.

Mmax in Pile (Factored), ft-lbs: Maximum factored level moment in the pile.  A factor of 1.6
is used.

Vmax in Pile (Factored), ft-lbs: Maximum factored level shear in the pile.  A factor of 1.6 is
used.

Deflection: This is a conditional result.

If the pile has no tie-backs, the result will report the deflection at the top of the pile.

If the pile has tie-backs, the result will report the deflection at the top of the pile, as well as the
extreme deflection and the location where the extreme deflection was found to occur.  Refer
to the Solver Results tab for more information on how to locate the point of extreme
deflection.

Embedment:

Reports the required pile embedment based upon allowable passive pressure, the specified
safety factor and the applied active pressure.  The result is further itemized into the length of
embedment that is considered effective for passive resistance and the portion that is
neglected (if any).  Finally, the results report the embedment used for documentation
purposes.
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Reactions:  This is a conditional result.

If the pile has no tie-backs, this area will be blank.

If the pile has tie-backs, the result will report the tie-back reactions and the base reaction as
determined by the stiffness analysis.

Status Checks:

Reports Mu (or Ma), phiMn (or Mn/Omega), the ratio, and an OK/NG status.

Reports Vu (or (Va), phiVn (or Vn/Omega), the ratio, and an OK/NG status.

Reports an OK/NG status on the Embedment.

Soldier Pile Section documents the selected section for the pile.

Lagging Section documents the selected section for the lagging.
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Construction Tab

Displays the soldier pile, the retained soil, tie-backs (if any), and critical dimensions.
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Wall Loading Tab

Displays the soldier pile, the retained soil, tie-backs (if any), surcharge load (if any), and
passive pressure diagram.
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Soil Pressure Reference

Displays the loading diagram that is applied to the 2D Frame analysis model, as well as the
derivation of the pressure values.

H:  Retained height

Th1...Thn: Tie-back reactions

H1...Hn:  Dimensions used to locate tiebacks

R: Lateral reaction at base

p:  Maximum pressure intensity as determined by [Ka_horiz * Gamma * H +
Surcharge * Ka_horiz] * Pile Spacing * Multiplier on Ka * Gamma * H 
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Solver Results

Displays the results from the 2D Frame analysis model.

Nodes:  Displays the node list as well as displacements and reactions

Beam Output: Displays list of beam segments with shears and moments

Detail Output:  Displays list of beam segments with shears and moments at small
increments along the height of the pile

Deflections: Displays list of beam segments with deflection values at small
increments along the height of the pile

13.7.3.5   Methodology / Analysis & Design Assumptions

References used for the development of this program are listed in Appendix E.
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A basic design requires these steps:

There are many theories presented for calculating embedment depths (Plum method and
others) and that shown in figure below is one that closely agrees with other methods.

Determine the driving forces, that is, forces imposed by any construction surcharges and the
active soil pressure tributary to each pile beam. Use the Rankine equation to calculate Ka.
Several designs may be done to optimize the beam spacing based upon lagging selection,
embedment depths, and beam sizes.

Referring to the figure below, after Pa and Pv, have been calculated, the depth of embedment
must be determined. This will be a function of the allowable passive pressure and arching
factor allowed to increase the effective flange width, or hole diameter if pre-drilling is used.
The arching factor. A. can be taken as 0.08 * phi, but should not exceed about 2.5. This
means that the effective pressure width in front of a 24" diameter drilled and concrete filled
beam encasement, with a phi of 32° would be 0.08 * 32 = 2.56. but use 2.5. Thus the effective
passive pressure would be a width of 2.0*2.5 = 5.00 feet which will considerably reduce
embedment depth and moment applied to the beam.

Figure illustrates theorized forces on cantilevered soldier beam in sandy soil

For determining the embedment depth to zero shear (where beam bending is maximum),
designated "d", the following equation can be used:
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Where Pp is equal to and counteracting to Pw + Pa; SF is the safety factor applied to
allowable passive pressure; A is the arching factor multiplier; Dia is the hole diameter or
flange width, whichever applicable; and p is the allowable passive pressure in pcf at “d". 

1. The maximum beam moment is then determined by summing moments above the
point of zero shear. Mathematically the result is equivalent to:

Mmax = Pw (0.50H + 0.67d) + Pa (0.33H + 0.67d)

2. The maximum moment is resisted by a passive pressure couple consisting of Fp *
0.67D. Therefore the required depth D can be estimated from the following equation:

The required depth of embedment is then (d + D). As a rule-of-thumb for sandy soils
this is usually in the range of 1.3 H to 1.5 H. It is conservative to add 20% - 30% depth
to calculated embedment.

3. After the maximum moment has been computed, convert it to LRFD (Load
Resistance Factor Design) by multiplying by the usually applicable load factor of 1.6.
Then select several beam options from AISC latest edition, LRFD Steel Design
Handbook. 

4. Select the lagging. Treated lumber should be used. Calculate the lateral pressure at
various depths, Hy,(to determine changing lagging thicknesses) which is Ka * Soil
Density * Hy. When the simple span moment is calculated it is common to multiply by
0.8 because of arching action of the soil between pile beams. Lagging is typically
either 3" or 4" by 12” treated wood. Lagging ends should bear against the beam flange
a minimum of 3". Allow about 1" between each lagging for drainage.

In addition, it is important to understand that the tied-back version of the module is based on a
stiffness analysis from the 2D Frame module within ENERCALC SEL.  It uses beam
elements spanning from the top of the retained height to the top tie-back, which is modeled as
a lateral support.  If there is more than one tieback, the subsequent tie-backs are modeled as
lateral supports.  The lowest beam segment spans from the lowest tie-back to a "base" node
that is modeled at the bottom of the embedment depth.

The top node is free to rotate and deflect.  Nodes representing tie-backs are free to rotate and
deflect vertically, but are constrained laterally.  The "base" node cannot translate at all, but the
user can specify whether it is able to rotate or if it should be treated as rotationally fixed.

The applied loading is as shown on the Soil Pressure Reference tab.

Reactions and displacements are reported by the solver.  The user will probably need to
increment the embedment depth until the module reports that the embedment is acceptable
for the modeled conditions.
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Steel design is performed at many increments along the length of the pile, taking into
consideration the steel yield strength, the section forces, and the bracing assumptions
specified by the user.

13.7.4  Segmental Retaining Walls

13.7.4.1   Segmental Wall Overview

Segmental walls are constructed of stacked masonry blocks, usually of proprietary
configurations, without steel rebar, grouting, or mortar. They are dry-stacked, either vertically
or with offsets at each block such that the wall is slightly battered and leans into the earth.
When geogrids are used in segmental retaining walls, they are placed in horizontal layers
separated by some vertical distance as the wall is constructed and backfilling progresses.
Their purpose is to reinforce the earth behind the wall such that the reinforced earth zone acts
en masse with the wall to resist sliding and overturning, hence no conventional foundation is
required. (These walls are also called MSE – Mechanically Stabilized Earth walls.)  The
geogrids extend beyond the failure plane and resist pullout by friction resistance due to the
weight of soil above. Connection to the wall blocks is achieved through friction between
blocks and sometimes by proprietary connection devices.

13.7.4.2   Design Assumptions for Geogrid Reinforced Segmental Walls

When working with the Geogrid Reinforced Segmental Retaining Wall module, the input
screens and output report vary from the conventional cantilevered and restrained retaining
walls.

In general, methodology used conforms to NCMA’s Design of Segmental Retaining Walls, 3rd
Edition.  
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Since segmental geogrid reinforced retaining walls can be highly complex, some simplifying
design assumptions have been implemented to make the program easier to use and still
cover most conditions encountered. These assumptions are:

1. All masonry units are the same size (height, width, depth) and single wythe.

2. Offsets between blocks are uniform for the full height of the wall.

3. Spacing of geogrid layers may be specified (number of blocks between layers), but
spacing is constant except for lowest layer and above uppermost layer.

4. Lengths of geogrids are constant for all layers.

5. Same geogrid material is used for all layers.

6. Coulomb method is used for determining lateral earth pressures.

7. Overall wall height is limited to 30 feet.

8. Setting base is assumed to be gravel or crushed stone, 6” thick, and extending 6” beyond
each edge of the bottom block.

9. Block dimensions are obtained from vendor websites or literature.

10. Weight of wall is assumed to be 120 pcf for depth of block.

11. Geogrid Long Term Design Strength and connection values have been obtained from
vendor websites or vendor ES-ICC Evaluation Reports. Verification with vendor is
recommended.

13.7.4.3   Design Assumptions for Gravity Segmental Retaining Walls

When working with the Geogrid Reinforced Segmental Retaining Wall module, the input
screens and output report vary from the conventional cantilevered and restrained retaining
walls.

In general, methodology used conforms to NCMA’s Design of Segmental Retaining Walls, 3rd
Edition.  

Since segmental retaining walls can be highly complex, some simplifying design assumptions
have been implemented to make the program easier to use and still cover most conditions
encountered. These assumptions are:

1. All masonry units are the same size (height, width, depth) and single wythe.

2. Offsets between blocks are uniform for the full height of the wall.

3. Coulomb method is used for determining lateral earth pressures.

4. Setting base is assumed to be gravel or crushed stone, 6” thick, and extending 6” beyond
each edge of the bottom block.

5. Block dimensions are obtained from vendor websites or literature.

6. Weight of wall is assumed to be 120 pcf for depth of block.
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13.7.4.4   Design Parameters Tab

Retained Height: Displays the retained height based on block
coursing and geometry entered on the Block &
Geogrid tab.

Embedment: Depth below grade (on the low side) to top of
setting pad. Usually one block course or 1’-0”.

Base Pad Depth: Thickness of the base pad. 

Soil Density, Exterior (in-situ): Enter the density of the native soil beyond the
backfill zone and under the base.
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Soil Density, Interior (backfill): Enter the density of the backfill material (typically
granular soil or gravel).

Soil Phi, Exterior (in-situ): Enter the angle of internal friction of in-situ soil.

Soil Phi, Interior (backfill): Enter the angle of internal friction of the backfill
soil. 

Allowable Soil Bearing Pressure: Enter the allowable soil bearing pressure.

Backfill Slope: Select the backfill slope from the drop-down list
box.  

Minimum Acceptable Factors of Safety: Specify the minimum acceptable factors of safety
for each of the different failure modes, or click the
reset button to easily reset all values to defaults
as per NCMA Table 5-2.
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13.7.4.5   Loads Tab

Surcharge DL, psf: Enter the dead load surcharge.

Surcharge LL, psf: Enter the live load surcharge – it will not be used to resist overturning
or sliding.

Seismic A factor: Specified horizontal peak ground acceleration expressed as a fraction
of the gravitational constant, g.  The site-specific values of A represent
a 90% probability of that value not being exceeded in 50 years.  See
NCMA 3rd Edition, Section 9.4.

dseismic: The lateral deflection that the retaining wall can withstand during a seismic event,

in units of inches.  See NCMA 3rd Edition, Section 9.4.  Note that this input is
optional.  If a non-zero value is entered, the program will apply the formulas that
consider the maximum permissible deformation.  If the value is left zero (blank),
the program will apply the formulas that are independent of the deformation.
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13.7.4.6   Geogrid Reinforced Segmental Retaining Walls

Block & Geogrid Data Tab (for Geogrid Reinforced Walls)

Segmental Type: Select either Gravity or Geogrid.

Select Block: From the drop down menu select the vendor and block
you want to use. Selecting a block will insert its values
into the criteria below.

Block depth, in: This will be automatically input based upon block selection.

Block height, in: This will be automatically input based upon block selection.

Wall weight, psf: This will be automatically input. Note that the full block depth is
assumed to be in-filled and an average density of 120 pcf is used. 
Note that block weight is in units of psf.  Think of looking at an
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elevation of a constructed wall.  It is the weight of one square foot of
finished wall.  It is calculated by knowing the weight of the solid portion
of the block and assuming that any hollow portions are filled with
material that weighs 120 pcf.

Offset per block, in: Select this value from the drop down menu – it is vendor-dependent.

Batter, degrees: This angle will be computed and displayed based upon offset and
block height entered.

Total No of Block Courses: Enter the number of block courses.

Retained Height: The retained height is automatically calculated and reported.

Blocks in Layer 1: Enter the number of courses below the first layer of
geogrid.

Blocks per Layer: Enter the typical number of courses between layers of
geogrid.

Min Blocks above top Layer: Enter the minimum number of courses above the top
layer of geogrid.

Base Width: Enter the full base width including wall depth. (usually
60% - 70% of retained height).

Select Geogrid: From the drop down menu select the geogrid vendor and the specific
geogrid.  Design parameters will be displayed below.

Ci factor: Select the coefficient of interaction for pullout (usually 0.70 – 0.90). 
Note:  The program will not permit a layer of geogrid to be placed
under the first course, so the value of Cds, coefficient of direct sliding
is hard coded to 1.0 for external sliding checks.

LTDS, lbs/ft: Long Term Design Strength will be automatically inserted based upon
the vendor/geogrid selection. 

RFCR: Creep Reduction Factor will be automatically inserted based upon the

vendor/geogrid selection.

LTDSseismic, lbs/ft: Long Term Design Strength for seismic loading will be automatically

calculated as LTDS / RFCR.

CDS: Select the coefficient of direct sliding.  Reference NCMA 3rd Edition,

Section 7.5.5.
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Wall Geometry Table:

Block: Displays the total number of block courses.

Layer: Displays the geogrid layer numbers in ascending order from bottom.

Height: Displays block and layer heights in ft-inches and decimals.

Show Block Courses / Show Grid Layers:  Toggles between the display of block courses
or grid layers.
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Results Tab (for Geogrid Reinforced Walls)

Displays the minimum acceptable factor of safety and the minimum actual factor of safety for
all failure modes, for the static condition and for the condition that includes seismic loading.
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External Stability Tab (for Geogrid Reinforced Walls)

Displays overturning and sliding factors of safety as well as bearing pressure results for
conditions with and without seismic loading.

Also reports eccentricity of vertical force and effective base width.
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Internal Stability Tab (for Geogrid Reinforced Walls)

Displays internal stability table:

Layer: Displays geogrid layer numbers.

Height, ft: Displays the height from the base to the elevation of each geogrid layer.

Trib Height: Displays the tributary height of each geogrid layer.

Depth to Midpoint: Displays the distance from the top of the wall to each geogrid layer.
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Tension from Soil: Displays the tension in each layer of geogrid due to lateral earth
pressure from the soil.

Tension from DL Surcharge: Displays the tension in each layer of geogrid due to
lateral earth pressure from a dead load surcharge.

Tension from LL Surcharge: Displays the tension in each layer of geogrid due to
lateral earth pressure from a live load surcharge.

Static Total Tension, Fg: The sum of Tension from Soil plus Tension from DL
Surcharge plus Tension from LL Surcharge.

LTDS: Echoes the Long Term Design Strength of the selected
geogrid.

LTDSseismic: Echoes the Long Term Design Strength for

seismic design of the selected geogrid.

Total Tension (w/ Seismic), Fi: Total tension in the geogrid when subjected to the load
condition that includes seismic loading.

FS Tensile Overstress (static): LTDS / Static Total Tension

FS Tensile Overstress (w/ seismic): LTDSseismic / Total Tension (w/ seismic), Fi

Pullout Strength: Ability of the geogrid to resist pullout failure.

FS Pullout (static): Pullout Strength / Static Total Tension, Fg

FS Pullout (w/ seismic): Pullout Strength / Total Tension (w/ seismic), Fi

Connection Strength: Connection strength of the selected block/geogrid
combination.

FS Connection (static): Connection capcacity / Static Total Tension, Fg

FS Connection (w/ seismic): Connection capcacity / Total Tension (w/ seismic), Fi

Internal Sliding Force (static): The driving force at each layer of geogrid from static
loading tending to cause the soil mass above to slide sideways.

FS Internal Sliding (static): Internal sliding resistance / Static internal sliding force

Internal Sliding Force (w/ seismic):The driving force at each layer of geogrid from loading
including seismic tending to cause the soil mass above to slide sideways.

FS Internal Sliding (w/ seismic): Internal sliding resistance / Internal sliding force (w/
seismic)
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Construction Tab (for Geogrid Reinforced Walls)

Displays schematic drawing of wall, reinforced area, geogrid layers, dimensions, and failure
line for Coulomb method.

13.7.4.7   Gravity Segmental Retaining Walls
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Block & Geogrid Data Tab for Gravity Walls

Segmental Type: Select either Gravity or Geogrid.

Total No of Block Courses: Enter the number of block courses.

Select block: From the drop down menu select the vendor and block
you want to use. Selecting a block will insert its values
into the criteria below.

Block Depth, in: This will be automatically input based upon block selection.

Block Height, in: This will be automatically input based upon block selection.
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Wall weight, psf: This will be automatically input. Note that the full block depth is
assumed to be in-filled and an average density of 120 pcf is used. 
Note that block weight is in units of psf.  Think of looking at an
elevation of a constructed wall.  It is the weight of one square foot of
finished wall.  It is calculated by knowing the weight of the solid portion
of the block and assuming that any hollow portions are filled with
material that weighs 120 pcf.

Offset per block, in: Select this value from the drop down menu – it is vendor dependent.

Batter, degrees: This angle will be computed and displayed based upon offset and
block height entered.

Masonry Friction Reduction Factor:  Select the desired Masonry Friction Reduction Factor.
 (The adjacent button offers a quick view of NCMA
Table 6.1 for some guidance on this factor.)

Gu Options: Select the desired method of calculating/specifying the value of Gu.  

Wall Geometry Table:

Block: Displays the total number of block courses.

Height: Displays block and layer heights in ft-inches and decimals.
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Results Tab (for Gravity Segmental Retaining Walls)

Displays the minimum acceptable factor of safety and the minimum actual factor of safety for
all applicable failure modes, for the static condition and for the condition that includes seismic
loading.
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External Stability Tab (for Gravity Segmental Retaining Walls)

Displays overturning and sliding factors of safety as well as bearing pressure results.

Also reports eccentricity of vertical force and effective base width.
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Internal Stability Tab (for Gravity Segmental Retaining Walls)

Displays internal stability table:

Block: Displays course numbers.

Height, ft: Displays the height from the base to the elevation of the top of each course.

Depth to Course: Displays the distance from the top of the wall to the top of each course.
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Internal Sliding Force (static): The driving force at each course from static loading
tending to cause the soil mass above to slide
sideways.

FS Internal Sliding (static): Internal sliding resistance / Static internal sliding
force

Internal Sliding Force (w/ seismic): The driving force at each course from loading
including seismic tending to cause the soil mass
above to slide sideways.

FS Internal Sliding (w/ seismic): Internal sliding resistance / Internal sliding force (w/
seismic)

Construction Tab (for Gravity Segmental Retaining Walls)

Displays schematic drawing of wall.
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13.7.4.8   Methodology / Analysis & Design Assumptions

References used for the development of this program are listed in Appendix E.

Surcharge can be composed of either dead load, live load, or both. 

The design of segmental retaining walls generally follows the guidelines in Design of

Segmental Retaining Walls, 3rd Edition published by the National Concrete Masonry
Association (NCMA). Some assumptions have been made to simplify the program (as stated
in the program), yet cover most construction practices and design requirements. 

13.7.5  Appendices

Appendix A  - Table of Horizontal Temperature and Shrinkage Reinforcing
Appendix B  - Development and Lap Lengths
Appendix C  - Weights of Masonry Walls
Appendix D  - Summary of Concrete & Masonry Design Formulas
Appendix E  - References Used For The Development Of This Program
Appendix F  - Rankine and Coulomb Formulas

13.7.5.1   Appendix A - Table of Horizontal Temperature and Shrinkage Reinforcing

Typical Horizontal Rebar Spacing
for .0007 Ag Masonry and .002 Ag for concrete

Mat’l Thick #3 #4 #5 #6 #7

Concrete 6 9 17 18 18 ¾

Concrete 7 8 14 18 18 ¾

Concrete 8 7 12 18 18 ¾

Concrete 9 6 11 17 18 ¾

Concrete 10 5.5 10 15 18 ¾

Concrete* 12 9 17 18 18 ¾

Concrete* 14 8 14 18 18 ¾

Concrete* 16 7 12 18 18 ¾

CMU 6 24 48 48 48 ¾

CMU 8 16 32 48 48 ¾

CMU 10 16 24 32 48 ¾

CMU 12 12 24 32 48 ¾

CMU 16 8 16 24 40 48

1115

1116

1117

1118

1119

1119
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* ACI 318-14 Section 11.7.2.3 requires two layers in walls over 10” thick, but “basement
walls” are exempted, which presumably applies to retaining walls also. However, the
above spacings assume that the specified rebar will be placed on each face.

13.7.5.2   Appendix B - Development and Lap Lengths

Lap Splice Lengths(1) and Hooked Bar Embedments (inches)

(1) Min. lap for spliced bars, in., assumes fy = 60 ksi, per ACI 318-14, Equation

(25.4.2.3a).

(2) 40 bar diameters for fy = 40 ksi and 48 diameters for fy = 60 ksi  

(3) Min. lap is development length x 1.3, assuming Class B splice. Cannot be reduced for
stress level.

(4) Assumes standard hook and not reduced by ratio As (required) / As (provided).

Note that IBC 2018 Section 2107.2, offers an alternative to TMS 402-16, Section 2.1.7.7.1.1.  If
the alternative is used, it replaces the following development length equation in TMS 402:

g = 1.0 for #3, #4, #5 bars, 1.4 for #6, #7, and 1.5 for #8
K = Smallest of (minimum masonry cover, the clear spacing between adjacent
reinforcement splices, and 9 db

This requirement resulted in much longer lap lengths and has met with considerable
objection.
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13.7.5.3   Appendix C - Weights of Masonry Walls

Wall Thickness Concrete Masonry Units

Solid Grouted
Wall

Lightweight
103 pcf

Medium Weight
115 pcf

Normal Weight
135 pcf

6” 8” 10” 12” 6” 8” 10” 12” 6” 8” 10” 12”

52 75 93 118 58 78 98 124 63 84 104 133

Vertical
Cores
Grouted
at:

16” o.c. 41 60 69 88 47 63 80 94 52 66 86 103

24” o.c. 37 55 61 79 43 58 72 85 46 61 78 94

32” o.c. 36 52 57 74 42 55 68 80 47 58 74 89

40” o.c. 35 50 55 71 41 53 66 77 46 56 72 86

48” o.c. 34 49 53 69 40 45 64 75 45 55 70 83
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13.7.5.4   Appendix D - Summary of Concrete & Masonry Design Formulas
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13.7.5.5   Appendix E - References Used For The Development Of This Program

· ACI 318-14, published by the American Concrete Institute. 

· International Building Code (IBC) 2015 and 2018, published by the International Code
Council (ICC).

· Building Code Requirements for Masonry Structures, TMS 402-13/ACI 530-13/ASCE 5-
13, TMS 402-16.

· Minimum Design Loads for Buildings and Other Structures, ANSI/ASCE 7-05,
ANSI/ASCE 7-10, and ANSI/ASCE 7-16.

· Design of Reinforced Masonry Structures, Concrete Masonry Association of California
and Nevada, 1997.

· Foundation Analysis and Design, Fifth Edition, by Joseph E. Bowles, published by
McGraw-Hill. 

· Reinforced Masonry Engineering Handbook, Fifth Edition, by J. Amrhein, published by
the Masonry Institute of America 

· CRSI Handbook, 1996, published by Concrete Reinforcing Steel Institute. 

· Design Manual for Segmental Retaining Walls, 3rd Edition, NCMA.

· Reinforced Concrete Design, Sixth Edition, Wang & Salmon, published by Harper &
Row.

· Principles of Foundation Engineering, 5th Edition, Braja Das, Thompson.

· Geotechnical Earthquake Engineering, Kramer, Prentice-Hall, 2003.

· The Seismic Design Handbook, 2nd. Edition, Farzad Naeim, Kluwer Academic
Publishers, Boston. 2001.

· NEHRP Recommended Provisions for Seismic Regulations for Buildings and Other
Structures, Parts 1 and 2, 2002. Edition.

· Foundations and Earth Structures, NAVFAC Design Manual 7.02, 1986.

· Foundation Engineering, 2nd Edition, Peck, Hansen, Thornburn, Wiley, 1974.

· Soil Mechanics in Engineering Practice, Tarzaghi and Peck, Wiley, 1967.

· Design and Performance of Earth Retaining Structures, ASCE Paper by Robert
Whitman, 1990.

· Lateral Stresses & Design of Earth-Retaining Structures, ASCE Paper by Seed and
Whitman, 1970.

13.7.5.6   Appendix F - Rankine and Coulomb Formulas

The three methods of inputting active soil pressure are the Equivalent Fluid Pressure (EFP)
method, Rankine method and Coulomb method.

With the Equivalent Fluid Pressure (EFP) method, the soil active pressure is defined by an
equivalent fluid pressure in psf per foot of depth (e.g. 35 psf).
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With the Rankine or Coulomb method, you can input the angle of internal friction and the
program will compute the horizontal (and vertical, if applicable) Ka by the respective formulas.

For a level backfill, both the Rankine and Coulomb formulas give the same result, except that
the latter also takes into account frictional resistance of the wall surface, and inclination of the
wall surface (i.e. batter).

The Rankine Formula

The Coulomb Formula

For both formulas:

b = Angle of backfill slope

f = Angle of internal friction

a = 90° - wall slope angle from horizontal

d = Angle of friction between soil and wall  (Assumed in program to be f/2 when heel does
not project beyond the soil face of the wall.  Otherwise, the failure plane is assumed to occur
at the end of the heel projection (soil-on-soil), and d is assumed to be f.)

13.8 Miscellaneous

Please select a subtopic.
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13.8.1  Steel Base Plate FEM

This module applies engineering principles to the design of a steel base plate though the
use of a finite element analysis of the plate.

General

AISC provides solutions for steel base plates with various loads in Design Guide 1.  But the
design guide does make some simplifying assumptions (infinitely rigid substrate, uniform
or triangular bearing pressure of a certain magnitude, extent of bearing pressure, etc).  And
the design guide also has some limitations (concentric loading).  While the design guide
has proven to be a reliable design reference over the years, there are some applications
where a different tool is required.  The purpose of this module is to provide an alternative to
the design guide.  

The methods of this module are based in engineering principles, but it should be noted that
it employs Finite Element Analysis and a different set of assumptions (spring support, non-
uniform bearing pressure) to arrive at code-compliant designs.  For this reason, one
should not be surprised to see that the module results in a different design than the AISC
Design Guide methods, even when the same starting parameters are entered, such as for
one of the design guide examples.

Flexural Design Approach

The code dictates that Mn shall be calculated with the smaller of Z or 1.6S.  For a
rectangular cross section, Z is always less than 1.6S.
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Therefore nominal moment should always be controlled by Z * Fy.  ENERCALC 3D reports
plate stresses as M/S.

This means that the actual stress can be modified by dividing by the ratio of Z/S.

Z = (bd 2̂/4)

S = (bd 2̂/6)

Z/S = 6/4 = 1.5

So the stresses determined by ENERCALC 3D, the underlying Finite Element Analysis
application, are then reduced by a factor of 1.5 when they are passed to this module.  In
this way, the stresses can be compared on par with allowable stresses determined as
follows:

ASD:  

Allowable stress is Fy / Omega.

LRFD:

Allowable stress is phi * Fy.

Target Mesh Element Size 

Typical mesh element target size is automatically established by finding the minimum of
plate width and plate height, and dividing that value by 50.  The target mesh element size is
automatically reduced in close proximity to the column footprint, where stress
concentrations occur.

Substrate Stiffness

The plate is supported on a bed of compression-only area springs.  In reality, the stiffness
of the resistance under the plate is a function of the pedestal material, the footing material
and configuration, and the stiffness of the subgrade.  To simplify the condition to
something that can reasonably be modeled and solved, the stiffness of the springs is
determined by using δ = PL/(AE), where: 

δ = deflection
P = axial load
L = length of material that is under compression
A = area of material that is under compression
E = modulus of elasticity 

Note that this can be rearranged into the form of P/(A * δ) = E / L, where:
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P / (A * δ) may be easier to visualize as (P / A) / δ, which is the value of the spring
constant we are seeking, and
E and L are known quantities.

In this case, E is the modulus of elasticity of concrete, and L represents the length of
concrete in compression.  It stands to reason that a logical value for L is the length of the
anchor rods, as they create the tensile portion of the couple that creates compression in
the concrete.

General 

Steel Design Method
Select between ASD or LRFD design methods.

Plate Material
Specify the yield strength of the base plate material.

Concrete Support Material
Specify f'c, the 28-day compressive strength of concrete used to support the base
plate.  Also collects Ec, the modulus of elasticity of concrete.  This is used to
determine the stiffness of the compression-only springs in the underlying ENERCALC
3D model.  Specify nominal bearing strength of concrete.  This is used to calculate an
allowable bearing stress.

ASD: Omega per AISC J.8
Displays the capacity reduction factor, Omega, to be used in ASD per AISC 360
Section J.8 as follows:
IBC 2015 references AISC 360-10: Omega = 2.31
IBC 2018 references AISC 360-16: Omega = 2.31
IBC 2021 references AISC 360-16: Omega = 2.31

LRFD: Phi per AISC J.8
Displays the capacity reduction factor, Phi, to be used in LRFD per AISC 360 Section
J.8 as follows:
IBC 2015 references AISC 360-10: Phi = 0.65
IBC 2018 references AISC 360-16: Phi = 0.65
IBC 2021 references AISC 360-16: Phi = 0.65

User Defined Allowable Bearing Pressure in Lieu of AISC 360 Section J.8
The module also offers the option to override the AISC 360 Section J.8 calculated
values with a user-specified input value for the allowable bearing pressure.  When this
option is used, the user-specified value will be multiplied by phi or divided by Omega.



Calculation Modules 1124

© 2024  ENERCALC, LLC

Column & Plate 

Steel Column Properties
Type the AISC section name in the entry and press [Tab]. The module will look up the
section in the Steel database and, if found, will retrieve the values. The name must be
typed just as it appears in the AISC Steel Construction Manual.

Or click the [Section Database]  button to display the built-in steel database
and select a section.

Column Rotation
Select orientation of column on plate.  Note that plate width dimension remains parallel
to the X axis. 

Column Offset
Specify offset of column from the center of the plate.  Note that plate remains centered
on the concrete support.

Base Plate Size
Specify the plate length, width and thickness.

Concrete Support
Specify the length and width of the concrete support.

Anchors 

Anchor Geometry
The module provides two options for specifying anchor layout:  Graphical Anchor
Layout and General Anchor Layout.

When using Graphical Anchor Layout, the coordinate axes are shown, and anchor
locations are specified by selecting the desired checkboxes and providing the relevant
dimensions.  To provide an anchor at a location, simply select the checkbox.  To skip
an anchor, clear the corresponding checkbox.

When using the General Anchor Layout, specify the number of anchors, then specify
the X an Z coordinates of each anchor with respect to the origin at the center of the
plate.  For convenience, checkboxes are provided to automatically specify an anchor
placed symmetrically about one or both of the axes.  This makes it possible to
replicate multiple anchors without actually having to enter the coordinates of every
anchor.

Anchor Diameter
Specify typical anchor diameter.
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Anchor Length
Specify typical anchor length.  Note that the program uses this value to estimate the
length of concrete that experiences significant compressive forces and therefore
affects the internally calculated spring constant used in the finite element model.

Tension Capacity in Concrete
Tension capacity due to controlling concrete failure mode considering ACI 318-14
Sections 17.4.2 through 17.4.5 after all capacity factors are applied.  The applied
tension is compared to phi times this value to report a ratio.

Shear Capacity in Concrete
Shear capacity due to controlling concrete failure mode considering ACI 318-14
Sections 17.5.2 and 17.5.3 after all capacity factors are applied.  The applied shear is
compared to phi times this value to report a ratio.

Tensile Steel Strength, Fu
Used to calculate a ratio for tensile strength due to steel failure mode in accordance
with ACI 318-14 Section 17.4.1.  Also used to calculate a ratio for shear strength due
to steel failure mode in accordance with ACI 318-14 Section 17.5.1.

Applied Loads 

P - Axial Load
This column of entries specifies the axial load applied to the base plate. Note that
positive values represent downward loads.

Vx and Vz - Shear
These columns of entries specify the shear applied parallel to the named axis and to
be resisted by the anchor bolts.

Mx and Mz - Moment
These columns of entries specify the moment applied about the named axis and to be
resisted by the anchor bolts and concrete.

Load Combinations 

This tab displays the load combinations used for either the ASD or LRFD method.

Calculate Button

The Calculate button initiates the analysis and design process, which includes:

· Gather all input parameters and pass the input to ENERCALC 3D.

· Create the optimal mesh for the specified parameters.

· Assign materials, properties, supports, spring constants, releases, loads, etc. to the
ENERCALC 3D model.
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· Run the ENERCALC 3D analysis.

· Return analysis results from ENERCALC 3D to the Steel Base Plate module.

· Perform code checks and display results. 

Click the Calculate button any time the input parameters change.

Calculations 

Summary 
The Summary sub-tab reports the selected design method, the governing stress ratio,
and the plate dimensions.  It then provides specifics on the controlling condition for
plate flexure, bearing stress, and bolt tension.

Plate Bending Stresses 
The Plate Bending Stresses sub-tab lists the analyzed load combinations, and reports
stress on the xx edge and the zz edge of each shell in the underlying ENERCALC 3D
model.  It also reports the location of the center of each shell.

Plate Bearing Stresses 
The Plate Bearing Stresses sub-tab lists the analyzed load combinations, and reports
bearing stress for each shell in the underlying ENERCALC 3D model.  It also reports
the location of the center of each shell.

Anchor Forces 
The Anchor Forces sub-tab lists the analyzed load combinations, and reports anchor
tensile forces and geometric locations.

Plate Deflections 
The Plate Deflections sub-tab lists the analyzed load combinations, and reports
deflection values at the center of each shell as well as the location of the center of
each shell.  Negative values represent downward deflections.  Note that if LRFD is
used, the plate deflections will be reported based on factored loads.  The main
purpose of this tab is to provide the data necessary to evaluate whether the plate is
behaving as rigid or flexible.  So the absolute deflections are not the focus of this tab. 
Its purpose is to view the "trend" rather than the detail.

3D Rendering

The 3D tab displays a 3D rendering of the base plate with its supported column and
supporting concrete.  It includes options to selectively display other relevant items.
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Mesh 

The Mesh tab displays a view of the mesh that will be used in the underlying ENERCALC
3D model.  The anchor numbers are shown, and they coordinate with the numbers used
on the Anchor Forces tab.  The Regenerate button can be used to refresh the view of the
mesh if anything has changed, such as plate dimensions, column shape, column
orientation, column location, etc.  The mesh density gets increased in close proximity to
the column.  This allows the program to pick up on stress concentrations where the load
is introduced to the plate.  As a beneficial side effect, it also makes it possible to see the
column location when viewing the mesh.  This can be useful in verifying the column
location and orientation.

Stress Plots

The Stress Plots tab displays a variety of stress distributions using color rendering for the
selected load combination.

· XX Stress displays the top/bottom flexural stress on the xx edge of each shell for the
selected load combination.  The xx edge is the edge that is generally parallel to the
global Z axis (perpendicular to the global X axis).

· YY Stress displays the top/bottom flexural stress on the yy edge of each shell for the
selected load combination.   The yy edge is the edge that is generally parallel to the
global X axis (perpendicular to the global Z axis).

· Max of XX, YY Stress displays the maximum of either the XX Stress or the YY Stress
on every shell for the selected load combination.

· Bearing Stress displays the bearing stress distribution for the selected load
combination.  Note that this module uses compression-only springs to model the
interface between the steel plate and the concrete support.  So certain load
combinations with significant moment may show large areas with no bearing stress. 
This signifies that the compression-only springs in that zone have been deactivated by
the iterative solution process.

· Plate Deflection displays color gradients to represent the vertical displacement of the
individual shells.  Red represents downward displacement.  Blue represents upward
displacement.
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13.8.2  Steel Base Plate

Need more? Ask Us a Question

This module designs steel column base plates according to the latest Edition AISC Steel
Construction Manual and the AISC Design Guide 1, Second Edition.  

This module handles base plate design for the following conditions:
· where the resultant eccentricity is zero,

· where the resultant eccentricity is within the middle third for full bearing pressure,

· where the resultant eccentricity is outside the middle third resulting in a triangular
pressure distribution on part of the base plate, and 

· extreme eccentricity conditions where anchor bolts are required.

This module does not handle conditions where NET UPLIFT is present.  When the
summation of factored axial loads in a load combination is negative, then uplift controls and
the module will not calculate. Under these conditions, a red error message will be
displayed in the status bar to notify you of this condition.  Consider using the Steel Base
Plate by FEM module for these situations.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General & Materials

Steel Design Method
Select between ASD or LRFD design methods.
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For Axial Load Cases Only....
This selection controls the upward pressure used to design the plate. A brief
description of each choice is provided below the buttons for each selection. 

Full Bearing: Bearing is assumed uniform under plate. If plate area is larger than
needed, the larger "m" and "n" cantilevered dimensions could result in a thicker plate
than would be required if the pressure was calculated by the other option.

Bearing Area = P / Fp: Base plate is considered flexible with bearing concentrated
close to column. Maximum Fp is used to calculate ''design'' minimum plate size.
Determining the bearing pressure by this method might result in thicker plates if
bending stress is high between webs or within pipe or tube walls.

Steel Base Plate Fy
Specify the yield strength of the base plate material.

ASD: Omega
Enter the capacity reduction factor, Omega, to be used in ASD per AISC 360.

LRFD: Phi
Enter the capacity reduction factor, Phi, to be used in LRFD per AISC 360.

Concrete Support f'c
28-day compressive strength of concrete used to support the base plate.

ASD: Omega per AISC J.8
AISC 360 Section J.8 specifies Omega as 2.5. This entry allows the value to be
modified.

LRFD: Phi per AISC J.8
AISC 360 Section J.8 specifies Phi as 0.6. This entry allows the value to be modified.
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Column & Plate 

Steel Section Name & Database Button
Type the AISC section name in the entry and press [Tab]. The module will look up the
section in the Steel database and, if found, will retrieve the values. The name must be
typed just as it appears in the AISC Steel Construction Manual.

Or click the [Section Database]  button to display the built-in steel database
and select a section.
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[Edit Values] Button
Clicking this button will allow you to enter the steel properties.

Plate Information

Enter the length, width and thickness of the base plate. Use the buttons to
quickly change the values...the results are instantly recalculated.

Concrete Support
Enter the support dimensions that will be used to calculate the allowable bearing
pressure increase, A1 * sqrt(A2/A1).
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Applied Loads

Py - Axial Load
This column of entries specifies the axial load applied to the base plate. Note that
positive values represent downward loads.

Vz - Shear
This column of entries specifies the shear applied parallel to the plate and to be
resisted by the anchor bolts.

Mx - Moment
This column of entries specifies the moment that the column applies to the plate.
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Anchor Bolts 

Items on this tab specify the strength and location of the anchor bolts that will resist shear
and tension.

Description
Text description of the bolt for your reference. Not used by module.

Tension Capacity
Net tension capacity of bolt after all capacity factors are applied.

Shear Capacity
Net shear capacity of bolt after all capacity factors are applied.

Edge Distance
Distance from edge of plate to center of bolt closest to edge.
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Number of Bolts in a Row
The "Row" referred to is a row of bolts at the plate edge that will take any tension
force.

Number of Bolt Rows
Number of rows of bolts on each side.

Row Spacing
Spacing of rows when more than one row is used.

Load Combinations 

This tab displays the load combinations used for either the ASD or LRFD method.

The screen capture below shows a sample of the load combinations factors:
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Calculations - Overall

The Calculations tab contains a list of load combinations on the left and a summary of all
the calculated values for each load combination on the right. Click one of the load
combinations in the list to view results specifically for that load combination.

The very first item in the list will always say Overall Results. The module will examine the
results for all of the load combinations and determine which gives the extreme condition of
stress and presents it the Overall Results item. This is the governing case for the base
plate.

Note that Maximum Bending Stress is calculated using the plastic section modulus, in
keeping with AISC Design Guide 1, Second Edition.
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Calculations - Axial Load Only

When the selected load combination results in only an axial load being applied, the
summary of information below is displayed. See the AISC Design Guide #1 starting on
page 4 for a description of the values present here.
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Calculations - Small Eccentricity

When the selected load combination results in an axial load and very small moment being
applied, the summary of information below is displayed. This condition is caused when the
moment causes the resultant eccentricity of the axial load to be within the middle 1/3rd of
the base plate. See the AISC Design Guide #1 starting on page 19 for a description of the
values present here.
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Calculations - Large Eccentricity

When the selected load combination results in an axial load and large moment being
applied, the summary of information below is seen. This condition is caused when the
moment causes the resultant eccentricity of the axial load to be outside the middle 1/3rd of
the base plate. See the AISC Design Guide #1 starting on page 21 for a description of the
values present here.
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2D Sketch
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3D Rendering
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13.8.3  Steel Bolt Group Analysis

Need more? Ask Us a Question

This module applies the Elastic Method to determine the force distribution from loads
applied to a group of up to 16 bolts.

The required input data includes vertical and horizontal load magnitudes and their location
with respect to a datum point, along with the coordinates of up to sixteen bolts. 

Using these force and bolt coordinates, the module calculates direct shears and torsional
shears on each bolt due to its relative location within the group.

Note:
· At least two bolts should be specified.

· All bolts are assumed to be of the same deformation characteristics when loads are
distributed.

· Vertical and Horizontal forces are divided by the number of fasteners to give direct
shears.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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General 

Specify the locations up to 16 bolts. Use the Total Number of Bolts entry to indicate bolt
quantity.  The correct number of data entry locations will be displayed.
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Loads 

Enter the magnitude of the applied loads, the angle of load application measured CCW
from Cartesian zero degrees and the location of the point of load application relative to the
Datum point.  The module now accepts applied moments as well.
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Load Combinations

Based upon the selection of ASD or LRFD factoring, the appropriate load combinations will
be displayed on the load combinations tab.
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Results 

This tab reports the calculated Center of Bolt Group location, calculated moment applied to
the group from the load combination that creates the extreme moment and the eccentricity
of the load application from the Center of Bolt Group.

In the table below are the calculated force for each bolt due to direct and torsional shears
for each axis (after the applied load is resolved into X & Y components).
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Detailed Bolt Results

This tab provides the detailed calculations for all load combinations and all bolts.
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Sketch
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13.8.4  Rebar Development Table

Need more? Ask Us a Question

This module calculates development and splice lengths for deformed steel rebar in
concrete. Since typical development lengths are readily available in tables, this module is
primarily for developing tables of development lengths when unusual conditions affect the
lengths.

The module uses the relevant sections of ACI 318 to determine straight tension &
compression development and hooked tension development lengths.

Print This Information
Check this box if you want the development calculation on the current tab to appear on
the printout.

This Bar
Enter a description for the current development calc.

Bar Details
Enter the basic stress info for this bar.

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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Straight Development
This section calculates tension & compression bar development according to ACI.
Please refer to the relevant ACI code for details.

Hooked Development
This section calculates tension hooked rebar development according to ACI. Please
refer to the relevant ACI code for details.

13.9 External Items

ENERCALC SEL allows you to add non-ENERCALC items into a locally saved Project
File.  Until 2023, the types of items that could be added were limited to: 

· MS Excel Spreadsheets

· MS Word Documents

· Adobe Acrobat PDF Files

· Scanned Images

However, in January 2023, this functionality received a huge enhancement.  By using the
native application to display the contents of an External Item file, ENERCALC SEL can
now support an almost limitless variety of file formats as External Items.  

For example, you can now think in terms of having a RAM or RISA model as an External
Item.  Have some JPEG photos of as-built conditions and want to preserve them as part of
an ENERCALC project file?  No problem.  Still prefer to use that MathCad sheet for the
design of certain elements?  Go for it, and then link it or embed it.

The ability to include External Items allows you to use the ENERCALC Project File as a
central point of document preparation and storage for structural project calculations.
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External Items can be interspersed throughout the list of calculations in the Project
Manager, or they can be placed in Divisions that have been created specifically to contain
the external items.



Calculation Modules 1152

© 2024  ENERCALC, LLC

13.9.1  Relating an External Item to a Project File

Relating External Items to an ENERCALC Project File

When relating External Items to an ENERCALC Project File, there are two options for the
way the External Items are saved:

· Linked: Saves a link to the External Item in Project File.  (Keeps Project File size small,
but it's not as easily portable.)

· Embedded:  Saves a copy of the External Item in what's called a "blob file" that actually
becomes a part of the Project File. (Easiest for portability, but results in larger Project
File size.)

The method is the same, regardless of which option is desired.  Click on the desired
location of insertion in the Project Manager, and then click the Add button:
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In the External Items category of the Module Selection screen, click Link or Embed:
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In the Select File to Open screen, browse for the desired file, click on it, and then click
Open:

The ENERCALC SEL screen will appear as shown below, and note that the
view/preview/display of the External Item no longer occurs within the ENERCALC
window.  This is to be expected.  The numbered features are described below the image.
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1:  Storage Method:  Indicates the current storage method, and allows it to be modified.  If
an Embedded item is changed to Linked, the program will report the
name and location of the resulting file.  

2:  External Item Location:  For Embedded items, this indicates the original name and
location of the item, and verifies that it is embedded in the
Project File.  For Linked items, this indicated the file name and
location of the item

3:  Description:  The user can enter a description to more easily identify the item.  The
Description will be shown in the Project Manager and will be prepended by
either "Linked" or "Embedded" for reference.

4:  Open in [native application]:  Button allows the External Item to be opened in its native
application.

5:  Open/Retrieve:  Allows a different file to be selected for the current External Item.

6:  Save & Close:  Saves changes to the Description or Storage Method.  (Any changes to
the External Item can be saved when the item is open in its native
application.

  

After Save & Close is clicked, the Project Manager will display the item like this:
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13.9.2  Limitations of Working with External Items

As of January 2023, External Items are not incorporated into a Project Print when using the
Project Printing Manager.  

The following table summarizes the capabilities of external items within the various
formats of ENERCALC SEL: 

Embedded
External Items
can be Used?

Linked External
Items can be

Used?

Embedded
External Items

can be Viewed?

Linked External
Items can be

Viewed?

Local Storage
option within the
Installed Version

Yes Yes Yes Yes

Hosted Storage
option within the
Installed Version

No No Yes No

Cloud Version No No No No
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13.9.3  Scanned Document

Need more? Ask Us a Question

ENERCALC SEL now offers you the ability to use your scanner to create items and insert
them into your Project File. To scan an item and add it to your Project File, click on the
Division where you would like to insert the scanned item, click the [Add] button, and then
click [Scan a Document]:

mailto:support@enercalc.com?subject=ENERCALC DOCS - Request for Additional Help
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When the module is loaded you will see the screen below:

Here is a description of the various controls in this module: 

Scan Page: Using all the settings on the "Scanner Setup" page, perform a high resolution
scan.

Delete & Rescan: Delete the currently visible scan and rescan the image at a different
resolution.

Print this Scan: Print the currently visible image to a printer.

Save scanned image: Save the current scan to a file.
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Scanner Setup: Access the scanner setup screen (see image below)

Options:

Reset Scanner: Send signals to the scanner to reset itself to its default state.

Preview/Crop/Scan: Perform a fast, low resolution "preview" scan and display it for your
use in defining the final region that will be used for the high resolution scan.

Delete Page: Remove the current scan from this viewer.
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Image Manipulation buttons: Allow you to change the way you view the scans in this
document.

To create a scanned item, place the item on the scanner and click the [Scan Page]
button. If desired, enter text in the Description field. Then, click the [Save & Close]
button. The display will return to the Project Manager, and you will see an indication that
the scanned item has been attached as shown in the image below:
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